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1
Introduction

To deliver a great customer experience, you need to know what you are doing right and what 
you need to do better. That requires full visibility into all of your customer touch points 
across customer service, sales, marketing, and feedback activities. You also have to be able to 
deliver timely, actionable analytics information to managers and decision-makers across your 
entire organization. With RightNow Analytics—our business analytics software—you can 
capture, analyze, and distribute information about customer interactions with ease and flexi-
bility.

RightNow Analytics is embedded throughout RightNow, providing your organization with a 
unified view of all analytics across all channels. With hundreds of standard reports and the 
ability to create custom reports and dashboards, you can easily measure your most critical per-
formance metrics and quickly respond to changing conditions and customer needs.

About this manual
This manual is intended for any staff member who works with RightNow’s Analytics compo-
nent. It contains an overview of the Analytics explorers and procedures for generating stan-
dard reports, creating custom reports and dashboards, and working with report styles, chart 
styles, color schemes, images, and text fields to use with reports.

Chapter 2, Analytics Explorers—Contains procedures for using the Reports, Styles, 
Images, Chart Styles, Color Schemes, and Text Fields explorers. Also describes how to copy, 
save, and search for items in the explorers.

Chapter 3, Report Management—Contains procedures for using custom and standard 
reports. A description of the report ribbon is provided, along with procedures to search for 
items in reports, and export, print, and queue reports. This chapter also includes procedures 
to format reports using slicing, cross-tabs, rollups, and other options.

Chapter 4, Creating Basic Reports—Contains procedures for creating a basic custom 
report. Suggestions for planning reports before creating them are also provided.



12 Introduction

Chapter 1

Chapter 5, Custom Reports—Contains an overview of the report design center and proce-
dures to create custom reports on the design center. This chapter also describes the content 
you can add to reports, how to create filters to limit the data returned in reports, how to for-
mat reports, how to link to other reports and dashboards, and how to change display options.

Chapter 6, Dashboards—Contains procedures for creating dashboards, how to search for 
records in dashboards, and how to work with reports that are displayed on dashboards.

Chapter 7, Enterprise Analytics—Describes Enterprise Analytics, which allows creating 
and running reports that return or query data from RightNow databases and external data-
bases.

Appendix A, Analytics System Configuration Settings—Describes the system configura-
tion settings that can impact report performance and output.

Appendix B, Transaction Descriptions—Describes the contents of the database’s transac-
tions table. This data can be used in custom reports to find and return information about 
events that occur to incidents, contacts, opportunities, and other records on your site.

Documentation conventions
As you work with RightNow documentation, you will notice certain conventions used to con-
vey information. To help you become familiar with these conventions, the following table 
contains examples and descriptions of the conventions used.

Convention Description

<angle brackets> as in:
http://<your_site>.custhelp.com/

Indicates variable information specific to your 
RightNow application.

RightNow Common>CTI>General>
CTI_ENABLED

Indicates the path to access a configuration setting 
or message base, beginning with the category and 
ending with the specific configuration setting or 
message base.

Click the Application button and select Help>
Help Contents

Indicates the multiple selections necessary to 
access an option or action from a tiered menu.

Asterisk (*) preceding field names in tables Indicates that the field is required. You cannot 
save a record, report, or file until you fill in all 
required fields.
Note: In RightNow, required fields are flagged 
with an asterisk, or the field name appears in red 
text, or both.
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RightNow August ’09 documentation
RightNow Technologies offers manuals, guides, and documents to help you install, adminis-
ter, and use RightNow products, including RightNow Service™, RightNow Marketing™, 
RightNow Feedback™, and RightNow Sales™. Our documentation is written for users who 
have a working knowledge of their operating system and web browsers and are familiar with 
standard conventions such as using menus and commands to open, save, and close files.

RightNow Administrator Manual—Contains procedures for configuring options com-
mon to RightNow Service, RightNow Marketing, RightNow Feedback, and RightNow Sales. 
This manual addresses navigation sets, staff management, workspaces, workflows, agent 
scripting, customizable menus and product linking, business rules, custom fields, system con-
figuration, communication configuration, monetary configuration, database administration, 
the external suppression list, multiple interfaces, Outlook integration configuration, CTI 
(computer telephony integration) configuration, screen pops, contact upload, and add-ins.

RightNow User Manual—Contains procedures common to all staff members, including 
customer service agents, marketing personnel, and sales representatives. This manual 
addresses common functionality that applies across products, plus contact and organization 
records, tasks, notifications, CTI (computer telephony integration), Outlook integration, 
shortcut keys, and SmartSense. 

RightNow Analytics Manual—Contains procedures for working with RightNow Analytics, 
including generating standard reports and creating custom reports and dashboards. Also 
included are descriptions of the elements used to build custom reports and dashboards, 
including styles, chart styles, color schemes, images, and text fields. This manual also contains 
information about and procedures for using Enterprise Analytics.

RightNow Service Administrator Manual—Contains procedures for configuring 
RightNow Service. This manual addresses standard text and variables in the content library, 
guided assistance, Offer Advisor, service level agreements, RightNow Chat, and RightNow 
Wireless.

Key combinations such as:
Ctrl+Shift+Tab
Ctrl+f

Indicates that more than one key must be pressed 
simultaneously to perform an action.
Note: Keyboard keys are set in bold type in the 
documentation for highlighting purposes.

Convention Description
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RightNow Service User Manual—Contains procedures for customer service agents work-
ing in RightNow Service. This manual addresses incidents, answers, RightNow Chat, cloud 
monitoring, Offer Advisor, incident archiving, and RightNow Wireless. 

RightNow Customer Portal Manual—Contains a description of the RightNow Customer 
Portal and the framework used to create and customize pages, templates, and widgets. In-
depth descriptions of all customer portal elements are also included as well as procedures for 
creating, editing, and deploying the RightNow Customer Portal.

RightNow Marketing User Manual—Contains procedures for staff members working 
with RightNow Marketing. This manual addresses Marketing explorers, audiences, the con-
tent library, mailings, and campaigns.

RightNow Sales Administrator and User Manual—Contains procedures for the 
RightNow administrator and all staff members working with RightNow Sales. Procedures for 
the RightNow administrator include adding sales process options and quote templates and 
configuring disconnected access. Procedures for sales staff members include working with 
opportunities, quotes, and disconnected access. 

RightNow Feedback User Manual—Contains procedures for all staff members working 
with RightNow Feedback. This manual addresses Feedback explorers, audiences, the content 
library, questions, and surveys.

RightNow Made Easy: An Administrator’s How-To Guide—Contains basic procedures 
for the RightNow administrator to configure all common areas in RightNow and all 
RightNow products, including RightNow Service, RightNow Marketing, RightNow 
Feedback, and RightNow Sales. This streamlined how-to guide gives administrators the basic 
steps to set up and configure all areas in RightNow, one task at a time, and complements the 
array of published RightNow manuals and documentation. 

RightNow Made Easy: A User’s How-To Guide—Contains the basic procedures for tasks 
that staff members perform on a regular or daily basis. With how-to instructions for each 
RightNow product, customer service agents, marketing personnel, and sales representatives 
can quickly and efficiently complete routine tasks as they work with customers and prospects. 
The user’s how-to guide combines several RightNow user manuals into one easy-to-use 
resource.

RightNow Voice Manual—Contains general information about the applications that com-
prise RightNow Voice as well as implementation information for each Voice application. This 
manual is intended for organizations who offer RightNow Voice or are considering this self-
service solution, anyone implementing RightNow Voice, and staff members who are respon-
sible for managing the software (on behalf of an organization or for their own organization) 
after implementation.
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RightNow August ’09 Release Notes—Contains a brief description of the new and 
expanded features in RightNow August ’09, including features common to all products and 
those specific to RightNow Service, RightNow Marketing, RightNow Feedback, and 
RightNow Sales.

RightNow HMS Guide—Contains upgrade instructions for customers hosted by 
RightNow Technologies.

RightNow Smart Conversion Guide—Contains procedures for upgrading from RightNow 
CRM 7.5 and subsequent versions to RightNow August ’09.

RightNow Smart Client Installation Guide—Contains procedures for installing the 
RightNow Smart Client on staff workstations using the Click-Once or MSI deployment 
method.

RightNow XML API Manual—Contains procedures for using the XML API to integrate 
the RightNow knowledge base with external systems, including help desks, data mining, and 
data reporting systems.

RightNow Pass-Through Authentication Guide—Contains procedures for integrating 
RightNow Service with an external customer validation source to allow your customers to 
automatically log in to RightNow Service from an external web page. Contact your RightNow 
account manager to obtain this manual.

Tip For a comprehensive list of all RightNow documentation, refer to 
http://community.rightnow.com/customer/documentation.
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2
Analytics Explorers

RightNow’s reporting features are accessed through the Analytics explorers. These explorers 
allow you to create custom reports and dashboards, view standard and custom reports, and 
edit report styles, chart styles, color schemes, images, and text fields to use with reports and 
dashboards.

For an overview of explorers in RightNow, refer to the RightNow Administrator Manual.

In this chapter

• Searching in explorers—Contains the procedure to search for items, such as reports and text 
fields, in Analytics explorers. Refer to page 18.

• Copying and saving in explorers—Contains procedures for copying and saving items in explor-
ers. These procedures are identical regardless of the explorer used. Refer to page 22.

• Reports explorer—Describes the Reports explorer, from which you can view, create, and edit 
reports. Refer to page 25.

• Styles explorer—Contains procedures for creating and editing report styles to quickly apply 
detailed display settings to any report. Refer to page 27.

• Chart Styles explorer—Contains the procedure for creating and editing chart styles, which can be 
applied to charts in your reports to give them common display formats. Refer to page 33.

• Color Schemes explorer—Contains the procedure for creating color schemes to give charts pre-
defined colors. Refer to page 50.

• Images explorer—Contains procedures to upload your own images to use in custom reports and 
dashboards. Refer to page 52.

• Text Fields explorer—Contains the procedure for creating your own standard text fields to add 
to custom reports and dashboards. Refer to page 54.

• Selecting fonts and colors—Contains procedures for selecting fonts and colors for items 
accessed from the explorers. Refer to page 61.
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Accessing Analytics explorers
The Analytics explorers are accessed from the navigation pane. Staff members’ ability to use 
the explorers is determined by the navigation set and profile they use. Refer to the RightNow 
Administrator Manual for information about configuring navigation sets and profiles.

To display Analytics explorers:
Click the Analytics button on the navigation pane.

Once you open any of the Analytics explorers, you will see a ribbon with options that allow 
you to create, delete, edit, and copy items shown in the explorers, navigate folders, and search 
for specific items. These options are described in the RightNow User Manual.

Searching in explorers
RightNow contains powerful functionality to help you find information. From any of the 
Analytics explorers, you can search for files specific to the explorer you are working in (for 
instance, you can search for reports from the Reports explorer, text fields from the Text 
Fields explorer, and so on). RightNow also contains a Quick Search feature that enables you 
to search for a specific file or record no matter where you are in the product. In order to use 
Quick Search, your navigation set must contain Quick Search reports. Refer to the RightNow 
User Manual for information about using Quick Search to find files and records.

This section contains the procedure to search for reports from the Reports explorer. How-
ever, the basic procedure is the same for all RightNow explorers—only the columns available 
for searching change between explorers.

To search for a report:

1 Double-click Reports Explorer on the navigation pane.

2 Click the Find button on the ribbon. The left side of the content pane displays a find 
menu, hiding the folders tree.

Note Explorers can be added to any navigation list, just like any report or other item. 
The procedures in this chapter assume that you access all Analytics explorers 
from the Analytics navigation list.
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Figure 1: Searching from the Reports Explorer
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3 Enter field information described in Table 1.

Table 1: Reports Explorer Find Menu Description

Field Description

Find Using Click this drop down menu to select a column in the reports list to 
search on. You can search by the report’s name, ID number, dates 
created or updated, the report’s initial run (opening report without 
prompting for search parameters) status, or the refresh on edit sta-
tus. Each column is associated with one of three data types which 
determine the available search options:

• Strings—Search for strings that start with, contain, end 
with, or match the value you enter in the text box. 

• Dates—Search for dates before, on, or after today’s date. 
You can also click the calendar to display the current 
month’s calendar and select another day, or click the arrows 
at the top of the calendar to change months.

• Integers—Search for values that are less than, equal to, or 
greater than a number.

Search text box Type your search text in this field.

Case Sensitive When searching a string column, select this check box if you want 
to match the case.

Show Advanced Options Click Show Advanced Options to display additional search options.
Note: Advanced search options apply only after you have con-
ducted a search.

Search globally, replace 
results

Select this radio button to remove the results from the previous 
search and replace them with results from this search.

Search globally, append 
to results

Select this radio button to keep results from the previous search 
and add results to them from this search.

Search within results, 
replace results

Select this radio button to search the current search results and 
keep only those results that match the new search.

Return Non-matching 
Items

Select this check box to return all reports that do not match your 
search criteria.
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4 Click the Find button. The search results replace the initial list of reports.

Figure 2: Report Search Results

5 To remove the search results, click the Clear button.

6 To replace the search results with the original reports list, click the Refresh button on the 
ribbon.

7 To remove the Find menu and display the folders list, click the Folders button on the rib-
bon.
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Copying and saving in explorers
The method of copying and saving reports and other items in the Analytics explorers is the 
same, no matter what type of explorer you are using. This section explains these processes 
when working in the Analytics explorers.

Creating custom folders
You can create custom folders in any explorer, where you can store new or copied reports, 
styles, chart styles, color schemes, images, and text fields. You can also rename custom folders 
and files.

To create a custom folder:
1 Right-click the parent folder you want to add the custom folder to.

2 Select New Folder.

3 Type a name for the folder.

4 Click outside the folder name, or press Enter, to save the name.

To rename a custom folder:
1 Right-click the custom folder.

2 Select Rename.

3 Type a new name for the folder.

4 Click outside the folder name, or press Enter, to save the name.

Note Not all standard folders will accept custom folders.

Tip You can also use right-click functionality to rename custom folders when you 
are saving or copying items.
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Copying items
The predefined reports, styles, chart styles, and color schemes you will find in the Analytics 
explorers cannot be edited, renamed, or deleted. However, you can copy any of these pre-
defined items and use the copy as a starting point when you want to create a customized ver-
sion. You can also use the same method to copy custom items that were created in any of the 
Analytics explorers.

To copy an item:
1 Open the appropriate explorer.

2 Right-click the item you want to copy.

3 Select Copy to open the Copy <name> As window.

Figure 3: Copying a Chart Style

4 To store the new item in a custom folder, navigate to the folder.

5 Type a name for the new item in the Name field.

6 Click the OK button to save the new item.

Note Custom files cannot be stored in the Reports explorer’s or Images explorer’s 
standard folders.
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Saving items
The procedure to save reports, styles, chart styles, color schemes, images, and text fields is 
similar, no matter what type of item you are saving.

To save an item:
1 After editing the item, select the appropriate save option on the ribbon’s Home tab:

a Select Save to save changes to the item without closing it.
b Select Save As to save a new item, or to save a copy of the item you are editing with a 

different name.
c Select Save and Close to save changes to the item and close it. This option is faster than 

saving a change and then manually closing the window.

When you select Save As, or attempt to save a new item for the first time, the Save As win-
dow will open where you name the item. An example of saving a new style in the Save As 
window is displayed in Figure 4.

Figure 4: Saving a New Style in the Save As Window

2 To store the new item in a custom folder, navigate to the folder.

Note Options for saving a custom report are accessed by clicking the arrow on the 
Save button on the report design center’s Quick Access toolbar.

Note Custom files cannot be stored in the Reports explorer’s or Images explorer’s 
standard folders.
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3 Type a name for the new item in the Name field.

4 Click the OK button to save the item.

Reports explorer
The Reports explorer provides you with one location to view and organize reports, and edit 
and create custom reports and dashboards. The content created in the other Analytics explor-
ers is applied to reports using the Reports explorer. The Reports explorer is shown in Figure 
5.

Figure 5: Reports Explorer
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Reports are contained in folders in the Reports explorer. These folders are in a tree structure 
and can be expanded or collapsed to hide or display their contents. Reports that are accessible 
by multiple staff members are contained in the Public Reports folder, and private reports that 
are accessible only to the staff member who created them are stored in the My Reports folder. 

Clicking a folder in the Reports explorer’s tree will display the folder’s contents in the list on 
the right. A folder’s contents can include reports, dashboards, and sub-folders. Reports and 
dashboards contained in the same folder are automatically sorted in alphabetical order and 
cannot be reordered. However, you can drag items from one folder to another.

Right-clicking a folder or report displays a list of actions you can take on the item, as shown in 
Figure 6.

Figure 6: Right-Clicking a Report in the List

Note Other staff members’ My Reports folders are not displayed in the Reports 
explorer. However, RightNow administrators can log in with a special account to 
access every account’s folders. This ensures that private reports can be edited, 
moved, and deleted if necessary.
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Specific procedures on using the Reports explorer are available throughout this manual:

• For information about using reports, changing report displays, and distributing reports, 
refer to Chapter 3, “Report Management,” on page 67.

• For information about creating reports, refer to Chapter 5, “Custom Reports,” on page 
175.

• For information about creating dashboards, refer to Chapter 6, “Dashboards,” on page 
359.

Styles explorer
Report styles allow you to quickly apply custom display settings to your reports without edit-
ing the underlying report. Styles can also help staff members use the same display settings for 
their reports so that all reports generated by your staff share the same appearance. For infor-
mation about applying a style to a report, refer to “Changing report displays with styles” on 
page 129.

RightNow contains a number of default styles, which may be all you need. However, you can 
easily create and edit styles to define the specific fonts, colors, borders, and margins which are 
most appropriate for your target audience. You can then apply your custom styles to reports 
just as you would the default styles.

You can edit style options for various components used in reports, such as text fields, column 
headers, exceptions descriptions, or entire report sections. The style options will vary depend-
ing on the type of component you are editing. For example, the options for a text component 
will include a Font tab, whereas the options for a non-text component will not, since font set-
tings do not apply. Refer to Chapter 5, “Custom Reports,” on page 175 for descriptions of the 
various components that can be added to reports.

Using the style editor
The style editor displays examples of the various report components that you can create cus-
tom styles for. This helps you easily identify the component you want to modify. You can also 
select the component you want to modify from a list if you know its name.

To select a component from the style editor:
1 Click the Analytics button on the navigation pane.

2 Double-click Styles Explorer. The Styles explorer will open, displaying the current styles.
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3 To create a style, click the New button.

Or

To edit an existing custom style, right-click the style and select Edit.

The style editor opens.

Figure 7: Style Editor

4 Select the component whose style you want to modify from the drop-down menu at the 
top of the editor and click Edit.

Or

Double-click the component on the style editor. A window opens for selecting style 
options.

5 Select style options described in the next section.

6 Save the style.
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Selecting style options
Once you select the component you want to modify from the style editor, you can define 
options for the component’s font, margins, background colors, and borders.

To select style options:
1 Open the style editor window for the component you have selected. By default, the editor 

window will open on the Font tab if the selected component includes text. Refer to 
“Choosing font attributes” on page 61 for information about the Font tab.

2 Click the Margins tab to define the amount of space surrounding the component when 
used in reports.

Figure 8: Styles Margins Tab

Note You can access all the style options for the selected component from the win-
dow that displays when you select a component and click Edit. However, you 
can also select common style options for the selected component using the but-
tons on the explorer’s ribbon, which provide shortcuts to many of the same 
options available on the window. In this procedure, we will show you how to 
change options from the window.
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3 Enter field information described in Table 2.

4 Click the Fill tab to modify the background fill colors for the selected component.

Figure 9: Styles Fill Tab

Table 2: Margins Tab Description

Field Description

Left Select the number of pixels between the component and the left 
side of the report section it resides in.

Right Select the number of pixels between the component and the right 
side of the report section it resides in.

Top Select the number of pixels between the component and the top of 
the report section it resides in.

Bottom Select the number of pixels between the component and the bot-
tom of the report section it resides in.

Spacing Select the number of pixels to change the spacing between the con-
tents of the report section.
Note: This option applies only when editing styles for report sec-
tions, such as the report header.
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5 Enter field information described in Table 3.

Table 3: Fill Tab Description

Field Description

Color/Top Color/Left 
Color

Click this box to select a primary color as the background. The text 
description for this option will vary depending on the Gradient 
Mode you select. For procedures on selecting a color, refer to 
“Choosing colors” on page 63.

No Fill Select this check box to clear any fill colors previously selected. If 
this check box is selected, the other options on the Fill tab will be 
disabled, except Color. Selecting a color will automatically clear the 
No Fill check box, thus enabling the other options.

Gradient Mode Select the positioning of the primary and secondary colors for the 
background from the Gradient Mode drop-down menu. Using gra-
dient coloring lets you merge two colors.

None Select this option to use only the primary color as the fill color. If 
you select None, the Gradient Color field is disabled.

Top to Bottom Select this option to merge the colors from the top of the back-
ground to the bottom.

Left to Right Select this option to merge the colors from the left of the back-
ground to the right.

Gradient Color/Bottom 
Color/Right Color

Click this box to select a secondary color to merge with the pri-
mary color. The fill colors will then merge using the method 
defined in the Gradient Mode menu. The text description for this 
option will vary depending on the gradient mode you select. For 
procedures on selecting a color, refer to “Choosing colors” on 
page 63.

Transparency (%) Select a percentage to define how intense the fill colors are. A set-
ting of 100% is completely transparent, which prevents the fill col-
ors from displaying. A setting of 0% has no transparency, resulting 
in intense background colors. The selected percentage is immedi-
ately reflected in the Preview field, so you can easily scroll through 
the transparency percentages to find a value that best suits your 
needs.

Preview This area provides a sample of how the fill colors you select will 
appear on the report background.
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6 Click the Borders tab to modify the borders of a component.

Figure 10: Style Borders Tab

7  Enter field information described in Table 4.

Table 4: Borders Tab Description

Field Description

Color Click this box to select a color for the border. For procedures on 
selecting a color, refer to “Choosing colors” on page 63.

Style Click this drop-down menu to select one of the following border 
styles: solid, dashed, dotted, inset, outset, double, groove, ridge, 
rounded, or separator. The separator option lets you add space 
around the component.

Weight Click this drop-down menu to select the pixel size of the border. 
You can choose a number between 1 and 10 pixels.

Preview Use this area to define the placement of the borders. Select any of 
the following buttons to place the borders, or click the area in the 
Preview white space where you want the border.

 Top Border
Click this button to add the selected border attributes to the top 
border of the component.

 Bottom Border
Click this button to add the selected border attributes to the bot-
tom border of the component.

 Left Border
Click this button to add the selected border attributes to the left 
border of the component.
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8 Click the Preview button to preview the style with the changes you have made to fonts, 
margins, fill, and borders.

9 Click the OK button to save your changes to the selected component.

10 Select other components on the style editor and repeat steps 1 through 9 to edit the style 
options for the selected component.

Chart Styles explorer
RightNow lets you create chart styles to define the appearance of charts shown on reports. By 
applying a chart style, you can immediately change a chart’s fonts, colors, scales, gridlines, 
backgrounds, and other display attributes. The Chart Styles explorer, shown in Figure 11, 
includes several predefined chart styles, which you can apply to charts, and allows you to cre-
ate custom chart styles. You can then apply the same chart style to charts in different reports 
to ensure that all the charts have a similar appearance.

 Right Border
Click this button to add the selected border attributes to the right 
border of the component.

 All Borders
Click this button to add the selected border attributes to all sides of 
the component.

 No Borders
Click this button to remove the borders from all sides of the com-
ponent.

Table 4: Borders Tab Description (Continued)

Field Description
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Figure 11: Chart Styles Explorer

The attributes defined in chart styles vary somewhat depending on the type of chart used in a 
report. Thus, the chart style options will vary depending on the type of chart the style should 
be applied to. The chart types available are described in Table 5.

Table 5: Chart Types Description

Chart Type Description

Vertical Bar Vertical bar charts display data as a series of vertical bars.

Horizontal Bar Horizontal bar charts display data as a series of horizontal bars.

Pie Pie charts display data as a percentage of a whole. 

Funnel Funnel charts display data as areas shown in ascending or descend-
ing order.

Line Line charts display data as a series of points connected by a line.

Line/Bar Combo Line/bar combo charts display both a line chart and a vertical bar 
chart.

Area Area charts display data as areas on an x- and y-axis.
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For procedures on applying a chart style to a chart, refer to Chapter 5, “Custom Reports,” on 
page 175.

Creating and editing chart styles
You can customize chart styles using options available on the chart styles editor’s ribbon. Dif-
ferent options are enabled depending on the type of chart selected when editing the chart 
style. A single chart style can be configured to be used with multiple chart types.

For example, the Bar Settings button will be enabled on the ribbon’s Home tab when editing 
a style for a vertical bar chart, whereas it will not be enabled when creating a style for a pie 
chart. In addition, pie chart types do not include a scale, so the Value Scale button on the Lay-
out tab will also be disabled. Once you change the chart type you are configuring, different 
buttons will be enabled based on the new chart type. The chart subtype, such as two- or 
three-dimensional, and stacked or not stacked, will also impact options enabled on the ribbon.

X–Y X–Y charts display data as a series of plotted points.

Radar Radar charts display data in a radar format. Numeric values are 
plotted at markers on the perimeter.

Stock Stock charts display the minimum and maximum values for data.

Pareto Pareto charts display data in descending order with an ascending 
plot line for cumulative percentage.

Gauge Gauge charts display a numeric value as a percentage of a whole. 

Gantt Gantt charts display time lines for completion of scheduled tasks.

Table 5: Chart Types Description (Continued)

Chart Type Description

Tip The same ribbon options available on the chart styles editor are also available 
when you add a chart to a custom report. This allows you to customize the dis-
play of an individual chart used in a report without creating or modifying a chart 
style.
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When creating a chart style, a sample of the currently selected chart type and subtype is 
shown on the content pane. The sample chart’s display changes depending on the options you 
select so you can quickly see how a chart that uses the selected settings will appear. This sec-
tion describes how to create a chart style on the chart styles editor.

To create or edit a chart style:
1 To create a new chart style, click the New button on the ribbon.

Or

To edit a chart style, right-click the chart style and select Edit.

The chart styles editor, shown in Figure 12, opens displaying a default chart type.

Figure 12: Chart Styles Editor

2 Click the Type button on the Home tab to display the chart type menu, shown in Figure 
13.

Note Once you select a chart type and subtype, you can follow the steps in this proce-
dure in any order you want. The steps in this procedure are listed according to 
the order of their associated buttons on the ribbon.
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Figure 13: Chart Type Menu

3 Select the chart and chart subtype you want to configure for the chart style. 

Note Once you configure your chart style for the selected chart type and subtype, you 
can select other types to configure your chart style for use with those types. This 
allows you to use the same chart style regardless of the types of charts you add 
to reports, while ensuring the charts’ colors, fonts, and other attributes are con-
sistent.
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4 To configure three-dimensional settings for a chart style with a 3D subtype, click the 3D 
Depth and 3D Angle buttons on the Home tab to enter values that impact how three-
dimensional charts display.

Table 6 describes the settings you can access from these buttons.

5 To configure colors, styles, borders, and other settings for the bar, line, or gauge elements 
in charts, click the Home tab and click the Bar Settings, Line Settings, or Gauge Settings 
button.

Tip You can modify the three-dimensional settings for charts with 3D subtypes by 
right-clicking the chart on the content pane and selecting Rotate. Your cursor 
will change and you can move your mouse horizontally and vertically to change 
the chart’s three-dimensional values. Click the left mouse button to quit rotating 
the chart. The right-click menu also gives you options to convert three-dimen-
sional charts to two-dimensional charts, or two-dimensional charts to three-
dimensional charts, as long as the chart type includes 3D subtypes. This right-
click menu is also available when creating or viewing reports.

Table 6: Three-Dimensional Chart Subtype Settings Description

Button Description

3D Depth Click this button and enter a number for the extent of the chart’s 
three-dimensional effect. A value of 0 removes the 3D appearance 
from the chart, where a setting of 125 maximizes the effect.

3D Angle Click this button to enter values for the chart’s horizontal and ver-
tical angles.

X Angle Enter a value from 0 to 180 degrees in this field. This value deter-
mines the vertical rotation of the chart.

Y Angle Enter a value from 0 to 180 degrees in this field. This value deter-
mines the horizontal rotation of the chart.
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Table 7 describes the settings you can access from these buttons.

Table 7: Bar, Line, and Gauge Settings Buttons Description

Button Description

Bar Settings Click this button to customize the display of the bar elements for 
chart types that include bars.

Bar Outline Select this option and then select the type of outline you want 
around the individual bars in the chart. You can choose from the 
following options:

• None—The bars have no outline.

• Lighter—The bar outline is a lighter shade of the bar’s 
color.

• Darker—The bar outline is a darker shade of the bar’s 
color.

• Color—The bar outline is a specified color.

Choosing Color enables the Outline Color option. Select this to 
open the color menu where you can select a color for the outline. 
Refer to “Choosing colors” on page 63 for information about how 
to choose colors from the menu.

Bar Style Select this option and then select the style you want for the bars in 
the chart. You can choose Block, Cylinder, Wedge, Emboss, or 
Light to Dark.

Multicolor Series Select this option to make the bars in different series use different 
colors. When this option is not enabled, the bars in different series 
are shown using the same set of colors.

Line Settings Click this button to customize the display of the line elements for 
chart types and subtypes that include lines.

Line Width Select this option and then select the number of pixels you want 
for the line’s width. Options include widths from one to ten pixels.

Symbols Select this option and then select the symbol you want to place on 
the line to mark data points. You can choose None, Square, Circle, 
or Triangle.
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6 To define color ranges for a gauge chart, click the Gauge Settings button on the Home tab 
and select Color Ranges. The Color Ranges window opens.

Prior to adding a range, the Color Ranges window will not show any ranges and Add 
Range will be the only option available. The Color Ranges window is shown in Figure 14, 
populated with three ranges.

Gauge Settings Click this button to customize the display of the gauge for gauge 
chart types.

Gauge Color Select this option to open the color menu to select a color for the 
gauge. Refer to “Choosing colors” on page 63. You can also select 
No Value from the menu to use the default color.

Border Color Select this option to open the color menu to select a color for the 
gauge’s outline. Refer to “Choosing colors” on page 63. You can 
also select No Value from the menu to use the default color.

Show Numeric Identifier Select this option to display a numeric indicator on the gauge 
which shows the actual value represented on the gauge.

Color Ranges Select this option to open the Color Range window where you can 
define different colors to use for different value ranges on the 
gauge. Refer to step 6 for information on defining color ranges for 
gauge charts.

Note Color ranges are unique to gauge charts and let you show ranges of different val-
ues on the chart in different colors.

Table 7: Bar, Line, and Gauge Settings Buttons Description (Continued)

Button Description
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Figure 14: Color Ranges Window

a Click Add Range to add a color range.
b Enter field information described in Table 8.

c Click the OK button to save the color ranges.

Table 8: Color Ranges Window Description

Field Description

Add Range Click Add Range to add a range.

Minimum Enter the percentage value the range should begin at. For example, 
a gauge with three color ranges could have a range that begins at 
34%.

Maximum Enter the percentage value the range should end at. For example, a 
gauge with three color ranges could have a range that ends at 66%.

Start Color Click this box to open the Color window and select a color for the 
beginning of the range. Refer to “Choosing colors” on page 63.

End Color Click this box to open the Color window and select a color for the 
end of the range. Refer to “Choosing colors” on page 63.

Remove Range Click Remove Range to remove the range shown next to the text.
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Figure 15 shows a gauge chart using the three color ranges displayed in Figure 14.

Figure 15: Gauge Chart with Color Ranges

7 To select a color scheme for the chart style, click the Color Scheme button on the Home 
tab and select the item you want from the color scheme menu, shown in Figure 16.

Color schemes are available for all chart types and define the colors used for the chart. 
Refer to “Color Schemes explorer” on page 50 for information about customizing color 
schemes.

Figure 16: Color Scheme Menu
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8 To define the placement of labels, such as titles and legends, click the Layout tab and click 
the button on the ribbon’s Labels group that corresponds to the label you want to config-
ure. The Layout tab is shown in Figure 17.

Figure 17: Chart Styles Editor Layout Tab

Table 9 describes the labels you can configure from these buttons.

Table 9: Labels Buttons Description

Label Description

Title Click this button to select options for the chart’s title. This label 
displays the chart’s title defined when you add a chart to a report. 
You can choose not to show this label, or you can show it at the 
left, right, top, or bottom of the chart.

Legend Click this button to select options for the chart’s legend. This label 
displays a legend to identify the chart’s contents. You can choose 
not to show this label, or you can show it at the left, right, top, or 
bottom of the chart.

Category Axis Title Click this button to select options for the chart’s category axis title. 
This label identifies the chart’s category axis. You can choose to 
show it or not show it.

Value Axis Title Click this button to select options for the chart’s value axis title. 
This label identifies the chart’s value axis. You can choose to show 
it or not show it.

Data Labels Click this button to select options for the chart’s data labels. Data 
labels can be displayed on the chart’s bars, lines, and other display 
components to show the actual values represented in the chart. 
You can choose to show data labels or not show them.
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9 To configure scale options for the chart style, click the Value Scale button on the Layout 
tab and select from the options described in Table 10.

Exception Box Click this button to select options for the chart’s exception box. 
This label describes the exceptions shown in the chart if the chart’s 
data includes exceptions and the report is configured to show 
exceptions on the chart. You can choose to show this label at the 
left, right, top, or bottom of the chart.

Table 10: Value Scale Button Description

Option Description

Primary Scale The options in this section let you show the primary scale, rotate the 
scale’s labels, and choose whether to configure the scale’s range manu-
ally or let RightNow do it for you.

Show Select this option to display the primary scale on the chart. By default, 
the primary scale is displayed.

Automatic Select this option to automatically determine the range of the scale 
based on the range of values in the data shown on the chart.

Manual Select this option to manually configure the range shown on the pri-
mary scale. When you select this option and hover over it, Scale Start 
and Scale End fields will be shown. Enter the minimum value you want 
for the scale in the Scale Start field and the maximum value you want in 
the Scale End field.

Rotate Labels Select this option and then select a degree to rotate the label text. Your 
choices are None, 15, 30, 45, 0, -15, -30, and -45 degrees (clockwise).

Secondary Scale The options in this section let you configure the secondary scale for the 
line values shown on line/bar chart types.

Show Select this option to display the secondary scale on the chart. By 
default, the secondary scale is not displayed.

Automatic Select this option to automatically determine the range of the scale 
based on the range of values in the data shown on the chart.

Table 9: Labels Buttons Description (Continued)

Label Description
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Manual Select this option to manually configure the range shown on the sec-
ondary scale. When you select this option, Scale Start and Scale End 
fields will be shown. Enter the minimum value you want for the scale in 
the Scale Start field and the maximum value you want in the Scale End 
field.

Rotate Labels Select this option and then select a degree to rotate the label text. Your 
choices are None, 15, 30, 45, 0, -15, -30, and -45 degrees (clockwise).

Position The options in this section let you choose where to place the primary 
scale on the chart.

Primary Scale Right Select this option to place the primary scale on the right side of the 
chart. If the secondary scale is also shown, it will be placed on the left 
side of the chart.
Note: This option is enabled only for chart types that display data ver-
tically.

Primary Scale Left Select this option to place the primary scale on the left side of the chart. 
If the secondary scale is also shown, it will be placed on the right side 
of the chart. This is the primary scale’s default display position.
Note: This option is enabled only for chart types that display data ver-
tically.

Primary Scale Top Select this option to place the primary scale at the top of the chart. If 
the secondary scale is also shown, it will be placed on the top of the 
chart.
Note: This option is enabled only for chart types that display data hor-
izontally.

Primary Scale 
Bottom

Select this option to place the primary scale at the bottom of the chart. 
If the secondary scale is also shown, it will be placed on the bottom of 
the chart. This is the primary scale’s default display position.
Note: This option is enabled only for chart types that display data hor-
izontally.

Use Logarithmic Scale Select this check box to use a logarithmic scale based on your report 
data.

Table 10: Value Scale Button Description (Continued)

Option Description
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10 To configure category and value grid lines shown on the chart, click the Category Grid 
Lines or Value Grid Lines button on the Layout tab. Table 11 describes the options you 
can configure from these buttons.

Table 11: Category Grid Lines and Value Grid Lines Buttons Description

Option Description

Scale The options in this section let you choose whether to use auto-
matic or manual offsets for the major and minor grid lines shown 
on the chart. The offsets determine the spacing between the grid 
lines.

Automatic Select this option if you want RightNow to automatically deter-
mine the offsets between the major and minor grid lines shown on 
the chart.

Manual Select this option to manually specify the offsets for the chart’s 
grid lines. When you select this option, Major Offset and Minor 
Offset fields are displayed. Enter the numeric offset value you 
want for the major grid lines in the Major Offset field, and the off-
set you want for the minor grid lines in the Minor Offset field.

Display The options in this section let you show or hide major and minor 
grid lines on the chart. Grid lines can make it easier to identify val-
ues on the chart.

Show Major Select this option to display major grid lines on the chart.

Major Color Select this option to open the color menu where you can choose 
the color you want for the major grid lines. Refer to “Choosing col-
ors” on page 63 for information about selecting colors from the 
menu.

Show Minor Select this option to display minor grid lines on the chart.

Minor Color Select this option to open the color menu where you can choose 
the color you want for the minor grid lines. Refer to “Choosing 
colors” on page 63 for information about selecting colors from the 
menu.

Show Left Select this option to show grid lines along the left side of the chart.
Note: This option is not available on the Value Grid Lines button.
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11 To configure options for tick marks shown on the chart’s scale, click the Tick Marks but-
ton on the Layout tab. Table 12 describes the options available on this button.

Left Color Select this option to open the color menu where you can choose 
the color you want for the grid line along the left side of the chart. 
Refer to “Choosing colors” on page 63 for information about 
selecting colors from the menu.
Note: This option is not available on the Value Grid Lines button.

Bottom Color Select this option to open the color menu where you can choose 
the color you want for the grid line along the bottom of the chart. 
Refer to “Choosing colors” on page 63 for information about 
selecting colors from the menu.
Note: This option is not available on the Category Grid Lines but-
ton.

Table 12: Tick Marks Button Description

Option Description

Scale The options in this section let you choose whether to use auto-
matic or manual offsets for the major and minor tick marks shown 
on the chart’s scale. The offsets determine the spacing between the 
tick marks.

Automatic Select this option if you want RightNow to automatically deter-
mine the offsets for the scale’s major and minor tick marks.

Manual Select this option to manually specify the offsets for the scale’s 
major and minor tick marks. When you select this option, Major 
Offset and Minor Offset fields are displayed. Enter the numeric 
offset value you want for the major tick marks in the Major Offset 
field, and the offset you want for the minor tick marks in the 
Minor Offset field.

Display The options in this section let you show or hide major and minor 
tick marks on the chart’s scale.

Major Tick Marks Select this option to show the major tick marks on the chart.

Minor Tick Marks Select this option to show minor tick marks on the chart.

Table 11: Category Grid Lines and Value Grid Lines Buttons Description (Continued)

Option Description



48 Analytics Explorers

Chapter 2

12 To customize the fonts, borders, and backgrounds of different sections of the chart, click 
the Format tab, shown in Figure 18.

Figure 18: Chart Styles Editor Format Tab

a Click the section of the chart you want to configure on the content pane.
Or
If you know the name of the chart section you want to configure, select it from the Cur-
rent Selection drop-down menu on the ribbon. The following chart sections are avail-
able, though not all sections are available for all chart types.

 Chart Area

 Grid Area

 Title

 Legend

 Category Axis Labels

 Category Axis Title

 Value Axis Title

 Primary Scale Labels

 Secondary Scale Labels

 Data Labels

 Exception Box
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b Select from the buttons on the Format tab’s Format group described in Table 13.

Table 13: Format Tab Buttons Description

Button Description

Border Click this button to select a border style for the selected section. 
The available options are:

• None

• Thin

• Medium

• Thick

• Dashed

To select a color for the border, select Border Color from the 
menu to open the color menu. Refer to “Choosing colors” on page 
63 for information about selecting colors from the menu.

Shadow Click this button to select a shadow style for the selected section’s 
border. The available options are:

• None

• Thin

• Medium

• Thick

To select a color for the shadow, select Shadow Color from the 
menu to open the color menu. Refer to “Choosing colors” on page 
63 for information about selecting colors from the menu.

Background Click the arrow on this button to open the color menu where you 
can select a background color for the selected section of the chart. 
Refer to “Choosing colors” on page 63 for information about 
selecting colors from the menu.

Transparency Click this button to enter a percentage to define how intense the 
background color is for the chart’s grid area. A setting of 100% is 
completely transparent, which prevents the fill colors from display-
ing. A setting of 0% has no transparency, resulting in intense back-
ground colors. The selected percentage is immediately reflected on 
the sample chart, so you can easily scroll through the transparency 
percentages to find a value that best suits your needs.
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13 To configure settings for a different chart type or subtype, repeat steps 2 through 12.

14 Save the new chart style.

Color Schemes explorer
The Color Schemes explorer, shown in Figure 19, lets you view standard color schemes used 
in conjunction with chart styles. You can also copy standard color schemes and edit the cop-
ies, or you can create your own custom color schemes. Color schemes you create can be cop-
ied, renamed, edited, and deleted using right-click functionality.

To create a color scheme:
1 Double-click Color Schemes Explorer. The Color Schemes explorer will open, displaying 

the current color schemes.

Gradient Click this button to select the type of gradient you want for the 
background of the chart area section. You can use gradient color to 
customize a background by blending two colors. Your options are:

• None

• Left to Right

• Top to Bottom

To select a gradient color to blend into the background color, 
select Gradient Color to open the color menu. Refer to “Choosing 
colors” on page 63 for information about selecting colors from the 
menu.

Font buttons Select the font, font size, and other attributes from these buttons. 
Refer to “Choosing font attributes” on page 61 for information 
about the available font options.

Table 13: Format Tab Buttons Description (Continued)

Button Description
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Figure 19: Color Schemes Explorer

2 Click the New button to open the New Color Scheme window, shown in Figure 20. The 
window populates with default colors.

Figure 20: New Color Scheme Window
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3 To change a particular color, click the box with the color to open the Color window. Refer 
to “Choosing colors” on page 63 for the procedure to select colors or create custom col-
ors.

4 Enter the transparency value for the color scheme in the Transparency field. A transpar-
ency value of 0 displays a solid color, and a value of 255 is completely transparent with no 
color.

5 Save the new color scheme. Refer to “Saving items” on page 24 for the procedure to save 
items in Analytics explorers.

Images explorer
Photos and other images can be uploaded to use in reports and dashboards. For example, 
your organization’s logo can be added as an image and then added to custom reports. Refer to 
Chapter 3, “Report Management,” on page 67 for information about adding images to report 
area backgrounds or “Adding images” on page 384 for information about adding images to 
dashboards.

The images used with reports and dashboards can be added, edited, and deleted using the 
Images explorer. You can also copy, edit, rename, or delete images using right-click function-
ality.

To add an image:
1 Double-click Images Explorer.

Figure 21: Images Explorer
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2 Click the New button on the ribbon.

Figure 22: Adding a New Image

3 Click Select an Image to open a window where you can select the image you want to add. 
You can add .bmp, .jpg, .gif, and .png file types.

Figure 23:  Select Image Window

4 Select the image you want to upload.

5 Click the Open button.
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6 Save the image.

Replacing images
You can easily replace images you have already added. This is helpful if you have added an 
image, such as a logo to reports or dashboards, and the logo is later changed. By replacing the 
image file, the reports and dashboards where the logo image has been used will automatically 
use the new image.

To replace an image:
1 In the Images explorer, right-click the image you want to replace and select Open. The 

Image window, shown in Figure 22 on page 53, opens.

2 Click Select a Different Image. A window will open where you can select the new image.

3 Select the image you want to replace the existing image with.

4 Click the Open button.

5 Save the new image. Refer to “Saving items” on page 24 for the procedure to save items in 
Analytics explorers.

Text Fields explorer
The Text Fields explorer lets you create text fields you can add to custom reports and dash-
boards. When you create a text field, you can specify the field’s text, fonts, borders, colors, and 
margins. You can also adjust these settings after you add the field to a report or dashboard. 
Refer to “Adding text fields to report sections” on page 228 for information about adding 
text fields to a custom report or “Adding images and text fields to dashboards” on page 379 
for information about adding text fields to dashboards.

For example, you could create a text field with your organization’s name, using your organiza-
tion’s preferred fonts and colors, which you could add to your reports’ titles. Since the text 
fields can be edited once they are added to reports, you can also create a template text field 
with your customized settings and change the wording in the field as necessary.

Using the Text Fields explorer, shown in Figure 24, you can edit, copy, delete, and rename text 
fields using right-click functionality. You can also create new text fields.
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To create a text field:
1 Double-click Text Fields Explorer.

Figure 24: Text Fields Explorer

2 Click the New button. A new text field opens on the content pane.

Figure 25: Text Tab for a New Text Field
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3 Enter field information described in Table 14. 

4 Click the Size tab.

Figure 26: Size Tab for a New Text Field

Table 14: Text Tab Description

Field Description

Text* Type the text you want to display in this field. This text will also 
serve as the text field name.

Text Alignment Click this drop-down menu to select the horizontal alignment for 
the text in the text field. Options are Left, Center, and Right.

Line Alignment Click this drop-down menu to select the vertical alignment for the 
text in the text field. Options are Top, Center, and Bottom.

Anchor Style Click this drop-down menu to select the anchor style for the field. 
Refer to “Defining anchor styles” on page 230 for information 
about anchor styles.
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5 Enter field information described in Table 15.

6 Click the Font tab to select the font settings for the text field. Refer to “Choosing font 
attributes” on page 61 for information about font settings.

7 Click the Margins tab to define the amount of space surrounding the text in the text field.

Figure 27: Margins Tab for a New Text Field

8 Enter field information described in Table 16.

Table 15: Size Tab Description

Field Description

Best Fit Select this radio button to have the size of the text field automati-
cally adjusted to best fit the available space in the report.

Specific Size (Pixels) Select this radio button to manually enter the specific width and 
height settings for the text field. Any text in the field boundaries 
that exceeds the size of the field will be clipped.

Table 16: Margins Tab Description

Field Description

Left Select the number of pixels between the text in the text field and 
the left side of the text field.

Right Select the number of pixels between the text in the text field and 
the right side of the text field.
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9 Click the Fill tab to define the background fill colors for the text field.

Figure 28: Fill Tab for a New Text Field

10 Enter field information described in Table 17.

Top Select the number of pixels between the text in the text field and 
the top of the text field.

Bottom Select the number of pixels between the text in the text field and 
the bottom of the text field.

Table 17: Fill Tab Description

Field Description

Color/Top Color/Left 
Color

The text description for this option will vary depending on the gra-
dient mode you select. Click this box to select a primary color as 
the background. For procedures on selecting a color, refer to 
“Choosing colors” on page 63.

No Fill Select this check box to clear any fill colors previously selected. If 
this box is selected, the other options on the Fill tab will be dis-
abled except Color. Selecting a color will automatically clear the No 
Fill check box, thus enabling the other options.

Table 16: Margins Tab Description (Continued)

Field Description
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11 Click the Borders tab to define the borders for the text field.

Gradient Mode Click this drop-down menu to select the positioning of the primary 
and secondary colors for the background. Using gradient coloring 
lets you merge two colors.

None Select this option to use only the primary color as the fill color. If 
you select None, the Gradient Color field is disabled.

Top to Bottom Select this option to merge the colors from the top of the back-
ground to the bottom.

Left to Right Select this option to merge the colors from the left of the back-
ground to the right.

Gradient Color/Bottom 
Color/Right Color

The text description for this option will vary depending on the gra-
dient mode you select. Click this box to select a secondary color to 
merge with the primary color. The fill colors will then merge using 
the method defined in the Gradient Mode menu. For procedures 
on selecting a color, refer to “Choosing colors” on page 63. 

Transparency (%) Select a percentage to define how intense the fill colors are. A set-
ting of 100% is completely transparent, which prevents the fill col-
ors from displaying. A setting of 0% has no transparency, resulting 
in intense background colors. The selected percentage is immedi-
ately reflected in the Preview area, so you can easily scroll through 
the transparency percentages to find a value that best suits your 
needs.

Preview This area provides a sample of how the fill colors you select will 
appear on the text field’s background.

Table 17: Fill Tab Description (Continued)

Field Description
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Figure 29: Borders Tab for a New Text Field

12  Enter field information described in Table 18.

Table 18: Borders Tab Description

Field Description

Color Click the color box to select a color for the border. For procedures 
on selecting a color, refer to “Choosing colors” on page 63.

Style Click this drop-down menu to select one of the following border 
styles: Solid, Dashed, Dotted, Double, Inset, Outset, Groove, 
Ridge, Rounded, or Separator. The Separator option lets you add 
empty space around the text field.

Weight Click this drop-down menu to select the pixel size of the border. 
The border weight can be from 1 to 10 pixels.

Preview This area defines the placement of the borders you define. Select 
any of the following buttons to place the borders or click the area 
in the Preview white space where you want the border.

 Top Border
Click this button to add the selected border attributes to the top 
border of the text field.

 Bottom Border
Click this button to add the selected border attributes to the bot-
tom border of the text field.

 Left Border
Click this button to add the selected border attributes to the left 
border of the text field.
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13 To preview the text field, click the Preview button on the ribbon.

Figure 30: Previewing a Text Field

14 Click the Close button to close the preview window.

15 Save the text field.

Selecting fonts and colors
Certain items you edit in the explorers include options to change font attributes or add colors. 
The methods to define fonts and colors are generally the same, regardless of the item you are 
editing or the explorer you are working in. This section explains how to choose font attributes 
and colors.

Choosing font attributes
When customizing text elements in RightNow Analytics, you can specify font attributes to 
change the display of the text. Font attributes can be selected from the ribbon in certain edi-
tors, such as the chart styles editor, or from a Font tab on a window in other areas. The same 
options are available from the ribbon or the tab. Some editors give you access to font 
attributes from both the ribbon and the tab, allowing you to change font attributes from 
either location. Font options on the style editor’s Font tab are shown in Figure 31.

 Right Border
Click this button to add the selected border attributes to the right 
border of the text field.

 All Borders
Click this button to add the selected border attributes to all sides of 
the text field.

 No Borders
Click this button to remove the borders from all sides of the text 
field.

Table 18: Borders Tab Description (Continued)

Field Description
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Figure 31: Selecting Font Options from a Tab

This procedure describes the options available on the Font tab. However, most designers 
allow you to click buttons on the ribbon to set these option.

To select font attributes from the Font tab:
1 Click the Font tab.

2 Enter field information described in Table 19.

3 Click the OK button to save your changes.

Table 19: Font Options Description

Field Description

Font Click this drop-down menu to select a font.

Style Select the check boxes for the style attributes you want. You can 
select multiple attributes to apply to the font: Regular, Bold, Italic, 
Underline, Strikethrough, and All Caps.

Size Click this drop-down menu to select the point size of the font.

Color Click the color box to select a color for the font. For procedures 
on selecting a color, refer to “Choosing colors” on page 63.

Preview Click this button to preview the font using the options you select.
Note: This button is not available on all Font tabs.
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Choosing colors
You can select colors for many objects in Analytics, such as text labels and report back-
grounds. When selecting colors from a tabbed window, the Color window is displayed; when 
selecting colors from a ribbon, the color menu is displayed. Both give you the same options, 
though they present them in slightly different ways.

This procedure explains how to select colors and define custom colors using both the color 
menu and Color window. Figure 32 shows the color menu on the left and the Color window 
on the right.

Figure 32: Color Menu and Color Window

To select a color:
1 To select a color shown on the menu, select it and it will be applied to the object you are 

editing.

2 To select a color shown on the window, select it and click the OK button to apply the 
change to the object.

3 To define a custom color from the window, click the Define Custom Colors button. The 
window expands to show custom color options.



64 Analytics Explorers

Chapter 2

Figure 33: Defining a Custom Color

a Click anywhere in the color palette or type the HSL (hue, saturation, lumination) or 
RGB (red, green, blue) components in the appropriate text boxes to define your custom 
color.

• The HSL color model defines the hue, saturation, and lumination of the color. 

 Hue—The hue is the pigment of the color and has a value between 0 to 359 
degrees. 

 Saturation—The saturation is measured as a percent from 0 to 100 and specifies 
the vividness of a color. 

 Lumination—Lumination is the amount of white in the color and is a value from 
0 to 100 percent. 

• The RGB color model defines the amount of red, green, and blue light the color con-
tains. RGB values can be between 0 and 255. For example, when all components are set 
to 255, the color is white, and when all are set to 0, the color is black.

b Click the Add to Custom Colors button. The color is added to your custom colors.
c Click the OK button to apply the color you selected or created to the component you 

are defining.

4 To view additional standard colors or to create a custom color from the color menu, click 
More Colors. The window shown in Figure 34 opens.
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Figure 34: Selecting Additional Standard Colors from the Color Menu

a To choose a standard color from the window, click the color you want and click the OK 
button to apply the color to the object you are editing.

b To define a custom color, click the Custom tab.

Figure 35: Defining Custom Colors from the Color Menu

You define custom colors from the Custom tab in the same manner as you would 
define custom colors from the Color window. Refer to step 3 for information about 
defining custom colors.

c Click the OK button to apply the custom color to the object you are editing.



66 Analytics Explorers

Chapter 2



67

3
Report Management

You can easily manage standard and custom reports using the Reports explorer. From the 
explorer you can organize, locate, and view reports. When viewing a report, you can print, 
forward, and export the report. If the report allows inline editing, you can also edit data 
shown on the report directly from the report. In addition, you can adjust the report’s display 
options to better suit your needs, and alter data characteristics to sort, filter, and output the 
data in different formats.

In this chapter

• Viewing reports—Contains procedures for opening reports, searching for information, and per-
forming tasks using common features in RightNow Analytics. Also included is a description of the 
report ribbon. Refer to page 68.

• Queuing reports—Describes report queuing, how to queue reports, and how to view them when 
they have run. Also explains how report databases are used in conjunction with queuing. Refer to 
page 100.

• Distributing reports—Contains procedures for exporting, publishing, forwarding, and printing 
reports. Refer to page 106.

• Changing output options—Contains procedures to modify report output by customizing the 
fields displayed, and using the Slice, Auto Filter, Cross Tab, and Rollups options. Refer to page 129.

• Editing data inline—Contains procedures to edit data directly from reports. Refer to page 161.
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Viewing reports
RightNow includes numerous standard reports you can use to track activity in Service, Sales, 
Marketing, Feedback, and RightNow Chat. If one of the standard reports does not meet your 
needs, you can create a custom report to return the specific information you want. Custom 
and standard reports are opened in the same manner, and the same methods are used to 
search for information in the reports. When searching for information or analyzing the results 
returned in reports, you will see that the reports share several common features, and the same 
tools are used to modify the reports’ appearance, share the reports with others, and work with 
the records shown in the reports.

This section explains how to open reports, search for information, and identify elements in 
reports you should be familiar with. This section also describes common features you will 
encounter when using reports.

Opening reports
Staff members with the appropriate permissions can open standard and custom reports from 
the navigation pane or from the Reports explorer. Reports are opened from navigation lists 
by double-clicking the report names in the lists. Opening a report from the Reports explorer 
is just as simple.

Once a report is open, you can view brief or detailed descriptions of the report to see infor-
mation provided by the report’s creator, or to view descriptions of the reports components. 
Some reports also include drill-down levels you can access to view more detailed information.

To open a report from the Reports explorer:
1 Click the Analytics button on the navigation pane.

2 Double-click Reports Explorer. The explorer opens on the content pane with the folders 
tree on the left and a detailed list of the selected folder’s contents on the right.
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Figure 36: Reports Explorer

3 In the list on the right, right-click the report you want to open and select Open.

When you open a report, the Search window may be displayed where you can specify the 
search parameters you want to use for the report. The window will display if the report 
has required run-time selectable filters or is configured to display the search window. For 
information about using the Search window, refer to “Searching in reports and analyzing 
output” on page 90.

Note When you attempt to open reports that take a long time to run, you may be pre-
sented with an option to queue the report. For information about queuing 
reports, refer to “Queuing reports” on page 100.
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An example of a report is shown in Figure 37.

Figure 37: Report Sections Shown on a Report

Report header

Charts

Docked filters

Output descriptions 
displayed inline

Data area

Report footer

Data exceptions
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Table 20 describes the standard sections you will see when you view reports. Some reports 
will not include all sections.

Table 20: Report Sections Description

Field Description

Docked Filters Docked run-time filters defined in the report will display above the 
report output, allowing you to quickly select different filter values. 
For information about adding docked run-time filters, refer to 
“Docking variables and run-time selectable filters” on page 322.
Note: You can dock output variables in reports in the same man-
ner as run-time filters.

Report Header Text added to this area will display near the top of each page in the 
report. Refer to “Adding text fields to report sections” on page 228 
for information about adding text to report headers.

Output Descriptions Report output descriptions let the report’s creator relay informa-
tion, such as the report’s intended purpose, to those who view the 
report. Output descriptions can be displayed inline, on a separate 
tab, or on column rollover.

Search Criteria 
Descriptions

Descriptions of the filters in the report can be displayed to 
describe the report’s filters and values. Refer to “Search criteria 
descriptions” on page 233 for information about adding search cri-
teria descriptions to a report.

Charts Any charts defined in the report will display above the tabular 
report output. Refer to “Adding and editing charts” on page 299 
for procedures on adding charts to reports.
Note: When viewing a chart in a report, you can right-click the 
chart to switch to a two- or three-dimensional view. When viewing 
a three-dimensional chart, you can right-click the chart, select 
Rotate, and drag the chart to change the viewing angle.

Data Area This area contains the tabular report output.

Report Footer Text added to this area will display near the bottom of each page in 
the report. Refer to “Adding text fields to report sections” on page 
228 for information about adding text to report footers.
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4 If output or search criteria descriptions are displayed as a tab in the report, click the 
Descriptions tab to view the descriptions. Descriptions can also be displayed as inline text 
in the report header, or by rolling over the column names in the report. Refer to “Adding 
output and search criteria descriptions” on page 231 for procedures on adding descrip-
tions to reports.

Figure 38: Output Descriptions Shown on the Descriptions Tab

Viewing report definitions
Output and search criteria descriptions provide brief descriptions of a report and the report’s 
search parameters. However, if you want to see details of all the report’s components, you can 
view the report definition. This can be helpful if you want to see exactly how the report was 
created or determine if it will meet your needs. The report definition includes the output and 
search criteria descriptions, but also includes information about the tables, output levels, out-
put columns, filters, logical expressions, sort orders, report links, and schedules used in the 
report. You can print a report’s definition, and you can export the output to a file for later 
viewing.

Data Exceptions Records matching data exceptions defined in the report will be 
flagged, and a summary of the data exception can be displayed in 
the report output. For information about data exceptions, refer to 
“Creating data exceptions” on page 284.

Table 20: Report Sections Description (Continued)

Field Description
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To view report definitions:
1 Select a report on the Reports explorer and click the ribbon’s View Definition button.

Or

Open a report, click the Home tab, click the Definition button, and select View.

The Report Definition window opens.

Figure 39: Report Definition Window

2 To preview the printed page before printing it, click the Print Preview button. Refer to 
“Previewing reports” on page 107.

3 To configure the printed page, click the Page Setup button. Refer to “Printing reports” on 
page 109.

Tip You can also open the Report Definition window by right-clicking reports in 
navigation lists or the Reports explorer and selecting View Report Definition.
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4 To save the output from the report definition to a file for later viewing, click the Export 
button and select the file type.

You can select HTML, PDF, Excel, Image, and Delimited file types. Refer to “Exporting 
report output” on page 115 for a description of these file types. You can also choose to 
export the definition to an XML file which you can use to create duplicate reports on 
other RightNow interfaces. Refer to “Exporting report definitions” on page 74.

5 To send the report definitions to the printer, click the Print button.

Exporting report definitions
If you have multiple RightNow interfaces, you can use report definitions saved in XML files 
to create reports on other interfaces. This allows you to create duplicates of complex custom 
reports on other interfaces without manually re-creating the reports.

This section explains how to export report definitions to XML files which you can later 
import. For information about importing report definitions, refer to “Importing report defi-
nitions” on page 178.

To export report definitions to XML files:
1 Open the Report Definition window, as described in “Viewing report definitions” on page 

72, click the window’s Export button, and select Report Definition.

Or

When viewing a report, click the Home tab, click the Definition button, and select Export.

The Save As window opens.

Figure 40: Saving a Report Definition
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2 Select a location for the file and enter a file name.

3 Click the Save button to save the report definition to an XML file.

Drilling down in reports
The drill-down feature lets you click data in a report to open another report, dashboard, or 
output level to view information related to that shown in the first report or output level. For 
example, if you have a report displaying contacts and the number of incidents they have sub-
mitted, you can add a report link to the column showing the number of incidents. When you 
click the number of incidents on one of the report’s rows, another report opens showing 
details about the contact’s incidents.

Drilling down to open another output level in the same report is similar to drilling down to 
open another report. For instance, the first level of the standard Incidents by Category report 
displays category names and the number of incidents in each category grouped by date range. 
By clicking a category name in the report’s chart or tabular data, you can drill down on the 
category to open a new level showing the number of incidents in each sub-category. You can 
then drill down on each sub-category to open an additional level showing details about the 
incidents in the sub-category.

To drill down into a report, you simply click the highlighted link shown on the row you want 
to drill down into. Figure 41 shows drill-down links on the Incidents Created by Category 
report. The top level of this report has drill-down links in two columns.

Tip By default, each time you drill down into another output level in a report, the 
database is queried to ensure the most current data is displayed even if you have 
already viewed the output level. However, this can take extra time and may be 
unnecessary when viewing reports with data that does not change quickly. To 
load report output levels you have already viewed more quickly, you can cache 
the data shown in each level. Refer to “Changing report properties” on page 
355.
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Figure 41: Drilling Down on the Incidents Created by Category Report

In this report, clicking a link in the Product column opens another output level that shows the 
number of incidents submitted by product name. Clicking a link in the Incidents column 
opens another level showing details about the incidents, as shown in Figure 42.

Figure 42: Incident Detail Page

Link to report’s 
top output level

Report’s current 
output level
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Output levels opened from drill-down links always replace the parent output level on the con-
tent pane. You can navigate back to other output levels above the level you are viewing, 
including the report’s top level, by clicking the level you want at the top of the report. Reports 
and dashboards opened from drill-down links can be configured to replace the parent report 
on the content pane in the same manner, but you can also configure them to display on a new 
tab or in a split window that also shows the parent report.

For information about adding output levels to custom reports, refer to “Adding additional 
output levels” on page 328. For information about adding links to other reports or dash-
boards to a report, refer to “Linking reports” on page 337.

Selecting report or layout views
When you open a report, you can choose to view it using a layout or report mode. The report 
view is used by default, and lets you look at the report’s data, print the report, and work with 
the report’s records if you have permissions to do so. However, you cannot add column calcu-
lations or adjust column formatting options using the report view. Most staff members will 
only need to use the report view when they look at a report.

You can also look at the report using the layout view. The layout view lets you select individ-
ual columns in the report and apply formatting options to the columns. For example, if you 
wanted to add conditional formatting to a column to highlight data that met certain criteria in 
the column, you could change to the layout view, select the column, and configure conditional 
formatting for the column.

To select the report or layout view:
1 Open a report. By default, the report opens in the report view.

2 Click the ribbon’s Display tab.

3 Click the arrow on the Views button and select Layout View to change the view. 

4 To return to the report view, click the arrow on the Views button and select Report View.



78 Report Management

Chapter 3

Ribbon options when viewing reports
When viewing a report, you can move between the Home, Display, and Page Setup tabs on 
the ribbon to access buttons to modify the report’s display, search for data, and edit records. 
When looking at a report using the layout view, you can also access Design and Format tabs 
to adjust formatting and display options. The buttons you see on some of the tabs vary 
depending on the report’s configuration and on what is selected on the report.

Each tab on the ribbon has one or more groups containing buttons you can use to modify the 
report or items on the report. Some groups have a button to the right of their name that you 
can click to open windows. For example, you can click the Background group’s button on the 
Page Setup tab, shown in Figure 43, to open the Display Options window.

Figure 43: Group Buttons on the Page Setup Tab

Windows give you access to the same features you can access from the ribbon, though the 
windows group the options differently, and sometimes contain options not available from the 
ribbon.

Home tab
The buttons on the Home tab let you access functions to search for records in the report, 
refresh the report, and modify records displayed in the report. Buttons to modify records are 
shown on the tab only when the current report level displays individual records. These 

Tip You can minimize the ribbon when viewing a report by double-clicking the 
active tab. Click the tab to temporarily display the buttons on the tab, or double-
click the tab again to maximize the ribbon.

Important When explaining features that can be accessed from a window or the ribbon, we 
describe the feature using the window. However, the ribbon’s buttons provide 
shortcuts to most of the same features available on windows.

Background group button
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options will vary depending on the type of records shown in the report and will be disabled if 
the staff member viewing the report lacks permissions to perform the action. The Home tab 
of an incidents report is shown in Figure 44.

Figure 44: Home Tab

The groups and buttons on the Home tab are described in Table 21.

Table 21: Home Tab Description

Group/Button Description

Record The buttons in this group let you work with the specific records 
returned in the report. The available buttons vary depending on 
the type of records returned in the report and permissions in your 
profile. The buttons displayed in this group can also be selected 
when editing custom reports. The functions you can access from 
these buttons, such as assigning records, are described in detail in 
the RightNow User Manual, the RightNow Service User Manual, and the 
RightNow Sales Administrator and User Manual. For information 
about customizing record buttons in custom reports, refer to 
“Customizing record commands” on page 347.
Note: The buttons in this group are displayed only if the report 
level you view returns unique records that can be edited such as 
incidents, answers, contacts, or organizations.

Open Click this button to open the selected record. To open a record 
that is associated with the selected record, click the arrow on the 
button and select the type of record you want to open. For exam-
ple, you could open the contact record for the customer who sub-
mitted the selected incident.

New Click this button to create a record of the same type as the record 
selected on the report. To create a record of a different type, click 
the arrow on the button and select the type of record you want to 
create.
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Print Click this button and select the record you want to print. You can 
print the selected record or another record associated with the 
selected record. For example, to print the contact record of the 
customer who submitted the selected record, click the Print button 
and choose Contact.

Copy Click this button and select the record you want to copy. You can 
copy the selected record or another record associated with the 
selected record.

Assign Click this button and select the record you want to assign to 
another staff member. You can assign the selected record or 
another record associated with the selected record.

Delete Click this button and select the record you want to delete. You can 
delete the selected record or another record associated with the 
selected record.

Preview Answer Click this button to view the selected answer as it will display on 
your site’s customer portal. This button is displayed only when 
viewing a report that lists answers.

Forward Incident Click this button to forward the selected incident in an email. This 
button is displayed only when viewing a report that lists incidents.

Propose Incident Click this button to propose the selected incident as an answer. 
This button is displayed only when viewing a report that lists inci-
dents.

Fill Inbox Click this button to assign incidents to yourself from incident 
queues. This button is displayed only when viewing a report that 
lists incident information and when the permissions in your profile 
allow you to pull incidents from queues.

Email Contact Click this button to open your default email program to send an 
email to the contact associated with the record.

Monitor Click this button to open the chat sessions workspace to monitor 
agents’ chat sessions. This button is displayed only when 
RightNow Chat is enabled and when the permissions in your pro-
file allow you to monitor chat sessions.

Table 21: Home Tab Description (Continued)

Group/Button Description
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Editing This group is displayed when inline editing is enabled on the 
report. The buttons in this group let you save and edit records 
using inline editing. Refer to “Editing data inline” on page 161.

Data Set The buttons in this group let you search for data in the report, 
refresh the display, and reset the search criteria to the report’s 
defaults. Refer to “Searching in reports and analyzing output” on 
page 90.
Note: The buttons in this group are not available when viewing a 
report that was queued. Refer to “Queuing reports” on page 100.

Search Click this button to open the report’s Search window to select cri-
teria for variables and run-time selectable filters.

Refresh Click this button to reload the data shown using the report’s cur-
rent search criteria. If staff members are permitted to change auto-
matic refresh settings, an arrow will be added to the button. You 
can click the arrow to enable or disable automatic refresh and set 
the refresh interval. For information about automatic refresh, refer 
to “Changing report properties” on page 355.

Reset Click this button to reload the data shown using the report’s 
default search criteria.

Analyze The buttons in this group let you sort the data shown on the report 
and apply auto filtering, rollups, and slicing to the data.

Auto Filter Click this button to enable auto-filtering in the report. Auto-filter-
ing provides column filtering after the report has been generated. 
Refer to “Using Auto Filter” on page 143.

Sort Click this button to open the Sort window and select which output 
columns to sort by and the sort method. Refer to “Changing sort 
options” on page 141.

Rollups Click this button to select rollup options and open the Rollups 
window. Refer to “Displaying rollup levels” on page 155.

Slice Click this button to select slice options and open the Slice window. 
Slicing groups data so you can view only the subset of records you 
are interested in. Refer to “Slicing report data” on page 147.

Table 21: Home Tab Description (Continued)

Group/Button Description
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Report The buttons in this group let you export the report, forward the 
report in an email, save and restore default settings, and view and 
export the report definition.

Export Click this button to export the data from a report to a file for use 
with third-party applications. You can export report data in the fol-
lowing formats: HTML, PDF, Excel, XML, Image, and Delimited. 
Refer to “Exporting report output” on page 115.
Note: Permission to export, print, and forward reports must be 
enabled in your profile for this button to display. Refer to the 
RightNow Administrator Manual for information about editing pro-
files.

Forward Click this button to send the report to individuals or distribution 
lists in an email. Refer to “Forwarding reports” on page 111.
Note: Permission to export, print, and forward reports must be 
enabled in your profile for this button to display. Refer to the 
RightNow Administrator Manual for information about editing pro-
files.

Default Settings Click this button and select Save as Default to save your personal-
ized display and data settings for a report for later use. Select 
Restore to remove personalized display and data settings from a 
report and restore the settings to those defined in the report. Refer 
to “Resetting display and data settings” on page 160.
Note: This button is not available on a report’s Home tab when 
viewing the report in a dashboard.

Definition Click this button and select View to view the report definition, 
showing descriptions of the report’s tables, columns, filters, and 
other information describing the report’s structure. Click Export 
to export the definition to a file which you can import into another 
RightNow interface to copy the report. Click Edit to open the 
report for editing on the report design center.
Refer to “Viewing report definitions” on page 72 and “Exporting 
report definitions” on page 74. For information about editing 
reports, refer to Chapter 5, “Custom Reports,” on page 175.
Note: This button is not available when viewing a report that was 
queued. Refer to “Queuing reports” on page 100.

Table 21: Home Tab Description (Continued)

Group/Button Description
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Display tab
The display tools allow you to adjust the fonts, colors, margins, and other display settings in 
the viewed report. The Display tab is shown in Figure 45.

Figure 45: Display Tab

The groups and buttons on the Display tab are described in Table 22.

Table 22: Display Tab Description

Group/Button Description

Views Click the arrow on this button to choose whether to view the 
report using the report view or layout view. Refer to “Selecting 
report or layout views” on page 77.

Auto Format Click this button to apply a style to a report. Refer to “Changing 
report displays with styles” on page 129.

Sections The check boxes in this section let you show or hide the Docked 
Filters, Charts, Exceptions, Report Header, and Report Footer 
report sections. You can also use the buttons in the group to select 
how you want to display the data, search criteria descriptions, and 
output descriptions.

Data Click this button to select how you want to display the report’s 
data. You can choose to hide the data, display the data in a tabular 
layout, or display it in a record layout. “Selecting record or tabular 
layouts” on page 130.

Search Criteria Click this button to hide or show the report’s search criteria. You 
can show the criteria inline or on a separate tab. Refer to “Opening 
reports” on page 68 for information about search criteria descrip-
tions.
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Output Descriptions Click this button to hide or show the report’s output description. 
You can show the description on column rollover, inline, or on a 
separate tab. Refer to “Opening reports” on page 68 for informa-
tion about output descriptions.

Options The buttons and check boxes in this group let you page the report, 
apply cross tabs, add links and row numbers, fix column headers, 
show multiline calculations, and select the fields and data excep-
tions you want to view.

Field Chooser Click this button to open the Field Chooser window and show or 
hide output columns in a report. Refer to “Selecting columns to 
display” on page 140.

Cross Tab Click this button to select cross tab options and open the Cross 
Tab window and select the output columns to use as cross tabs. 
Refer to “Displaying data using cross tabs” on page 152.

Page Report Click this button to add page breaks to a report and select the 
number of records to display on each page. Refer to “Adding page 
breaks” on page 146.

Links Click this button to select the action links you want displayed on 
the report or to hide links that you do not want displayed. The 
available links vary depending on the type of record the report 
returns and on the links that are enabled when editing the report.
Note: This button is active only if the current report level displays 
unique records and the report is configured to display links by 
default. Refer to “Adding record command links” on page 350.

Exceptions Click this button to show or hide data exceptions in the report. 
Refer to “Showing and hiding data exceptions” on page 139.
Note: This button is active only if the current report level includes 
data exceptions.

Fix Column Headers Select this check box to fix the column headers. Fixed column 
headers do not move when you use the vertical scroll bar, letting 
you more easily analyze the report’s output.

Row Numbers Select this check box to display row numbers in the report.

Multiline Calculations Select this check box to display calculations on separate rows.

Table 22: Display Tab Description (Continued)

Group/Button Description
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Page Setup tab
The options on the Page Setup tab allow you to configure printing options for the report. 
You can also change the report’s background, margins, and width. The Page Setup tab is 
shown in Figure 46.

Figure 46: Page Setup Tab

The groups and buttons on the Page Setup tab are described in Table 23.

Table 23: Page Setup Tab Description

Group/Button Description

Print The buttons in this group let you configure the report for printing, 
and add the Page Header and Page Footer sections. Refer to 
“Printing reports” on page 107.
Note: This button group displays only if your profile includes the 
Print/Export/Forward Reports permission. Refer to the RightNow 
Administrator Manual for information about editing profiles.

Print Margin Click this button to select the size of the margins used when print-
ing the report. The available options are Normal, Narrow, 
Medium, and Wide.

Size Click this button to select the size of the paper used when printing 
the report. The available options are Letter, Legal, Executive, A3, 
A4, and A5.

Portrait/Landscape Click these buttons to print the report in portrait or landscape 
mode.

Page Header/Page 
Footer

Select these check boxes to include a page header and page footer 
when printing the report.

Print to Fit Select this check box to scale the report to your printer’s default 
page width and send the report to the printer.
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Design tab
When viewing a report in the layout view, you can select a column and select options on the 
Design tab to change how the data in the column is presented. For example, you can add cal-
culations to the column or roll up the column’s data. The Design tab is shown in Figure 47.

Figure 47: Design Tab

Background The buttons in this group let you add a background color to the 
report. You can select the background color and add a gradient 
color to blend into the primary color. You can also choose how 
intense the colors should be with the Transparency setting.

Display The buttons in this group let you add margins to the report and set 
the report’s width.

Margin Click this button to select the width of the margins around the 
report. The available options are None, Narrow, Medium, Wide, 
and Custom. Selecting Custom lets you specify the number of pix-
els for the top, bottom, left, and right margins.

Width Click this button to select the width of the entire report. The avail-
able options are Best Fit and Fit to Window.

Table 23: Page Setup Tab Description (Continued)

Group/Button Description
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The groups and buttons on the Design tab are described in Table 24.

Format tab
When viewing a report in the layout view, you can select a column and select options on the 
Format tab to change how the data in the column is displayed. For example, you can change 
the fonts, hide repeating lines of data, and replace numeric data with gauges. The Format tab 
is shown in Figure 48.

Table 24: Design Tab Description

Group/Button Description

Arrange The buttons in this group let you move and hide the selected col-
umn.
Note: To show hidden columns, right-click the header of a visible 
column, select Insert Hidden Column, and select the column you 
want to show.

Sort Click this button and select Sort Ascending or Sort Descending to 
sort the data in the report by the values in the selected column. 
Refer to “Changing sort options” on page 141.

Calculations The buttons in this group let you add calculations to the selected 
column. You can hover over each button to view a description of 
the calculation. You can also choose to show multiple calculations 
on a single row or on separate rows. Refer to “Adding column cal-
culations” on page 281.

Rollup The buttons in this group let you group the information in the 
report by the selected column. You can also change the ordering if 
your report has multiple rolled-up columns. Refer to “Displaying 
rollup levels” on page 155.

Slice The buttons in this group let you slice the data in the report by the 
selected column. You can also change the slice level if your report’s 
data is sliced by more than one column. You can choose to display 
slice columns as a tree or as links. Refer to “Slicing report data” on 
page 147.
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Figure 48: Format Tab

The groups and buttons on the Format tab are described in Table 25.

Table 25: Format Tab Description

Group/Button Description

Font The buttons in this group let you change the font style, size, and 
color. You can also select font attributes, such as bold and italic, 
and change the text’s alignment. In addition, you can add a back-
ground color.

Margin Click this button to select the width of the margins around the 
selected column. The available options are None, Narrow, 
Medium, Wide, and Custom. Selecting Custom lets you specify the 
number of pixels for the top, bottom, left, and right margins.

Border The buttons in this group let you add borders to the column and 
change the borders’ display options. You can identify which bor-
ders you want and choose the borders’ color, size, and style.

Display The buttons in this group let you apply conditional formatting to 
the column, change the column’s width, freeze the column, and 
hide repeating values in the column. You can also select other dis-
play options for the column.

Conditional Formatting Click this button to apply conditional formatting to the column’s 
data. Refer to “Editing column format options” on page 264.

Width Click this button to select a width for the column. Select Best Fit to 
automatically set the width based on the amount of space needed 
to display the column’s contents. Best Fit also takes into account 
the width needed by other columns in the report. Select Percentage 
to specify a percentage of the total report width for the column.
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Freeze Column Click this button to fix the selected column in place so it does not 
move when you horizontally scroll the report. This can be helpful 
if you want to continue to view the first column in the report while 
scrolling the report to see the columns on the right of the report.
Note: When you fix a column, all columns to the left of the col-
umn will also be fixed. You will still be able to scroll the columns to 
the right of the fixed column.

Hide Repeating Click this button to hide consecutive repeating values in the col-
umn. For example, if the name of a staff member is shown in the 
column in five consecutive rows, you can hide repeating values to 
show the name in only the first column.
Note: If the Exclude Hidden Values from Calculations check box 
is selected on the Column Format window’s Alignment tab, any 
calculations applied to a column with the Hide Repeating option 
enabled will not include any values in the column that are in hidden 
rows. Refer to “Editing column format options” on page 264 for 
more information.

Options Click this button to select display options for the column. Refer to 
“Editing column format options” on page 264 for descriptions of 
all options.

Number The options in this group let you display numeric values as a gauge 
and select numeric formats. Refer to “Editing column format 
options” on page 264 for descriptions of these options.
Note: This group displays when selecting a column containing 
numeric values.

Date The options in this group let you select a date format for the col-
umn and view the format. Refer to “Editing column format 
options” on page 264 for descriptions of these options.
Note: This group displays when selecting a column containing 
date/time data.

Table 25: Format Tab Description (Continued)

Group/Button Description
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Searching in reports and analyzing output
You can search for specific records in reports from the Search window. You can open the 
Search window from the report’s Home tab. This window also opens automatically when the 
report includes required run-time filters or if the Open Report Without Prompting for Search 
Parameters report option is not selected. Refer to “Changing report properties” on page 355 
for information about report options.

The options available when searching for information consist of the run-time filters, output 
variables, sorting options, and other search parameters added when the reports are created or 
edited. The search parameters are specific to each report, though many reports share similar 
filters and output variables.

To search for records in a report:
1 Click the Home tab.

2 Click the Search button to open the Search window.

Figure 49: Search Window

Important Reports are intended to output only the information you need to view or access 
for a specific purpose. We recommend that you configure custom reports to 
include fixed filters or required run-time selectable filters to limit the data they 
can return. Refer to “Custom Reports” on page 175 for information about cre-
ating custom reports and configuring report filters.
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3 To resize the Search window, drag the borders. The window size is saved to your personal 
settings so it will open with the size you specify the next time you open the window when 
running the same report. Clicking the window’s Reset button resets the search parameters 
and the window size to their default values.

4 Select the filters, sort options, and record limit for the report.

The options available on the Search window are described in Table 26.

Note Search options often include date range filters and date grouping output vari-
ables. For the procedure to select date ranges, refer to “Selecting date ranges” on 
page 93. For information about date grouping, refer to “Understanding date 
grouping output variables” on page 94.

Table 26: Search Window Description

Field Description

Filters This section displays the report’s run-time selectable filters. The 
methods used to set the filter values vary depending on the filters’ 
data types and operators. For example, the values might be multi-
selected from menu lists, specified in date fields, or typed in a text 
field. Text area fields are not available for use in report filters.
If the filter displays a menu list, you can select all options in the list 
by selecting the Select All check box, or you can clear all options in 
the list by clearing the Select All check box. Refer to “Creating 
report filters” on page 313 for information about defining run-
time filters.
This section also lists output variables that have been added to the 
report. Output variables can have the same types of selection 
methods as run-time selectable filters. Refer to “Variables” on page 
238 for information about output variables.

Limit and Order This section allows you to limit the number of rows returned in the 
report and select how the report output should be sorted.
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Limit To Select this check box to limit the number of rows returned on each 
page of the report’s output level or on the entire output level. Lim-
iting the total number of records returned on the output levels pre-
vents reports from returning more records than can be easily 
viewed or printed.
Note: The VLR_HARD configuration setting sets a hard limit on 
the number of rows that can be returned in a report. Values 
entered in the Limit To field that exceed this will be ignored. Refer 
to Appendix A, “Analytics System Configuration Settings,” on page 
417 for information about VLR_HARD and other configuration 
settings that can impact reports.

Rows Type the number of rows that should be returned.

Per Page Select this check box to change the number entered in the Rows 
text box from a hard limit on the total number of rows returned in 
the report to a limit on the number of rows returned on each page 
of the report.

Order By Click the current sort order fields to open the Sort window where 
you can select different sort options. The report’s default sort order 
is displayed with the primary sort field listed first, followed by any 
subsequent sort fields. The direction each sort field is ordered in is 
also indicated (Asc for ascending order and Desc for descending 
order). For information about sorting, refer to “Changing sort 
options” on page 141.

Save as Defaults Click this button to save the filter values you select to the local set-
tings on your workstation. These saved values will be used as the 
defaults when you run the report again when you are logged in 
with the same staff account.
Note: The default values will be overwritten if you select different 
values and click this button again. If the report is later edited to 
change filters, the default filter values stored in the local settings 
will be ignored.

Restore Defaults Click this button to restore the search values to the report’s default 
search values. This deletes saved search values from personal set-
tings.
Note: This button is disabled if the report’s current search param-
eters were not populated from personal settings.

Table 26: Search Window Description (Continued)

Field Description
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5 To close the Search window without saving your changes, click the Cancel button.

6 Click the Search button to search the report with the search parameters you selected.

Selecting date ranges
Most of the standard reports in RightNow include run-time filters created from date/time 
fields that allow you to select a time and date range on which to filter the report’s data. Which 
records are included in the time period depend on the type of report. For example, the Inci-
dent Activity report includes the Date Created run-time filter, which allows you to display 
incidents created during a particular date range.

You have several options when selecting a date range. For example, you can select whether 
you want to use exact dates, a period of time relative to today’s date, or even the current time. 
When the Relative check box is cleared, you can type in a specific date and time, or click the 
Calendar button next to the date and time to view a calendar and select a specific date. By 
selecting the Relative check box, you can define relative times to search on, such as the previ-
ous three months, instead of absolute times.

To select a relative date range in report run-time filters:
1 Select the Relative check box on the Search window to toggle from a specific date to a rel-

ative date.

2 Click the Calendar button to display the relative options.

Figure 50: Date/Time Run-Time Filter Selection Window

Reset Click this button to reset the search parameters’ values to the 
default values that were populated when the report was opened. 
Clicking this button also resets the Search window to the default 
size if it has been resized.

Table 26: Search Window Description (Continued)

Field Description
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3 Enter field information described in Table 27.

4 Click the OK button to save the relative date period you want to search on.

Understanding date grouping output variables
While most options on the Search window are run-time selectable filters, which limit the 
returned data, date grouping options are output variables that group the report’s data by the 
time period in which a specified event occurred. This output variable can be added to custom 
reports and is frequently used in standard reports.

For example, the Agent Activity standard report displays incidents that were assigned to staff 
members within a certain time range. The default time range is Year/Month/Day, so a row is 
displayed for each day in the selected date range listing the number of incidents assigned to 
the agent per day. However, you can select from the options on the Date Grouping menu to 
group the data by a different time period, such as week or quarter. Figure 51 shows the Date 
Grouping menu on the Agent Activity report’s Search window.

Table 27: Relative Date Range Description

Field Description

Offset By Enter the number of time units to use in this field. Values can be 
positive or negative. For example, negative values would be used to 
report on a date range of 6 months ago to 1 month ago.

Time Units Select the time unit to use from this drop-down menu. The avail-
able options are Minutes, Hours, Days, Weeks, Months, Quarters, 
and Years.

Exactly Select this radio button to use the exact time period entered. For 
example, if you run a report at noon on a Wednesday that returns 
records created from exactly one week ago to the current day, the 
report will return records created between noon on Wednesday of 
the previous week and the current day.

Rounded to Beginning of 
Time Period

Select this radio button to round the selected time period to the 
beginning of the time period. For example, if you run a report on a 
Wednesday that returns records created from one week ago 
rounded to the current day, the report will return records created 
between 12:01 A.M. on Sunday of the previous week and the cur-
rent day.
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Figure 51: Date Grouping Output Variable

When date groupings are shown in the report’s output, they display as the number associated 
with the time period. Selecting Year/Week, for instance, displays the year followed by the 
number of the week (2009/23). However, the display format of grouped date columns can be 
changed with the Group Date Format configuration settings located at Common Configura-
tion>System Configuration>Settings>RightNow Common. Refer to the RightNow 
Administrator Manual for information about changing configuration settings and Appendix A, 
“Analytics System Configuration Settings,” on page 417 for descriptions of the configuration 
settings that impact reports.

Understanding incident performance intervals
Incident performance intervals are used as run-time selectable filters in several standard 
Service reports, and can be added as filters or output columns to custom reports. Incident 
performance intervals help you track the length of time between events that occur in the life 
of an incident. For example, the Create to Initial Response interval tracks the time between 
the incident’s creation and when the first incident response was sent. There are several types 
of intervals, some of which can overlap others. For example, the Create to Final Resolved 
interval overlaps the shorter Assign to Response interval.

Some intervals can occur more than once in the life of an incident. For instance, the Assign to 
Response interval records the time between an incident being assigned to an agent and the 
agent sending a response to the incident. If the incident is assigned to and responded to by 
several agents, several instances of this interval will be recorded for the incident.
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The following incident performance intervals are available for use in reports:

• Create to Initial Response—Measures the interval between the creation of the inci-
dent and the first incident response being sent from an agent.

• Status Change to Response—Measures the interval between an incident’s status type 
being changed from Waiting or Solved and being set to Unresolved.

• Assign to Response—Measures the interval between an incident being assigned to an 
agent and the first response following the assignment.

• Create to Final Resolved—Measures the interval between the creation of the incident 
and the last time the incident was set to the Solved status type.

• Last Assigned to Final Resolve—Measures the interval between the last time the 
incident was assigned and the last time the incident was set to the Solved status type.

• Create to Initial Assigned—Measures the interval between the creation of the inci-
dent and the first time the incident was assigned to an agent.

• Create to Initial Resolved—Measures the interval between the creation of the inci-
dent and the first time the incident was set to a Solved status type.

• Assigned to Reassigned—Measures the interval between the incident being assigned 
to an agent and the incident being assigned to a different agent or to no agent.

• Status Change to Reassigned—Measures the interval between the incident being 
changed from a Waiting or Solved status type to Unresolved and the incident being 
reassigned to another agent. 

• Queued to De-queued—Measures the interval between the time an incident enters a 
queue to the time the incident is moved to no queue or a different queue. If the inci-
dent’s queue does not change, the interval ends when the incident is set to the Solved 
status type.

• Queued to Initial Assigned—Measures the interval between an incident being placed 
in a queue and the incident being assigned to an agent for the first time.

• Queued to Initial Response—Measures the interval between an incident being placed 
in a queue and being responded to for the first time.

• Queued to Initial Resolved—Measures the interval between an incident being placed 
in a queue and being set to the Solved status type for the first time.

• Backlog—Measures the interval between an incident being created, or being changed 
from a Waiting or Solved status type to the Unresolved status type, or being added to a 
queue, to the incident being edited (with the edit saved).

• Incident Edit—Measures the interval between an incident being edited and the edit 
being saved.



Searching in reports and analyzing output 97

• Servicing—Measures the interval between an incident being created, added to a queue, 
or changed from a Waiting or Solved status type to the Unresolved status type, to the 
incident being set to a Waiting or Solved status type or being added to a different queue.

• Initial Response to Initial Resolved—Measures the interval between the incident 
first being responded to and first being set to the Solved status type.

• Queue Initial Response to Initial Resolved—Measures the interval between the 
time an incident that is assigned to a queue is responded to and the time the incident is 
set to a Solved status type, while in the same queue.

• Final Waiting to Final Resolved—Measures the interval between the last time an 
incident is set to the Waiting status type and the last time the incident is set to the 
Solved status type.



98 Report Management

Chapter 3

A graphical representation of the incident performance intervals is shown in Figure 52.

Figure 52: Interval Types
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Understanding the First Contact Resolution Rate
The First Contact Resolution Rate (FCRR) is used in several standard Service reports and can 
be included in custom reports. This calculation can be used to search by or display the per-
centage of incidents that were resolved after only one response. To use the FCRR correctly, it 
is important that you understand how the result is derived.

The FCRR is calculated by taking the number of incidents solved after one response by the 
agent and dividing this number by the number of incidents that were solved after one or more 
responses. To ensure your agents’ performance is reflected in the FCRR, some incidents and 
responses are not included in the calculation. If an incident is solved without any responses 
sent, the incident will not be included. In addition, responses automatically appended by rules 
are not included. If an incident is responded to by a staff member, then reassigned, only the 
responses sent by the agent who solved the incident are included.

Understanding report caching
Some of RightNow’s standard reports return data compiled during previous time periods, and 
you can create custom reports that use data from tables that store this cached information. 
Reports that use cached data can query a large amount of information in a short amount of 
time since cached data is stored in only a few database tables. Reports that use cached data are 
often designed to compare data from one time period to another, such as comparing sales fig-
ures from one quarter to another.

Before you analyze data returned in reports, it is beneficial to understand how using cached 
data can affect your reports. The Agedatabase utility runs nightly to cache data to prepare for 
the following day’s reporting needs. Cached data will remain constant throughout the day and 
will not be updated until the next day, after Agedatabase has compiled the information. For 
this reason, reports using cached data will not have data for the current day. Understanding 
which reports use cached data will help you accurately interpret your reports’ results. If you 
view the report definition for the report you want to run and see the report includes a data-
base table that stores cached data, you will know the report uses cached information and may 
not include data from the current day. Refer to “Viewing report definitions” on page 72 for 
information about report definitions.
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Queuing reports
Reports, whether opened individually or in dashboards, can take a long time to run if their 
database queries attempt to query a large amount of information. However, you can queue 
reports with intense queries so you can continue to work in RightNow while the reports run 
in the background. When the queued reports have been run, you can open them and immedi-
ately view their data.

You can manually queue reports that you think may take a long while to run or that you want 
to view at a later time. If RightNow determines that a report will take an excessive amount of 
time to run, which can result in unnecessary load on your database, you will be given the 
option to queue the report using the report’s current search parameters. If you choose not to 
queue the report, you can select more restrictive search parameters for your report and try to 
run it again.

If your site is configured to use a report database for reporting purposes, queuing works 
somewhat differently than it does on sites without a report database. Refer to “Report data-
bases” on page 105.

This section describes how to manually queue a report, what to do when presented with auto-
matic queuing options, and how to view reports that have been queued once they process.

Manual queuing
You can easily queue reports or dashboards that you think may query or return large amounts 
of data. This is also helpful if you want to view a number of reports but do not want to wait 
for each to generate.

To manually queue a report or dashboard:
1 Select the report or dashboard on the Reports explorer and click the ribbon’s Queue but-

ton.

Or

Right-click the report or dashboard, either on the Reports explorer or the navigation list, 
and select Queue.

The Queue Search Filters window opens where you specify the search parameters you 
want to use for the queued report.

Note Reports that attempt to query too many rows in the database will not be able to 
run. If you queue such a report, the server will not be able to process it.
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Figure 53: Entering Search Parameters for a Queued Report

2 Enter the search parameters you want to use. For information about specifying search 
parameters, refer to “Searching in reports and analyzing output” on page 90. 

3 Click the Queue button. A message displays an approximation of when the report or dash-
board will be generated.

Figure 54: Estimated Delivery Time for a Queued Report

4 Click the OK button to close the window.

For information about viewing reports in the queue and opening queued reports that have 
processed, refer to “Viewing queued reports” on page 103.

Note The time displayed is an approximation of how long it will take to process the 
queued report or dashboard. However, if there are other reports or dashboards 
in the queue, it can take longer than the displayed time to process your queued 
report or dashboard.
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Automatic queuing
When you attempt to open a report, the database query for the report is checked. If the sys-
tem determines that the query will likely take too long to process, the Unable to Process 
Report message asks if you want to queue the report.

Figure 55: Choosing to Queue a Report

If you want to attempt to run the report using different search parameters, click the Cancel 
button and the report’s Search window will open. If you want to queue the report using the 
search parameters you selected when you attempted to run the report, click the OK button. If 
you do so, a message, shown in Figure 54 on page 101, will display an estimate of how long it 
should take to process the report, just as if you had manually queued the report.

Once a report is automatically queued, it will be queued every time it is run thereafter, since it 
is assumed the report’s filters and data set result in long run times. If you do not want the 
report to be automatically queued when it next runs, you can open it for editing and save it. 
When you edit the report, we recommend adding fixed filters or otherwise reducing the 
amount of data the report looks at to allow it to run more quickly. 

To view reports that will be automatically queued when they are next run, you can run the 
Deferred Reports standard report. This report is located in the Reports explorer’s Com-
mon>Site Administration>Reports folder.

Note Reports that are displayed on workspaces or previewed on the report designer 
are never queued. If it is determined such a report will take too long to generate, 
the report will not be displayed.
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Queuing failures
It is possible that a report you queue will not run successfully. There are several reasons why 
this might happen.

• You already queued the report using the same search parameters and the first queued 
report has not yet run.

• The original report you queued was deleted after you queued it and before the queued 
report could be processed.

• The report is deleted from the queue by another staff member before the report can 
run and you can view it. However, only the staff member who queues the report and 
staff members with the Analytics Administrator profile permission can remove reports 
from the queue.

• The queued report processes, but is not opened within the number of days specified in 
the PURGE_QUEUED_REPORT_DAYS configuration setting. Queued reports and 
dashboards that have been run but not opened within this time period are automatically 
removed. The default value for this configuration setting is seven days.

• You manually queue a report or dashboard that cannot run due to the query surpassing 
a limit on the number of database rows that can be accessed.

Viewing queued reports
After you queue a report, you can use standard reports to see what the report’s status is in the 
queue. Once the report runs and is ready to view, you will be notified and you can open it 
from several locations. When you view the report, you will see that most of the standard 
options are available on the report’s ribbon, though there are some exceptions.

This section explains how to check the status of a queued report, how to open a queued 
report that is ready to view, and describes changes to the ribbon for queued reports.

Viewing reports in the queue
When you queue a report, it is placed in a queue where it will be processed by the server. If 
there are other reports in the queue that have not yet been processed, your report will be 
placed at the end of the queue. You can see the reports that are in the queue using the My 
Queued Reports and Reports Waiting in Queue standard reports, located in the Reports 
explorer’s Public Reports>Common>Site Administration>Reports folder.
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My Queued Reports shows you the reports you have queued and not yet viewed. When you 
view this report, you will see that queued reports can be in one of three states:

• Waiting—Reports in this state are waiting to be run on the server. You can remove 
reports from the queue that are in this state.

• Processing—Reports in this state are currently being run on the server. You cannot 
remove reports from the queue that are in this state.

• Complete—Reports in this state have been run on the server and are ready to view. 
You can remove reports from the queue that are in this state without viewing them.

Reports Waiting in Queue shows you all the reports that are in the queue waiting to be pro-
cessed, regardless of who queued the report. Staff members with the Analytics Administrator 
profile permission can remove reports from the queue using this report if necessary.

Opening queued reports
When the database server has run a queued report and it is ready to view, you will receive a 
message in a toast notification and in your list of notifications. An example of a toast notifica-
tion informing you that a queued report is ready is shown in Figure 56.

Figure 56: Queued Report Toast Notification

To view the report, click Open on the toast notification or double-click the notification in 
your notifications list. The report will open on the content pane. You can also open reports 
you queued from the My Queued Reports standard report.

Important Once a queued report is processed, you have a default of seven days to view it. 
Reports older than the time period specified in the PURGE_QUEUED_
REPORT_DAYS configuration setting will be deleted from the list of processed 
reports by the Agedatabase utility. For information about this and other config-
uration settings that impact reports, refer to Appendix A, “Analytics System 
Configuration Settings,” on page 417.



Report databases 105

Using queued reports
When you open a report that you queued, it will display and function just like a report that has 
not been queued, letting you print the report, change display options, open records from the 
report, and view drill-down levels.

However, some of the standard features you see in reports are not available when viewing a 
report that was queued. Docked filters are not displayed and the report does not include the 
optional Action column that shows links such as Open and Delete. In addition, you do not 
have access to the following buttons on the ribbon.

• Search

• Refresh

• Reset

• Definition

• Links

Report databases
Some RightNow sites have a copy of their database available for reporting purposes. Queuing 
works slightly different on those sites because of the increased options a second database pro-
vides.

Note The queries used to return data in drill-down levels are not queued when you 
queue a report. If your report includes drill-down levels, the queries are run on 
the server when you open the drill-down levels.

Note You can view the output from a queued report as many times as you want. How-
ever, it is important to remember that the output is static. If you need current 
information from the report, you will need to run or queue the report again.

Note For information about report databases, contact your RightNow account man-
ager.
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If your site is configured to use a report database, keep the following considerations in mind 
when running and queuing reports.

• Any reports you queue will automatically run on the report server unless the report is 
configured to always run on the production server. You can select this option when 
editing the report. Refer to “Changing report properties” on page 355.

• When you attempt to run a report, RightNow checks the database query generated by 
the report. If it is determined the query will take longer than ten seconds to run, the 
report will run on the report server unless the report is configured to always run on the 
production server.

• If a report is to be run on the report server and it is determined it will take longer than 
sixty seconds to run the report’s query, you will be given the option to queue the report. 
If you choose not to queue the report, you can attempt to run it again using different 
search parameters.

• Reports that you attempt to run on the report server can encounter limits on the num-
ber of database rows that can be queried. However, the row limits for queries run on 
the report server are considerably higher than the row limits on the production server.

Distributing reports
After you open a report, you can print it, forward it to an email address, publish the report to 
your folder list, or export the data to be used in an external application. You can also schedule 
reports to be published or emailed at specified times, or when specified data conditions are 
met. If you have another RightNow interface and want to create a copy of your report on the 
other interface, you can also export your report’s definition and import it on the other inter-
face.

Reports opened outside RightNow may not display exactly as they do when viewed within 
RightNow. Descriptions of the changes you may see when viewing reports outside RightNow 
are included in this section, along with descriptions of each distribution method.

Important Before you can print, export, or forward reports or dashboards, the Print/
Export/Forward Reports permission must be enabled on your profile’s 
Analytics tab. Refer to the RightNow Administrator Manual for information about 
editing profiles.
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Modifications made to distributed reports
When reports are exported, forwarded, printed, published, or sent as a scheduled report, cer-
tain changes are made to the reports to ensure that they display correctly. These changes are 
described in this section.

• Drill-down links to other reports, dashboards, or report levels will be disabled in the 
distributed report. Refer to “Adding additional output levels” on page 328 for informa-
tion about drilling down into report levels and “Linking reports” on page 337 for infor-
mation about drilling down into other reports or dashboards.

• If the report includes the Links column, which contains links to modify the report’s 
records, the column will not be shown on the report.

• If the report’s width is set to Fit in Window, the report is shown using the Best Fit 
width setting. Refer to Table 35 on page 132 for descriptions of these settings.

• Reports shown in the record layout by default are converted to tabular layout when they 
are exported or scheduled in an Excel format. This ensures that the report’s data can be 
easily read in a column and row format. Refer to “Selecting record or tabular layouts” 
on page 130 for information about layouts.

• If the report lacks a report header or has a blank header, a header containing the 
report’s name is added to the report.

• If the width of a report column is set to be a percentage of the report’s width, and the 
report’s width is not fixed, the column’s width setting is changed to Best Fit. Refer to 
“Editing columns” on page 262 for information about column width settings.

Printing reports
In RightNow, you can preview reports to see what they will look like on a printed page and 
send reports to the selected printer.

Previewing reports
The Print Preview option lets you see how your report will print before you send the report 
to your printer. From the Print Preview window, you can print your report, zoom in and out 
of the displayed page, view other pages, and specify how the pages should display in the pre-
view window.

Important If your report includes multiple output levels, drill down to the information you 
want to display in the distributed report before you export, forward, or publish 
it.
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To preview a report:
1 Open the report you want to print.

2 Click the Application button and select Print>Print Preview. The Print Preview window 
opens.

Figure 57: Print Preview Window

3 Enter field information described in Table 28.

Table 28: Print Preview Window Description

Field Description

 Print
Click this button to send the report to the printer.

 Zoom
Click the down arrow to select the desired zoom percentage and 
preview the report with the selected zoom level. Click the binocu-
lars button to reset the zoom level to the default percentage.

 One Page
Click this button to view one page of the report on the Print Pre-
view window.

 Two Pages
Click this button to view two adjacent pages of the report on the 
Print Preview window.

 Three Pages
Click this button to view three pages of the report on the Print 
Preview window.

 Four Pages
Click this button to view four pages of the report on the Print Pre-
view window.
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Printing reports
Reports can be sent directly to the printer from the Page Setup tab or from the application 
menu’s Print option, allowing you to bypass print preview.

To print a report:
1 Click the Page Setup tab.

2 To include the page header or page footer report sections on the printed report, select the 
Page Header or Page Footer check boxes.

3 To scale the report to your printer’s default page width, select the Print to Fit check box.

4 Click the button to the right of the Print group name to open the Page Setup window 
where you can set printing options.

Or

Select printing options from the Page Setup tab’s Print group. Refer to Table 23 on page 
85 for option descriptions.

 Six Pages
Click this button to view six pages of the report on the Print Pre-
view window.

Close Click this button to close the Print Preview window without print-
ing the report.

Page Select the page number to view on the Print Preview window, 
either by typing in the page number or by scrolling through the 
available page numbers with the arrow buttons.

Tip If you know the specific options you want, it can be faster to select them from 
the ribbon. Opening the window gives you an overview of all the available 
options.

Table 28: Print Preview Window Description (Continued)

Field Description
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Figure 58: Page Setup Window

5 Enter field information described in Table 29.

6 Click the OK button to save your page setup settings.

Table 29: Page Setup Window Description

Field Description

Paper This section contains options for selecting paper size and source.

Size Click the appropriate paper size for the report from this drop-
down menu. The available paper sizes are dependent on your 
selected printer.

Source Click the paper source from this drop-down menu. The available 
paper sources are dependent on the printer that is currently 
selected.

Orientation Select whether the report should be printed in landscape or por-
trait mode.

Margins Define the Left, Right, Top, and Bottom margins for the report.
Note: The measurement units used for the margin size are deter-
mined by your computer’s environment.

Printer Click this button to select the printer you want to use.



Forwarding reports 111

7 Click the Application button, select Print, and select your printing preference:

a Select Print to open your workstation’s print window where you can define printer set-
tings and send the report to the printer.

b Select Quick Print to send the report directly to your default printer using the printer’s 
default settings.

Forwarding reports
Once you view a standard or custom report, you can immediately forward the report to one 
or more recipients as an HTML email. You can also forward dashboards using the same pro-
cedure.

To forward a report:
1 Click the Home tab.

2 Click the Forward button to open the Forward Report window.

Figure 59: Forward Report Window

Important Reports can be forwarded as long as the resulting HTML email does not exceed 
8 MB.
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3 Type one or more email addresses in the To field. Multiple addresses must be separated by 
semicolons. You can also enter addresses in the Cc field to send copies of the email to 
other addresses, or enter addresses in the Bcc field to send copies of the email to other 
addresses that are hidden from the other email recipients.

Or

Click the To, Cc, or Bcc buttons to open the Select Names window, displayed in Figure 60. 
From this window you can add recipient addresses by selecting from a list containing staff 
members, groups, and distribution lists.

Figure 60: Selecting Recipients

4 Enter field information described in Table 30.

Table 30: Select Names Window Description

Field Description

Type Name or Select from 
List

Select the entry from the list of names or enter the first few letters 
of the name in the text field. You can select multiple entries by 
pressing Shift or Ctrl while selecting the entries.

Name Click the Name column header to sort the list by name.

Address Click the Address column header to sort the list by email address.
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5 Click the OK button to return to the Forward Report window.

6 Select a format for the forwarded email. The options are HTML Email or HTML Attach-
ment (Images/Charts stored on the server).

7 Type a subject for the email.

8 Type any text you want to appear in the email in the Comment text box.

9 Click the Send button to forward the report.

Type Click the Type column header to sort the list by type.

Message Recipients This section lists the groups, staff members, and distribution lists 
the report will be forwarded to.

To Click this button to add highlighted entries to the Message Recipi-
ents To field.

Cc Click this button to add highlighted entries to the Message Recipi-
ents Cc field.

Bcc Click this button to add highlighted entries to the Message Recipi-
ents Bcc field.

Important Not all email clients show HTML emails in the same manner. If email recipients 
cannot view a forwarded report correctly, select the HTML Attachment 
(Images/Charts stored on the server) format. Email recipients will then be able 
to save the image or chart to their hard disk and then open it in a browser. The 
images and charts used in the email will be stored on the server for the number 
of days specified in the CHART_KEEP_SCHEDULED configuration setting. 
Refer to Appendix A, “Analytics System Configuration Settings,” on page 417 
for information about this and other configuration settings that impact reports.

Table 30: Select Names Window Description (Continued)

Field Description
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Publishing reports
Publishing a report lets you modify the data and display options of an existing report and 
then save a copy of the report with these settings which other individuals can then access. 
Once a report is published, it cannot be modified and the report data will remain unchanged 
even as the knowledge base is updated. This ensures that your audience is presented with the 
report as you want them to see it.

Published reports can be viewed by staff members who have permissions in their profile. You 
can change the permissions and published report properties by editing the published report. 
For detailed instructions about changing permissions, refer to “Specifying permissions” on 
page 354.

The published report will appear exactly as it appeared when you published it, with the fol-
lowing exceptions:

• Drill-down links are disabled for report levels and linked reports.

• The report’s run-time selectable filters are not available.

• Actions that can be taken on individual records in the report are disabled. Therefore, 
buttons on the Home tab’s Record group are not available, inline editing is disabled, and 
action links will not be displayed.

• The Publish option is not available.

You can also automatically publish a report at specific times using the Published format when 
you schedule a report. Published reports created in this manner are saved in a custom reports 
folder you select on your site where your audience can easily access them. If you specify an 
account or email address when you create the report schedule, a notification or email will be 
sent when the published report is created.

The following procedure describes how to manually publish a report. For information about 
scheduling a report using the Published format, refer to “Scheduling reports” on page 121.

Note If the report style the report used when it was published is deleted, a default 
report style will be used when rendering the published report.

Tip You can view the published reports you own using the My Published Reports 
standard report.
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To manually publish a report:
1 Run the report using the search parameters you want the published report to use.

2 Click the Application button and select Publish to open the Publish As window.

Figure 61: Publish As Window

3 Select a directory to store the published report and type the name of the report. The name 
must be unique.

4 Click the OK button to save the published version of the report in the location you speci-
fied.

Exporting report output
You can export your report’s output to be opened in third-party applications. You can choose 
to export your data in HTML, PDF (Portable Document Format), Excel, XML (Extensible 
Markup Language), Image, or Delimited formats. Dashboards can be exported using the 
same formats.

Tip You can right-click non-standard folders and select New Folder to create a new 
folder.

Tip If you want to copy the contents from a few cells in your report to another 
application, you do not need to export the report’s data. Instead, you can right-
click the cell you want to copy and select Copy Cell to Clipboard. Once the data 
is on your clipboard, you can copy the data to other applications.
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When you export a report, you can choose to export only the information shown on the cur-
rent page of the report or you can export all the data in the report, up to 100,000 rows. If you 
need to export more data than this, we recommend using an Open Database Connectivity 
(ODBC) connector. For information about this option, contact your RightNow account man-
ager.

This section describes exporting data from reports, but dashboards are exported in the same 
manner except where noted.

To export report data:
1 Click the Home tab.

2 Click the Export button to display a menu containing export options.

3 Select from the options described in Table 31. 

Note When viewing a report in RightNow Analytics, a maximum of 50,000 characters 
can be displayed in a single field even if the field contains more characters than 
this. However, up to 300,000 characters in a field can be exported, though char-
acter limitations in third-party applications may still be encountered when view-
ing the exported report.

Important Reports exported from RightNow and opened in third-party applications are 
subject to the functionality of those applications. We recommend that you 
review the version of your application to ensure it supports current functionality. 
Refer to your software’s user manual for information about configuring your 
application.

Table 31: Export Format Options

Field Description

HTML This option exports the data to an HTML-encoded document, 
which is compatible with exporting images and charts. Reports can 
be exported using absolute or relative HTML layouts. Refer to 
Table 32 on page 118 for more information.
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Once you select a format, the Export Options window will open where you can specify 
the file name and location you want for the exported report, whether to include the report 
name, and whether all the report’s data should be returned or only data shown on the cur-
rent page. The HTML, PDF, and custom delimiter export options include additional 
export options. The Export Options window for an HTML export is shown in Figure 62.

PDF This option exports the report data as a PDF file, which is compat-
ible with exporting images and charts. When you select this option, 
you can choose to set the file’s page width automatically or use the 
options on the Page Setup window. Refer to Table 32 on page 118 
for more information.

Excel This option exports the report data in Microsoft Excel format.
Note: When exporting in this format, the version of Microsoft 
Excel installed on your workstation is automatically checked and 
the report is exported as an .xls or .xlsx file depending on the ver-
sion.

XML This option exports the report data in XML format.

Image This option exports the report data to a .jpg image file, which is 
compatible with exporting images and charts.

Delimited This option exports the data to a character-delimited file. When 
you select this option, the Delimiter Selection window will open, 
where you can specify the character you want to use as the delim-
iter. You can choose Comma, Space, Tab, Pipe, Caret, or a custom 
delimiter you select. The delimited format is intended for use with 
tabular data only.

Table 31: Export Format Options (Continued)

Field Description
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Figure 62: Export Options Window

4 Select from the options described in Table 32.

Table 32: Export Options Window Description

Field Description

Location This field displays the location and file name the exported report 
will be saved to. When the Export Options window is initially 
opened, a default directory location and file name is displayed.

 Save to Folder
Click this button to open the Save As window if you want to spec-
ify an alternate location or file name for the exported report. 

Launch Application Select this check box to automatically launch the application asso-
ciated with the exported report’s file type when you close the 
Export Options window.
Note: If you are exporting a large amount of data, you may want 
to clear this check box to prevent the application from attempting 
to immediately open when you export the report.
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Append Date/Time to 
File Name

Select this check box to append a date/time stamp to the file name 
that shows when the export file is generated. The date/time stamp 
will be appended to the end of the file name before the file name 
extension.

Date/Time Format Type the format you want to use for the date/time stamp you 
append to the export file name. The default format is %Y-%m-%d 
%H.%M.%S. This creates a date/time stamp with the year listed first, 
followed by the month, day, hour, minute, and second (such as 
2009-02-25 09.43.30). The format you specify is automatically 
saved to your personal settings so this will be your default format 
the next time you export a report.
Note: For a list of the date/time tokens you can use in the format, 
refer to the RightNow Administrator Manual.

Reset Click this button to reset the date/time format to the default for-
mat (%Y-%m-%d %H.%M.%S).

Save the Selected 
Directory as the Default 
Directory

Select this check box to make the folder you specify your default 
export directory. Selecting this check box saves the folder name to 
your personal settings so future exports will be saved to the speci-
fied folder.

Add Report Name to 
Output

Select this check box to include the report’s name in the export file.
Note: This option is not available when exporting dashboards. 
Report names will display in exported dashboard files if their title 
bars are enabled in the dashboard’s display options. Refer to 
“Changing dashboard options” on page 386 for information about 
including report title bars on a dashboard.

Data Set The radio buttons in this group let you choose to export all the 
data returned by the report’s current search criteria or only data 
shown on the report when the Export button is clicked.
Note: Data Set options display only if the report’s output is 
restricted by record limits, page limits, slicing, or auto-filters when 
the Export button is clicked. These options do not display when 
exporting dashboards.

Export Current Page Select this radio button to include only the data currently shown 
on the report in the export file.

Table 32: Export Options Window Description (Continued)

Field Description
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Export All Data Select this radio button to include all the data from the report, up 
to 100,000 rows, regardless of the report’s current record limits, 
page limits, slicing, or auto-filters settings.

HTML Options Select how you want the HTML file to be generated in this section.
Note: This section displays only when you select HTML format.

Use Absolute Layout Select this radio button to format the export file using absolute lay-
out. The exported report will match the display of the original 
report very closely, though discrepancies may be noticed in some 
reports.
Caution! Some browsers do not support printing HTML files that 
use this layout.

Use Relative Layout Select this radio button to format the export file using relative lay-
out. The exported report will be similar to the original report, 
though there may be some discrepancies.
Note: Most browsers support printing HTML files that use this 
layout.

PDF Options Select how you want to specify the width of the PDF document in 
this section.
Note: This section displays only when you select PDF format.

Set Page Width to Best 
Fit the Report

Select this radio button to automatically set the width of the PDF 
file to best fit the width of the report. This method will display the 
report in its original width, though the size of fonts may be 
reduced and the file may use landscape orientation to fit wide 
reports.

Use Printer Page Setup to 
Set Page Dimensions

Select this radio button to open the Page Setup window to manu-
ally select margins, paper size, and orientation for the PDF file. 
The Page Setup window is shown in Figure 58 on page 110. Refer 
to Table 29 on page 110 for information about this window.

Table 32: Export Options Window Description (Continued)

Field Description
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5 Click the OK button to save the exported report.

Scheduling reports
You can schedule reports to be sent by email to yourself, other staff members, email 
addresses, or distribution lists. You can also create a schedule to automatically publish a 
report. When you define a schedule, you can select the specific times when the report should 
be sent, including the time of day, the days of the week, the days of the month, and the 
months of the year. You can also create alerts to send the report any time that certain criteria 
in data exceptions are met.

Excel Options Select how you want to format date/time columns for the Excel 
file in this section.
Note: This section displays only when you select Excel format.

Convert All Dates into 
Excel Formatted Dates

Select this check box to convert all the date and time values shown 
in the report’s columns to Excel’s MM/DD/YYYY HH:MM AM/
PM date format. Selecting this option ensures the date columns in 
exported reports are consistent with Excel’s functionality. 

Delimiter Options Select the custom delimiter you want to use in this section.
Note: This section displays only when you select Delimited format 
with a custom delimiter.

Custom Delimiter Type the character you want to use as the custom delimiter in this 
field.

Note If you selected the Launch Application check box, the application on your work-
station that is associated with the specified type will open.

Table 32: Export Options Window Description (Continued)

Field Description

Note Scheduled reports are available only when the option is enabled. For informa-
tion about enabling scheduled reports, contact your RightNow account man-
ager.
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To schedule a report:
1 Right-click the report you want to schedule and select Edit.

When creating a schedule for a standard report, the Scheduling window will be shown on 
the left side of the content pane. The window displays information about any schedules 
for the report that have been created.

a To schedule a custom report, click the Home tab and then click the Scheduling button 
to open the Schedules window.

Figure 63: Schedules Window

2  Click Add Schedule. The New Schedule window opens.

Figure 64: New Schedule Window
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3 Type a name for the new schedule in the Name field. The name should clearly identify the 
purpose of the schedule.

4 Type the email addresses the scheduled report email should be sent to in the To field. Sep-
arate addresses with semicolons. 

Or

Click the To button to open the Select Recipients window where you can add staff mem-
bers, groups, and distribution lists to the schedule. Refer to Figure 30 on page 112 for 
information about this window.

5 Type a subject for the scheduled report email in the Subject field.

6 Type any text you want to include in the body of the scheduled report email in the Com-
ment field.

7 Select the format of the report from the Format drop-down menu:

• HTML Attachment (Images/Charts stored on the server)

• HTML Email (Images/Charts stored on server)

• HTML Email (Images/Charts sent in email)

• Excel Attachment (Images/Charts unavailable)

• Comma Delimited Attachment (Images/Charts unavailable)

• XML Attachment (Images/Charts unavailable)

• Image Attachment

• PDF Attachment

• Published

Note When creating a schedule to publish a report, the report that is created in the 
destination folder is given the name you specify in the Name field.

Note Specifying accounts or email addresses is not necessary when using the Pub-
lished format.
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8 To select the folder in the Reports explorer where you want published reports sent, click 
the Destination Folder drop-down menu and select the folder you want. This drop-down 
menu is available only when you select the Published format. For more information about 
published reports, refer to “Publishing reports” on page 114.

9 From the Run Report As drop-down menu, select the staff account which would be used 
were the report being run manually. This lets you specify which account should be used in 
reports that use the “logged in” filter value.

Since the time zone used in the report is dependent on the account that runs the report, 
this will also impact the times listed in the report. For example, if a staff member working 
in the Pacific time zone runs a report, the times shown in the report will be adjusted to use 
the Pacific time zone. Refer to the RightNow Administrator Manual for information about 
specifying time zones for staff accounts.

10 Click the schedule time next to the Recurrence field to open the Schedule Recurrence win-
dow. The underlined text displays the report’s current schedule. This is set to Every Day 
Every Hour by default.

Important The format you select for the report schedule determines if charts or images will 
be available when recipients view the report. If recipients need to see the 
report’s charts or images but do not have access to the server which stores the 
charts and images, we recommend that you set the schedule format to Image 
Attachment, PDF Attachment, or HTML Email (Images/Charts sent in email).



Scheduling reports 125

Figure 65: Schedule Recurrence Window

11 Enter field information described in Table 33.

Table 33: Schedule Recurrence Window Description

Field Description

Schedule Times Select the times of the day from this menu when the scheduled 
report should be sent. The available times include fifteen-minute 
intervals, so a report could be scheduled to send at 6:15 A.M. and 
4:45 P.M.

Every Hour Click this text to automatically select all the hourly check boxes.

Clear All Click this text to clear all selected schedule time check boxes.

Recurrence Pattern Select the weekly or monthly interval when the report should be 
sent. For example, a report could be sent every two weeks on Tues-
day, or every month on the 7th and 19th.

Clear All Click this text to clear all selected recurrence pattern check boxes.
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12 Click the OK button to save the recurrence settings and return to the New Schedule win-
dow.

Monthly Select this radio button to display check boxes for the days of the 
month. You can then select the days of the month when the report 
should be sent.

Weekly Select this radio button to display check boxes for each day of the 
week. You can then select the check boxes next to the days when 
you want the report to be sent.
When you select this radio button, a Recur drop-down menu will 
also display where you can specify the frequency of the weekly 
report. For example, if you want the report sent every week on the 
days selected, enter 1 in the field. If you want the report to be sent 
every third week on the days selected, enter 3 in the field. This field 
accepts values from 1 to 99.

Schedule Specific Months Click the Schedule Specific Months header to display check boxes 
for the months of the year. Select the months during which the 
scheduled report should be sent. By default, every month is 
selected, but if you do not want the report sent during a specific 
month, you can clear the check box for that month.

Clear All Click this text to clear all check boxes for the selected months.

Range of Recurrence Options in this section let you specify a date range during which 
the scheduled report will be sent.

Start Enter the start date of the schedule or click the Calendar button to 
open a calendar from which you can select the start date. The cur-
rent day is the default start date.

End Enter the end date of the schedule or click the Calendar button to 
open a calendar from which you can select the end date.

Table 33: Schedule Recurrence Window Description (Continued)

Field Description
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13 To specify search parameters for the scheduled report, click the underlined text next to Fil-
ter Values. This opens the Search window, shown in Figure 49 on page 90, where you can 
select the values for the report’s run-time filters to use when the scheduled report is auto-
matically generated. If you do not specify filter values, the report’s default values will be 
used.

14 Click the OK button to save the schedule.

Adding alerts to schedules
If a report includes data exceptions, you can create an alert to send an email when the data 
exception criteria is met. You can also specify how many times in a row the exception must be 
met before the alert is sent. The report’s data exception is checked at the times specified in the 
report’s Schedule Recurrence window, shown in Figure 65 on page 125.

For instance, a report’s data exception could be configured to trigger when ten incidents 
returned in the report meet the criteria you specify, such as the incidents’ response times not 
being met. You could then configure a schedule for the report to trigger once an hour every 
work day. Once the schedule is created, you could create an alert to be sent if the data excep-
tion is met twice in a row. This would result in the report’s data exception being automatically 
checked once every hour each work day, according to the times specified on the Schedule 
Recurrence window. If the report’s data exception is met a single time, the alert would not be 
sent. However, if the data exception was also met when it was next checked, the alert email 
would be automatically sent.

The Alerts section of the New Schedule window, shown in Figure 64 on page 122, displays 
email alerts and their attributes, and lets you create new alerts. Alerts will be disabled if the 
report does not include data exceptions, since alerts are based on data exceptions being met. 
Refer to “Creating data exceptions” on page 284 for procedures on adding data exceptions.

Note The Ordering feature will not be available when selecting filter options for 
scheduled reports.
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To add an alert to a schedule:
1 Open the New Schedule window, as described in “To schedule a report:” on page 122.

2 Type the email addresses to send the alert to, separated by semicolons.

Or

Click the To button to open the Select Names window, where you can add staff members, 
groups, and distribution lists to the alert. Refer to Figure 30 on page 112 for information 
about this window.

3 Click Add Alert to open the Add Alert window.

Figure 66: Add Alert Window

4 Enter field information described in Table 34.

Important A report schedule needs to be created in order to add an alert. If the report 
should be sent as a regular scheduled report and as an alert, you will add recipi-
ents to both the schedule’s To field and the alert’s To field. However, if the pur-
pose of the schedule is only to send an alert, do not add recipients in the 
schedule’s To field.

Table 34: Add Alert Window Description

Field Description

Name* Type a name for the alert.

Exception Click this drop-down menu to select the data exception that will be 
used to trigger the alert. The options that are listed in the menu are 
those that have been added to the report.

Rule Enter the number of consecutive times the data exception must be 
met before the alert will trigger.
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5 Click the OK button to save the alert.

Changing output options
When viewing a standard or custom report, you can change the report’s colors, fonts, and 
other display options, and you can adjust the sorting, filtering, slicing, and other formatting 
options of the records returned in the report. In addition, you can apply calculations and for-
matting to individual columns in the report. This section describes how you can change the 
report characteristics using these options.

Changing report displays with styles
Styles can be quickly applied to reports to change how the report text and background is dis-
played. The fonts, colors, backgrounds, spacing, padding, and borders for the different report 
areas can all be changed by applying a style. Refer to Figure 37 on page 70 to view common 
report areas that can be modified using styles.

You can use one of the predefined styles in RightNow, edit an existing style, or create your 
own style and save it to use immediately or for reports you view in the future. For procedures 
on editing and creating styles, refer to “Styles explorer” on page 27.

Styles you create or default styles can be easily applied to any report you view. The style you 
apply to the report will impact the report’s appearance when you print it, export it in certain 
formats, and forward it to others.

To apply a style to a report:
1 Right-click a report and select Open.

2 Click the Display tab.

3 Click the Auto Format button to open the Auto Format window.

Important Your profile must include the Customize Reports Analytics permission to 
change output options in reports.
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Figure 67: Auto Format Window

4 To prevent the style from being applied to other levels in the report, clear the Apply Style 
to All Report Levels check box.

5 Click the style you want to use.

The report will be updated to use the style you select.

Selecting record or tabular layouts
Reports can be displayed using a record or tabular layout. Most reports use tabular layouts 
with column headers across the top of the report and data listed in rows beneath the column 
headers. However, you can reformat the report to remove the column headers and instead 
display the field names inline with the field’s values from each record returned in the report. 
Changing the report’s display to use the record layout allows you to quickly do this without 
editing the report. Figure 68 shows the Incident Activity report displayed with the record lay-
out.

Note When a report total is included in a report with a record layout, the total is 
shifted to the left of the column that it totals.
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Figure 68: Example of Report with a Record Layout

To select a layout:
1 Click the Display tab and click the Data button.

2 To display the report with a record layout, select Display Data in a Record Layout.

3 To display the report with a tabular layout, select Display Data in a Tabular Layout.

Modifying report display options
Report styles let you change the display options for specific areas of a report, such as the title 
or data areas. However, if you want to change the margins, width, background, and borders of 
the entire report, or change how the report output is displayed, you can do so by changing the 
report’s display options. These are modified using buttons on the ribbon or by using the tabs 
on the Display Options window. The procedures in this section show you how to change dis-
play options on the Display Options window.

Changing page options settings
The Page Options tab on the Display Options window contains settings which control report 
width and the margins surrounding the report content.

Note For descriptions of ribbon buttons, refer to “Ribbon options when viewing 
reports” on page 78.
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To change page options:
1 Click the Page Setup tab and click the button to the right of the Display group name. The 

Display Options window opens with the Page Options tab selected.

Figure 69: Page Options Tab on the Display Options Window

2 Enter field information described in Table 35.

Table 35: Page Options Tab Description

Field Description

Report Width Define the width of the entire report using the available radio but-
tons.

Best Fit Select this radio button to display the report columns within the 
width of the window if possible. If data would be truncated, the 
width of the report will span beyond the open window and a scroll 
bar will be added to the bottom of the page, allowing you to view 
the entire width of the report.

Fit in Window Select this radio button to display the report columns within the 
width of the window. This can result in column names and data 
being truncated.

Specific Width Select this radio button to manually specify the report width in pix-
els, inches, or centimeters.

Margins Define the left, right, top, and bottom margins for the report.



Modifying report display options 133

3 Click the OK button to save the display options.

Changing data display options
Data display options control a number of features which give you more flexibility in deter-
mining how data in your report displays. For example, you can add or remove row numbers 
and add links to the report, which allow staff members with appropriate permissions to mod-
ify records returned in the report. You can also output report data in a record format.

To change data display options:
1 Click the Page Setup tab and click the button to the right of the Display group name. 

2 Click the Data Display Options tab.

Figure 70: Data Display Options Tab on the Display Options Window

3 To format the report in record layout, select the Display Columns in a Record Layout 
check box. Refer to “Selecting record or tabular layouts” on page 130.

4 To fix the report’s column headers at the top of the report so they are always visible when 
scrolling the report, select the Fix Column Headers check box.

5 To add row numbers to each row of the report, select the Display Row Numbers check 
box.

6 To display multiple calculations in the report on separate lines, select the Display Calcula-
tions on Separate Rows check box. If this check box is not selected and the report displays 
more than one calculation, the calculations will be displayed on the same line.
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7 To add a column to your report which displays actions you can take on records in the 
report, select the Display Links Column check box and select the commands you want to 
include in the column.

8 Click the OK button to save your display options.

Changing report backgrounds
Adding colors or images to a report’s background can make it more suitable for presentations 
or other formal purposes. You can add colors and images from the Background tab of the 
Display Options window.

To change a report’s background:
1 Click the Page Setup tab and click the button to the right of the Background group name. 

2 Click the Background tab.

Figure 71: Background Tab on the Display Options Window

Note If the rows do not refer to unique records, such as a specific incident or contact, 
the Display Links Column check box will be disabled.
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3 Enter field information described in Table 36. 

Table 36: Background Tab Description

Field Description

Fill This section lets you define the colors to be used for the report’s 
background.

Color/Top Color/Left 
Color

The text description for this option will vary depending on the 
Gradient Mode you select. Click this box to select a primary color 
as the background. For procedures on selecting a color, refer to 
“Choosing colors” on page 63.

No Fill Select this check box to clear any fill colors previously selected. If 
this box is selected, the other options on the Fill window will be 
disabled except Color. Selecting a color will automatically clear the 
No Fill check box, thus enabling the other options.

Gradient Mode Select the positioning of the primary and secondary colors for the 
background from the Gradient Mode drop-down menu. Using gra-
dient coloring lets you merge two colors.

None Select this option to use only the primary color as the fill color. If 
you select None, the Gradient Color field is disabled.

Top to Bottom Select this option to merge the colors from the top of the back-
ground to the bottom.

Left to Right Select this option to merge the colors from the left of the back-
ground to the right.

Gradient Color/Bottom 
Color/Right Color

The text description for this option will vary depending on the 
Gradient Mode you select. Click this box to select a secondary 
color to merge with the primary color. The fill colors will then 
merge using the method defined in the Gradient Mode menu. For 
procedures on selecting a color, refer to “Choosing colors” on 
page 63. 

Transparency(%) Select a percentage to define how intense the fill colors are. A set-
ting of 100% is completely transparent and prevents the fill colors 
from displaying. A setting of 0% has no transparency, resulting in 
intense background colors. The selected percentage is immediately 
reflected in the Preview field, so you can easily scroll through the 
transparency percentages to find a value that best suits your needs.
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4 Click the OK button to save the background.

Adding borders to a report
You can also add borders to a report from the Display Options window. Each border can 
have different colors, styles, and weights applied.

To add a border to a report:
1 Click the Page Setup tab and click the button to the right of the Display group name. 

2 Click the Borders tab.

Preview This area provides a sample of how the fill colors you select will 
appear on the report background.

Picture In addition to adding background colors for a report, you can add 
a background or watermark image to the report.

Select Image Click Select Image to select the image to use with the report. 
Images are added using the Images explorer. Refer to “Images 
explorer” on page 52 for procedures on adding images in the 
Images explorer.

Clear Image Click Clear Image to remove a previously selected image from the 
report.

Layout Click this drop-down menu to define the placement of the image 
on the background. Available options are None, Title, Center, and 
Stretch.

Table 36: Background Tab Description (Continued)

Field Description
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Figure 72: Borders Tab on the Display Options Window

3 Enter field information described in Table 37.

Table 37: Borders Tab Description

Field Description

Color Click this box to select a color for the border. For procedures on 
selecting a color, refer to “Choosing colors” on page 63.

Style Click this drop-down menu to select one of the following border 
styles: Solid, Dashed, Dotted, Inset, Outset, Double, Groove, 
Ridge, or Rounded.

Weight Click this drop-down menu to select the width of the border in pix-
els. You can choose between 1 and 10 pixels.

Preview This area defines the placement of the borders you define. Click 
any button to place a border or click the area in the Preview white 
space where you want the border.

 Top Border
Click this button to add the selected border attributes to the top 
border of the report area.

 Bottom Border
Click this button to add the selected border attributes to the bot-
tom border of the report area.

 Left Border
Click this button to add the selected border attributes to the left 
border of the report area.
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4 Click the OK button to save the borders.

Showing and hiding report sections
Reports can display a large amount of information in a number of report sections. For exam-
ple, a report’s data area contains the tabular data returned by the report. Other report sections 
include docked filters, headers, descriptions, charts, footers, and data exceptions. However, 
there may be times when you do not want to display all sections in a report. RightNow lets 
you choose what sections you see in a report.

To show or hide report sections:
1 Click the Display tab.

2 To remove a section from the report, clear its check box in the Sections tab group. The 
available check boxes are Docked Filters, Charts, Exceptions, Report Header, and Report 
Footer.

3 To add a section to the report, select the check box next to the section name.

4 To remove the data section from the report, click the Data button and select Do Not Dis-
play Data.

 Right Border
Click this button to add the selected border attributes to the right 
border of the report area.

 All Borders
Click this button to add the selected border attributes to all sides of 
the report area.

 No Borders
Click this button to remove the borders from all sides of the report 
area.

Table 37: Borders Tab Description (Continued)

Field Description

Note If a section is disabled, it cannot be added to the report since it was not included 
when the report was created.
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Showing and hiding data exceptions
When you run a report that includes multiple data exceptions, you may not want to always 
display every exception in the report. You can hide any exception included in a report or 
show hidden exceptions from the Exception Visibility window.

To show and hide data exceptions:
1 Click the Display tab and then click the Exceptions button.

Figure 73: Exception Visibility Window

2 To hide an exception, clear the check box next to the exception.

3 To display a hidden exception, select the check box next to the exception.

4 Click the OK button to apply the exception visibility to the report.

Modifying report magnification
To better view report data, you can easily zoom in and out of reports. You can select from 
magnification levels ranging from 10 percent to 200 percent to shrink or expand the report. 
You can alter a report’s zoom level using the slider on the bottom right of the content pane 
shown in Figure 74. The slider is always displayed on the content pane, but is enabled only 
when a report is shown.



140 Report Management

Chapter 3

Figure 74: Magnification Slider on the Content Pane

To change report magnification:
Drag the slider to the left or right to decrease or increase magnification.

Or

Click the plus or minus sign on either end of the slider.

The current magnification level is shown to the left of the slider.

Changing data options
You can change the way data is shown in your report to present it more clearly. For example, 
you can sort the data differently, hide certain columns in the report, add page breaks to the 
report, or filter the data to display only a subset of the records the report returns. The other 
available features are slicing, cross tabs, and rollups.

Selecting columns to display
You can quickly hide columns in your report to simplify a report’s output without editing the 
original report. You can then show the hidden columns when you want to view them again.

You can show and hide columns using the Field Chooser or you can select from options avail-
able when right-clicking a column in the report.

Magnification slider
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To show or hide fields with the Field Chooser:
1 Click the Display tab and then click the Field Chooser button.

Figure 75: Field Chooser Window

2 To hide a column in a report, drag the field from the Show Fields in this Order section to 
the Available Fields section, or select the field to hide and click the left arrow.

3 To display a column that is currently hidden, drag the field from the Available Fields sec-
tion to the Show Fields in this Order section, or select the field to display and click the 
right arrow.

4 Click the OK button to save your changes.

To show and hide columns using the right-click menu:
1 To hide a column, right-click the column you want to hide and select Hide Column.

2 To show a hidden column, right-click a visible column, select Insert Hidden Column, and 
select the column you want shown in the report. The column will be displayed in the 
report in the column’s last location.

Changing sort options
A report’s default sort options are determined by the report’s parameters and output. After 
generating a report, you can change your sort options to sort by any column in the report. 
You can sort columns from the report’s Data tab or, if your report is shown using the report 
view, by clicking column headers.
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To change sort order from the ribbon:
1 Click the Home tab and click the Sort button to open the Sort window. This button is also 

on the Design tab, which is available when using the layout view.

Figure 76: Sort Window

2 Select the primary field you want to sort by from the Sort Items By drop-down menu.

3 To sort by the selected field in ascending order, select the Ascending radio button. To sort 
in descending order, select the Descending radio button. For example, to sort a report’s 
output by date created, with the newest dates at the top of the list, you would sort the out-
put in descending order.

4 To sort menu fields by the sequence of the field’s entries, select the Sort by Sequence check 
box.

By default, when sorting information in a report using a menu field, the information is 
sorted by the menu field’s entries in alphabetic order. For example, sorting a report by the 
Incidents Severity field with entries of Severe, Mid-Range, and Unimportant in ascending 
order will list records with Mid-Range, then Severe, and then Unimportant severities.

Important This option is available only when editing a custom report.
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However, when editing a custom report and defining the report’s default sort order, you 
can select the Sort by Menu Sequence check box to sort by the order or the menu field’s 
entries. Thus, sorting the Severity field by sequence in ascending order would result in 
records with Severe, then Mid-Range, and then Unimportant severities. In this example, 
this sort order would likely be more helpful for those using the report.

5 To sort on additional fields, select the fields to sort on from the Then By drop-down 
menus.

When you define multiple sort fields, the records are initially sorted by the first sort field. 
If any of the records have the same value for the first sort field, those records will then be 
sorted by the subsequent sort fields.

6 To remove all sort options, click the Clear All button.

7 Click the OK button to view the report with the defined sort order.

To change sort order by clicking column headers:
1 Click the Views button on the Display tab and verify that your report is shown using the 

report view.

2 Click the header of the column you want to sort by. The report will be sorted by the col-
umn you selected in ascending order, and an arrow will display on the column’s header.

3 To change the direction of the sort, click the arrow in the column’s header.

4 To add additional levels of sorting to the report, press Shift and click the headers of the 
columns in the order in which they should be added to the sort. The report will be sorted 
by the selected columns in ascending order, and arrows will be displayed on the sort col-
umns’ headers.

5 To change a column’s sort direction when sorting by multiple columns, press Shift and 
click the column’s header.

Using Auto Filter
The Auto Filter function provides filtering on each column in the report. This provides easy 
access to filtering on any field included in the report. When this feature is enabled, a down 
arrow appears in the specified column headings of a generated report. By clicking the down 
arrow, you can filter the report by a value in that column.

For example, in a column that displays incidents’ associated products, you could click the 
down arrow to select a certain product. Only incidents associated with that product would 
display in the report. 
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To enable auto filters:
1 Click the Home tab.

2 Click the Auto Filter button to display arrows next to each column in the report as shown 
in Figure 77 on page 144. The Auto Filter button acts as a toggle. Click the Auto Filter 
button again to turn off auto filtering.

3 To filter on a column, click the down arrow located in the column’s header to open the 
drop-down menu for the column. A sample menu is shown in Figure 77.

Figure 77: Auto Filter Sample Report

4 To show only those records that have a specific value for the column, select the value to 
filter on. Any records that do not have this value will be removed from the report output.

5 To remove any filtering on values in the selected column, select All.

Note When data is filtered by a value in a particular column, the down arrow in that 
column’s header will change from blue to red to show that filtering is active.
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6 To show only those records with values at the top or bottom ranges of the selected field’s 
values, select Top 10. When you select this option, the Top 10 window opens.

Figure 78: Auto Filter Top 10 Window

a Select Top or Bottom to define whether the records with the highest or lowest field val-
ues will display.
The definition of what a high or low value in a field is depends on the type of field. For 
example, in date fields, the oldest dates are at the top and the newer dates are at the bot-
tom, whereas values in text fields are in descending alphabetical order.

b Select the number of records or the percentage of the total number of records returned 
in the report to include in the filtered data.

c Select whether the filtered data should include a specific number of items or a percent-
age of the total number of records.

d Click the OK button to save the Top 10 auto-filter settings.

7 To create a custom filter on the field, select Custom. The Custom Auto Filter window 
opens. Only records that match your custom filter will display in the report.

Figure 79: Custom Auto Filter Window

a Define the custom filter you want to use. 
The filter options will vary somewhat depending on the type of field that is being fil-
tered on. For example, date fields include calendar options, whereas text fields do not. 
However, every window will have a drop-down menu from which you can select the 
operator and an area to enter the filter value(s). Refer to “Specifying filters” on page 312 
for procedures on creating filters.

b Click the OK button to apply your custom filter to the report output.
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Adding page breaks
You can easily add page breaks to your reports to make them easier to use. If page breaks are 
added to a report, only the specified number of rows will display. A report with page breaks 
will include controls to navigate to other pages.

Page breaks can be added from the Search window or from the Display tab when viewing a 
report. This section describes adding page breaks from the Display tab. Refer to “Searching in 
reports and analyzing output” on page 90 for information about using the Search window.

To add page breaks to a report:
1 Click the Display tab.

2 Click the Page Report button and select the number of rows per page you want.

3 To remove paging from the report, click the Page Report button and select Remove Pag-
ing.

 

Figure 80: Example of Report with Paging

Note When page breaks are added to a report, the slicing, cross tab, and rollups 
options will be disabled.
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Once you select the number of rows you want, the report will display with a list of page num-
bers and arrows at the top of the page, as shown in Figure 80. Clicking |< or >| will take you 
to the first or last page of the report. Clicking < or > will take you to the preceding page or 
the next page of the report. If enough pages are present in the report, you will also see << 
and >> at the top of the report. Clicking these arrows will display the preceding or next set of 
page numbers in the report controls.

Slicing report data
Slicing a report allows you to group tabular data sharing common values in fields included in 
the report. You can then select from the slice tree or links and view only the report data that 
matches the selected field values. For example, in an incidents report, you could slice by the 
assigned staff member to display incidents assigned to that person. You could then further 
break down the incidents assigned to the staff member by other fields such as status.

An example of an incidents report sliced in this manner is shown in Figure 81. The slice 
options are displayed in a tree format.

Figure 81: Sliced Report Example–Slice Displayed as a Tree

Note When slicing and cross tabs are applied to a report at the same time, the cross 
tab is applied first, followed by slicing.
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Figure 82 shows a report sliced on assigned account with the slice options displayed as links.

Figure 82: Sliced Report Example–Slice Displayed as Links

To slice report data:

1 Click the Home tab and then click the Slice button.

2 Select Choose Columns to open the Slice window.

Tip You can easily hide the slice section in your report by clicking the section’s Auto-
Hide button or you can remove slicing from the report by clicking the Close 
button on the slice section’s header.

Tip When viewing a report using the layout view, you can select a column, click the 
Design tab, and click the Slice button to quickly slice the report by the selected 
column.
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Figure 83: Slice Window

3 Enter field information described in Table 38.

Table 38: Slice Window Description

Field Description

Slice By Select from the following options to define the slice by column val-
ues or buckets.

Column Values Select this radio button to define slicing by specific values in the 
fields included in the report. For example, if slicing on the inci-
dents’ Status Type field, you can slice on Unresolved, Waiting, or 
Solved.

Buckets Select this radio button to define slicing by groupings of values in 
the fields included in the report, such as Solved AND Waiting inci-
dents. When you select this option, the window will change to let 
you define the groupings. Refer to “Defining slice buckets” on 
page 151 for information about creating buckets.
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4 Click the OK button to save the settings and display the report with the defined slice 
groups.

5 To quickly remove slicing from your report, click the Slice button and select Reset.

6 To display the number of records in each slice group displayed as a tree, click the Slice but-
ton and select Display Group Counts. The number of records in each slice group will be 
shown next to the group names in the slice tree.

Display Slices Select from the following options to define how the slice groups 
selection appears in the report.

As a Tree Select this radio button to display slice groups in a tree that is 
docked to the report, as shown in Figure 81 on page 147.

Show Group Counts Select this check box when displaying slices as a tree to include the 
number of records in the slice group. The number will display next 
to each group name in the tree.

As Links Select this radio button to display the slice groups as links above 
the data, as shown in Figure 82 on page 148. This option is avail-
able only when a single report field is included in the slice.

Slice Items By Select the field(s) from the report to slice items by. If more than 
one field is selected, the first field will define the top slice group, 
and the subsequent fields selected will define sub-groups in the top 
group, as displayed in Figure 81 on page 147. If there are multiple 
slice fields defined, and the first is set to None, the other slice 
fields will also be cleared.

Ascending Select this radio button to sort the entries in the slice tree or links 
in ascending order.

Descending Select this radio button to sort the entries in the slice tree or links 
in descending order.

Clear All Click this button to reset all slice fields to None.

Table 38: Slice Window Description (Continued)

Field Description
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7 To quickly switch between displaying slice groups as a tree and as links, click the Slice but-
ton and select Display Slice Items>As a Tree or As Links.

Defining slice buckets
Slicing records by buckets allows you to define groupings of data to sort on that would not be 
allowed by slicing on specific values in a field. For example, slicing incident reports on the 
date created values may not be effective since the unique values in date/time fields cover a 
small span of time. Thus, slicing on such a field would result in very granular slices. However, 
defining a slice bucket on the date created field would allow you to slice the report output by 
incidents created during a date range, such as the past seven days.

To define a slice bucket:
1 Select the Buckets radio button in the Slice By section of the Slice window. The options on 

the Slice window will change, so you can create, edit, or delete buckets.

Figure 84: Defining Buckets

2 Select the field to slice on from the Slice Column drop-down menu.

3 Click Add Bucket to open the Slice Bucket window.

Note If you are slicing by more than one column and change the display from a tree to 
links, only the first slice column will be displayed.
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Figure 85: Slice Bucket Window

4 Enter field information described in Table 39.

5 Click the OK button to return to the main Slice window.

Displaying data using cross tabs
The Cross Tab feature lets you display data in a table to quickly summarize large amounts of 
data. A cross tab table lets you select the fields to define the table’s rows, columns, and output 
fields, essentially grouping the data by both the row and column output. The output fields are 
a culmination of the row and column data.

For example, if you had a report that returned the number of incidents solved by staff mem-
ber and product, you could designate the staff member column as a row field, product as a 
column field, and number of incidents as a data field. The output would be similar to the sam-
ple report displayed in Figure 86, which shows incident reference numbers categorized by 
assigned staff member and incident category.

Table 39: Slice Bucket Window Description

Field Description

Name* Type a name for the new bucket.

Operator Click this drop-down menu to select the operator to use. Operator 
options are the same as those available when defining filter values. 
Refer to “Specifying filters” on page 312 for information about 
defining filter values.

Value Select the values from this field to add to the bucket. The available 
values will change depending on the field selected. For example, 
some fields will display drop-down menus with various values to 
select, while other fields will display a calendar to select specific 
dates or date ranges.
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Figure 86: Sample Report Using Cross Tabs

Once you view your report data using the columns, rows, and output fields you define, you 
can select different fields to use as the columns, rows, and output fields. This lets you quickly 
restructure the report to view groupings of different data, such as the number of incidents 
each staff member has, grouped by category instead of product. Without using cross tabs, the 
only way to retrieve these different summaries of data would be to use separate reports.

To define cross tab reports:
1 Click the Display tab and then click the Cross Tab button.

2 Select Choose Columns to open the Cross Tab window.

Note When cross tabs and slicing are applied to a report at the same time, the cross 
tab is applied first, followed by slicing.
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Figure 87: Cross Tab Window

3 Enter field information described in Table 40.

Table 40: Cross Tab Window Description

Field Description

Available Columns This section lists the output fields included in the report available 
for cross tabs. Fields from this section can be dragged to the row, 
column, and output fields, or a field can be moved by selecting it 
and clicking the right arrow.

Row Fields Move fields to this section to define them as rows in the report.

Column Fields Move fields to this section to define them as columns in the report.

Output Fields Move fields to this section to define them as output fields in the 
report.

Display Output Fields The options in this section let you define where the headers for the 
output fields should be in relation to the column fields.

Above Column Fields Select this option to place the output field above the columns’ val-
ues.
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4 Click the OK button to save the changes and generate the report.

5 To remove cross tabs from your report, click the Cross Tab button and select Reset.

6 To perform cross tab calculations on the report, click the Cross Tab button and select Per-
form Cross-Tab Calculations.

7 To switch between displaying output fields above or below column fields, click the Cross 
Tab button and select Display Output Fields>On Top or On Bottom.

Displaying rollup levels
You can define rollup levels in a report to group data beneath headings in the report. You can 
add additional rollup levels to further break down the data under each heading by grouping 
data under sub-headings. Using rollups, you can group rows in a report that share the same 
value in the columns you select for the rollup levels. For example, you could add rollups to an 
incident report to group incidents by their assigned staff member, and then add an additional 
rollup level to group the staff members’ incidents by the incidents’ associated product. A sam-
ple report using these rollup levels is shown in Figure 88.

Below Column Fields Select this option to place the output field below the column val-
ues.

Perform Cross-Tab 
Calculations

Select this check box to perform cross tab calculations. An addi-
tional column will display for each cross tab calculation.

Clear All Click this button to clear all fields and reset the cross tab defini-
tion.

Table 40: Cross Tab Window Description (Continued)

Field Description
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Figure 88: Sample Rollups Report

To define rollups:
1 Click the Home tab and then click the Rollups button.

2 Select Choose Columns to open the Rollups window.

Tip When viewing a report using the layout view, you can select a column, click the 
Design tab, and click the Rollup button to quickly roll up the report by the 
selected column.
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Figure 89: Rollups Window

3 Enter field information described in Table 41.

Table 41: Rollups Window Description

Field Description

Rollup Items By Select output columns from the drop-down menus in this section 
to use as the primary rollup level. Once you select a column, you 
can select the sort order for the rollup column. Options include 
Do Not Sort, Sort Ascending, and Sort Descending.
You can add additional columns to the primary rollup level in this 
section by selecting the columns from the other drop-down menus. 
When multiple columns are used in a rollup level, the data dis-
played together under the same rollup heading will have the same 
values in all the columns selected for the rollup level.

Show Field in View Select this check box to display the rollup column you selected as a 
column in the report. If this check box is not selected, the column 
name will display in the rollup heading, but will not be included as 
a column in the report output.
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Then By Select output columns from the drop-down menus in this section 
to use as the secondary rollup level. Once you select a column, you 
can select the sort order for the rollup column. Options include 
Do Not Sort, Sort Ascending, and Sort Descending.
Secondary rollup levels break down the data in the primary rollup 
level according to the columns selected for the secondary level.
Once you define a secondary rollup level, an additional Then By 
field will display, allowing you to define a third rollup level to fur-
ther break down the data grouped under the secondary rollup level.
Note: If records grouped under the secondary rollup have null val-
ues for the rolled up field and if the rolled up column is formatted 
to display blanks for records with null values, the header for the 
secondary rollup level will not display.

Display Rollup Headings Select this check box to display the rollup headings and sub-head-
ings. If this check box is not selected, the headings will not display, 
though the report data will still be sorted as if the headings were 
present.

Display Rollup Headings 
Multi-Line

Select this check box to display each rollup column as a separate 
heading. If this check box is not selected, when using multiple col-
umns in the same rollup level, the columns for the rollup level will 
be displayed in the same heading.
Note: This check box is disabled if the Display Rollup Headers 
option is not selected.

Display Rollup Column 
Headings

Clear this check box to hide the name of the rolled up column on 
rollup group headings. By default, the name of the column you roll 
up is displayed for each rollup group. For example, Figure 88 on 
page 156 shows groups rolled up by the Assigned Account column, 
with the name of the column displaying on each rollup heading. 
The Assigned Account text would not display on the headings if you 
disabled the Display Rollup Column Headings option.

Repeat Column Headings 
for Each Rollup

Select this check box to show the output column headers before 
each rollup heading and sub-heading. If this option is not selected, 
the column headers will display only at the top of the report.

Display Group Counts Select this check box to display the number of items under each 
rollup heading and sub-heading.

Table 41: Rollups Window Description (Continued)

Field Description
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4 To remove the rollups you have selected on the Rollups window, click the Clear All button.

5 Click the OK button to generate the report using the rollups settings.

6 To remove rollups from your report, click the Rollups button and select Reset.

7 To display the number of records in each rollup, click the Rollups button and select Dis-
play Group Counts.

8 To show or hide headings for each rollup group, click the Rollups button and select Dis-
play Rollup Headings to enable or disable the option.

9 To show or hide the name of the rolled up column in the heading for each rollup group, 
click the Rollups button and select Display Column Headings to enable or disable the 
option.

10 To show or hide repeating column headers, click the Rollups button and select Repeat Col-
umn Headings to enable or disable the option.

When viewing a report with rollup headings, you can click the minus or plus button next to 
each heading to collapse or expand the headings to hide or display the rows under the head-
ings. An example is shown in Figure 88 on page 156 where the first heading in the report is 
collapsed.

Editing output columns
In addition to applying formatting to an entire report, you can apply formatting to individual 
columns to change the alignment and fonts of data and column headers, and to change the 
column width when viewing the report using the layout view. You can also add calculations to 
individual columns. For example, if you want a total of the values shown in a currency col-
umn, you can add a calculation to display the total at the bottom of the column. You can also 
move columns in a report if you want them displayed in a different order.

For information about moving columns, changing column format options, and adding col-
umn calculations, refer to “Editing columns” on page 262.

Saving and resetting report display settings
Once you edit a column or make changes to a report’s output options, you can use the Save as 
Default and Restore options on the Home tab’s Default Settings button to preserve the 
changes or to clear any changes you have made.
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Saving display and data settings
When you change display and data settings or column formatting to modify a report’s appear-
ance, those changes will be lost when you close the report. When you next view the report, it 
will open using the defaults defined when the report was created. However, using the Save as 
Default feature, you can save changes to these settings to your workstation so the report will 
open using the display and data settings you previously defined.

If you save default settings for a report and the report’s default settings are later changed, your 
saved settings will be removed. Saved settings are user specific, so you must log in as the same 
staff account to have your saved settings applied to the report.

For more information about personal and local settings, refer to the RightNow User Manual.

To save display and data settings for a report:
1 Open a report and change display and data settings.

2 Click the Home tab.

3 Click the Default Settings button and select Save as Default.

Resetting display and data settings
You can remove a report’s display and data settings that are stored on your workstation. Once 
you do so, these settings will return to the defaults defined in the report.

To reset display and data settings:
1 Open a report which has display and data settings stored on your workstation.

2 Click the Home tab.

3 Click the Default Settings button and select Restore. A warning message will display asking 
if you are certain you want to restore the default settings.

4 Click the Yes button to delete your personalized report settings from your workstation.
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Editing data inline
When a report displays unique records, such as incidents or opportunities, the Inline Editing 
feature lets you edit the values in columns shown on the report without opening the records. 
Individual values can be edited directly from the report, or you can edit values in multiple 
records. For example, if a report shows the staff member an incident is assigned to, you can 
change the assigned staff member from the report without opening the record, or you can 
reassign several incidents shown on the report to a selected staff member.

When you edit data inline on a report, the changes you have made need to be saved to the 
server. If this is not done, the information stored in the server’s database will not be updated. 
You can either manually save the changes or use the Auto Save feature to automatically save 
each change after it is made.

This section describes editing data inline on reports and updating the database with the 
changes you make on your workstation.

Editing individual values inline
When editing options are enabled in a report, the data shown on the report can be edited by 
selecting individual values directly on the report. Editing options vary depending on the type 
of field being edited. For example, a text field will present a text box and a menu field will 
present a drop-down menu.

An example of a menu field being edited inline on a report is shown in Figure 90.

Important In order for staff members to edit records using inline editing, their profile must 
include permission to edit records inline and permission to edit the type of 
records returned in the report. In addition, inline editing must be enabled for the 
report, and the report must display data that can be edited. Refer to “Enabling 
inline editing” on page 351 for information about enabling inline editing and the 
RightNow Administrator Manual for information about editing profiles.

Note If a required custom field is selected for inline editing, the field will require a 
value before the record can be saved.
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Figure 90: Editing a Report Inline

To edit an individual value inline:
1 Click the row that you want to edit.

2 Click the field that you want to change. Editing options specific to the field’s data type will 
be displayed.

3 Enter the new value.

4 To apply the edit, press Enter or click outside the field you are editing. Changes to some 
field types are applied automatically when you enter the value.

5 To cancel the edit, press Esc.

6 Save the change to the server if this is not done by default when changes are made to a 
record with inline editing. Refer to “Saving changes to the server” on page 164.

Editing values in multiple rows
If your report includes numerous rows with the same value that you want to edit, you can 
select the rows and change the value using the Edit Selection feature. You can also use slicing 
to group the records by the field you want to edit, and then drag the records you want to 
change to the correct slice group.

Tip You can see which fields can be edited inline by mousing over the fields on the 
selected row. Fields that can be edited will be highlighted in blue.
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To edit values using Edit Selection:
1 Press Ctrl while selecting each record.

2 Click the Home tab.

3 Click the Edit Selection button. A menu displays the fields that can be edited in the rows, 
as shown in Figure 91.

Figure 91: Opening the Edit Selection Menu

4 Select the field that you want to edit. Editing options specific to the field’s data type will be 
displayed. The editing options when changing an incident’s status field is shown in Figure 
92.

Figure 92: Changing an Incident’s Status Using Inline Editing

5 Enter the value you want the selected records to have.

6 Click the OK button to apply the change to the selected records.

7 Save the change to the server. Refer to “Saving changes to the server” on page 164.
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To edit multiple values using slicing:
1 Slice the report to group the records by the field you want to edit, displaying the slices as a 

tree rather than links.

For example, if you want to reassign several incidents to a different staff account, slice the 
report by the report’s Assigned Account column. Refer to “Slicing report data” on page 
147 for information about slicing.

2 Select the folder in the slice tree that contains the records you want to edit.

3 Press Ctrl while selecting each record you want to edit.

4 Drag the selected rows to the folder on the slice tree that shows the value you want. Once 
you drop the rows on the slice tree, the report will be updated to show the new values for 
the selected rows.

5 Save the change to the server. Refer to “Saving changes to the server” on page 164.

Saving changes to the server
When you edit data inline on reports, the changes need to be saved to the server. If the Auto 
Save feature is enabled, each change will be saved automatically. However, you can also dis-
able Auto Save if you want to make several changes and then save the changes to the server. 
Refer to “Enabling inline editing” on page 351 for information about enabling Auto Save.

To automatically save changes:
Click the Home tab and then click the Auto Save button. The button will be highlighted when 
Auto Save is enabled.

To manually save changes:
Click the Home tab and then click the Save button.

Tip When data has been edited on a report but the changes have not been saved to 
the server, a visual indicator will display on the report next to the edited value. 
Once the data is saved to the server, the visual indicator is removed.
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4
Creating Basic Reports

RightNow Analytics provides tools to create custom reports that include advanced features 
such as multiple output levels, linked reports, calculations, data exceptions, variables, com-
puted fields, and custom scripts. These reports can take time to plan or may require input 
from several people. However, you can quickly create reports that fulfill most of your report-
ing needs.

In this chapter

• Planning reports—Contains suggestions to help you plan reports before creating them. Refer to 
page 166.

• Creating reports—Contains the procedures to create a simple custom report, describing how to 
add columns, filters, and report levels. Refer to page 167.

Important This chapter provides an overview of planning and creating basic custom 
reports. For information about all the tools available to create and edit reports, 
refer to Chapter 5, “Custom Reports,” on page 175.
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Planning reports
No matter how simple or complex a custom report is, there are certain guidelines to follow to 
help you create the report you want. Since each custom report you create can output different 
data and include different components, you may want to design your report before you start 
to create it. This helps determine what steps you will need to create the report you want.

We recommend considering the following questions before you create your report.

• What audience will view or use the report? This determines which report layout you will 
use since some layouts include charts, titles, and other information, whereas other lay-
outs do not. Refer to “Applying report layouts” on page 216.

• What information do you want the report to return? This determines the fields to 
include in the report’s output. Refer to “Managing output columns” on page 236.

• What fields do you want to be able to search on when running the report, and what 
information should be excluded? This determines the report’s fixed and run-time 
selectable filters. Refer to “Specifying filters” on page 312.

• Do you want to be able to drill down on any fields to view additional information? This 
determines if multiple output levels or linked reports need to be configured. Refer to 
“Adding additional output levels” on page 328 and “Linking reports” on page 337.

• How do you want the information that is returned to be ordered? This determines the 
sorting options that will be used. Refer to “Changing sort options” on page 141.

• Who should have access to run or edit the report? This determines if the report should 
be made public and what permissions will be applied to the report. Refer to “Specifying 
permissions” on page 354.

Tip Before creating a report, we recommend reviewing the reports already on your 
site to see if any of them are similar to the report you want. If so, you can copy 
the existing report and then edit the copy to meet your reporting needs. For 
information about finding and copying reports, refer to Chapter 2, “Analytics 
Explorers,” on page 17. For information about viewing the contents of a report, 
refer to “Viewing report definitions” on page 72.
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Creating reports
Once you have an understanding of what your report should contain, you create it on the 
report design center. The following procedures describe how to create a sample report to 
demonstrate the basic steps that are required to create most reports. While the sample report 
might not be useful to your organization, knowing how to create a report such as this will 
help you create reports your organization needs.

In this sample report, you will be able to see the number of unresolved and updated incident 
in each incidents queue. You will also be able to drill down on the information in the first 
level to open a second output level to view details about the incidents in each queue.

Opening the report design center
Reports are created and edited using the report design center. The design center gives you 
access to all the tools you need to create our report or more complex reports. For detailed 
information about the design center, refer to “Opening the report design center” on page 
176.

To open the report design center:
1 Click the Analytics button on the navigation pane, double-click Reports Explorer, and 

then click New Report on the ribbon.

2 Select the type of report you want to build: a Grid report, Standard report, or Standard 
report with Chart. Since the sample report will primarily be used internally by staff mem-
bers to work with records, select Grid report.

Note The following procedures describe the steps to create a custom report in a spe-
cific order, but you can perform these steps in almost any order you want.

Tip You can also open the report design center by clicking the Application button, 
located at the upper left of the console, and then selecting Report.

Note Grid reports are most commonly used on the console to list records that 
staff members can open for editing. The other report types are generally used 
to present summaries of data inside or outside of your organization. If you 
decide you want a different report type after you start creating a report, you 
can change it from the Report Layouts button on the ribbon’s Home tab.
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After selecting the report type, the report design center opens where you create your 
report. The report design center is shown in Figure 93 and the main areas of the design 
center are indicated.

Figure 93: Viewing the Report Design Center

Adding columns
Now that the report design center is open, we will add two columns to the report’s first out-
put level, displaying incident queues and the number of incidents in each queue. For detailed 
information about adding output columns to reports and the types of columns you can add, 
refer to “Managing output columns” on page 236.

Data Dictionary

Design Surface

Ribbon
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To add output columns:
1 Expand the All Tables tree on the data dictionary and then select Incidents.

2 Select Queue (queue_id) on the right side of the data dictionary and drag it to the design 
surface. The field is added to the report as a column and is automatically named Queue, 
but you can right-click the column to change the name and customize other options.

3 On the data dictionary, scroll down to the Functions tree and expand it.

4 Select Aggregate Functions and then drag count(expr) onto the design surface. The Col-
umn Definition window opens where you select the field you want counted.

Figure 94: Adding a Count Column

We will edit the column’s expression to specify what records we want counted. In this 
example, we want to count the incidents in each queue.

5 To change the name of the column you are adding, type the name you want in the Heading 
field. For our example, you can type Number of Incidents.

6 On the left side of the window, expand Current Dataset and Incidents.

7 Scroll down to Incident ID (i_id) and drag it to the text between the parentheses on the 
right side of the window. We want to count this field since it is a unique identifier for inci-
dents; no two incidents share the same ID number.

8 Click the OK button to save the change and add the column to the report. The new col-
umn will automatically display a count of all incidents in each incident queue.

The first output level of the sample report now has two columns displaying incident queues 
and the number of incidents in each queue.
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Adding drill-down levels
Next, we will add a second level to the report that you can drill down into to view details 
about the incidents in the queues. For detailed information about adding output levels to 
reports, refer to “Adding additional output levels” on page 328.

To add another output level:
1 Click the Level tab on the ribbon and then click the Add Drilldown button. The Level Set-

tings window opens, displaying information about the new output level.

Figure 95: Configuring a New Output Level

You can type a different name for the new output level in the Name field, add notes about 
the level in the Description field, and change other options that are described in “Adding 
additional output levels” on page 328.

Tip If you already have a report that returns the information you want to see in the 
drill-down level, you can link the reports together instead of adding another out-
put level. Refer to “Linking reports” on page 337.
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As you review the options in the Drilldown Settings area of the window, notice that the 
drill-down filter is automatically set to incidents.queue_id. Thus, when you use the report and 
click a drill-down link on the first level of the report, the second output level knows to dis-
play only information related to the queue in the row you clicked. For more complex 
reports, the drill-down filter can be changed, but it is not necessary to do so here.

The link you click when using the report is also automatically set to incidents.queue_id. How-
ever, for our sample report, we will make the incident count column the link we click to 
drill down.

2 Click the Link drop-down menu and select count(incidents.i_id).

3 Click the OK button to save the new output level.

You can now drag fields from the data dictionary onto the design surface to add columns to 
the second level of the report. Since this output level is intended to display details about the 
incidents, you could add fields from the incidents table such as Reference #, Subject, 
Assigned Account, and Date Created. You can also add fields from the contacts table to view 
information about the contacts who submitted the incidents. Refer to “Adding columns to a 
report” on page 253.

Adding filters
Now that we have two output levels added to the report that display incident information, we 
will add a fixed filter to return only unresolved and updated incidents in the report. Fixed fil-
ters prevent reports from querying more information than you need in the report.

You could also add run-time selectable filters to the report to return only incidents created in 
a certain time period, assigned to particular accounts, or that match other criteria you specify. 
Unlike fixed filters, run-time selectable filters allow you to select the values you want when 
you run the report. For more information about filters, refer to “Specifying filters” on page 
312.

Tip If you want to change the output level you are editing, click the Level drop-down 
menu at the top of the design surface and select the level you want.
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To add a filter to the report:
1 Click the Home tab on the ribbon and then click the Add Filter button.

Figure 96: Adding a Report Filter

2 If you want to specify a name for the filter, type a name in the Name field. This name is 
used only on the report design center. If you do not specify a name, the filter’s database 
field will be used as the name.

3 Clear the Make this Filter Selectable at Run Time check box.

4 In the Definition section, right-click in the Expression field and select Incidents followed 
by Status (status_id). This is the database field we are using to filter the report’s output by.

5 Click the Operator drop-down menu and select in list.

6 By default, when you use this operator all items are selected. Clear the check box next to 
each item you do not want to include or clear the Select All check box and select the check 
box next to each item you want to include. For our example, select Unresolved and 
Updated. The report will include only incidents with one of these statuses.

Note If you were creating a run-time selectable filter, you would leave this check box 
selected and you could type a filter name in the Label this Filter field that you see 
when running the report. You can also select the Required check box for run-
time selectable filters if you want to force the report’s users to specify a filter 
value before they can run the report.
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7 Click OK to save the filter.

Saving reports
The final step in creating the report is to save it to a location where the audience you want can 
access it. Once you save the report, your staff members will be able to open it, assuming they 
have permission to open the report. For information about changing report permissions, 
refer to “Specifying permissions” on page 354.

To save the report:
1 Click the arrow next to the Save button on the Quick Access toolbar and select Save and 

Close. The Save As window opens where you specify the name of the report and where 
you want it saved. 

Figure 97: Saving a New Report

2 Select Public Reports or a custom sub-folder beneath Public Reports. Reports that are 
saved in the My Reports folder are accessible only by you.

a To create a custom sub-folder, right-click Public Reports, select New Folder, and type 
the name you want for the folder.

3 Type the name you want for the report in the Name field.

4 Click the OK button to save the report and close the report design center.

Your staff members can now access the report from the Reports explorer or you can add the 
report to their navigation sets. You can edit the report whenever you want to add additional 
columns, filters, or output levels. You can also add advanced functionality such as column cal-
culations, variables, inline editing, and other options. If you want to show the information in 
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the report to a wider audience, you can also change the report’s layout and add charts, text 
fields, and images. For information about these and other options, refer to Chapter 5, “Cus-
tom Reports,” on page 175.
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Custom Reports

Creating custom reports gives you the flexibility to output the information you need in the 
format you want. Custom reports can be simple, pulling data from one table and returning 
data from the same table, or they can be complex, pulling data from several tables, filtering it, 
and returning tabular and chart information in multiple output levels or linked reports.

When creating a custom report, you can select the database fields you want, add calculations 
and functions to the fields, and create fixed and run-time selectable filters to find the exact 
records you want. You can also add charts and text to your report, and specify the display and 
data options used when your report is opened. This ensures the information presented in 
your report is clear and easily accessible to your audience.

In this chapter

• Using the report design center—Describes the report design center. Refer to page 176.

• Report design center components—Describes the components used to create reports. Refer to 
page 181.

• Managing report sections—Contains procedures for adding report sections. Refer to page 215.
• Adding optional content to reports—Contains procedures for adding descriptions, images, and 

text fields to reports. Refer to page 226.

• Managing output columns—Contains procedures for adding output columns and data excep-
tions to reports. Refer to page 236.

• Managing table relationships—Contains procedures for modifying table relationships. Refer to 
page 291.

• Adding and editing charts—Contains procedures for adding charts. Refer to page 299.

• Specifying filters—Contains procedures for adding filters to reports. Refer to page 312.

Important This chapter describes creating and editing custom reports using RightNow 
Analytics. For information about creating and editing reports using Enterprise 
Analytics, refer to “Enterprise Analytics” on page 409. For step-by-step instruc-
tions for creating a basic custom report, refer to “Creating Basic Reports” on 
page 165.
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• Adding additional output levels—Contains procedures for adding multiple output levels to a 
report. Refer to page 328.

• Linking reports—Contains procedures for linking reports together. Refer to page 337.

• Configuring reports for editing records—Contains procedures for configuring record com-
mands available on reports and enabling inline editing. Refer to page 347.

• Selecting report options—Contains procedures for viewing the audit log, changing permissions, 
and customizing other report options. Refer to page 353.

Using the report design center
You create and edit custom reports from the report design center. All the tools you need to 
create a report are available from one location. You can also access optional items, such as 
chart styles and color schemes you have configured in the other Analytics explorers, from the 
report design center to enhance your reports. Refer to Chapter 2, “Analytics Explorers,” on 
page 17 for information about the Analytics explorers.

You can customize reports based on your organization’s needs using the report design cen-
ter’s ribbon, data dictionary, and design surface components. Figure 101 on page 182 shows 
the report design center and highlights its components.

This section describes how to open the report design center, select layouts for creating new 
reports, import reports from another RightNow interface, and select views to use to design or 
preview your report.

Opening the report design center
The report design center can be opened from several places. You can open it from the 
Reports explorer, from a report’s right-click menu, or from the Definition button on the rib-
bon’s Home tab when viewing a report. Once you open the report design center, you can 
increase the amount of space on the design surface by hiding the data dictionary or elements 
on the design surface. When you need an item that is hidden, you can easily display it again.

Note The navigation pane is collapsed in the screen shots in this chapter for clarity.
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To open and configure the report design center:
1 Open the Reports explorer.

2 To edit an existing custom report, right-click the report and select Edit. The report design 
center, shown in Figure 101 on page 182, opens.

3 To create a new report, click the New Report button. When creating a new report, a win-
dow, shown in Figure 98, opens where you select the report’s initial layout.

Figure 98: Selecting a Layout for a New Report

4 Click the name of the layout you want to use for the report. The options are Grid Report, 
Standard Report, and Standard Report with Chart. When you select a layout, the report 
design center will open with the selected layout. Refer to “Applying report layouts” on 
page 216 for information about report layouts.
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5 To create a copy of a report from another RightNow interface by importing a report defi-
nition, click Import Existing Report Definition. Refer to the next section for information 
about importing reports.

Importing report definitions
If you have multiple RightNow interfaces, you can use report definitions saved in XML files 
to create reports on other interfaces. This allows you to create duplicates of complex custom 
reports from other interfaces without manually re-creating the reports.

This section explains how to import report definitions from XML files created from another 
RightNow interface. For information about exporting report definitions, refer to “Exporting 
report definitions” on page 74.

To import a report definition:
1 Click the New Report button to select the report layout, as shown in Figure 98.

2 Click Import Existing Report Definition and select the XML file containing the report 
definition.

Figure 99: Selecting the Report Definition File
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3 Select the XML file you want and click the Open button.

The imported report will open on the report design center where you can modify it.

4 Save the new report.

Selecting a view
When you open the report design center, you can choose to use one of four views to look at 
your report. Each view presents your report in a different way and gives you access to differ-
ent tabs on the ribbon. The following describes the four views available to you when editing a 
report:

• Report View— This view shows you the report just as your staff members will see it 
when they open it. The report presents real data and thus is particularly useful when 
you want to preview a report you are editing. This view does not let you add column 
calculations, adjust column formatting options, or use action links. The options avail-
able when using this view are described in Chapter 3, “Report Management,” on page 
67.

• Layout View—This view is very similar to the report view and is also useful for pre-
viewing reports. However, unlike the report view, this view lets you select individual col-
umns in the report and apply formatting options to the columns. For example, if you 
want to add conditional formatting to a column to highlight data that meets certain cri-
teria in the column, you could select the layout view, select the column, and configure 
conditional formatting for the column. The options available when using this view are 
described in Chapter 3, “Report Management,” on page 67.

Note When you import a report definition to create a report, you will be shown any 
items from the imported report definition that do not correspond to existing 
fields in the database. You can edit the new report to modify or delete items that 
do not correspond to existing fields in the database.

Note When you select the report or layout view, a message appears if your report que-
ries too much data. You can save reports such as this, but we recommend that 
you add fixed filters or reduce the number of tables in the report to ensure that 
the report will run.
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• Design View—This is the default view when you open the report design center. This 
view gives you access to the tools you need to create and edit your report on the design 
surface, and you will generally use this view to initially create your reports. The options 
available when using this view are described in this chapter. A report shown using the 
design view is shown in Figure 101 on page 182.

• Data Set View—This view shows your report in a textual design space. You can add 
columns, filters, and variables using this view, just as you can when using the design 
view, but you cannot add graphic elements, such as charts, images, or text fields. The 
data set view is particularly helpful if you want to quickly view text descriptions of your 
report’s contents, and quickly access different report components to edit them. A 
report shown using the data set view is shown in Figure 100. The options available 
when using this view are described in this chapter.

Figure 100: Report Using the Data Set View
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To select views:
1 Edit a report. By default, the report opens in the design view.

2 Click the arrow on the Views button on the ribbon’s Home tab and select the view you 
want.

The report display will be updated to use the view you select.

Report design center components
The majority of the tasks you perform when creating or editing a custom report are done 
through the ribbon, design surface, and data dictionary components of the report design cen-
ter. These components provide access to the data, report sections, parameters, and other 
items you will use to create and edit custom reports. The ribbon, design surface, and data dic-
tionary are described in this section, along with the items you can add to your report using 
these components. Figure 101 shows the report design center’s main components and 
includes the grid, rulers, rule lines, field outlines, and section headers design tools you can 
enable from the ribbon’s Display tab.
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Figure 101: Report Design Center

Report design center ribbon
The report design center’s ribbon includes eight tabs from which you can access options to 
create or edit a report. The tabs on the ribbon change depending on which view you use and 
what is selected on the design surface. When editing a report using the design view, you can 
select the Home, Display, Insert, Level, and Page Setup tabs to add filters and report levels, 
insert charts, and modify the report’s display. The Design, Format, and Options tabs are dis-
played when you select objects on the report, giving you options to edit the selected object. 

Data
dictionary

Design
surface

Ribbon
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The data set view gives you similar options, though the Insert tab is not available. Fewer tabs 
are available when using the report and layout views. For descriptions of the tabs available in 
the report and layout views, refer to “Ribbon options when viewing reports” on page 78.

Each tab on the ribbon has one or more groups containing buttons you can use to modify the 
report or items on the report. Some groups have buttons to the right of their names that you 
can click to open a window. For example, the Page Setup tab, shown in Figure 102, has groups 
for Print, Background, and Display options, and you can click the Background group’s button 
to open the Display Options window.

Figure 102: Button Groups on the Page Setup Tab

Windows give you access to the same features you can access from the ribbon, though the 
windows group the options differently, and sometimes contain additional options not avail-
able from the ribbon.

The buttons available on the tabs that are unique to the report design center’s ribbon are 
explained in this section. Since the buttons on some tabs vary depending on what is selected 
on the design surface, the buttons you see when editing a report may be different from what 
is shown in this section.

Tip You can minimize the ribbon when editing a report by double-clicking the active 
tab. Click the tab to temporarily display the buttons on the tab or double-click 
the tab again to maximize the ribbon.

Important When explaining features that can be accessed from a window or the ribbon, we 
describe the feature using the window, but keep in mind that the ribbon’s but-
tons provide shortcuts to most of the same features available on windows.

Background group button
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Home tab
The report design center’s Home tab gives you access to options that impact the entire report. 
For example, you can select report layouts, view or export a definition of the report, schedule 
the report to be sent out in an email, adjust permissions, view an audit log, and enable inline 
editing for the report. You can also sort the data in the report or view it differently using rol-
lups or slicing. Buttons on the tab’s Data Set group give you access to the report’s tables, fil-
ters, variables, and columns. The Home tab is shown in Figure 103.

Figure 103: Home Tab

The groups and buttons on the Home tab are described in Table 42. 

Table 42: Home Tab Description

Group/Button Description

Views This button lets you choose whether to view the report using the 
report, layout, design, or data set view. Refer to “Selecting a view” 
on page 179 for descriptions of the views.

Layouts The buttons in this group let you select a style and layout for the 
report.

Report Layouts Click this button to load a predefined report layout. The available 
layouts are Grid Report, Standard Report, Chart, and Standard 
Report with Chart. When you select a layout, the report sections 
needed for the type of report you select are automatically dis-
played. Refer to “Applying report layouts” on page 216 for more 
information.

Tabular Click this button to edit the report in a tabular layout. This is the 
default layout used when creating a report. Refer to “Selecting 
record or tabular layouts” on page 130.

Record Click this button to edit the report in a record layout. Refer to 
“Selecting record or tabular layouts” on page 130.
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Properties The buttons in this group let you modify properties that apply to 
the entire report.

Options Click this button to select how the time zone used in the report will 
be determined, who the owner of the report is, set Auto Refresh 
and other options, and add notes to the report. Refer to “Changing 
report properties” on page 355.

Definition Click this button and select View to view the report definition, 
showing descriptions of the report’s tables, columns, filters, and 
other information describing the report’s structure. Refer to 
“Viewing report definitions” on page 72.
Click this button and select Export to export the definition to a file 
which you can import into another RightNow interface to copy the 
report. Refer to “Exporting report definitions” on page 74.

Records Click this button to select the record commands buttons to display 
on the report’s ribbon’s Home tab. Refer to “Customizing record 
commands” on page 347.

Scheduling Click this button to schedule the report to be sent to other individ-
uals. Refer to “Scheduling reports” on page 121.
Note: This button appears only when scheduled reports are 
enabled. For information about enabling scheduled reports, con-
tact your RightNow account manager.

Permissions Click this button to define which profiles should have access to run 
and edit the report. Refer to “Specifying permissions” on page 
354.

Audit Log Click this button to open the audit log for the report, which shows 
you when the report was created, edited, run, and published, and 
which staff members performed these actions.
For information about the audit log, refer to “Viewing the audit 
log” on page 353.

Table 42: Home Tab Description (Continued)

Group/Button Description
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Inline Editing Click this button to select options for inline editing, which allows 
staff members to edit data directly from a report. Refer to 
“Enabling inline editing” on page 351.
Note: This button does not display if the staff member’s profile 
lacks inline editing permission. Refer to the RightNow Administrator 
Manual for information about profile options.

Analyze The buttons in this group let you sort the data shown on the report 
and apply auto filtering, rollups, and slicing to the data.

Sort Click this button to open the Sort window and select which output 
columns to sort by and the sort method. Refer to “Changing sort 
options” on page 141.

Rollups Click this button to select rollup options and open the Rollups 
window. Refer to “Displaying rollup levels” on page 155.

Slice Click this button to slice the data in the report. Slicing lets you 
group tabular data that shares common values in fields included in 
the report. Refer to “Slicing report data” on page 147.

Data Dictionary Click this button to hide or display the data dictionary at the bot-
tom of the report design center. You can select fields from the 
database to use in the report from the data dictionary. Refer to 
“Data dictionary” on page 207 for more information.

Data Set The buttons in this group let you add or edit columns, tables, fil-
ters, variables, and edit comparison date offsets.

Tables Click this button to view the tables used in the report, change the 
joins used between the tables, add and delete tables from the 
report, and add join filters. Refer to “Managing table relationships” 
on page 291.

Filters Click this button to view, add, edit, or delete report filters. Refer to 
“Creating report filters” on page 313.

Variables Click this button to view, add, edit, or delete variables. Refer to 
“Variables” on page 238.

Add Filter Click this button to add a report filter. Refer to “Creating report 
filters” on page 313.

Table 42: Home Tab Description (Continued)

Group/Button Description
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Display tab
The Display tab on the report design center ribbon is similar to the Display tab available 
when viewing a report. Each gives you options to apply report styles, add report sections, 
page the report, fix column headers, and display data using cross tabs. The report design cen-
ter’s Display tab also includes a Show/Hide button group that lets you add rulers, lines, and 
headings to help you identify sections and fields shown on the design surface.

The report design center’s Display tab is shown in Figure 104.

Figure 104: Report Design Center Display Tab

Add Variable Click this button to add a variable to the report. Refer to “Vari-
ables” on page 238.

Comparison Click this button to add comparison date offsets for comparison 
columns. Refer to “Adding comparison columns to reports” on 
page 255.

Add Column Click this button to open the Column Definition window to add a 
column to the report. Refer to “Adding columns to a report” on 
page 253.
Note: You can also add columns by dragging them from the data 
dictionary onto the design surface.

Table 42: Home Tab Description (Continued)

Group/Button Description



188 Custom Reports

Chapter 5

For descriptions of the buttons on the tab’s Format, Sections, and Options button groups, 
refer to “Display tab” on page 83. The buttons on the Display tab’s Show/Hide group are 
described in Table 43. An example of the report design center with these options enabled is 
shown in Figure 101 on page 182. 

Insert tab
The Insert tab allows you to add columns, charts, and data exceptions to your report. You can 
also add standard text fields or custom text fields created from the Text Fields explorer (refer 
to “Text Fields explorer” on page 54) and images added in the Images explorer (refer to 
“Images explorer” on page 52). The Insert tab is shown in Figure 105.

Figure 105: Insert Tab

Table 43: Display Tab Show/Hide Group Description

Button Description

Show Rulers Click this button to display horizontal and vertical rulers when 
designing the report to provide a perspective on the report’s size.

Show Rule Lines Click this button to display horizontal lines separating the report 
sections displayed on the design surface.

Show Field Outlines Click this button to display borders around the fields you add to 
the report.

Show Section Headers Click this button to display a heading above each report section.

Show Grid Click this button to display a grid in the report’s header and footer 
sections to help you align items you add to the sections. You can 
also select the grid size you want to use.
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The groups and buttons on the Insert tab are described in Table 44.

Level tab
The report design center’s Level tab gives you access to options you can apply to report levels. 
You can also create reports with drill-down levels from this tab. If your report already has 
multiple output levels, you can select the level you want to edit from the Level drop-down 
menu located on the design surface.

You can apply level filters and group filters from this tab and add custom scripts to the report 
level you are viewing. You can also click the Edit button to add output descriptions to the 
report level. The Level tab is shown in Figure 106.

Figure 106: Level Tab

Table 44: Insert Tab Description

Group/Button Description

Column Click this button to open the Column Definition window to add a 
column to the report. Refer to “Adding columns to a report” on 
page 253.
Note: You can also add columns by dragging them from the data 
dictionary onto the design surface.

Text Click this button to insert a text field into a report section that 
accepts text fields. Refer to “Adding images and text fields to 
reports” on page 226.

Image Click this button to add an image to your report. Refer to “Adding 
images to report sections” on page 226.

Chart The buttons in this group let you select a chart to add to the Charts 
section of your report. You can select different chart types and 
subtypes. Refer to “Adding and editing charts” on page 299.

Exception Click this button to add data exceptions to the report. Refer to 
“Creating data exceptions” on page 284.
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The groups and buttons on the Level tab are described in Table 45.

Table 45: Level Tab Description

Group/Button Description

Current Level The buttons in this group let you edit the report level that is cur-
rently selected on the Level drop-down menu at the top of the 
design surface. You can also delete the selected level, or add cus-
tom scripts or drill-down levels to the level.

Edit Click this button to open the Level Settings window where you can 
configure all level options for the selected level. Refer to “Adding 
additional output levels” on page 328.

Delete Click this button to delete the selected level. This option is not 
available for the top level of a report.
Note: All columns and drill-down levels in the level will also be 
deleted when you remove the level.

Add Drilldown Click this button to add a drill-down level to the selected level. 
Refer to “Adding additional output levels” on page 328.

Custom Scripts Click this button to add a custom script to the selected level. Refer 
to “Adding custom scripts to output levels” on page 335.

Drilldown Settings The options in this group let you select the drill-down filter and 
link for the level. Refer to “Configuring recursive drill-down levels” 
on page 333.

Drilldown Filter Click this drop-down menu to select the output column or col-
umns to use as the filter for the new level. The drill-down filter 
determines the data set that will be displayed in the drill-down 
level.

Drilldown Link Click this drop-down menu to select the output column that will be 
clicked on to open the drill-down level. You can also select Entire 
Row to open the drill-down level by clicking anywhere on a row in 
the parent output level.

Open in Window Click this drop-down menu to specify how you want to open the 
drill-down output level. To replace the current output level, select 
None. To open the output level in a new window, select the loca-
tion on the screen where you want the window to open by default. 
You can choose Top, Bottom, Left, or Right.
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Page Setup tab
The options on the Page Setup tab allow you to configure default printing options for the 
report. You can also change the report’s background, margins, and width. This tab is also 
available when staff members view reports. Refer to “Page Setup tab” on page 85 for a 
description of the options on this tab.

Grouping The buttons in this group let you configure result grouping for the 
drill-down level.

Group Results Select this check box to group data on the selected level. Refer to 
“Result grouping” on page 328.

Change Group Order Click this button to change the order of the grouped output col-
umns. Refer to “Changing group ordering” on page 329.

Parameters The buttons in this group let you manage level and group filters, 
and add record limits to the selected level.

Level Filters Click this button to view, add, edit, or delete level filters. Refer to 
“Creating level filters” on page 315.

Group Filters Click this button to view, add, edit, or delete group filters. Refer to 
“Creating group filters” on page 316.

Add Level Filter Click this button to add a level filter. Refer to “Creating level fil-
ters” on page 315.

Add Group Filter Click this button to add a group filter. Refer to “Creating group fil-
ters” on page 316.

Record Limit Click this button to limit the number of records that can be 
returned on the selected level. Refer to “Limiting records 
returned” on page 290.

Table 45: Level Tab Description (Continued)

Group/Button Description
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Design tab
The report design center’s Design tab is available when you click a column, text field, excep-
tion, or chart. The Design tab also displays when you select a filter, variable, or table when 
using the data set view.

Different buttons are shown on the tab depending on the item you select. For example, when 
working with a column, buttons are available to add calculations, configure data rollups, and 
add comparison values. When working with text fields, you can change fonts, margins, and 
borders. The Design tab for a column is shown in Figure 107.

Figure 107: Design Tab

The groups and buttons on the Design tab are described in the following tables, with the 
options for columns, text fields, data exceptions, charts, tables, and filters or variables 
described in separate tables.

The groups and buttons available on the Design tab when editing a column are described in 
Table 46.

Note The Design tab is renamed to Text Field when a text field is selected.

Note The groups and buttons available on the Design tab vary depending on the type 
of object you select. In addition, when editing a column, the options on the tab 
will vary depending on the type of data the column returns.

Table 46: Design Tab Column Options Description

Group/Button Description

Edit Click this button to open the Column Definition window, from 
which you can edit the column’s definition. Refer to “Adding col-
umns to a report” on page 253.
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Arrange The buttons in this group let you hide, remove, and order the posi-
tion of the selected column.

Hide Click this button to hide the selected column.
Note: To show hidden columns, right-click the header for a visible 
column, select Insert Hidden Column, and select the column you 
want to show. The column will be displayed in the column’s default 
location.

Move Left/Move Right Click these buttons to move the selected column one column to 
the left or right.

Delete Click this button to remove the selected item from the report.

Insert Before/Insert 
After

Click these buttons to open the Column Definition window, from 
which you can create a new column inserted before or after the 
selected column.

Sort Click this button and select Sort Ascending or Sort Descending to 
sort the data in the report by the values in the selected column. 
Refer to “Changing sort options” on page 141.
Note: Columns with a text area data type cannot be sorted.

Calculations The buttons in this group let you add calculations to the selected 
column. You can hover over each button to view a description of 
the calculation. You can also choose to show multiple calculations 
on a single row or on separate rows. Refer to “Adding column cal-
culations” on page 281.

Calculation buttons Click the button for the calculation that you want to add to the 
selected column. 

Options Click this button and select Display Calculations on Single Row to 
show all the selected calculations on one row beneath the column. 
Select Display Calculations on Separate Rows to show each calcula-
tion on a separate row below the column.

Report Linking Click this button to add, edit, and remove links to other reports. 
You can add conditional or unconditional links to columns. Refer 
to “Linking reports” on page 337.

Table 46: Design Tab Column Options Description (Continued)

Group/Button Description
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Rollup The buttons in this group let you group the information in the 
report by the selected column. You can also change the ordering if 
your report has multiple rolled-up columns. Refer to “Displaying 
rollup levels” on page 155.

Rollup Click this button to roll up the report’s data by the selected col-
umn. Click the button again to remove the rollup.

Move Up If your report’s data is rolled up by more than one column, click 
this button to move the selected column up one rollup level. 

Move Down If your report’s data is rolled up by more than one column, click 
this button to move the selected column down one rollup level. 

Options Click this button to select rollup options. The available options are 
Display Group Counts, Display Rollup Headings, Display Column 
Headings, and Repeat Column Headings.

Insert Column Click this button in the Computed group to add a computed col-
umn to the report. The types of computed columns available 
depend on the values in the selected column. You can also add 
computed columns from the data dictionary. Refer to “Computed 
fields” on page 242 for information about computed columns.

Trend Options The buttons in this group let you edit trend options for the 
selected trend column. Refer to “Specifying trend value duration” 
on page 260.

Perform Forecast Select this check box to enable forecasting in the trend value col-
umn. 

Forecast Units Enter the number of time units that will be forecast forward. For 
example, if the trended column groups data by week, trending for-
ward three units will show data trended three weeks in the future.

Table 46: Design Tab Column Options Description (Continued)

Group/Button Description
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The groups and buttons available on the tab when editing a text field are described in Table 
47.

% Change The buttons in this group let you edit comparison percentage and 
trend percentage column options for the selected comparison per-
centage or trend percentage column. Refer to “Adding comparison 
percentage columns” on page 257 and “Adding trend percentage 
columns” on page 260.

Comparison Direction Click this button and select how the percentage value shown in the 
comparison or trend percentage column should be derived. The 
value can be derived from the difference between the value in the 
original column being compared/trended versus the value in the 
comparison or trend column. The value can also be derived from 
the difference between the value in the comparison or trend col-
umn versus the value in the original column being compared/
trended.

Show Icon Select this check box to display icons next to the percentage values 
returned in the column. The icons will indicate whether there is a 
positive change, negative change, or no change.

Icon Colors Click this button to change the colors used for the icons to indicate 
a positive change, negative change, or no change.

Table 47: Text Field Tab Options Description

Group/Button Description

Edit Click this button to open the Edit Text Field window, from which 
you can edit the selected text field. Refer to “To create a text field:” 
on page 55 for information about editing text fields.

Arrange The buttons in this group let you position the selected text field on 
the design surface.

Anchor Click this button to define an anchor style for the text field. 
Anchor styles determine how a text field moves in relation to the 
borders of the report section. Refer to “Defining anchor styles” on 
page 230 for information about defining anchor styles.

Table 46: Design Tab Column Options Description (Continued)

Group/Button Description
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The groups and buttons available on the Design tab when editing a data exception are 
described in Table 48.

Bring to Front/Send to 
Back

Click these buttons to place the selected item on top of or beneath 
overlapping items.

Size to Fit Click this button to automatically shrink or expand the element 
containing the text field to fit the selected item.
Note: Manually resizing the selected element disables this option.

Font The buttons in this group let you change the selected text field’s 
font style, size, and color. You can also select font attributes, such 
as bold and italic, and change the text’s alignment within the text 
field. In addition, you can add a background color for the text field.

Margin Click this button to select the width of the margins around the 
item. The available options are None, Narrow, Medium, Wide, and 
Custom. Selecting Custom lets you specify the number of pixels 
for the top, bottom, left, and right margins.

Border The buttons in this group let you add borders to the text field and 
change the borders’ display options. You can identify which bor-
ders you want and choose the borders’ color, size, and style.

Table 48: Design Tab Data Exception Options Description

Group/Button Description

Edit Click this button to open the Exception Editor, from which you 
can edit the selected data exception. Refer to “Creating data excep-
tions” on page 284.

Display Reference The drop-down menu in this group lets you select the field you 
want to highlight to indicate which rows meet the selected data 
exception.

Table 47: Text Field Tab Options Description (Continued)

Group/Button Description
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Arrange The buttons in this group let you add, remove, and position the 
selected data exception.

Add Click this button to open the Exception Editor window to add a 
new data exception. Refer to “Creating data exceptions” on page 
284 for information about the window.

Delete Click this button to remove the selected exception from the report.

Move Up/Move Down Click these buttons to move the selected exception up or down in 
the list of exceptions. Refer to “Ordering data exceptions” on page 
289 for information about exception order.

Insert Before/
Insert After

Click these buttons to open the Exception Editor window to add a 
new data exception before or after the selected exception. Refer to 
“Ordering data exceptions” on page 289 for information about 
exception order.

Tabular Display The options in this group let you configure the tabular display for 
the selected data exception. Refer to “Creating data exceptions” on 
page 284 for information about data exception options.

Show Notifications Click this button to show the selected exception at the bottom of 
the report’s tabular data.

Show Criteria Select this check box to display the exception criteria. For example, 
if the data exception marks opportunities that are still active, the 
criteria would display opportunities.status_id = Active.

% Meeting Criteria Select this check box to show the percentage of data in the report 
that meets the specified exception criteria. This will display at the 
bottom of the report in the Data Exceptions report section.

% Not Meeting Criteria Select this check box to show the percentage of data in the report 
that does not meet the specified exception criteria. This will display 
at the bottom of the report in the Data Exceptions report section.

Graphical Display The options in this group let you configure the graphical display 
for the selected data exception. Refer to “Creating data exceptions” 
on page 284 for information about data exception options.

Show Notifications Click this button to show the selected exception in charts shown 
on the same report output level as the data exception.

Table 48: Design Tab Data Exception Options Description (Continued)

Group/Button Description
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The groups and buttons available on the Design tab when editing a chart are described in 
Table 49.

Show Criteria Select this check box to display the exception criteria in the chart. 
For example, if the data exception marks opportunities that are still 
active, the criteria would display opportunities.status_id = Active.

% Meeting Criteria Select this check box to show the percentage of data that meets the 
specified exception criteria on the chart.

% Not Meeting Criteria Select this check box to show the percentage of data that does not 
meet the specified exception criteria on the chart.

Color Click this button to select a color to use for the indicator on the 
chart that shows the amount of data meeting the exception criteria.

Table 49: Design Tab Chart Options Description

Group/Button Description

Define Data Source Click this button to open the Chart Wizard where you can select 
data options for your chart. Refer to “Using the Chart Wizard” on 
page 303.

Arrange The buttons in this group let you position the selected chart on the 
design surface and remove it from the report.

Delete Click this button to remove the selected chart from the report.

Bring to Front/Send to 
Back

Click these buttons to place the selected chart on top of or beneath 
overlapping charts.

Type Click this button to change the type and subtype of the selected 
report. If the data options in the new chart type differ from those 
in the old chart type, the Chart Wizard will open, allowing you to 
select new data options. Refer to Table 87 on page 304 for descrip-
tions of the available chart types.

Chart Style Click this button to select a chart style for the selected chart. Refer 
to “Chart Styles explorer” on page 33 for information about chart 
styles.

Table 48: Design Tab Data Exception Options Description (Continued)

Group/Button Description
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The buttons available on the Design tab when editing a table from the data set view are 
described in Table 50.

Labels Click in the text fields in this group to type text for the chart’s title, 
category, and value labels.

3D Settings Click the buttons in this group to specify angle and depth settings 
for a three-dimensional chart. Refer to “Chart Styles explorer” on 
page 33 for information about 3D settings.
Note: The buttons in this group are active only if a three-dimen-
sional chart is selected.

Settings Click the buttons in this group to modify settings specific to charts 
that include bars, lines, or gauges. Refer to “Chart Styles explorer” 
on page 33 for information about settings specific to each chart 
type.
Note: The buttons in this group are active only if a chart with bar, 
line, or gauge properties is selected.

Colors Click the button in this group to select a color scheme for the 
chart. Refer to “Chart Styles explorer” on page 33 for information 
about applying color schemes to charts.

Table 50: Design Tab Table Options Description

Group/Button Description

Tables Click this button to open the Data Set window, where you can edit 
the tables used in the report. Refer to “Managing table relation-
ships” on page 291.

Outer Join Click this button to join the selected table with the parent table 
using an outer join. Refer to “How join types work” on page 292.

Inner Join Click this button to join the selected table with the parent table 
using an inner join. Refer to “How join types work” on page 292.

Join Condition Menu Select the fields used to link the selected table with the parent table 
from this drop-down menu.

Table 49: Design Tab Chart Options Description (Continued)

Group/Button Description
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The groups and buttons available on the Design tab when editing a filter or variable from the 
data set view are described in Table 51.

Table 51: Design Tab Filters and Variables Options Description

Group/Button Description

Edit The buttons in this group let you modify filter properties and the 
logical expression combining filters.

Edit Click this button to open the Edit Filter window, from which you 
can edit the filter’s properties. Refer to “Specifying filters” on page 
312.

Logical Expression Click this button to open the Edit Logical Expression window, 
where you can modify the logical expression combining the report 
filters, level filters, or group filters. The type of filter you select 
determines which logical expression you can edit. Refer to “Defin-
ing logical expressions” on page 319.

Arrange The buttons in this group let you add, remove, and order filters 
and variables.

Add Click this button to open the Add Filter or Add Variable window 
to add a new filter or variable. Refer to “Specifying filters” on page 
312 for information about adding filters, and “Creating variables” 
on page 238 for information about adding variables.
Note: The type of filter you select determines whether you add a 
report, level, or group filter.

Delete Click this button to remove the selected item from the report.

Move Up/Move Down Click these buttons to move the selected run-time selectable filter 
or variable up or down in the list of filters or variables on the data 
set view.
Note: Moving filters and variables can help you organize them for 
easier management when using the data set view. However, their 
positions do not change their placement on the Search window or 
the filters’ logical expression.

Insert Before/
Insert After

Click these buttons to open the Add Filter window to add a new 
filter or variable before or after the selected filter or variable.
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Layout tab
The report design center’s Layout tab is available when you click a chart. The buttons on this 
tab let you apply chart style options to individual charts in your report. This allows you to cre-
ate a custom look for a chart without creating or modifying a chart style. This tab is identical 
to the Layout tab on the Chart Styles designer. Refer to “Chart Styles explorer” on page 33 
for information about options available on this tab.

Format tab
The report design center’s Format tab is available when you click a column, data exception, or 
chart. This tab provides access to general display options, such as fonts, margins, borders, and 
width. Some buttons on the tab vary depending on the type of item you select. For example, 
when working with a column, you can apply conditional formatting to flag data in the column 
that meets certain criteria. The Format tab for a column is shown in Figure 108.

Filter/Variable Options The check boxes in this group let you modify options for the 
selected filter or variable.

Display in Docked Filters Select this check box to display the selected variable or run-time 
selectable filter on the docked filters section of the report. Refer to 
“Docking variables and run-time selectable filters” on page 322.

Display in Search Criteria Select this check box to include descriptions of the selected vari-
able or filter in the search criteria description. Refer to “Search cri-
teria descriptions” on page 233.

Run-Time Selectable Select this check box to make the selected filter available on the 
Search window when the report is run. Refer to “Creating report 
filters” on page 313.

Required Select this check box to make the selected run-time selectable filter 
required. Staff members must specify values for required filters 
when they run the report.

Table 51: Design Tab Filters and Variables Options Description (Continued)

Group/Button Description
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Figure 108: Format Tab

The groups and buttons on the Format tab are described in Table 52.

Table 52: Format Tab Description

Group/Button Description

Font The buttons in this group let you change the font style, size, and 
color. You can also select font attributes, such as bold and italic, 
and change the text’s alignment. In addition, you can also add a 
background color.
Note: This group does not display when editing a chart.

Margin Click this button to select the width of the margins around the 
selected column. The available options are None, Narrow, 
Medium, Wide, and Custom. Selecting Custom lets you specify the 
number of pixels for the top, bottom, left, and right margins.
Note: This button displays when editing a column.

Border The buttons in this group let you add borders to the column and 
change the borders’ display options. You can identify which bor-
ders you want and choose the borders’ color, size, and style.
Note: This group does not display when editing a chart.

Display The buttons in this group let you apply conditional formatting to 
the column, change the column’s width, freeze the column, and 
hide repeating values in the column. You can also select other dis-
play options for the column.
Note: This group displays when editing a column.

Conditional Formatting Click this button to apply conditional formatting to the column’s 
data. Refer to “Editing column format options” on page 264.
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Width Click this button to select a width for the column. Select Best Fit to 
automatically set the width based on the amount of space needed 
to display the column’s contents. Best Fit also takes into account 
the width needed by other columns in the report. Select Percentage 
to specify a percentage of the total report width for the column.

Freeze Column Click this button to fix the selected column in place so it does not 
move when you horizontally scroll the report. This can be helpful 
if you want to continue to view the first column in the report while 
scrolling the report to see the columns on the right of the report.
Note: When you fix a column, all columns to the left of the col-
umn will also be fixed. You will still be able to scroll the columns to 
the right of the fixed column.

Hide Repeating Click this button to hide consecutive repeating values in the col-
umn. For example, if the name of a staff member is shown in the 
column in five consecutive rows, you can hide repeating values to 
show the name in only the first column.
Note: You can also hide repeating values from the Column For-
mat window, described in “Editing column format options” on 
page 264. This window has an option to exclude hidden repeating 
values from consideration in column calculations and column 
auto-filter options. When you hide repeating values from the rib-
bon, they will be included in column calculations and auto-filtering.

Options Click this button to select display options for the column. Refer to 
“Editing column format options” on page 264 for descriptions of 
all options.

Number The options in this group let you display numeric values as a gauge, 
and select numeric formats. Refer to “Editing column format 
options” on page 264 for descriptions of these options.
Note: This group displays when selecting a column containing 
numeric values.

Date The options in this group let you select a date format for the col-
umn and view the format. Refer to “Editing column format 
options” on page 264 for descriptions of these options.
Note: This group displays when selecting a column containing 
date/time data.

Table 52: Format Tab Description (Continued)

Group/Button Description
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Options tab
The report design center’s Options tab is available when you click a report section, column, 
table, or other item. The tab displays options appropriate for the report item you have 
selected. The type of item you select is displayed above the Options tab. For example, Figure 
109 shows the tab after selecting a report section. In this example, you could edit the section’s 
margins, borders, fill colors, and layout options from the tab. Figure 109 shows the Options 
tab for a text field.

Figure 109: Options Tab

Image The options in this group let you configure the image used to indi-
cate columns that meet data exception criteria. These options are 
also available when creating data exceptions. Refer to “Creating 
data exceptions” on page 284.
Note: This group displays when editing a data exception.

Current Selection The options in this group let you select the area of the chart you 
want to edit and reset the style options.
Note: This group displays when editing a chart.

Area Menu Select the area of the chart you want to edit from this drop-down 
menu. You can also select the area by clicking it on the chart on the 
design surface.

Reset to Match Style Click this button to reset the display and formatting of the selected 
chart area to match the settings specified in the chart style applied 
to the chart.

Format The buttons in this group let you select border, background, and 
font characteristics for the selected chart area. These same options 
are available when creating chart styles. Refer to “Creating and 
editing chart styles” on page 35.
Note: This group displays when editing a chart.

Table 52: Format Tab Description (Continued)

Group/Button Description
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The groups and buttons on the Options tab are described in Table 53.

Table 53: Options Tab Description

Group/Button Description

Margin Click this button to select the width of the margins around the 
item. The available options are None, Narrow, Medium, Wide, and 
Custom. Selecting Custom lets you specify the number of pixels 
for the top, bottom, left, and right margins.

Border The buttons in this group let you add borders to the selected item 
and change the borders’ display options. You can identify which 
borders you want and choose the borders’ color, size, and style.

Fill The buttons in this group let you add a background color to the 
selected item. You can select the background color and add a gra-
dient color to blend into the primary color. You can also choose 
how intense the colors should be with the Transparency setting.

Layout The buttons in this group let you define how the content of the 
selected report section should be arranged and how the height of 
the section should be managed. Refer to “Editing section layout 
properties” on page 224.
Note: This group is not shown when a column is selected.

Manual Click this button to manually size the report section and manually 
position text fields and images you add to the section. When a sec-
tion is configured with manual layout, you control the placement 
of items on the section and the section’s height.

Automatic Click this button to automatically size the report section and auto-
matically position text fields and images you add to the section. 
When a section is configured with automatic layout, you do not 
need to specify the placement of items on the section or the sec-
tion’s height.

Layouts Click the down arrow on this button to select a layout for the chart 
section. Refer to “Adding charts with chart table layouts” on page 
302.
Note: This button is shown when a chart is selected on the report.

Auto Height If Automatic layout is selected, you can click this button to prevent 
the height of the section from being automatically set.
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Design surface
The design surface displays all of the sections you add to your report from the ribbon. Only 
report sections displayed on the design surface will be included in a report when it is run. 
Once you add a section to the design surface, you can add, edit, and remove content in the 
section or modify the display of the section itself. For example, you can drag database fields to 
the data area, insert charts into the Charts section, and edit the report’s title in the report 
header. Information about working on the design surface is included throughout this chapter.

When working on the report design center, you can add rulers, lines, and headings to help you 
identify sections and fields shown on the design surface. These options are accessed from the 
Show/Hide group on the ribbon’s Display tab. Figure 101 on page 182 shows the report 
design center with these options enabled.

Table Layout If Automatic layout is selected, you can click this button to config-
ure the layout of the table that underlies each report section. For 
example, you can specify that all columns in the table have the 
same width, giving any images or text fields in those columns the 
same amount of horizontal space. Refer to “To change a report 
section’s table layout options:” on page 224 for information about 
table layout.

Add Text Field Click this button to add a new text field to the report.
Note: This button is shown when a text field, image, or report sec-
tion is selected on the report.

Add Chart Click this button to add a new chart to the report.
Note: This button is shown when a chart is selected on the report.

Add Column Click this button to add a new output column to the report.
Note: This button is shown when a column is selected on the 
report.

Table 53: Options Tab Description (Continued)

Group/Button Description
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Data dictionary
The data dictionary is shown on the report design center when you use the design or data set 
views, and lists the available tables and fields from the database that can be used in custom 
reports. Functions, variables, and computed fields can also be selected from the data dictio-
nary. Any item listed in the data dictionary can be dragged to the Data Area section to add the 
field as an output column, dragged to Docked Filters to create a filter based off the field, or 
dragged to the Data Exceptions section to create an exception based on the field.

You can view detailed information about the tables and fields shown in the data dictionary 
and customize the data dictionary to show only the fields and tables you regularly use. You 
can also reposition the data dictionary if you want a different location for it.

Viewing table and field information
Before you add database fields to a report from the data dictionary, you may need to view 
information about the field’s contents. You can view brief descriptions of tables and fields in 
the data dictionary by hovering over their names, and you can view more detailed information 
by right-clicking tables or fields and selecting View Data Definition.

If you want to view the entire data dictionary that describes all the tables and fields in the 
RightNow database, you can right-click any table name and select View Full Data Dictionary. 
The data dictionary will open in a separate window. You can also open the full data dictionary 
from Common Configuration>Database Administration>Data Dictionary.

Customizing the data dictionary
The list of available tables and fields in the data dictionary can be customized to hide the 
tables and fields that you do not use in your reports. This is helpful if you use only certain 
tables and fields in your reports and want to simplify the data dictionary to make it easier to 
select the tables and fields you use.

To customize the data dictionary:
1 Click Customize at the top of the data dictionary, shown in Figure 101 on page 182, to 

open the Customize Data Dictionary window.
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Figure 110: Customizing the Data Dictionary

2 Expand the modules, tables, and fields that you want to see.

3 Clear the check boxes for those tables, fields, or RightNow modules, such as Feedback or 
Sales, that you do not want to see in the data dictionary. 

4 To group the database tables by the module they are most frequently used with, select the 
Show Modules check box.

5 Click the OK button to save your customizations to the data dictionary.

Moving the data dictionary
By default, the data dictionary is located at the bottom of the report design center, but you 
can reposition it on the content pane.

Note The procedure described in this section is the same as that used to move the 
report explorer on the dashboard design center. Refer to Chapter 6, “Dash-
boards,” on page 359 for information about the dashboard design center.
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To move the data dictionary:
1 Click the data dictionary’s title bar and drag it. When you drag the data dictionary, you will 

see positioning images appear. Hovering over the various images will highlight portions of 
the report design center, as shown in Figure 111.

Figure 111: Moving the Data Dictionary

2 Drop the data dictionary once the section where you want it is highlighted.

The design center will be updated to show the data dictionary in the new location.

Note Since the location of the data dictionary is stored to your personal settings, it will 
remain where you placed it until you move it again.
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Report elements
Every report consists of items added to the report and configured using the ribbon, design 
surface, and data dictionary. Reports can have one or more output levels that contain report 
sections, and each section can contain text fields, images, charts, and output columns. The 
data shown in charts and output columns in each output level is impacted by the filters, vari-
ables, and comparison date offsets you add to the report. Each of these elements is described 
in this section.

Output levels
Each custom report has at least one output level, and each output level contains one or more 
report sections and can have unique filters, variables, and comparison date offsets. If your 
report has drill-down levels, you will add a separate output level for each drill-down level. 
Refer to “Drilling down in reports” on page 75 for a description of the drill-down feature and 
“Adding additional output levels” on page 328 for information about output levels.

Report sections
Report sections store the content you add to the output level, such as docked filters, headers, 
footers, descriptions, charts, tabular data, and data exceptions. Some sections are designed to 
contain text fields, such as the report’s title, and others are designed to display non-tabular 
data, such as charts. The sections you should include in each output level are primarily deter-
mined by the report’s audience and the output level’s purpose. For example, a custom report 
that only you will use may not need a report header, report footer, or similar report sections 
that clarify the report’s purpose and make it more presentable. However, these report sections 
are useful if the report will be sent to other staff members. If a section is added to the design 
surface, but has no content, the section will not display when the report is run. For proce-
dures on adding and editing report sections, refer to “Managing report sections” on page 215.

Important The output level you are currently viewing on the design surface is shown in the 
Level drop-down menu at the top of the design surface. If your report has mul-
tiple output levels, you select the level you want to view from the drop-down 
menu.

Note When creating a report, you can select a layout to have the appropriate report 
sections automatically included in the report. Refer to “Applying report layouts” 
on page 216 for information about report layouts.
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The sections you can add to your output levels are described in Table 54, along with the type 
of contents each section can contain.

Table 54: Report Sections Description

Report Section Description

Docked Filters This section is used to display run-time selectable filters at the top 
of the report for easy changes to the report’s search parameters. 
Refer to “Docking variables and run-time selectable filters” on 
page 322 for more information.
Note: This section can be added or removed from the design sur-
face using the Docked Filters check box on the ribbon’s Display 
tab.

Page Header This report section is displayed only on printed reports. By default, 
this section contains the Current Date text field, which is a variable 
that outputs the date when the report is run.
Note: This section can be added or removed from the design sur-
face using the Page Header check box on the ribbon’s Page Setup 
tab. 

Report Header This section contains text fields that will display at the top of each 
page of the report. By default, this section contains the Title and 
Sub Title text fields.
Note: This section can be added or removed from the design sur-
face using the Report Header check box on the ribbon’s Display 
tab.

Output Descriptions This section contains text that you can modify to provide general 
information about the report. Output descriptions can display 
inline, as text on a separate tab, or by rolling over the columns in 
the report. Refer to “Output descriptions” on page 231.
Note: This section is shown on the design surface by selecting 
Display Descriptions Inline from the Output Descriptions button 
on the ribbon’s Display tab.

Search Criteria 
Descriptions

This section contains text explaining the filters that are added to 
the report. Search criteria descriptions can be displayed inline or as 
text on a separate tab in the report. Refer to “Search criteria 
descriptions” on page 233.
Note: This section is shown on the design surface by selecting 
Display Search Criteria Inline from the Search Criteria button on 
the ribbon’s Display tab.
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Charts This section contains charts that you insert into the report. Charts 
provide a graphic representation of data and are most useful for 
quickly comparing groups of data.
Note: This section can be added or removed from the design sur-
face using the Charts check box on the ribbon’s Display tab.

Data Area This section contains database fields you add to the report, which 
outputs tabular data. This report section is used in almost all 
reports, as it provides text with specific details about specific 
records or specific numbers summarizing groups of records.
Note: This section can be removed from the design surface by 
selecting Do Not Display Data from the Data button on the rib-
bon’s Display tab.

Report Footer The report footer is similar to the report header, though the text 
fields in the footer display on the bottom of each page of the 
report. By default, the report footer contains the Record Count 
text field. This is a variable which displays the number of records 
returned on the page.
Note: This section can be added or removed from the design sur-
face using the Report Footer check box on the ribbon’s Display 
tab.

Data Exceptions This section contains information summarizing the data excep-
tions that are indicated in the data area. Data exceptions are used 
to highlight specific information in the report that meets certain 
criteria you define.
Note: This section can be added or removed from the design sur-
face using the Exceptions check box on the ribbon’s Display tab.

Page Footer The page footer is similar to the page header section. The text 
fields added to this section display at the bottom of printed 
reports. By default, this section contains the page number text 
field. This is a variable which outputs the current page number and 
the total number of pages in the report.
Note: This section can be added or removed from the design sur-
face using the Page Footer check box on the ribbon’s Page Setup 
tab.

Table 54: Report Sections Description (Continued)

Report Section Description
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Text fields and images
You can add text fields and images to your report to enhance the report’s appearance and to 
clarify the report’s purpose. Refer to “Adding images and text fields to reports” on page 226 
for information about adding and modifying images and text fields.

Output columns
The output columns you add to the report levels’ data sections determine the information 
your staff members can see about the records returned in the report. There are different types 
of output columns, including database fields, functions, and computed fields. You can apply 
formatting to the columns in your report and also add calculations to tally data shown in each 
column. Columns can be added from the Column Definition window or by dragging fields 
from the data dictionary. Refer to “Managing output columns” on page 236.

Charts
Charts offer a graphical display of the data returned in your report. You can add multiple 
charts to the charts report section in each output level. Different types of charts are available 
so you can present the data in different ways, and you can modify the display for each chart, 
selecting different colors, fonts, scales, and other attributes. Refer to “Adding and editing 
charts” on page 299.

Data exceptions
Data exceptions let you highlight data displayed in charts and output columns that meet cer-
tain requirements. Each output level can have multiple exceptions to highlight data for differ-
ent reasons. For example, in an incidents report, you could display unresolved incidents in red 
text and overdue incidents in bold text. The exceptions’ criteria and percentage of data meet-
ing or not meeting the exceptions can be shown in the report level’s charts and exceptions 
report section. Refer to “Creating data exceptions” on page 284.

Search parameters
You can add search parameters to your report to define the data shown in the report’s col-
umns, charts, and exceptions. Search parameters include filters, variables, and comparison 
date offsets. These are shown on the report’s Search window when staff members run the 
report, allowing them to modify the data that is returned, or you can hide filters so their val-
ues cannot be changed by staff members.

Tip If you want to highlight data in a single column, you can often apply conditional 
formatting to the column instead of using data exceptions. Refer to “Editing 
column format options” on page 264.
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The types of parameters available on the Search window are described in Table 55.

Table 55: Search Parameters Description

Parameter Description

Filters Filters limit the data returned in your report by selecting a subset 
of information from the database. Different types of filters are 
available, and each serves a different purpose.

Report Filters Report filters limit the data accessible to any of the report’s output 
levels and can be fixed or run-time selectable. Fixed filters cannot 
be changed when the report is run, but run-time selectable filters 
can be changed by staff members. Run-time selectable filters can 
also be required if you want to force staff members to select filter 
values. Refer to “Creating report filters” on page 313.

Level Filters Level filters are similar to report filters and can be fixed or run-
time selectable. However, unlike report filters, level filters limit the 
data accessible at individual output levels rather than the entire 
report. Refer to “Creating level filters” on page 315.

Group Filters Group filters can be fixed or run-time selectable and are applied to 
data that is grouped to prevent information about certain groups 
from being returned. For example, a report that shows the number 
of unresolved incidents for each staff member could have a group 
filter to display information only for staff members with more than 
ten unresolved incidents. Refer to “Creating group filters” on page 
316.

Variables Variables can be used to return different data, or the same data in 
different formats, in one column. For example, you could create a 
single report that displays the number of incidents by staff mem-
ber, group, queue, or status. You select the information you want 
when you run the report. Refer to “Variables” on page 238.

Comparison Date Offset Staff members can select comparison date offsets when they run a 
report with comparison columns. Comparison columns are used to 
display related information from different time periods. For exam-
ple, comparison columns can be used to see how many opportuni-
ties were created in two different quarters. Refer to “Adding 
comparison columns to reports” on page 255.
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Managing report sections
Report sections are added to the design surface by using a layout or by selecting the sections 
on the ribbon. When a section is displayed on the design surface, you can resize the section 
and add content such as text fields, database fields, and charts. You can also change section 
colors, margins, and borders using the options on the ribbon, and adjust layout properties for 
certain sections. An example of a report’s design surface showing report sections included is 
shown in Figure 112.

Figure 112: Report Design Center Displaying the Design Surface
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Applying report layouts
You can apply one of RightNow’s predefined layouts to quickly modify the report’s display to 
make it appropriate for the report’s audience. For example, the Grid layout can be applied to 
operational reports that are used by staff members who work with incidents, contacts, or 
other records in RightNow. This layout is ideal for such reports since it does not include titles, 
headers, or other report sections that are not needed when working with records. If your 
report is to be emailed or printed, you could use the Standard Report layout, which includes 
titles, headers, and other report sections that help explain the report’s context and purpose. 
The other layouts available are Standard Report with Chart and Chart Report.

Layouts can be selected on the Getting Started window when creating reports, shown in Fig-
ure 98 on page 177, or from the report design center’s ribbon. Layouts selected from the Get-
ting Started window are applied to all the output levels added to the report, and layouts 
selected from the ribbon are applied to individual output levels. Refer to “Opening the report 
design center” on page 176 for more information about adding layouts from the Getting 
Started window. The following section describes how to apply a layout to individual output 
levels.

To apply a layout to an output level:
1 If your report includes more than one output level, select the output level the layout 

should be applied to from the Level drop-down menu at the top of the design surface.

2 Click the Home tab.

3 Click the Report Layouts button to open the report layouts menu.
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Figure 113: Selecting a Report Layout

4 Click one of the layouts to apply it to the current output level. The predefined layouts are 
described in Table 56.

Table 56: Report Layout Options

Layout Description

Grid Report Select this layout for an output level with the Docked Filters, Page 
Header, Data Area, and Page Footer report sections.

Standard Report Select this layout for an output level with the Docked Filters, Page 
Header, Report Header, Data Area, Report Footer, and Page 
Footer report sections.

Standard Report with 
Chart

Select this layout for an output level with the Docked Filters, Page 
Header, Report Header, Charts, Data Area, and Page Footer report 
sections.
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Manually adding sections to the design surface
While layouts will automatically add certain report sections to the design surface, you may 
want to customize the sections displayed once the layout is applied. Manually adding report 
sections to the design surface is simple using the ribbon. You can add different sections to 
each output level in a report. For example, the primary output level in your report might 
include a header and chart, and the other output levels in the report might include only the 
data area section.

To display and hide report sections on the design surface:
1 If your report includes more than one output level, select the level you want from the 

Level drop-down menu at the top of the design surface.

2 Click the Display tab on the ribbon.

3 Select the check box next to the section you want to display from the tab’s Section group. 
The design surface changes to include the report section you select.

4 To display the Page Header or Page Footer section when the report is printed, click the 
Page Setup tab and select the Page Header or Page Footer check box on the tab’s Print 
group.

5 To remove a report section from the design surface, clear the section’s check box on the 
ribbon. The design surface changes to remove the report section.

Chart Select this layout for an output level with the Page Header, Charts, 
and Page Footer report sections. This layout is not available on the 
Getting Started window.
Note: When a report output level includes a chart but not tabular 
data, you can add data for the chart directly from the Chart Wizard. 
Refer to “Using the Chart Wizard” on page 303.

Table 56: Report Layout Options (Continued)

Layout Description
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Resizing sections
When a report section is added to the design surface, it is displayed with a default size. You 
may want to resize a section to allow more room for images or text fields or to reduce the size 
of the section to allow more room for other sections.

To resize report sections:
1 Move your cursor over the section border that you want to move on the design surface. 

The cursor will change to display directional arrows when it is over a border.

2 Drag the border to the position you want.

Editing section styles
Sections that are included in a report can be customized, allowing you to further tailor your 
report to your audience. The available style options for each section will vary. You can change 
the fill colors and borders of all the sections, and you can also change the margins in the out-
put descriptions, search criteria descriptions, data area, and data exceptions sections.

Section styles can also be changed by applying report styles with the Auto Format feature. If 
the style selected using auto format is applied after you manually modify a section style, your 
edits to the section style will be overwritten. Editing a section style after an auto-format style 
is applied will overwrite the auto-format style. Refer to “Changing report displays with styles” 
on page 129 for more information about the Auto Format feature.

To edit section styles:
1 Right-click the section on the design surface that you want to edit and select Edit Style.

2 Click the Margins tab to modify the amount of space surrounding the contents in the sec-
tion.

Tip The procedures in this section describe editing section styles from the Edit Style 
window. However, you can also adjust style options by selecting the report sec-
tion and using the buttons on the ribbon’s Options tab.

Note The Edit Style window for some report sections includes an Options tab that 
allows you to set layout options. Refer to “Editing section layout properties” on 
page 224 for information.
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Figure 114: Margins Tab on the Edit Style Window

3 Enter field information described in Table 57.

4 Click the Fill tab to modify the background fill colors for the selected section. When edit-
ing styles for report sections that do not have margins, the Fill tab will be active when you 
edit the style.

Table 57: Margins Tab Description

Field Description

Left Select the number of pixels between the section contents and the 
left side of the section.

Right Select the number of pixels between the section contents and the 
right side of the section.

Top Select the number of pixels between the section contents and the 
top of the section.

Bottom Select the number of pixels between the section contents and the 
bottom of the section.

Spacing Select the number of pixels between the section contents.



Editing section styles 221

Figure 115: Fill Tab on the Edit Style Window

5 Enter field information described in Table 58.

Table 58: Fill Tab Description

Field Description

Color/Top Color/Left 
Color

The text description for this option will vary depending on the gra-
dient mode you select. Click this box to select a primary color as 
the background. For procedures on selecting a color, refer to 
“Choosing colors” on page 63.

No Fill Select this check box to clear any fill colors previously selected. If 
this box is selected, the other options on the Fill window will be 
disabled except Color. Selecting a color will automatically clear the 
No Fill check box, thus enabling the other options.

Gradient Mode Click this drop-down menu to select the positioning of the primary 
and secondary colors for the background. Using gradient coloring 
lets you merge two colors.

None Select this option to use only the primary color as the fill color. If 
you select None, the Gradient Color field is disabled.

Top to Bottom Select this option to merge the colors from the top of the back-
ground to the bottom.

Left to Right Select this option to merge the colors from the left of the back-
ground to the right.
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6 Click the Borders tab to modify the borders of a report section.

Figure 116: Borders Tab on the Edit Style Window

Gradient Color/Bottom 
Color/Right Color

The text description for this option will vary depending on the gra-
dient mode you select. Click this box to select a secondary color to 
merge with the primary color. The fill colors will then merge using 
the method defined in the Gradient Mode menu. For procedures 
on selecting a color, refer to “Choosing colors” on page 63.

Transparency(%) Select a percentage to define how intense the fill colors are. A set-
ting of 100% is completely transparent, which prevents the fill col-
ors from displaying. A setting of 0% has no transparency, resulting 
in intense background colors. The selected percentage is immedi-
ately reflected in the Preview field, so you can easily scroll through 
the transparency percentages to find a value that best suits your 
needs.

Preview This area provides a sample of how the fill colors you select will 
appear on the report background.

Table 58: Fill Tab Description (Continued)

Field Description
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7  Enter field information described in Table 59.

8  Click the OK button to save the section’s style changes.

Table 59: Borders Tab Description

Field Description

Color Click this box to select a color for the border. For procedures on 
selecting a color, refer to “Choosing colors” on page 63.

Style Click this drop-down menu to select one of the following border 
styles: Solid, Dashed, Dotted, Inset, Outset, Double, Groove, 
Ridge, Rounded, or Separator. The separator option lets you add 
empty space around the report section.

Weight Click this drop-down menu to select the pixel size of the border. 
You can choose a number between 1 and 10 pixels.

Preview This area defines the placement of the borders you define. Select 
any of the following buttons to place the borders, or click the area 
in the Preview white space where you want the border.

 Top Border
Click this button to add the selected border attributes to the top 
border of the report area.

 Bottom Border
Click this button to add the selected border attributes to the bot-
tom border of the report area.

 Left Border
Click this button to add the selected border attributes to the left 
border of the report area.

 Right Border
Click this button to add the selected border attributes to the right 
border of the report area.

 All Borders
Click this button to add the selected border attributes to all sides of 
the report area.

 No Borders
Click this button to remove the borders from all sides of the report 
area.
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Editing section layout properties
Section layout properties determine how the charts, images, and text fields you add will be 
positioned on the section. A manual layout lets you manually position items you add. If the 
section has an automatic layout, the item will be positioned automatically, and the section’s 
height will be adjusted to best fit the item. You can also set table layout options to change 
how the items in the section are sized. By default, report sections have manual layout enabled.

To enable automatic layout of a report section:
1 Add the report section you want to the report output level.

2 To add the report header or footer sections, click the Display tab and select the Report 
Header or Report Footer check box.

3 To add the page header or footer sections, click the Page Setup tab and select the Page 
Header or Page Footer check box.

4 Click the report section on the design surface to select it.

5 Click the Options tab and click the Automatic button.

6 To prevent the section’s height from being automatically adjusted to fit the items you add 
to the section, click the Auto Height button to disable it.

If a report section has an automatic layout, the charts, images, and text fields you add to it are 
arranged in an invisible table structure, with the items placed in rows and columns. You can 
adjust the sizing of the rows and columns to arrange the images and text fields exactly like you 
want them.

To change a report section’s table layout options:
1 Add images and text fields to the report section.

2 Click the report section on the design surface and then click the Options tab.

3 If the section has a manual layout, click the Automatic button to change to an automatic 
layout.

Tip When Auto Height is disabled, you can manually change the height of the sec-
tion by dragging the section’s horizontal borders up or down, just as you would 
if the section had a manual layout.
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4 Click the Table Layout button.

5 To give each column in the section’s table the same amount of width, select Size All Col-
umns Equally.

6 To give each row in the section’s table the same amount of height, select Size All Rows 
Equally.

7 To size each column to best show the column’s contents, select Auto Size All Columns.

8 To size each row to best show the row’s contents, select Auto Size All Rows.

9 To manually configure the table’s layout, select More Options. The Edit Table Layout 
Properties window opens.

Figure 117: Configuring a Report Section’s Table Layout

10 Enter field information described in Table 60.

Table 60: Edit Table Layout Properties Window Description

Field Description

Show Select the row column you want to configure and then click this 
drop-down menu to select whether you are configuring rows or 
columns.

Size Type Specify how the size of the report section is determined in this sec-
tion.

Absolute Select this radio button to specify a certain size for the selected row 
or column in pixels.
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11 Click the OK button to save your changes.

Adding optional content to reports
You can add optional content to make your reports more presentable, or to explain the pur-
pose or functionality of the report. You can add images and text fields to the report’s headers 
and footers, and you can add output and search criteria descriptions to describe the report’s 
purpose to your staff members.

Adding images and text fields to reports
When presenting a report, you may want the report to include images, such as a logo, to 
enhance the report’s appearance or to customize it for your audience. You may also want the 
report to include standard or custom text fields to help your audience fully understand the 
report’s purpose. When creating or editing a report, you can easily add images and text fields 
to certain report sections.

The images available for use in reports are loaded in the Images explorer. While there are a 
number of standard text fields available, you can also create custom text fields in the Text 
Fields explorer to add to reports. Refer to Chapter 2, “Analytics Explorers,” on page 17 for 
procedures on using the Images and Text Fields explorers.

Adding images to report sections
You can add images you have created in the Images explorer to the Page Header, Report 
Header, Report Footer, and Page Footer sections. Images can act as backgrounds or header 
images in these sections. Refer to “Images explorer” on page 52 for information about using 
the Images explorer.

Percentage Select this radio button to specify a certain percentage of the total 
available space in the section to allocate to the selected row or col-
umn.

Best Fit Select this radio button to have the size of the select row or col-
umn automatically adjusted to best fit the row’s or column’s con-
tents.

Table 60: Edit Table Layout Properties Window Description (Continued)

Field Description
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To add an image to a report section:
1 Click the Insert tab.

2 Click the Image button to open the list of images available in the Images explorer.

Figure 118: Example of Images List

3 Click the image you want to add. The images list will close.

4 Mouse over the report section where you want to add the image. The image name will dis-
play when the cursor is over a section that can accept an image.

5 Click to place the image in the report section you select.

6 To move an image you have added to a report section, drag the image to the position 
where you want to place it in the section.

7 To resize an image you have added to a report section, click the image to activate it, and 
then drag one of the handles displayed on the image’s borders. The image will be resized 
as you drag the handle.

Note To move an image from one report section to another, both sections must have 
Automatic layout enabled. Refer to “Editing section layout properties” on page 
224.
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Adding text fields to report sections
You can add standard text fields or custom text fields you have created in the Text Fields 
explorer to the Page Header, Report Header, Report Footer, and Page Footer report sections. 
Refer to “Text Fields explorer” on page 54 for information about creating and editing custom 
text fields in the Text Fields explorer.

To add a text field to a report:
1 Click the Insert tab and click the Text Field button to open the list of text fields, shown in 

Figure 119. The window displays standard text fields, such as “Title,” and custom text 
fields, such as “RightNow Technologies.” The text fields’ default fonts, colors, and other 
attributes are reflected in the display.

Figure 119: Text Fields List

2 Click the text field you want to add to the report. The text fields list will close, and the cur-
sor displays with a small version of the text field when you hover over report sections that 
accept text fields.

3 Click the report section where you want to add the text field. The text field will be added 
to your report, as shown in Figure 120.
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Figure 120: Text Field Added to the Report Header

4 To move the text field, drag it to the position you want.

5 To resize a text field in a report section, click the text field to activate it and then drag one 
of the handles displayed on the text field’s borders. The text field will be resized as you 
drag the handle.

Editing text fields
Once you add a text field to a report section, you can edit it to change the fonts, colors, text, 
and other attributes. This allows you to have one generic text field that can be added to sev-
eral reports, which can then be modified for each individual report.

Note To move a text field from one report section to another, both sections must 
have Automatic layout enabled. Refer to “Editing section layout properties” on 
page 224.

Note Certain standard text fields, such as Record Count or Rows per Page, include 
values that are dynamically updated when the report is run. While these fields 
can be edited, you cannot edit their dynamic value placeholders.
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To edit a text field in a report:
1 Right-click the text field in the report section on the design surface and select Edit Text 

Field.

2 Edit the text field on the Edit Text Field window. Refer to “Text Fields explorer” on page 
54 for information about using this window.

3 Click the OK button on the Edit Text Field window to save your changes.

Defining anchor styles
Once you add an image or text field to a report section, you can define how the item should 
move in relation to the report section’s border by specifying an anchor style. By default, when 
a report section is resized, images and text fields in the section will maintain the same distance 
between the top and left side of the report section. However, you can change the default 
anchor style so the item instead moves with the bottom or right side of the report section 
when the section’s borders are changed.

To select an anchor style:
1 Click an image or text field on the design surface to select it.

2 Click the Text Field tab.

3 Click the Anchor button to view anchor style options. The item’s current anchor style will 
be displayed. The gray bars identify which sides of the report section the image will be 
anchored to.

Figure 121: Defining Anchor Style

4 To clear an anchor, click the gray bar indicating an active anchor.

Tip If you know the specific options you want, it can be faster to select them from 
the ribbon. Opening the window gives you an overview of all the available 
options.
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5 To add an anchor, click the appropriate clear bar. For example, to anchor an image to the 
bottom and right side of the report section, clear the gray bars at the top and left side, and 
click the clear bars at the bottom and right side of the anchor style selection control.

Adding output and search criteria descriptions
You can add descriptions to your reports to provide additional information about the report’s 
output levels, columns, and filters. The information is customizable, so you can add informa-
tion you think would be helpful to the report’s audience. You can add output descriptions and 
search criteria descriptions.

Output descriptions
The Output Descriptions report section displays text you enter to describe output levels and 
columns in the output level. The output descriptions you add can be displayed inline, on a 
separate tab in the report, or when rolling over the columns in the report that have definitions 
defined. You can select the placement of the output descriptions from the ribbon. Figure 122 
shows a report with output descriptions displayed inline.

Figure 122: Output Descriptions Displayed Inline

To add text to output descriptions:
1 To add a description to an output level, select the output level you want from the Level 

drop-down menu at the top of the design surface.
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a Click the Level tab and click the Edit button to open the Level Settings window.

Figure 123: Level Settings Window

b Type the text you want to describe the output level in the Description field.
c Click the OK button to save the output level’s description.

2 To add an output description to a column, click the column on the design surface to select 
it.

a Click the Design tab.
b Click the Edit button to open the Column Definition window, shown in Figure 130 on 

page 253.
c Type the text you want to describe the column in the Description field.
d Click the OK button to save the column description.
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To display output descriptions on reports:
1 Click the Display tab.

2 Click the Output Descriptions button and select the display option you want from the list. 
The options are described in Table 61.

Search criteria descriptions
By default, the Search Criteria Descriptions report section includes information about the fil-
ters in your report, along with descriptions of the report’s variables, record limits, and com-
parison date offsets. However, you may not want to display descriptions of all report 
components, so you can specify which descriptions you want to display. Search criteria 
descriptions can be displayed inline or on a tab in the report. You select where to place the 
descriptions from the Search Criteria button on the ribbon’s Display tab. An example of the 
Search Criteria Descriptions report section displayed on the design surface is shown in Figure 
124.

Table 61: Output Descriptions Display Options

Option Description

Do Not Display 
Descriptions

Select this option to remove output descriptions from the report.

Display Descriptions on 
Column Rollover

Select this option to show the output descriptions when rolling 
over the report columns that have definitions defined.

Display Descriptions 
Inline

Select this option to show the output descriptions in the output 
level’s output, below the page header and report header sections.

Display Descriptions on 
Separate Tab

Select this option to show the output descriptions on a separate 
Description tab that will be added to the report.
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Figure 124: Sample of Search Criteria Descriptions Displayed Inline

To display search criteria descriptions on reports:
1 Click the Display tab.

2 Click the Search Criteria button and select the display option you want from the list. The 
options are described in Table 62.

Table 62: Search Criteria Descriptions Display Options

Option Description

Do Not Display Search 
Criteria

Select this option to remove search criteria descriptions from the 
report.

Display Search Criteria 
Inline

Select this option to show the search criteria descriptions in the 
output level’s output, below the page header and report header text 
fields.
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To specify which search criteria descriptions to display:
1 Click the Search Criteria Descriptions tab or report section on the design surface.

2 Click the Options tab.

3 Click the Search Criteria button.

Figure 125: Editing Search Criteria Description Options

4 Clear the check boxes next to the descriptions you do not want to display.

5 Click the OK button to save your changes.

Display Search Criteria on 
Separate Tab

Select this option to show the search criteria descriptions on a sep-
arate Description tab.

Table 62: Search Criteria Descriptions Display Options (Continued)

Option Description
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Managing output columns
The output columns you add to a report display tabular information about your data. Output 
columns are added to the data area of each output level. Once an output column is added to 
the output level, you can easily move the column, change the column headers, add notes to 
the column, change the column’s display, and add calculations to tally the values shown in the 
column. You can also create data exceptions to highlight data returned in the columns. For 
example, if you want to highlight all incidents in a report that are unresolved and overdue, you 
could create data exceptions to display these records in bold red text.

Output columns can be fields from the database, functions, variables, or computed fields. All 
of these items can be added from the ribbon or by dragging the field from the data dictionary 
to the design surface. The items that can be added as output columns are described in the fol-
lowing section.

Database fields
Most of the columns you add to reports will be fields from the database, which contain the 
Sales, Service, Marketing, and Feedback data you see throughout RightNow. The database 
fields that can be used in reports are listed in the report design center’s data dictionary.

Adding suffixes to database fields
When certain database fields are used in report columns, RightNow modifies the output to 
display the data in an easily readable format. For example, the incidents.assgn_acct_id field stores 
the ID numbers of the agents who have incidents assigned to them. Since report users gener-
ally prefer to see agent names instead of ID numbers, RightNow returns the names instead of 
the ID numbers.

However, there are occasions when you may want the report to return the agents’ ID num-
bers instead of their names. In such cases, the suffix .id can be added to incidents.assgn_acct_id, 
changing the column’s expression to incidents.assgn_acct_id.id. This suffix prevents RightNow 
from performing the name lookup and forces the report to return the ID number from the 
database field.

Tip To view descriptions of the tables and fields in the data dictionary, right-click the 
table or field and select View Data Definition. A new window will open with a 
description of the table or field.
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There are several suffixes that can be added to name lookup fields, such as inci-
dents.assgn_acct_id, or currency fields, such as opportunities.mgr_value. Other types of database 
fields do not accept suffixes. Each suffix has a different function, as described in Table 63.

Table 63: Database Field Suffixes

Suffix Description

Name lookup field suffixes These suffixes can be used with database fields that trigger an 
automatic name lookup when used in reports.

.id This suffix prevents RightNow from performing a name lookup 
and returns the ID number stored in the field. For example, 
answers.assgn_acct_id.id would return the account ID number of the 
staff member an answer is assigned to.

.desc This suffix can be used only with name lookup fields that have a 
description field. The suffix returns the text from the field’s 
description rather than the field’s ID number or name. For exam-
ple, incidents.prod_lvl1_id.desc would return the text description of 
the parent product an incident is associated with.

.name This suffix returns the name that is associated with the database 
field. For example, answers.map_cat_lvl1_id.name would return the 
name of the parent category an answer is associated with.
Note: This suffix is rarely used since the name lookup is usually 
performed by default.

Currency field suffixes These suffixes can be used with database fields that store currency 
values.

.curr_id This suffix returns the type of currency the value was stored in, 
rather than the currency value. For example, opportunities.mgr_
value.curr_id could return USD, GBP, or another currency type.

.rate_id This suffix returns the exchange rate that is used to calculate the 
field’s currency value when returning the value in a different cur-
rency format. For example, opportunities.rep_value.rate_id could 
return 1.45000 or another exchange rate.

.native This suffix returns the field’s value in its original currency instead 
of the currency determined by staff account or interface settings. 
For example, opportunities.mgr_value.native used in a report on a Brit-
ish interface would return the manager forecast value in USD if 
that value was originally entered on a U.S. interface.
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Variables
You can create variables to use in report output columns and data exceptions. Using a variable 
in an output column lets you return different data, or data in different formats, in the same 
column. For example, you could create a single report that displays the number of incidents 
by staff member, group, queue, or status. You select which of the four variable values to use in 
the report from the Search window or from a menu at the top of the report if the variable is 
docked.

Examples of a report with a variable used as an output column are shown in Figure 126.

Figure 126: Incidents Filtered by Variable Options

Using a variable in a data exception lets you use a single exception to flag different data. This 
eliminates the need to create multiple exceptions to flag data in different columns. For exam-
ple, you could use a variable in an exception to flag incidents that were created more than one 
day ago or to flag incidents that were updated more than one day ago. The information you 
want to flag is selected on the Search window when you run the report. For information 
about creating data exceptions, refer to “Creating data exceptions” on page 284.

Creating variables
Before you use variables in output columns or data exceptions, the variables first need to be 
created. There are several types of variables you can use, including predefined lists, user-
defined lists, ad hoc values, and replacement values. Each of these serves a unique function. 
In reports such as the sample report shown in Figure 126, a user-defined list is used to pro-
vide exactly the menu options you want.

To add variables:
1 Click the Home tab.

2 Click the Add Variable button to open the Add Variable window.
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Figure 127: Add Variable Window

3 Type a name for the variable in the Name field. Variable names will always be preceded by 
the dollar sign.

4 Type an optional prompt in the Prompt field. This text is displayed on the Search window 
when running the report. If this field is left empty, the variable’s name will be displayed 
instead.

5 Select the variable type from the Type drop-down menu. The variable types are described 
in Table 64.

Note The options on the Add Variable window will change depending on the variable 
type that is selected.

Note The Prompt field is not available when using a Replacement Value variable type, 
as this type is not displayed when running a report.

Table 64: Variable Types

Field Description

Predefined List Select this type to use values from an existing menu or predefined 
list in the variable. When selecting this option, all menu fields from 
the database are available, along with three predefined lists:

• Group Date—This list contains date/time formats, such as 
Month, Week, and Day of Month.

• Yes/No—This list contains Yes and No options.

• Currency Formats—This list contains currency formats, 
such as USD and CAN, that are defined on your site.
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6 If using a predefined list variable type, select the list to use from the List Name drop-down 
menu.

7 If using a user-defined list or ad hoc value variable type, select the data type to use from 
the Data Type drop-down menu. The data types are described in Table 65. 

User Defined List Select this type to compile your own list of menu items to use for 
the variable. For example, if you wanted the variable to return 
either incidents’ statuses or assigned staff accounts, you could cre-
ate a variable value for incidents.status and another for
incidents.assgn_acct_id.
Note: When you select this type, you will then select a data type 
for the variable. Refer to Table 65 on page 240 for a description of 
the available data types.

Ad Hoc Value Select this type to allow staff members to type their own value for 
the parameter at run-time, without having to select from a list. For 
example, an individual using the report types the exact expression 
or string to use as the variable value.
Note: When you select this type, you will then select a data type 
for the variable. Refer to Table 65 on page 240 for a description of 
the available data types.

Replacement Value Select this type to enter an expression that will be used in several 
places in the report. The replacement value variable you create can 
be added to the report in any place you would otherwise need to 
type the expression. This lets you use a short variable name rather 
than a lengthy expression.

Table 65: Variable Data Types

Data Type Description

String Select this option to add a variable that uses a string field.

Integer Select this option to add a variable that uses an integer field.

Float Select this option to add a variable that uses a numeric field that 
can contain decimal points.

Table 64: Variable Types (Continued)

Field Description
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8 If using a user-defined list variable type, create the list items you want to include.

a Click Add Item to open the Edit Variable List Item window. Figure 128 shows the win-
dow when adding a variable with an Expression data type.

Figure 128: Adding a User-Defined List Expression Variable

b Type a name for the list item in the Name field.
c Enter a value for the list item in the Value field.

The format of the Value field will change depending on the data type selected for the 
user-defined list. For example, the Value field for a Date and Time list item will display 
a calendar, whereas the Value field for an expression list item will display a text box and 
will include an Advanced option you can click to open the data dictionary to help you 
build the expression.

d Click the OK button to save the list item.
e Add the other list items you want to be able to select for the variable.

9 If using a predefined list or user-defined list variable type, enter a default value for the vari-
able in the Default field.

Date and Time Select this option to add a variable that uses a date and time field.

Currency Select this option to add a variable that uses a currency field.

Expression Select this option to add a variable that uses a database field (for 
example, incidents.status).
Note: This data type is not available for Ad Hoc Value.

Table 65: Variable Data Types (Continued)

Data Type Description
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10 If using an ad hoc value variable type, type a default value for the variable in the Default 
field.

11 If using a replacement variable type, type the expression you want the variable to replace.

Or

Click Use Data Dictionary to open the data dictionary to create the expression from data-
base fields and functions.

12 Click the OK button to save the variable.

Adding variables to a column
Once you create a variable in a report, it is added to the variables list in the report design cen-
ter’s data dictionary. You can then create output columns that use the variable in the same 
manner as you would any other output column, creating the column’s expression out of data-
base fields, functions, computed fields, and variables listed in the data dictionary. In some 
cases, the variable will be the only item in the column’s expression. In other cases, the variable 
will be combined with functions or database fields to form the column’s expression. Refer to 
“Adding columns to a report” on page 253 for information about adding columns to reports.

When a predefined list, user-defined list, or ad hoc value variable is included in a report’s out-
put columns, a menu listing the variable’s options will display on the report’s Search window. 
The variable menu can also display at the top of the report in the docked filters section for 
easy access by individuals using the report. Refer to “Docking variables and run-time select-
able filters” on page 322 for information about docking filters.

Computed fields
Computed fields are not actual fields in the database, but are calculated from the columns in 
your output level. Before the output level has columns added, computed fields will be unavail-
able. Once you add columns to the output level, the data dictionary’s Computed Fields tree 
will show the columns you have added. If you click a column in the tree, the available com-
puted fields for that column will appear in computed fields in the data dictionary. You can 
then drag the computed field you want to the design surface, just as you would with a stan-
dard database field.

Tip You can also add computed fields by clicking a column on the design surface to 
select it, clicking the Design tab, clicking the arrow on the Insert Column but-
ton, and selecting the computed field you want to add.



Computed fields 243

Most database fields will have only a comparison value computed field available. Integer 
fields, which store numbers, will have additional calculations available. The moving average, 
moving total, percentage of average, percentage of total, running average, and running total 
columns are all available to use in output levels and in rollups, if rollups exist in the report. 
When computed fields are added to rollups, the values will reset at the beginning of each rol-
lup section.

The Comparison Value and Comparison Percentage Value computed fields are described in 
“Adding comparison columns to reports” on page 255. The Trend Value and Trend Percent-
age Value computed fields are described in “Adding trending columns to reports” on page 
259. The other computed field types that are available are described in the following section.

Report moving average
This column outputs a centered moving average. Centered averages calculate the average for a 
value in a column by averaging that value, along with a number of values in the column prior 
to and preceding that value. For example, if a report outputs the number of incidents per 
month, a centered average for March that uses three data points would use the number of 
incidents from February, March, and April to derive the average.

For an odd number of data points, the centered average at i for a given data point, di, and 
number of data points, N, is:

(di-(N-1)/2 + di-(N-1)/2 +1 + ...di + ...di + (N-1)/2 -1 + di + (N-1)/
2)/N.

For an even number of data points, the centered average at i for a given data point, di, and 
number of data points, N, is:

(di-N/2 + 2*di-N/2 +1 + ...2*di + ...2*di + N/2 -1 + di + N/2)/2N.

When you add a report moving average column to a report, the calculation will automatically 
use three data points. However, the number of data points can be changed using the proce-
dure described in the following section.

Report moving total
A report moving total column outputs a running total of the values in the specified column. 
The totals are calculated for the current row, and a number of preceding rows determined by 
the number of data points you select. By default, the report moving total calculation uses 

Tip Moving averages work best using odd numbers of data points, but can use an 
even number, though the internal calculation to derive the value will differ 
somewhat.
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three data points. For example, if you had a column with four rows, with values of 10, 20, 30, 
and 40, respectively, and used three data points, the corresponding values in the report mov-
ing total column would be NULL, NULL, 60, and 90.

Specifying data points for moving calculation columns
The report moving average and report moving total computed fields use data points in their 
calculations. The method to select the number of data points to use is identical for either 
computed field.

To change the number of data points:
1 Add a report moving average or report moving total column to the output level.

2 Right-click the column on the design surface and select Edit Moving Calculations Options.

Figure 129: Moving Calculation Options Window

3 Type the number of data points you want to use in the calculation.

4 Click the OK button to save the number of data points used for the moving calculation.

Report percentage of average
A report percentage of average column calculates the average of the values in the specified 
column, and then returns the percentage of that total of the value in the current row. For 
example, if you had a column with three rows whose values were 10, 20, and 30, the average 
of the values in the column would be 20. The values returned in the report percentage of 
average column would be derived by dividing the value in each row by the average value of the 
column, and multiplying the result by 100. In this example, the values returned would be 50%, 
100%, and 150%, respectively.

Tip You can also change the number of data points by selecting the moving calcula-
tions column, clicking the Design tab, and entering the number of data points in 
the Number of Data Points drop-down menu.
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Report percentage of total
A report percentage of total column calculates the total of the values in the specified column, 
and then returns the percentage of that total of the value in the current row. For example, if 
you had a column with three rows whose values were 10, 20, and 30, the total of the values in 
the column would be 60. The values returned in the report percentage of total column would 
be derived by dividing the value in each row by the total value of the column, and multiplying 
the result by 100. In this example, the values returned would be 16.6%, 33.3%, and 50%, 
respectively.

Report running average
A report running average column averages the values in a specified column for all the col-
umn’s rows, up to and including the value in the current row. For example, if you had a col-
umn with three rows, with values of 10, 20, and 30, respectively, the corresponding values in 
the report running average column would be 10, 15, and 20.

Report running total
A report running total column totals the values in a specified column for all the column’s 
rows, up to and including the value in the current row. For example, if you had a column with 
three rows, with values of 10, 20, and 30, respectively, the corresponding values in the report 
running total column would be 10, 30, and 60.

Functions
Functions allow you to apply standard mathematical functions to the data from your database, 
and output the modified data in report columns. For example, using the count() function, you 
can output the number of contacts associated with an organization. The column’s expression 
in this example would be count(contacts.c_id). More complex functions allow more complex 
modifications to the data that is displayed. You can also combine different functions and 
database fields in the same column’s expression.

When you drag a function from the data dictionary to the design surface, the Column Defini-
tion window, displayed in Figure 130 on page 253, will automatically open. This lets you enter 
the variables used in the function’s expression. You can either type the variables in the 
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Expression field or, if the variable is an item listed in the Available Columns/Functions field, 
you can drag the item into the function’s expression. Refer to Table 66 for descriptions of the 
functions you can use in reports.

Table 66: Functions Description

Function Description

Aggregate Functions Select from the following to use an aggregate function in the 
expression.
Note: Aggregate functions can be used only when defining output.

avg(expr) This function computes an average value for the data set expr.

count(expr) This function returns the number of rows included in the data set 
expr.

max(expr) This function returns the largest numerical value, the last string in 
alphabetical order, or the latest date in the data set expr.

min(expr) This function returns the smallest numerical value, the first string 
in alphabetical order, or the earliest date in the data set expr.

sum(expr) This function returns the sum of the values in the data set expr.

sum_distinct(expr, 
reference)

This function returns the sum of distinct values in an expression 
for a particular record (reference) rather than for all records of the 
same type in a table. For example, if you want to calculate the sum 
of all quotas for a particular sales person, you could add a function 
of sum_distinct(sa_period2accts.quota, 
sa_period2accts.acct_id).

stddev(expr) This function returns the standard deviation of expr. For example, 
the expression stddev(answers.solved_count) returns the 
standard deviation of all the values in the solved_count column of the 
answers table.

String Functions Select from the following to use a string function in the expression:

concat(str1, str2) This function combines input character strings from multiple 
expressions into a single output string. Two or more expressions 
can be appended with this function. For example, the expression 
concat('www.','global','.com') returns the value 
www.global.com.
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instr(str, substr) This function returns the numeric position (in characters) of the 
initial occurrence of string substr in string str. For example, the 
expression instr('globalcellphones.com','cell') 
returns the value 7.

length(str) This function returns the length (in characters) of the string. For 
example, the expression length('cell phones') returns the 
value 10.

lower(str) This function returns string str in all lowercase characters. For 
example, the expression lower('Global.COM') returns the 
value global.com.

ltrim(str) This function returns the string str without leading spaces. For 
example, the expression ltrim('     Cell phone') returns 
the value Cell phone.

lpad(str1, X, str2) This function returns str1 padded on the left with str2 until str1 is X 
characters long. For example, the expression lpad('phone', 
10, '@') returns the value @@@@@phone.

rpad(str1, X, str2) This function returns str1 padded on the right with str2 until str1 is 
X characters long. For example, the expression rpad('phone', 
10, '@') returns the value phone@@@@@.

rtrim(str) This function returns the string str without trailing spaces. For 
example, the expression rtrim('agarfield@global.com        
') returns the value agarfield@global.com.

substr(str, start_pos, 
[length])

This function returns a portion of the string str starting at the char-
acter defined by start_pos (an integer) and ending at the character 
defined by length (an integer). If length is not indicated, it will return 
the remainder of the string.

to_char(expr) This function converts the numeric expr to a character string.

to_number(str) This function converts the character string str to a numeric. If the 
str is not numeric, this function will return zero. If str is a combina-
tion of numbers and other characters and begins with a number, 
this function will return only the initial numeric portion. For exam-
ple, to_number('123ABC') will return 123.

Table 66: Functions Description (Continued)

Function Description
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upper(str) This function returns string str in all uppercase characters. For 
example, the expression upper('global.COM')returns the 
value GLOBAL.COM.

Date Functions Select from the following to use a date function in the expression:
Note: Refer to the RightNow Administrator Manual for a list of the 
datetime format tokens you can use in date functions. Most of the 
date functions allow you to combine the supported format tokens 
in any combination you want.

date_add(date, units, 
interval, round)

This function returns the value of date plus a specified amount of 
time where date is a datetime type column or a literal string in the 
format YYYY-MM-DD or YYYY-MM-DD HH:MM:SS. The 
amount of time to add is specified by units and interval. Units must 
be a positive integer or an expression referring to an integer data-
base field specifying the number of intervals to add. Interval can be 
SECONDS, MINUTES, HOURS, DAYS, WEEKS, MONTHS, or 
YEARS. To round the result to the beginning of the specified 
interval, set the round argument to 1; otherwise, set round to 0 and 
the result will not be rounded. For example, the expression 
date_add(2007-11-25 22:35:00, 48, HOURS, 1) will 
return the value 2007-11-27 22:00:00.

date_format(date, 
format)

This function converts date from a datetime data type to a string 
and reformats it to match the format specified by format. Date can 
be a datetime type column or a literal string in the format YYYY-
MM-DD or YYYY-MM-DD HH:MM:SS. For example, the 
expression date_format('2007-11-25 22:25:00', 'DAY, 
MONTH DD, YYYY, HH12:MI PM') returns the value 
Tuesday, November 25, 2007 10:25 PM.

date_diff(date, date) This function returns the number of seconds occurring between 
two dates. For example, the expression date_diff('2003-11-
25', '2003-11-26 22:25:00') would return the value 
86400.
Note: To change the format of the output, use the date_format or 
time format function. For example, 
date_format(date_diff('2003-11-25', '2003-11-26 
22:25:00'), 'HH24h MIm SSs') will return 24h 00m 
00s.

Table 66: Functions Description (Continued)

Function Description
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to_date(str, format) This function converts the value entered in str that is in the format 
specified in format to a date or date/time value. For example, the 
expression to_date(‘20090215’,’YYYYMMDD’) will return a 
value of 02/15/2009.
Note: Unlike other date functions, to_date supports only the fol-
lowing date formats.

DD MM YYYY HH24:MI:SS
DD MM YYYY HH:MI:SS AM
DD MON YY
DD MON YYYY
DD-MM-YY
DD-MM-YYYY
DD.MM.YY
DD.MM.YYYY
DD/MM/YY
DD/MM/YYYY
DD/MM/YYYY HH:MI:SS AM
MM-DD-YY
MM-DD-YYYY
MM/DD/YY
MM/DD/YYYY
MON DD YY
MON DD YYYY
MON DD YYYY HH:MI AM
MON DD YYYY HH:MI:SS AM
YY.MM.DD
YY/MM/DD
YYMMDD
YYYY-MM-DD
YYYY-MM-DD HH24:MI:SS
YYYY-MM-DDTHHH24:MI:SS
YYYY.MM.DD
YYYY/MM/DD
YYYYMMDD

Table 66: Functions Description (Continued)

Function Description
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date_trunc(date, units) This function truncates date to the unit specified by units, with units 
being a time interval. For example, the expression 
date_trunc('2003-11-25 22:25:10', HOURS) returns 
the value 2003-11-25 22:00:00.

sysdate() This function returns the current system date in the format YYYY-
MM-DD HH:MM:SS.

time_format
(seconds, format)

This function converts seconds to the specified time format. For 
example, the expression time_format(86610,'HH24 MI 
SS') returns the value 24 03 30.

date_group(expr, format) This function lets you group records together according to a date 
range that you specify, and include rows for date ranges that have 
no associated records. If you do not want to return rows for date 
ranges with no records, you could use date_format instead.
For example, if you have incidents created in January and March, 
but none in February, and create a report with the expression for 
column A set to date_group(incidents.created, ‘YYYY-MM’), and the 
expression for Column B set to count(*), the report would output:
2006-01 10
2006-02 0
2006-03 15
If Column A’s expression to date_format(incidents.created, ‘YYYY-
MM’) used the date_format function instead of date_group, the 
output would be similar, but would not include a row for February.
Note: When this function is used in a column, the report design 
center automatically groups the data in the output level, and sets 
the output level’s group and sort order options. At least one date 
filter is required to use this function.

Table 66: Functions Description (Continued)

Function Description
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Logical Functions Select from the following to use a logical function in the expres-
sion:

if(expression, then result, 
else result)

This function returns the then result if expression is true; returns 
the else result if expression is false. For example, the expression 
if(incident.c$field=1, ‘Yes’, ‘No’) will return Yes 
for incidents where the value of c$field is 1; otherwise, No will be 
returned.
Note: You can use IS NULL and IS NOT NULL as part of the 
expression. For example, you could use the expression 
if(incident.c$field IS NOT NULL, 'Yes', 'No').

decode(test expression, 
test value 1, result 1, [, 
next test value, next 
result]* [,default])

This function compares test expression to each test value in order and 
returns result for the first test value that expression matches. If expres-
sion does not match any test value, default will be returned; if default is 
undefined, NULL will be returned. The decode function can per-
form table lookups, allowing you to use text strings as test values 
rather than requiring coded values (for example, you can use 
Review as a test value for the expression faqs.status even though the 
table contains code value in the status column).

nvl(expr1, expr2) If the value expr1 is null, this function returns the value expr2; how-
ever, if the value expr1 is not null, then the value expr1 is returned. 
The value of expr2 must match the data type of expr1.

Math Functions Select from the following to use a math function in the expression:

bitand(X, Y) This function returns the bitwise AND of two integers, X and Y.

ceiling(X) This function returns the smallest integer value greater than or 
equal to X.

floor(X) This function returns the largest integer less than or equal to X.

power(X, Y) This function returns the value of X to the power of Y. For exam-
ple, power(2,3) would return 8.

Table 66: Functions Description (Continued)

Function Description
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rand() This function generates a random number between 0 and 1. This 
output can be used to produce a random sampling of data. For 
example, to generate a random sample of incidents, add a column 
with an expression of rand() to an incidents report and sort on 
the column. The report will show information for incidents meet-
ing your search criteria, sorted randomly.

round(X, D) This function returns the value X rounded to the nearest number 
with D decimals. For example, round(5.55555,2) returns the 
value 5.56.

truncate(X, D) This function returns the value X truncated to the D decimal 
places. For example, the expression truncate(5.55555, 2) 
returns the value 5.55.

Currency Functions Select from the following to use a currency function in the expres-
sion.

cvt_currency(expr, str) This function converts the currency value expr to the specified cur-
rency str. For example, the expression 
cvt_currency(sa_opportunities.rep_value, 'USD') 
will return the rep_value in U.S. dollars when “USD” is stored as the 
abbreviation for U.S. dollars in the currencies table.

make_currency(expr, str) This function converts expr to the specified currency str. For exam-
ple, the expression make_currency(100.00, 'USD') will 
return the expr in U.S. dollars. You can also use replace str with the 
value dflt to convert the expression to the user’s currency.

to_currency(expr, str) This function converts expr to a value in str currency. The value is 
returned as an amount in the user’s default currency. The conver-
sion rate used for this function is the exchange rate defined in the 
exchange_rates table.
For example, for a user with a default currency of USD, 
to_currency(opportunities.mgr_value, ‘EUR’) will 
return an amount in USD that is equal to the number in the 
mgr_value converted to Euros.

Table 66: Functions Description (Continued)

Function Description
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Adding columns to a report
The procedures to add report columns are the same whether you are adding fields from the 
database, functions, variables, or computed fields. If your column returns information directly 
from the database, and does not require a complicated expression, you can add columns using 
the data dictionary. If your column’s expression will be complicated, using several functions, it 
can be easier to add the column from the Column Definition window.

To add an output column from the data dictionary:
1 Select the field, function, variable, or computed field you want from the data dictionary.

2 Drag the field you selected to the data area on the design surface.

When you drag an item from the data dictionary to the data area, you can place it in any posi-
tion. If other columns are in the data area when you drag a field, you will see arrows appear 
between column headers indicating where the field will be placed. When the field is in the 
desired location, drop it onto the data area.

To add a column from the Column Definition window:
1 Click the Home tab and click the Add Column button. The Column Definition window 

opens.

Figure 130: Column Definition Window

Tip Each output level can have a maximum of one hundred output columns. In 
addition, the number of tables used in a report is limited to twenty.

Note If the data dictionary is not shown on the design surface, click the Home tab and 
click the Data Dictionary button to display it.
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2 Enter field information described in Table 67.

3 Click the OK button to add the output column.

The column will be added as the last column on the report level. Refer to “Moving columns” 
on page 262 for information about how to reposition the column.

Once you add columns to the data area, the report design center will display the columns on 
the design surface. Four rows of sample text will be shown under each column to give you an 
idea of what the report output will look like.

Table 67: Column Definition Window Description

Field Description

Heading* Type a heading for the column. This heading will display in the 
report output.

Use predefined heading 
when available

Select this check box to use the default heading for the column. 
This is the name of the field as it appears in the data dictionary. 

Description Type an optional description for the column. Text that you enter in 
this field will display in the report when you include the Output 
Descriptions report section. Refer to “Output descriptions” on 
page 231.

Available Columns/
Functions

This area displays the data dictionary, which lists the available 
fields, functions, and parameters you can add as columns to the 
report. To add an item, expand the tree, select the item, and drag it 
to the Expression section.
Note: This option will not display when defining columns for 
computed fields.

Expression This area displays the field, function, or parameter you have 
defined as a column. If you know the specific field or function you 
want to add, you can also type it in this field to add it as an output 
column, without dragging it from the Available Columns/Func-
tions field. You can also manually edit the expression shown in this 
section.
Note: This option will not display when defining columns for 
computed fields.
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Adding comparison columns to reports
Adding a comparison value computed field to a report lets you view the same data for two 
different time periods side-by-side in a report. You can specify the time periods used, and 
change them while running the report to quickly view the data for different time periods. For 
example, you could have a report that shows the number of incidents created in the current 
week and the number of incidents created in the previous week. You could then run the 
report again to compare numbers of incidents created in the current month and previous 
month.

Once you add a comparison value column to a report, the Comparison button on the ribbon’s 
Home tab becomes active and you can select the comparison time period. The comparison 
time period is relative to the time specified in a required date filter you will add to the report.

To add a comparison value column to a report:
1 Add an output column that returns values you want to compare. For example, if you want 

to compare the number of incidents created from one week to the next, you could add a 
column for count(incidents.i_id) to return a count of incidents.

2 Expand the Computed Fields tree in the data dictionary.

3 Click the column you want to compare.

4 From the right side of the data dictionary, drag Comparison Value (column name) and drop it 
on the design surface.

5 Click the Home tab.

6 Click the Comparison button and select Edit Comparison Date Offset.

Figure 131: Comparison Date Offset Window

Tip You can also add comparison columns by clicking the column you want to com-
pare on the design surface, clicking the Design tab, clicking the arrow on the 
Insert Column button, and selecting the column you want to add.
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7 Type the relative value you want to use for the default comparison date offset. For exam-
ple, entering “-1 Weeks Exactly” will return values in the comparison value column that 
are derived from data that is exactly one week earlier than the data returned in the column 
that is being compared.

Or

Click the Calendar button to specify relative date and time values. Refer to “Selecting date 
ranges” on page 93 for information about defining relative dates.

When you run the report, the default comparison date offset can be changed on the 
Search window. This allows you to quickly run the report several times to compare differ-
ent time periods.

8 Click the OK button to save the default comparison date offset.

9 Add a fixed or run-time selectable date filter to the report. This date filter is used to filter 
the data returned in the column being compared and determines the time period that the 
comparison column’s relative comparison date offset is based on. Refer to “Creating 
report filters” on page 313 for information about creating report filters.

Changing comparison options
When using comparison values in a report, the comparison and compared values will not nec-
essarily display on the same row as the corresponding values in the other column. This is 
because a value is not automatically returned in a comparison column if there are no records 
to return. For example, if a report outputs numbers of incidents assigned to two staff mem-
bers during the current week and previous week, but the top staff member listed in the report 
had no incidents assigned in the previous week, there will not be an entry for that staff mem-
ber in the comparison value column. This will result in the comparison value for the second 
staff member displaying on the first row of the report.

To prevent this, you can set comparison options to have the report output a zero for any rows 
that lack a value in a column. This results in the corresponding values lining up with one 
another.

To change comparison options:
1 Add a comparison value column to a report.

2 Click the Home tab.

3 Click the Comparison button and select Edit Comparison Match Columns.
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Figure 132: Comparison Match Columns Window

4 Select the column(s) that define the corresponding values. For example, to keep the num-
ber of incidents assigned to the same staff member on the same row, select the Assigned 
Account column.

5 Move the selected column to the Comparison Match Columns panel by dragging the field 
or clicking the right arrow.

6 Click the OK button to save the change to the comparison options.

Adding comparison percentage columns
Once you add a comparison value column to a report for a numeric field, you can then add a 
Comparison Percentage computed field column to the report. This column returns the per-
centage difference between the comparison value column and the column being compared. 
For example, if a value in the compared column is 10, and the corresponding comparison 
value is 15, the percentage difference would be 50%.

To add a comparison percentage column to a report:
1 Add a comparison value column to the report, as described in “Adding comparison col-

umns to reports” on page 255.

2 Expand the Computed Fields tree in the data dictionary.

3 Click the comparison value column you added.

Tip You can also add comparison percentage columns by clicking the comparison 
column you added on the design surface, clicking the Design tab, clicking the 
arrow on the Insert Column button, and selecting Comparison % Change.
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4 From the right side of the data dictionary, drag Comparison Percentage (column name) and 
drop it on the design surface.

5 To set options for the column, right-click the column on the design surface and select Edit 
Comparison Percentage Options.

Figure 133: Comparison Percentage Options Window

a Enter field information described in Table 68.

Tip You can also adjust options by selecting the column and using the buttons on 
the Design tab’s % Change group.

Table 68: Comparison Percentage Options Window Description

Field Description

Comparison Direction Select whether the comparison column or the compared column is 
used as the initial column to derive the comparison percentage.

Comparison Data to 
Report Data

Select this radio button to use the comparison value column as the 
initial column to derive the comparison percentage. If the value in 
the comparison value column is greater than the corresponding 
value in the compared column, a positive percentage will be 
returned.

Report Data to 
Comparison Data

Select this radio button to use the compared column as the initial 
column to derive the comparison percentage. If the value in the 
compared column is greater than the corresponding value in the 
comparison value column, a positive percentage will be returned.
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b Click the OK button to save the comparison percentage options.

Adding trending columns to reports
Trend value computed fields are similar to comparison value computed fields. However, 
where comparison value columns return data from previous time periods, trend value col-
umns return forecasts of data in future time periods, calculated from current data.

To add a trend value column to a report:
1 Add a numeric output column that returns values you want to trend. For example, if you 

want to forecast the number of incidents that will be created in future weeks, you could 
add a column for count(incidents.i_id) to return a count of incidents.

2 Expand the Computed Fields tree in the data dictionary.

3 Click the column you want to trend.

4 From the right side of the data dictionary, drag Trend Value (column name) and drop it on 
the design surface.

Display Change Icon Select this check box to display icons next to the percentage values 
returned in the column. The icons will indicate whether there is a 
positive change, negative change, or no change. To alter the colors 
used for the icons, click the icon to open the Color window. Refer 
to “Choosing colors” on page 63 for information about using the 
Color window.

Table 68: Comparison Percentage Options Window Description (Continued)

Field Description

Note Trend values are best used when trending a column that groups data together by 
a time period, such as a column that shows the number of incidents created in 
the same week.

Tip You can also add trend value columns by clicking the column you want to trend 
on the design surface, clicking the Design tab, clicking the arrow on the Insert 
Column button, and selecting Trend Value.
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Specifying trend value duration
You can edit trend options to specify the number of time units that will be forecast forward. 
For example, if the trended column groups data by week, trending forward three units will 
show data trended three weeks in the future.

To change trend options:
1 Right-click the trend value column on the design surface and select Edit Trend Options.

Figure 134: Column Trend Options Window

2 Select the Perform Forecast check box to enable forecasting.

3 Type the number of units.

4 Click the OK button to save the number of trending units.

Adding trend percentage columns
Once you add a trend value column to a report, you can then add a Trend Percentage com-
puted field column to the report, either from the data dictionary or the Design tab’s Insert 
Column button. Trend Percentage columns return the percentage difference between the 
trend value column and the column being trended. For example, if a value in the trended col-
umn is 10, and the corresponding trend value is 15, the percentage difference would be 50%.

To add a trend percentage column to a report:
1 Add a trend value column to the report, as described in “Adding trending columns to 

reports” on page 259.

2 Expand the Computed Fields tree in the data dictionary.

3 Click the trend value column you added.

Tip You can also edit trend options from the Trend Options group on the Design 
tab after selecting the column on the design surface.



Adding trending columns to reports 261

4 From the right side of the data dictionary, drag Trend Percentage (column name) and drop it 
on the design surface.

5 To set options for the column, right-click the column on the design surface and select Edit 
Trend Percentage Options.

Figure 135: Trend Percentage Options Window

a Enter field information described in Table 69.

Tip You can also edit trend percentage options from the % Change group on the 
Design tab.

Table 69: Trend Percentage Options Window Description

Field Description

Comparison Direction Select whether the trend value or the trended column is used as the 
initial column to derive the trend percentage.

Trend Data to Report 
Data

Select this radio button to use the trend value column as the initial 
column to derive the trending percentage. If the value in the trend 
value column is greater than the corresponding value in the 
trended column, a positive percentage will be returned.

Report Data to Trend 
Data

Select this radio button to use the trended column as the initial col-
umn to derive the trending percentage. If the value in the trended 
column is greater than the corresponding value in the trend value 
column, a positive percentage will be returned.
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b Click the OK button to save the trend percentage options.

Editing columns
Once you add a column to the data area, you can quickly edit it to change the header, defini-
tion, sorting, or position in the report. Depending on the type of information the column 
returns, you may also have options to add calculations to the column or change how the data 
is displayed.

Moving columns
You can easily rearrange the columns displayed on the design surface by clicking anywhere in 
the column’s header and dragging it to the new position in your report. You can also move a 
column by clicking it on the design surface to select it, clicking the Home tab, and selecting 
Move Left or Move Right.

Changing column options
To view the available edit options for a column, you can right-click the column on the design 
surface to display a list of options. You can also click the column on the design surface to 
select it and then choose from options shown on the ribbon’s Design and Format tabs.

The options shown in the list when you right-click a column are described in Table 70.

Display Change Icon Select this check box to display icons next to the percentage values 
returned in the column. The icons will indicate whether there is a 
positive change, negative change, or no change. To alter the colors 
used for the icons, click the icon to open the Color window. Refer 
to “Choosing colors” on page 63 for information about using the 
Color window.

Table 69: Trend Percentage Options Window Description (Continued)

Field Description

Table 70: Column Options Description

Button Description

Edit Definitions Select this option to open the Column Definition window, shown 
in Figure 130 on page 253, where you can edit the column heading, 
descriptions, and expression. Refer to “To add an output column 
from the data dictionary:” on page 253 for information.
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Edit Format Select this option to open the Column Format window where you 
can change the column format, alignment, width, and styles. Refer 
to “Editing column format options” on page 264.

Edit Calculations Select this option to open the Calculations window where you can 
select calculations on the column values to display beneath the col-
umn. Refer to “Adding column calculations” on page 281.

Sort Ascending Select this option to sort the values in the column in ascending 
order. Refer to “Changing sort options” on page 141.

Sort Descending Select this option to sort the values in the column in descending 
order. Refer to “Changing sort options” on page 141.

Move Column Left Select this option to move the column left. You can also move col-
umns by dragging them on the design surface.

Move Column Right Select this option to move the column right. You can also move 
columns by dragging them on the design surface.

Insert New Column 
Before

Select this option to add a new column before the column you 
have selected. When you select this option, the Column Definition 
window, shown in Figure 130 on page 253, will open so you can 
create the new column.

Insert New Column After Select this option to add a new column after the column you have 
selected. When you select this option, the Column Definition win-
dow, shown in Figure 130 on page 253, will open so you can create 
the new column.

Delete Column Select this option to delete the column from the report. You can 
also delete a column by selecting the column and pressing Delete.

Freeze Column Click this button to fix the selected column in place so it does not 
move when you horizontally scroll the report. This can be helpful 
if you want to continue to view the first column in the report while 
scrolling the report to see the columns on the right of the report.
Note: When you fix a column, all columns to the left of the col-
umn will also be fixed. You will still be able to scroll the columns to 
the right of the fixed column.

Table 70: Column Options Description (Continued)

Button Description
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Editing column format options
Format options are available to output a column’s data differently and to modify the column’s 
display. You can adjust a column’s fonts, colors, width, and alignment settings, and modify 
other settings that are specific to the column’s data type. In addition, conditional formatting 
can be added to a column to flag data that meets your specified criteria, and numeric values 
returned in a column can be replaced with gauges to display graphical representations of the 
data. You can also add a URL link to a column that, when clicked, launches the web page you 
specify.

To edit column format options:
1 Right-click the column and select Edit Format to open the Column Format window. The 

tab that is initially displayed when you open the window will vary depending on whether 
you are editing a column that contains text, dates, numbers, or currency. Figure 136 shows 
the column format options for a text column.

Hide Column Select this option to prevent the column from displaying in the 
report output. The column will still remain in the report, which 
allows you to show the column when running the report. For 
information about showing and hiding columns, refer to “Selecting 
columns to display” on page 140.

Insert Hidden Column Select this option to view a list of any hidden or rolled-up columns 
in the report. Click the hidden or rolled-up column you want to 
display.

Note The procedure in this section describes editing column format options from a 
window. However, many of the options available from the window are also avail-
able on the ribbon.

Table 70: Column Options Description (Continued)

Button Description
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Figure 136: Text Tab on the Column Format Window

2 To define options for a text column, enter field information described in Table 71.

Table 71: Text Tab Description

Field Description

Text Length Define limits to the length of text strings appearing in the column.

Do not limit text length Select this radio button to allow an unlimited length of text strings 
in the column. The column will be automatically resized to fit the 
length of the output text.

Limit text to x characters Select this radio button to limit the text string length to a certain 
number of characters and then type the number of characters. Text 
strings that exceed this will be truncated.

Text Options Define options to determine how column contents are displayed.

Display “more” link 
when text width exceeds 
cell width

Select this check box to display a link in a row whose text exceeds 
the allowed width of the column. When a link is displayed, you can 
click the link or hover over it to open a window with the full text.

Display tooltip when cell 
text exceeds cell bounds

Select this option to display a tooltip showing the field’s entire text 
entry when hovering over a field with a text entry that exceeds the 
width of the column.
Note: This option is available only from the Options button on 
the ribbon’s Format tab. 

Strip HTML tags Select this check box to remove HTML tags from text that is dis-
played in a column.
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Figure 137 shows the column format options for a date column.

Figure 137: Date Tab on the Column Format Window

3 To define options for a date column, enter field information described in Table 72.

NULL Values Define how NULL values in the database should display.

Display Blank Select this radio button to display a blank for NULL values.

Display as No Value Select this radio button to display “No Value” for NULL values.

Table 72: Date Tab Description

Field Description

Date Format Click this drop-down menu to select the date format you want to 
use to display content in date fields. The available options are Date 
Time, Long, Short, Month Year, Clock, Month Day, Year, Date 
Time (time zone), and Custom.
Note: When you select any option other than Custom, the selected 
format will be displayed in the Format String field so you can see 
the string that will be used for the selected format.

Format String Type the format string for the custom date format in this field 
when the Custom date format option is selected.

Table 71: Text Tab Description (Continued)

Field Description
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Figure 138 shows the column format options for a numeric column.

Figure 138: Number Tab on the Column Format Window

4 To define options for a numeric column, enter field information described in Table 73.

NULL Values Define how NULL values in the database should display.

Display Blank Select this radio button to display a blank for NULL values.

Display as No Value Select this radio button to display “No Value” for NULL values.

Table 73: Number Tab Description

Field Description

Show Value As Click this drop-down menu to select the format to use when dis-
playing content in numeric columns. The available options are 
Number, Seconds, Minutes, Percent, and File Size.
Note: The options available on the Number tab will vary depend-
ing on the selected value format.

Table 72: Date Tab Description (Continued)

Field Description
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Digit Grouping Define whether digits are grouped in threes. For example, instead 
of the column returning “123456,” you can group the digits to 
return “123,456.”
Note: This option appears only when the selected value format is 
Number, Decimal, or Percent.

Do not show group 
separator

Select this radio button to prevent the values in the column from 
including a separator character.

Use default group 
separator

Select this radio button to use the default group separator charac-
ter. The default separator is a comma.

Use custom group 
separator

Select this radio button to define your own group separator charac-
ter. Type the character you want to use in the field.

Decimal Define how decimal and percentage formats should be displayed.
Note: This option appears only when the selected value format is 
Percent.

Decimal Places Enter the number of decimal places to display in the output.

Use default decimal 
separator

Select this radio button to use the default group separator charac-
ter. The default separator is a period.

Use custom decimal 
separator

Select this radio button to define your own decimal separator char-
acter. Type the character you want to use in the field.

Multiply by 100 Select this check box to multiply the decimal values by 100.
Note: This option appears only when the selected value format is 
Percent.

Seconds Define how time units should be displayed.
Note: This option appears only when the selected value format is 
Seconds or Minutes.

Seconds When the column outputs a value in seconds, specify the format 
you want to display the time in. The available options are “Days, 
Hours, Minutes,” and “Hours, Minutes, Seconds.”

Minutes When the column outputs a value in minutes, specify the format 
you want to display the time in. The available options are “Days, 
Hours, Minutes,” and “Hours, Minutes.”

Table 73: Number Tab Description (Continued)

Field Description
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Figure 139 shows the column format options for a currency column.

Figure 139: Currency Tab on the Column Format Window

5 To define options for a currency column, enter field information described in Table 74.

NULL Values Define how NULL values in the database should display.

Display Blank Select this radio button to display a blank for NULL values.

Display as 0 Select this radio button to display 0 for NULL values.

Table 74: Currency Tab Description

Field Description

Use Default Currency 
Format

Select this radio button to use default currency settings, as speci-
fied by your RightNow administrator. When this radio button is 
selected, most of the other fields on the Currency tab will be dis-
abled.

Table 73: Number Tab Description (Continued)

Field Description
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6 Click the Alignment tab to define the column’s alignment.

Use the Following Format 
Options

Select this radio button to define your own currency format set-
tings. When you select this option, the fields on the Currency tab 
will be enabled.

Display Symbol Select this option to display the symbol for the currency. For exam-
ple, ten U.S. dollars would display as $10.00.

Display Code Select this option to display the code for the currency. For exam-
ple, ten U.S. dollars would display as 10.00USD.

Digit Grouping The radio buttons in this section let you group digits in threes. For 
example, instead of the column returning “$123456,” you can 
group the digits to return “$123,456.”

Do Not Show Group 
Separator

Select this radio button to prevent the values in the column from 
including a separator character.

Use Default Group 
Separator

Select this radio button to use the default group separator charac-
ter. The default separator is a comma.

Use Custom Group 
Separator

Select this radio button to define your own group separator charac-
ter. Type the character you want to use in the field.

Decimal Define how decimal and percentage formats should be displayed.

Decimal Places Enter the number of decimal places to display in the output.

Use Default Decimal 
Separator

Select this radio button to use the default group separator charac-
ter. The default separator is a period.

Use Custom Decimal 
Separator

Select this radio button to define your own decimal separator char-
acter. Type the character you want to use in the field.

NULL Values Define how NULL values in the database should display.

Display Blank Select this radio button to display a blank for NULL values.

Display as 0 Select this radio button to display “No Value” for NULL values.

Table 74: Currency Tab Description (Continued)

Field Description
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Figure 140: Alignment Tab on the Column Format Window

7 Enter field information described in Table 75.

Table 75: Alignment Tab Description

Field Description

Header The fields in this section determine the text alignment for the col-
umn’s header.

Text Alignment Click this drop-down menu to select the column header’s align-
ment. The available options are Left, Center, and Right.

Wrap Text Select this check box to allow the column header’s text to wrap to a 
new line if it exceeds the width of the column.

Data The fields in this section determine the text alignment for the col-
umn’s data.

Text Alignment Click this drop-down menu to select the alignment for the col-
umn’s data. The available options are Left, Center, and Right.

Wrap Text Select this check box to allow the column’s data to wrap to a new 
line if it exceeds the width of the column.

Limit Wrapped Text to x 
Rows

If the Wrap Text check box is selected, type the maximum number 
of wrapped rows that should be shown in the report output. You 
can type a value between 1 and 100.
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8 Click the Width tab to define the column’s width.

Figure 141: Width Tab on the Column Format Window

9 Enter field information described in Table 76.

Repeating Values The fields in this section let you hide repeating values in the col-
umn.

Hide Repeating Values Select this check box to hide repeating values in the column. Only 
the first row with the value will show the value. Subsequent rows 
with the same value will be blank. Selecting this option can make a 
report’s output more legible by hiding repetitive text in a column.

Exclude Hidden Values 
from Calculations and 
Auto-Filtering

Select this check box to exclude hidden values from consideration 
in column calculations and column auto-filter options.

Table 76: Width Tab Description

Field Description

Best Fit Select this radio button to allow RightNow to automatically size 
the width of the column to the best fit.

Table 75: Alignment Tab Description (Continued)

Field Description
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10 Click the Styles tab to define the column’s text styles. Text styles control the font, color, 
margins, background colors, and borders for text fields. The current setting for each text 
field’s style is shown next to the name of the text field.

Figure 142: Styles Tab on the Column Format Window

11  Enter field information described in Table 77.

Specific Width Select this radio button to define a width for the column. Type the 
width of the column and select the unit to use from the drop-down 
menu. You can choose Percentage (of the total width of the 
report), Pixel, Inch, Cm (centimeter), Mm (millimeter), Pica, Point, 
Em, and Ex.

Table 77: Styles Tab Description

Field Description

Data Headings Click Edit to define the style for the column’s heading when the 
report is shown with a tabular layout.

Rollup Headers Click Edit to define the style for the rollup headers if shown in the 
report’s output.

Table 76: Width Tab Description (Continued)

Field Description
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12 Click the Conditional tab to apply conditional formatting to the column.

Record Labels Click Edit to define the style for the column’s heading when the 
report is shown with a record layout.

Record Data Click Edit to define the style for the column’s data when the report 
is shown with a record layout.

Data Define the style for the data text in the column when the report is 
shown with a tabular layout.

Edit Click Edit to edit the style that is currently used for the data text in 
the column.

Add Click this text to add other styles for alternating data rows in the 
column. The new style you create will initially be identical to the 
original data style. Once you add the new style, another data style 
will appear. The data rows in your report will then alternate 
between the two styles you have defined. If you add a third data 
style, every third row will have the style.

Remove Click this text to remove the new data style. “Remove” will appear 
next to new data styles you add. You cannot remove the original 
data style.

Rollup Totals Click Edit to define the style for the rollup totals if shown in the 
report’s output.

Report Totals Click Edit to define the style for the report totals headers if shown 
in the report’s output.

Apply Styles to All 
Columns

Click this text to apply the styles you defined on this tab to all the 
columns currently in your report.

Note Conditional formatting is not available for columns that return hierarchical val-
ues.

Table 77: Styles Tab Description (Continued)

Field Description
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Figure 143: Conditional Tab on the Column Format Window

Conditional formatting flags information in output columns without creating a data 
exception. For example, you could add formatting to a column in an incidents report to 
display the column’s output in red text if an incident’s status is Unresolved. Multiple for-
mat options can be used to flag output using images, background colors, and fonts.

13 Click Add to open the Conditional Format window.

Figure 144: Selecting a Conditional Format Operator for a Date Column

14 Select the operator and value(s) you want flagged.

Note The options shown on the Condition tab will vary depending on the type of data 
output in the column the condition is added to. For example, a column that out-
puts dates will have operators and values that are unique to date fields.
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15 Click the Format tab to define how the flagged data is displayed.

Figure 145: Selecting Conditional Format Display Attributes

16 Enter field information described in Table 78.

Table 78: Conditional Format Window Description

Field Description

Display Click this drop-down menu to select the type of formatting you 
want to use to indicate column output that meets the selected con-
dition(s).

Image and Text Select this option to show images next to the column output that 
meets the selected condition(s) and display the output with differ-
ent font options.

Image Only Select this option to show an image next to the column output that 
meets the selected condition(s).

Text Only Select this option to use different font options for column output 
that meets the selected condition(s).

Image Click this drop-down menu to select the image to display. The 
options are Circle, Square, Flag, Check, Up Arrow, Down Arrow, 
and Custom. Select Custom to select the image from the Images 
explorer.
Note: This drop-down menu is disabled if Text Only is the 
selected display option.

Change Color Click this text to change the color of the selected image.
Note: The color of custom images cannot be changed.
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17 Click the OK button to save the conditional formatting.

18 If multiple conditional formats are applied to the column, define the order in which the 
formats should be applied.

Multiple conditional formats can be applied to the same column to indicate different val-
ues. For example, different incident statuses can have different font colors or images. 
When a column has multiple formats, the order of the conditions is important since this 
determines which condition is applied first. If a row in a report meets both the first and 
second conditions in a column, only the first condition is applied to the value.

a Select the conditional format to move from the Conditional Formats list.
b Click the Move Up or Move Down button to move the conditional format up or down 

in the list.

19 Click the URL tab to add URL links to your column.

Preview This field displays a preview of the selected image, text, or both, 
depending on the selected display option.

Change Style Click this text to select font attributes for conditional column text.

Note When you click a URL link in a report, your web browser will launch and the 
web site the URL points to will open. You can customize the URL and add vari-
ables to the link, using the values in any of the report’s columns. For example, 
you could direct a URL to open an answer on the customer portal in RightNow 
Service, or you could direct the URL to a page designed by your organization.

Table 78: Conditional Format Window Description (Continued)

Field Description
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Figure 146: Displaying a Column with URL Links

20 Enter field information described in Table 79.

Table 79: URL Tab Description

Field Description

URL Options Specify how you want to define the URL in this section.

Display Cell Value as Link Select this check box to enable URL options for the column.

Use Cell Value as URL Select this radio button to use the value in the field as the URL 
link. Select this option only if the value in the field is a valid URL.

Use Custom URL Select this radio button to manually specify the URL. You can 
enter the URL you want in the text box, or click Advanced URL 
Definition to view options to help you define the URL.

Advanced URL Definition Click this text to display advanced URL formatting options.
Note: When you click Advanced URL Definition, the text will 
change to Simple URL Definition. Click this text to hide the 
Advanced URL Definition options.
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21 Click the Gauge tab to configure the column to display values using gauges.

Figure 147: Gauge Tab on the Column Format Window

Report Column Selection You can add variables and variable values to the custom URL in 
this section. Type the variable you want to add to the URL in the 
text field, and then select the column to use to populate the vari-
able’s values from the drop-down menu.

Append Session ID Select this check box to append the session ID number to the 
URL. Use this option when the URL links to a customer portal 
page to ensure the URL for the page is valid.

Begin with Server URL Select this check box to automatically prepend the path to the 
RightNow server’s PHP directory to the custom URL.

Note The Gauge tab is available only for columns that return numeric or currency val-
ues.

Table 79: URL Tab Description (Continued)

Field Description
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22  Enter field information described in Table 80.

Table 80: Gauge Tab Description

Field Description

Inline Gauge Type Click this drop-down menu to select the type of gauge you want to 
use. The available options are None, Linear Gauge, Circular 
Gauge, and Progress Bar.

Display Numeric Value Select this check box to display numeric values on the gauge.

Scales Define the scale ranges used for the gauge in this section.

Scale Start Enter the minimum value for the scale used in the gauge.

Use Report Min Select this check box to use the lowest value returned in the col-
umn as the scale start value.

Scale End Enter the maximum value for the scale used in the gauge.

Use Report Max Select this check box to use the highest value returned in the col-
umn as the scale end value.

Colors Select colors used for the gauge in this section.

Indicator Color Click this color box to select the color to use as the gauge indicator 
color.

Border Color Click this color box to select the color to use as the gauge border 
color.

Gauge Color Ranges Add color ranges and define range colors in this section. Color 
ranges can be used to display numeric ranges in different colors. 
For example, a range of 0-33 could be green, 34-65 could be yel-
low, and 66-100 could be red.
Note: Color ranges are not available with Progress Bar gauges.

Add Range Click this text to add a color range.
Note: A maximum of five ranges can be shown on the gauge. The 
range values cannot contain gaps or overlap.

Remove Range Click this text to remove a range you have added.

Minimum Enter the starting value for the range.

Maximum Enter the ending value for the range.
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23 Click the OK button to save the changes to your column’s format.

Adding column calculations
You can add rows to the bottom of a column to display calculations performed on the col-
umn’s data. You can also perform calculations on data rollups. Refer to “Displaying rollup lev-
els” on page 155 for information about rollups.

The Calculations window displays all the calculations that can be performed on the data in the 
column. If the report does not have rollup columns, the Rollup Calculations section will not 
appear. Also, columns that do not contain numeric values will have only the Minimum, Maxi-
mum, and Median calculations available.

To add calculations to a column:
1 Right-click the column and select Edit Calculations. The Calculations window opens.

Figure 148: Calculations Window

Start Color Click the color box to select a start color for the range.

End Color Click the color box to select an end color for the range.

Table 80: Gauge Tab Description (Continued)

Field Description
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2 Enter field information described in Table 81.

Table 81: Column Calculations Window Description

Field Description

Rollup Calculations The check boxes in this section apply to calculations for data rol-
lups.
Note: These options display only when a rollup is defined in the 
report output.

Total Select this check box to display the total value of the output col-
umn for all records.

Minimum Select this check box to display the minimum value of the output 
column for all records.

Maximum Select this check box to display the maximum value of the output 
column for all records.

Weighted Average Select this check box to display the weighted average of the column 
for all records.

Average Select this check box to display the average value of the output col-
umn for all records.

Median Select this check box to display the median (middle) value of the 
output column for all records.

Standard Deviation Select this check box to display the standard deviation of the col-
umn for all records. Standard deviation is the square root of the 
variance. It projects how various values in a set of values deviate 
from the mean for that set.

Report Calculations The check boxes in this section apply to calculations for the output 
columns in the report.

Total Select this check box to display the total value of the output col-
umn for all records.

Minimum Select this check box to display the minimum value of the output 
column for all records.

Maximum Select this check box to display the maximum value of the output 
column for all records.
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3 Click the OK button to save the column calculation.

Weighted Average Select this check box to display the weighted average of the column 
for all records.

Average Select this check box to display the average value of the output col-
umn for all records.

Median Select this check box to display the median (middle) value of the 
output column for all records.

Standard Deviation Select this check box to display the standard deviation of the col-
umn for all records. Standard deviation is the square root of the 
variance. It projects how various values in a set of values deviate 
from the mean for that set.

Weighted Column Click the Weighted Column drop-down menu and select the col-
umn to use in conjunction with the current column to derive the 
weighted average. This drop-down menu is activated when the 
Weighted Average report or rollup calculation is selected, and dis-
plays only numeric columns you can use with weighted averages.
For example, if you have a report with column X showing the 
number of incidents solved by a group, and column Y showing the 
average amount of time spent solving the incidents, a weighted 
average calculation can determine the average amount of time 
spent solving each incident regardless of how many incidents each 
group solved.
That is, if group A solves 30 incidents and averages 30 minutes per 
incident, and group B solves 10 incidents averaging 110 minutes 
per incident, a normal average would calculate 70 minutes per inci-
dent, which would not reflect the different number of incidents for 
each group. A weighted average would show a more accurate aver-
age of 50 minutes per incident, since it takes the number of inci-
dents solved by each group into account.
The calculation RightNow uses to determine weighted averages is 
((x1*y1)+(x2*y2)) / (x1+x2) or, in this example, 
((30*30) + (10*110)) / (30 + 10) = 50.

Tip You can also add calculations from a selected column’s Design tab.

Table 81: Column Calculations Window Description (Continued)

Field Description
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Creating data exceptions
You can create data exceptions to highlight data displayed in columns or charts that meets 
certain criteria. Exceptions can be created to flag data that matches expressions built from 
database fields, functions, and variables. For example, you could create an exception to flag 
incidents with a response time greater than twenty-four hours. Incidents that match the 
exception could be shown on the report with custom colors, fonts, and markers. Information 
about the percentage of data meeting the exception can also be displayed.

After you define your exceptions, you can schedule the report to send alerts whenever the cri-
teria of a data exception is met. For more information about report scheduling, refer to 
“Scheduling reports” on page 121.

To create a data exception:
1 Click the Insert tab on the ribbon.

2 Click the Exception button to open the Exception Editor.

Figure 149: Exception Editor

Tip Each report level can have a maximum of thirty-two data exceptions.
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3 Enter field information described in Table 82.

4 To define how the data exception will display in the report’s tabular output, click the Tabu-
lar Display tab.

Table 82: Definition Tab Description

Field Description

Name Type the name of the data exception.

Display Reference Click this drop-down menu to select how the data will be high-
lighted. Options are Entire Row or specific columns from the 
report.

Expression* Right-click in this field to select the database column used to 
except data in the report.

Use Data Dictionary Click this text to open the Edit Expression window where you can 
select functions, variables, and database fields.

Operator Click this drop-down menu to select the operator to use in the 
exception criteria. This drop-down menu is activated once a data-
base column is selected. Refer to Table 91 on page 317 for a 
description of operators.

Value Specify the second part of the expression in this field. The options 
available vary depending on the selected value type, the type of 
database field the exception is based on, and the operator that is 
used. You can type in a value, select items from a drop-down 
menu, or select dates from calendars.
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Figure 150: Tabular Display Tab

5 Enter field information described in Table 83.

Table 83: Tabular Display Tab Description

Field Description

Show Tabular Notification Select this check box to display the data exception in the report’s 
tabular output. If this option is cleared, the other options on the 
Tabular Display tab will be unavailable.

Use Default Display 
Options

Select this radio button to display the exception using the color, 
font, and marking method defined in the style that is being used for 
the report. Refer to “Styles explorer” on page 27 for information 
about creating styles and “Changing report displays with styles” on 
page 129 for information about applying styles to reports.
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Use Custom Display 
Options

Select this radio button to define a custom color, font, and data 
marking method for the exception.

Data Marking Click this drop-down menu to select a data marking to mark the 
data that meets your exception criteria. You can choose None, Cir-
cle, Square, Flag, Check, Up Arrow, Down Arrow, or Custom.

• Select Custom to open the Select Image window and select 
images you have added in the Images explorer. Refer to 
“Images explorer” on page 52 for information about the 
Images explorer.

• Select None to prevent a graphic from indicating the data 
exception, but the text style you define for the marker will 
still be applied to the data exception. This allows you to 
change the color or font of tabular data that meets the 
exception without adding a graphic.

Note: The data marking symbol will be shown in the window’s 
Preview field so you can view the symbol as you define it.

Hide Cell Values Select this check box to hide the value in the column that is used as 
the display reference.
Note: This check box is available if the exception’s display refer-
ence is set to a column rather than an entire row.

Change Color Click this text to open the Color window to change the color of the 
graphic. Refer to “Choosing colors” on page 63.
Note: This option appears if Circle, Square, Flag, Check, Up 
Arrow, or Down Arrow is selected in the Data Marking drop-down 
menu.

Change Image Click this text to open the Select Image window to change the 
image data marking image.
Note: Change Image appears only if Custom is selected in the 
Data Marking drop-down menu.

Table 83: Tabular Display Tab Description (Continued)

Field Description
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6 To define how the data exception will display in the report’s graphical output, click the 
Graphical Display tab.

Figure 151: Graphical Display Tab

Style Click Add next to the Style box to open the Edit Style window 
where you can change the font, colors, margins, and borders for the 
data in the report that matches your data exception criteria. Refer 
to “Selecting style options” on page 29 for information about edit-
ing styles.
To remove a style that has already been defined, click Clear next to 
the Style box.

Show Exception Criteria Select this check box to display the exception criteria at the bottom 
of the report in the Data Exceptions report section. For example, if 
the data exception marks opportunities that are still active, the cri-
teria would display opportunities.status_id = Active.

Show Percentage Meeting 
Criteria

Select this check box to show the percentage of data in the report 
that meets the specified exception criteria. This will display at the 
bottom of the report in the Data Exceptions report section.

Show Percentage Not 
Meeting Criteria

Select this check box to show the percentage of data in the report 
that does not meet the specified exception criteria. This will display 
at the bottom of the report in the Data Exceptions report section.

Table 83: Tabular Display Tab Description (Continued)

Field Description
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7 Enter field information described in Table 84.

Ordering data exceptions
When you add multiple data exceptions that are based on the same database field to the same 
output level, the ordering of the exceptions can impact which exception the data matches. In 
such cases, you will want the most restrictive exception listed first, since the data will be 
checked against the first exception before other exceptions in the list are matched.

For example, you could create exceptions in a report that show the number of open incidents 
each of your contacts have. You could create an exception to indicate contacts with five or 
more incidents and another exception to indicate contacts with ten or more incidents. If the 
first exception is count(incidents.i_id) > 5, and the second is count(incidents.i_id) > 10, then your 

Table 84: Graphical Display Tab Description

Field Description

Show Graphical 
Notification

Select this check box to display the data exception in the report’s 
chart output. If this option is cleared, the other options on the 
Graphical Display tab will be unavailable.

Use Custom Display 
Options

Select this radio button to choose your own line color for the data 
exception. If this box is not selected, the exception will use the line 
color defined in the chart style that is being used for the report. 
Refer to “Chart Styles explorer” on page 33 for information about 
creating chart styles and “Adding and editing charts” on page 299 
for information about applying chart styles to reports.

Line Color Click the color box to open the Color window and select a line 
color for the excepted data. Refer to “Choosing colors” on page 
63.

Show Exception Criteria Select this check box to display the exception criteria in an excep-
tions box in the chart.

Show Percentage Meeting 
Exception

Select this check box to show the percentage of data in the report 
that meets the specified exception criteria. This will display in an 
exceptions box in the chart.

Show Percentage Not 
Meeting Exception

Select this check box to show the percentage of data in the report 
that does not meet the specified exception criteria. This will display 
in an exceptions box in the chart.
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data would match only the first exception even if a row had an incident count greater than 
ten. This occurs because the first exception has precedence over the second exception. To 
correct this, you would reorder the data exceptions.

To order data exceptions:
1 Select the data exception you want to move on the design surface.

2 Click the Design tab.

3 Click the Move Up or Move Down button to move the exception to the position you want.

Limiting records returned
Reports can return large amounts of data, especially if they lack fixed filters or required run-
time selectable filters. It can be difficult to print or view a report with thousands of rows, and 
finding specific records in such a report can be challenging. However, you can limit the num-
ber of rows returned on each page or on the entire output level. Limits are set for each output 
level in the report.

To set record limits:
1 Select the level you want to add the record limit to from the Level drop-down menu at the 

top of the design surface.

2 Click the Level tab.

3 Click the Record Limit button.

Figure 152: Limiting Records Returned

Tip You can also reorder exceptions by dragging them in the exceptions report sec-
tion on the design surface.
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4 Enter field information described in Table 85.

5 Click the OK button to save the change to the record limit.

Managing table relationships
When you add fields from different database tables as output columns, the tables that contain 
the fields are automatically added to the report and joined together. This allows information 
from one table that is related to information from the other table to be returned on the same 
rows in the report. For example, a report can show the email address from the contacts table 
and incident information from one of the contact’s incidents on the same row in the report, 
since RightNow Analytics recognizes that these records are related.

When tables from a database are added to a report, they can be joined using two methods, or 
join types:

• Inner join—Inner joins select records from the joined tables on the condition that the 
value in the specified column of the primary table is equal to the value in the specified 
column of the secondary table.

Table 85: Edit Row Limit Window Description

Field Description

Limit To Select this check box to limit the records returned on the output 
level.

Rows Type the maximum number of rows you want returned.
Note: The VLR_HARD configuration setting sets a hard limit on 
the number of rows that can be returned in a report. Values 
entered in this field that exceed the VLR_HARD limit will be 
ignored. Refer to Appendix A, “Analytics System Configuration 
Settings,” on page 417 for information about VLR_HARD and 
other configuration settings that can impact reports.

Per Page Select this check box to apply the record limit to each page of the 
report. If this check box is not selected, the row limit you enter 
restricts the total number of rows returned in the selected output 
level.
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• Outer join—Outer joins select rows from two tables regardless of whether the speci-
fied columns contain corresponding values. An outer join will return all rows from the 
primary table and any rows from the secondary table where the value in the specified 
column of the primary table is equal to the value in the specified column of the second-
ary table.

How join types work
When you add a database field to a report, the table containing that field is added to the 
report and becomes the report’s primary table. When you then add a field from a different 
table to the report, RightNow attempts to automatically join the second table to the primary 
table using an inner join. Outer joins are not automatically used since inner joins generally 
meet the requirements of the report and are easier for a database to process than outer joins.

The join type that is used can impact what records the report can return. An inner join 
returns only records from the primary table that are related to records in the secondary table. 
For example, if contacts is the primary table and incidents is the secondary table, an inner join 
will return only contacts that have incidents associated with them. A contact that had never 
submitted an incident could not be returned by the report. However, if the tables were joined 
with an outer join, all contacts from the primary table could be returned, even if they did not 
have associated incidents in the secondary table.

Given that RightNow automatically adds tables to the report when you add a field from the 
table, the order in which you add fields to the report impacts what records the report can 
return. For example, if you add a field from the incidents table and then a field from the contacts 
table to a report, you can only report on contacts that have incidents associated with them, 
since incidents is the primary table and contacts is the secondary table. Because of this, you 
should generally add a field from the table in which you are most interested in first. Thus, if 
your report’s purpose is primarily to output information about contacts, a field from the con-
tacts table should be added as a column before fields from other tables.

Manually adding tables
When you add output columns or filters, RightNow automatically adds the appropriate data-
base tables to the report. However, you can also manually add the tables you want in the 
report.

Caution To ensure report queries are efficient, manually adding tables to a report should 
only be performed by individuals with a thorough understanding of SQL que-
ries.
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To manually add tables to a report:
1 Delete all columns and filters from an existing report, or start with a report with no col-

umns.

2 Click the Home tab.

3 Click the Tables button. When a report has no tables, the Data Set window will display, as 
shown in Figure 153.

Figure 153: Data Set Window with No Tables

4 Click Select Table.

Figure 154: Select Table Window

5 Select the table you want from the Select Table window.

6 Click the OK button to add the table to the report.

7 To join additional tables to the table you added, right-click the table you added, select Join 
To, and select the table to join. Repeat this step for each table you want to add.
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Defining table relationships when adding columns
When you add fields from different tables to the same report, the tables will be joined by their 
fields that are linked together in the database. Many tables, such as incidents and contacts, are tied 
together with one field in each table (specifically the incidents.c_id field ties to the contacts.c_id 
field). Since there is only one way to link these tables together, RightNow can do so automat-
ically when you add fields from these tables to a report.

However, other tables can be joined through more than one field. For example, incidents can 
link to accounts through three fields in the incidents table. In this instance, RightNow does not 
automatically create the table link since there are multiple options, so you must define which 
field should be used to tie the tables together in the report. This is done using the Select Join 
window, shown in Figure 155 on page 294, which automatically opens when you add fields 
from tables such as this to the same report.

Figure 155: Select Join Window

The Select Join window also appears if your report already has fields from two tables and you 
add a field from a third table that can be related to either of the tables already in the report. In 
this case, you must define which table the new table should be joined to, since different data 
can be returned by joining different tables. By default, the new table will be joined to the pri-
mary table in the report using an inner join.

An example that illustrates both cases is if your report includes the incidents and contacts tables, 
and you then add a field from the accounts table. The accounts table can link to the incidents table 
through three incident fields and can link to the contacts table through one contact field. In this 
instance, you would be asked if the accounts table should link to incidents or contacts, and, if it is 
the incidents table, which field in the incidents table should be used as the link.
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To define the table relationship:
1 To accept the default table relationship that is displayed, click the OK button.

2 To define which tables should be linked, select the radio button next to the table that the 
new table should join to.

a If the new table can link to the selected table by more than one field, select the correct 
field from the drop-down menu that displays next to the table’s radio button.
The field you join the new table to should be associated with the information you want 
to output in the report. For example, if you are joining the accounts table to the incidents 
table, select the incidents.created_by => accounts.acct_id option to output information about 
the staff member who originally created the incident. If you instead want to output 
information about the staff member the incident is assigned to, select the inci-
dents.assgn_acct_id => accounts.acct_id option.

3 To prevent the Select Join window from displaying again when editing the current report, 
select the Do Not Show This Dialog Again check box. If you then add another field that 
requires defining a table relationship, you will need to define the relationship from the 
Data Set window.

4 To not define any table relationship, click the Cancel button.

5 Click the OK button to save the table relationship.

Defining intermediate table joins
If your report uses data from tables that are not directly linked together in the database, you 
may need to choose how you want to link the tables together when you create your report. 
Tables that are not directly linked together in the database can still be joined by going through 
intermediate tables that are common to both.

Important If you click the Cancel button, the field you added will still be added to the 
report output, and the new table will be added to the report as another primary 
table. However, there will be no relationship between this table and the other 
tables in the report until you manually define the relationship from the Data Set 
window. You will not be able to save the report until this relationship is defined. 
Refer to “Changing table relationships” on page 297 for information about the 
Data Set window.

Note Most reports should not require intermediate table joins.
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To define intermediate table joins:
1 Add a column or filter to the report that requires an intermediate table join. The Select 

Intermediate Table and Join window, shown in Figure 156, opens.

Figure 156: Defining Intermediate Table Joins

2 In the Join From column, select the radio button next to the table you want to join the new 
table to.

3 In the Intermediate Table column, select the radio button next to the table you want to use 
as the intermediate table to join the new table with the table selected in the Join From col-
umn.

4 In the First Join column, click the drop-down menu and select the fields you want to join 
from the intermediate table and the table selected in the Join From column.

5 In the Second Join column, click the drop-down menu and select the fields you want to 
join from the intermediate table and the new table you are adding. The join tree you define 
is displayed on the window.

6 To prevent the Select Intermediate Table and Join window from displaying again when 
editing the current report, select the Do Not Show This Dialog Again check box. If you 
then add another field that requires defining an intermediate table relationship, you will 
need to define the relationship from the Data Set window.

7 Click the OK button to save the intermediate table join.
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Changing table relationships
If you create a report that returns data from multiple tables and find that the data you want is 
not being returned, you may need to change the relationships of the report’s tables. You can 
change the order of the tables, the join types connecting the tables, and the specific fields that 
are linked together in the tables. You can also delete tables that are no longer needed in the 
report.

Editing data set properties
You can easily edit your report’s data set to change the tables’ join types. In addition, if the 
tables can be linked by more than one field, you can select a new field to link to.

To change the table join and linked fields:
1 Click the Home tab.

2 Click the Tables button to open the Data Set window.

Figure 157: Data Set Window Showing Contacts Inner Joined to Incidents

3 Click the table that is joined to the primary table. In the example shown in Figure 157, the 
contacts table is joined to the incidents table, which is the parent in the table relationship.

Note When you open the Data Set window, you will see the tables in your report and 
their relationships. When two tables are inner joined,  displays next to the sec-
ondary table;  displays next to the secondary table of two tables that are outer 
joined.
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4 Enter field information described in Table 86.

Table 86: Data Set Window Description

Field Description

Table This field displays the database name of the table you have 
selected.

Delete Table Click this text to remove the table you have selected from the 
report. If the table acts as a parent to other tables in the report, the 
child tables will also be removed.
Note: Columns will not be automatically removed from the report 
when their associated tables are deleted. These will need to be 
manually removed before the report can be saved.

Alias This field displays the alias name of the table you have selected. 
The alias allows you to add multiple instances of the same database 
table to the same report. For example, the first instance of the con-
tacts table could have an alias of “contacts,” and the second 
instance could have an alias of “contacts2” to distinguish it from 
the first instance.

Join To This field displays the table the selected table is joined to.

Join Condition If the table join can link to more than one field in the joined tables, 
click this drop-down menu to select the fields you want to use to 
join the tables.

Join Type Select the Inner radio button to use an inner join or the Outer 
radio button to use an outer join.
Note: To change the join type, you can also right-click the joined 
table in the data set tree and select Toggle Join Type.

Join Filters You can add, delete, or view join filters in this section. Refer to 
“Creating join filters” on page 324 for information about adding 
join filters.
Note: Join filters apply only to outer joins and are not available if 
the Inner join type radio button is selected.
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Repositioning tables in the data set
Since the ordering of tables can affect what data the report can return, you can change the 
primary tables and change the relationships between secondary tables in the data set.

To change the ordering of tables:
1 Open the Data Set window, shown in Figure 157 on page 297.

2 To select a different table in the data set as the primary table, right-click the table and select 
Set as Root.

3 To move a table beneath another to make it a secondary table, drag the table onto the pri-
mary table. The tables will automatically be joined, and the new table relationship will be 
displayed on the Data Set window.

Adding and editing charts
You can add charts to your reports to provide the audience with graphical representations of 
the report’s data. Using charts, you can clearly compare data or highlight trends or patterns in 
the data. For example, a pie chart could show comparisons in the number of incidents 
assigned to staff accounts in the previous week, or you could use a bar chart to view patterns 
in sales opportunities generated during the previous quarter. An example of a chart displayed 
in a report is shown in Figure 158.

Note When you set a new table as the root, or primary table, the relationship between 
the table and the old primary table will be broken, resulting in the data set hav-
ing two primary tables.
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Figure 158: Incident Trend Report with a Chart

Adding charts to reports
You can manually add charts to reports, or you can use a chart table layout to automatically 
add generic charts with preconfigured positions. You can edit charts with the Chart Wizard, 
which lets you select the chart type (for example, line, bar, pie, or gauge), the data used in the 
chart, labels for the chart, and other settings. You can change the appearance of your chart by 
selecting a chart style created from the Chart Style explorer, or you can define custom style 
attributes for an individual chart by selecting from style options on the ribbon. You can also 
edit display attributes for the report’s chart section, which contains the charts you add to your 
report.

Tip Each report level can have a maximum of twenty charts.
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Adding charts manually
When you manually add a chart to a report, you can define all the chart elements, determine 
how the chart should be sized, and where it should be located in the report. This section 
describes how to add a chart and how to manually configure the chart’s placement in the 
report.

To manually add a chart:
1 If your report has multiple output levels, select the level you want to add the chart to from 

the Level drop-down menu at the top of the design surface.

2 Click the Insert tab. Buttons for the types of charts you can add to the report are displayed 
on the tab’s Chart group.

3 Click the button for the chart type you want to add and select the chart subtype you want 
to add to your report. Refer to Table 87 on page 304 for descriptions of the available chart 
types.

4 Click the Charts report section to add the chart to the report. The Chart Wizard opens.

5 Configure the chart and select a chart style with the Chart Wizard. Refer to “Using the 
Chart Wizard” on page 303 for information about configuring charts.

6 Apply any custom style attributes you want for the chart from the ribbon’s Design, Layout, 
and Format tabs. For information about the options available on these tabs, refer to their 
descriptions in “Creating and editing chart styles” on page 35.

7 To enable automatic positioning and sizing for your chart, edit style options for the chart’s 
report section. Refer to “Modifying chart placement and sizing” on page 312.

8 Repeat steps 1 through 6 to add additional charts to your report.

Note This procedure describes adding charts using the buttons on the Insert tab. You 
can also add charts by selecting the Charts report section, clicking the Options 
tab, and clicking the Add Chart button to open the Chart Wizard. Refer to 
“Using the Chart Wizard” on page 303.
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Adding charts with chart table layouts
If you do not want to manually place charts in your report, you can easily add one or more 
charts with chart table layouts. When you use a layout, charts are automatically added to your 
report and are given the most optimal placement. In addition, the charts will be automatically 
sized in your report. For information about automatic placement and sizing of charts, refer to 
“Modifying chart placement and sizing” on page 312.

To add charts using chart layouts:
1 If the Charts report section is not displayed on the report level, click the Display tab and 

select the Charts check box.

2 Click the Charts report section on the design surface to select it.

3 Click the Automatic button on the Options tab to apply automatic formatting to the 
report section. Refer to “Editing section layout properties” on page 224 for a description 
of section layouts.

4 Click the Layouts button to view chart section layouts.

Figure 159: Selecting a Chart Layout

5 Click one of the table layouts to apply it to the current output level. The table layout you 
select will determine how many blank charts are added to your report and how they are 
arranged.
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6 Right-click a blank chart on the design surface and select Edit Chart to configure the chart 
with the Chart Wizard. Refer to “Using the Chart Wizard” on page 303 for information 
configuring charts.

Or

Select a chart on the design surface.

a Click the Design tab.
b Click the Type button and select the chart type and subtype you want to use.

The wizard will open automatically if the new chart type requires different source data 
than the previous chart type.

c To change data options for a chart type that does not require different source data, click 
the Define Data Source button to manually open the Chart Wizard.

Using the Chart Wizard
The Chart Wizard displays a series of windows for customizing charts. The first window 
(shown in Figure 160) displays the list of available chart types and subtypes. Each successive 
window contains additional options for customizing your chart. The available options on each 
succeeding window will vary depending on the chart type and subtype selected. The options 
that differ are noted in the procedure.

To add or edit a chart with the Chart Wizard:
1 Add or edit a chart to open the Chart Wizard.

Figure 160: Chart Wizard
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2 Select the chart type you want from the Chart Type menu. Refer to Table 87 for descrip-
tions of the available chart types.

Table 87: Chart Types Description

Chart Type Description

 

Vertical bar charts display data as a series of vertical bars. Subtype 
options can display the chart with single or stacked bars and as 
two- or three-dimensional.

Horizontal bar charts display data as a series of horizontal bars. 
Subtype options can display the chart with single or stacked bars 
and as two- or three-dimensional.

Pie charts display data as a percentage of a whole. Subtype options 
can display two- or three-dimensional pie charts or doughnut 
charts.

Line charts display data as a series of points connected by a line. 
Subtype options can display the chart as two- or three-dimensional.

Line/bar combo charts display both a line chart and a vertical bar 
chart. Subtype options can display the chart with single or stacked 
bars and as two- or three-dimensional.

Area charts display data as areas on an x- and y-axis. Subtype 
options can display the chart as two- or three-dimensional.

X-Y charts display data as a series of plotted points. Subtype 
options can display the plotted points as points, lines, or bubbles 
and as two- or three-dimensional.

Radar charts display data in a radar format. Numeric values are 
plotted at markers on the perimeter.
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3 Select one of the chart subtypes from the Chart Subtype section.

4 Click the Next button to open the Source Data window.

 

Stock charts display the minimum and maximum values for data. 
Subtype options can display the chart using squares or lines to rep-
resent the high and low points of each plot.

Pareto charts display data in descending order with an ascending 
plot line for cumulative percentage. Subtype options can display 
the chart as two- or three-dimensional.

Gauge charts display a numeric value as a percentage of a whole. 
Subtype options can display the chart as a gradation bar or a simple 
color meter.
Note: Gauge charts cannot be used in reports that contain non-
aggregate columns.

Funnel charts display data as areas shown in ascending or descend-
ing order. Subtype options can display two- or three-dimensional 
funnel or pyramid charts.

Gantt charts display time lines for completion of scheduled tasks. 
Subtype options can display the chart as two- or three-dimensional.

Table 87: Chart Types Description (Continued)

Chart Type Description
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Figure 161: Selecting Source Data for a Vertical Bar Chart

The source data options let you specify the data to display in the chart. For example, if you 
are creating a vertical bar chart, you can specify a column to use as the chart’s category 
value, displaying on the x-axis, and the column to use as the chart’s series value, displaying 
on the y-axis. The wizard also displays a sample chart to help you identify chart elements.

5 Enter field information described in Table 88. 

Table 88: Select Source Data Description

Field Description

Available Columns This field displays the columns you have added to the report level that 
can be used in the chart.
Note: If you have not yet added columns to the report, you can click 
this area to open the Column Definition window. Refer to “To add a 
column from the Column Definition window:” on page 253 for infor-
mation about the Column Definition window.

Add Column Click this text to open the Column Definition window to add a column 
to your report level. This option provides a method to add columns if 
your report level does not have any columns or does not include a col-
umn you want to use for your chart. Refer to “To add a column from 
the Column Definition window:” on page 253 for information about 
the Column Definition window.
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Add a Column for the 
Category Value

Drag one or more columns from Available Columns to this grid to use 
the column(s) as categories in your chart. To remove a column, drag it 
back to the Available Columns section or select the column and press 
Delete.
Note: This option is not available for Pie, Gauge, and Funnel charts.

 Up Arrow Select a column and then click this button to move the column up one 
position.

 Down Arrow Select a column and then click this button to move the column down 
one position.

Add One or More 
Series

Drag one or more columns from Available Columns to this grid to use 
the column(s) as series in your chart. To remove a column, drag it back 
to the Available Columns section or select the column and press 
Delete. Only numeric columns can be used as series.
Note: This option is not available for Gauge and Line/Bar Combo 
charts.

 Up Arrow Select a column and then click this button to move the column up one 
position.

 Down Arrow Select a column and then click this button to move the column down 
one position.

Define Series This section allows you to manually choose the output columns or col-
umn values to use for the series.
Note: This section is not available for Pie, Line/Bar Combo, X-Y, 
Stock, Pareto, Gauge, and Funnel chart types.

By Manually 
Selecting from 
Available Columns

Select this radio button to manually select the columns used as values in 
the chart. For example, if you were reporting on incident statistics for 
different products, you could define the category as “Products” and the 
series as “Unresolved Incidents” and “Solved Incidents.” The category 
axis would display each product and the value axis would display a list 
of values. Each product would have two bars: one for unresolved inci-
dents and one for solved incidents.

Table 88: Select Source Data Description (Continued)

Field Description
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Using Values From Select this radio button to choose the output column that RightNow 
should automatically use for values. For example, if you were reporting 
on incident statistics for different products and assigned to different 
groups, you could define the category as “Products” and the series as 
“Unresolved Incidents.” If you selected groups from the drop-down 
menu associated with this radio button, each group would be used as a 
bar chart for each product. The category axis would display each prod-
uct and the value axis would display a list of values (unresolved inci-
dents). Each product would have bars for each group.

Get Labels From Drag one or more columns from Available Columns to this grid to use 
the column(s) as labels in your chart. Labels represent each piece of the 
pie. To remove a column, drag it back to the Available Columns section 
or select the column and press Delete.
Note: This option is available only for Pie and Funnel charts.

Add Line Series Drag one or more columns from Available Columns to this grid to use 
the column(s) as the line series in your chart. To remove a column, drag 
it back to the Available Columns section or select the column and press 
Delete. Only numeric columns can be used as series.
Note: This option is available only for Line/Bar Combo charts.

Add Bar Series Drag one or more columns from Available Columns to this grid to use 
the column(s) as the bar series in your chart. To remove a column, drag 
it back to the Available Columns section or select the column and press 
Delete. Only numeric columns can be used as series.
Note: This option is available only for Line/Bar Combo charts.

Select Gauge Series Drag one or more columns from Available Columns to this grid to use 
the column(s) as series in your chart. To remove a column, drag it back 
to the Available Columns section or select the column and press 
Delete. Only numeric columns can be used as series.
Note: This option is available only for Gauge charts.

Select Line Series Drag one or more columns from Available Columns to this grid to use 
the column(s) as the line series in your chart. To remove a column, drag 
it back to the Available Columns section or select the column and press 
Delete. Only numeric columns can be used as series.
Note: This option is available only for X-Y charts with a combo sub-
type.

Table 88: Select Source Data Description (Continued)

Field Description
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6 Click the Next button to define general chart settings.

Add Bubble Series Drag one or more columns from Available Columns to this grid to use 
the column(s) as the bubble series in your chart. To remove a column, 
drag it back to the Available Columns section or select the column and 
press Delete. Only numeric columns can be used as series.
Note: This option is available only for X-Y charts with bubble or 
combo subtypes.

Add Bubble Values Drag one or more columns from Available Columns to this grid to use 
the column(s) as bubble values in your chart. To remove a column, drag 
it back to the Available Columns section or select the column and press 
Delete.
Note: This option is available only for X-Y charts with bubble or 
combo subtypes.

Category Axis Series Select a column to use as the category for the chart from this drop-
down menu.
Note: This option is available only for Gantt charts.

Select Progress Series Select a column to use as the progress series for the chart from this 
drop-down menu. Only integer columns can be selected for the 
progress series.
Note: This option is available only for Gantt charts.

Select Start Date 
Series

Select a column to define the start date series from this drop-down 
menu. Only date columns can be selected for the start date series.
Note: This option is available only for Gantt charts.

Select End Date Series Select a column to define the end date series from this drop-down 
menu. Only date columns can be selected for the start date series.
Note: This option is available only for Gantt charts.

Table 88: Select Source Data Description (Continued)

Field Description
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Figure 162: General Chart Settings

7 Enter field information described in Table 89.

Table 89: General Chart Settings Description

Field Description

Chart Title Type the title of the chart in this text box.

Category Axis Label Type the label of the category axis in this text box.
Note: This option is not available for Pie, Radar, Gauge, or Funnel 
charts.

Value Axis Label Type the label of the value axis in this text box.
Note: This option is not available for Pie, Line/Bar Combo, Radar, 
Gauge, or Funnel charts.

Bar Value Axis Label Type the label for the chart’s bar value.
Note: This option is available only for Line/Bar Combo charts.

Line Value Axis Label Type the label for the chart’s line value.
Note: This option is available only for Line/Bar Combo charts.

Sync Bar Line Scales Select this check box to use the same range for the chart’s bar and line 
scales.
Note: This option is available only for Line/Bar Combo charts.
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Chart Style Click the underlined text to select a chart style for the chart. The chart 
style you select will be reflected on the sample chart displayed on the 
Chart Wizard.
Note: Once you apply a chart style, you can customize the style options 
for the chart you are editing using options on the ribbon’s Design, Lay-
out, and Format tabs. Refer to “Chart Styles explorer” on page 33 for 
procedures on creating and editing chart styles options.

Scale Specify the scale used by the chart in this section.
Note: This option is not available for Pie, Radar, or Funnel charts.

Default Select this radio button to use the scale values specified in the selected 
chart style.

Custom Select this radio button to define a custom scale for the chart. For 
example, if the values listed in a chart range from 10 to 50, you can cre-
ate a custom scale to use these values as the scale’s start and end points 
to prevent the chart from displaying ranges with no data.

Scale Start Enter the starting value (lowest value) for the chart’s scale.
Note: This option is enabled only when defining a custom scale.

Scale End Enter the ending value (highest value) for the chart’s scale.
Note: This option is enabled only when defining a custom scale.

Gauge Color Ranges Add color ranges and define range colors in this section. Color ranges 
can be used to display numeric ranges in different colors. For example, 
a range of 0-33 could be green, 34-65 could be yellow, and 66-100 could 
be red.
Note: This option is available only for Gauge charts.

Add Range Click this text to add a color range.
Note: A maximum of five ranges can be shown on the gauge. The 
range values cannot contain gaps or overlap.

Remove Range Click this text to remove a range you have added.

Minimum Enter the starting value for the range.

Maximum Enter the ending value for the range.

Start Color Click the color box to select a start color for the range.

Table 89: General Chart Settings Description (Continued)

Field Description
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8 Click the Finish button to save your chart.

You can edit or delete any chart you add by right-clicking the chart on the design surface and 
selecting the appropriate option. You can also click the chart on the design surface and edit 
the chart with options available on the Design, Layout, and Format tabs. Refer to “Creating 
and editing chart styles” on page 35 for information about the options on these tabs.

Modifying chart placement and sizing
The Charts report section can be configured to use automatic or manual section layouts, 
described in “Editing section layout properties” on page 224. Each type of layout for the 
report section will affect the display of data in your charts.

When the Charts section has a manual layout, you can select a chart on the report section and 
drag it to reposition it. You can also select a chart and drag the handles on the chart’s outline 
to resize the chart. When you specify a specific chart size using a manual layout, the data dis-
played on the chart is adjusted to fit the chart. Thus, a large chart displaying a small amount of 
data may appear too large. Also, a small chart displaying a large amount of data can be diffi-
cult to read since the data is compressed to fit the chart.

However, when using an automatic section layout, charts you add will be automatically sized 
to best display the data initially presented in the charts. In addition, when you adjust the 
report’s search parameters, the charts will be automatically resized to ensure that all the data is 
clearly displayed. For example, if your chart shows incidents created over a date interval, and 
the report’s interval is adjusted to a longer period, the chart will automatically expand to 
clearly display all the additional intervals shown in the report. 

Specifying filters
Filters are added to a report to limit the data the report will return. If filters were not used, a 
report that included information from a certain table would always return all the records in 
that table. Some filters set hard limits as to what the report can return and other filters can be 
changed when you run the report so you can look at different records. Filters also help 
improve report performance by preventing the report from examining data you do not want 
included in the report.

End Color Click the color box to select an end color for the range.

Table 89: General Chart Settings Description (Continued)

Field Description
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You can restrict the data returned in a report using the following filters.

• Report fixed filters—Fixed filters restrict the data the report can access. Fixed filters 
cannot be changed or edited when the report is run. Refer to “Creating report filters” 
on page 313.

• Report run-time selectable filters—Run-time filter values can be changed from their 
default values when running a report. This lets you run the report to view data about 
records that share the values selected in the filter and then immediately run the report 
again with different values selected in the filter. Refer to “Creating report filters” on 
page 313.

• Level filters—Level filters are fixed or run-time selectable filters that limit data at the 
individual output levels. Level filters can restrict data from appearing in one level, while 
allowing it to be returned in other levels in the same report. Refer to “Creating level fil-
ters” on page 315.

• Group filters—Group filters are applied to an output level’s grouped data to filter out 
certain groups from displaying in the report level’s output. Refer to “Creating group fil-
ters” on page 316.

• Join filters—Join filters restrict data returned in the secondary table of outer table 
joins. Refer to “Creating join filters” on page 324.

Creating report filters 
Report filters limit the data that can be returned in any level of the report. Report filters can 
be fixed or run-time selectable. These filters are similar in that both restrict the data that is 
returned in the report according to what the filter allows and are created in the same way. 
However, run-time filters can be changed when the report is run, whereas fixed filters cannot. 
Run-time filters values can be changed by anyone viewing the report, either from the Search 
window or from docked filters, to return different data each time someone runs the report. 
Fixed filter values cannot be changed when the report is run, which allows you to restrict the 
data that report users can view.

To create a fixed or run-time selectable report filter:
1 Click the Home tab.

2 Click the Add Filter button.

Tip Each report can have up to one hundred report filters and each output level in a 
report can have one hundred level filters and one hundred group filters.
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Figure 163: Add Filter Window

3 Enter field information described in Table 90.

Table 90: Add Filter Window Description

Field Description

Name Type a name for the filter in this field. The name identifies the filter 
on the report design center but does not display when the report is 
run. Entering a value for this field is optional. If a name is not 
entered, the name will default to the name of the filter’s database 
field.

Make This Filter 
Selectable at Run-time

Select this check box to make the field a run-time selectable filter. 
If this check box is cleared, the filter will be a fixed filter.

Label This Filter x in 
Search Box

Type a label for the filter in this text field. This label will display on 
the Search window when the report is run.

Required Select this check box to require the report’s user to enter a value 
for the filter when running the report. If this option is selected, the 
Search window will open automatically when the report is opened 
and the filter’s value must be specified before results are returned.
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4 Click the OK button to save the filter.

Creating level filters
Level filters are similar to the filters that are applied to the main report. However, while report 
filters are applied to the report as a whole, restricting the data that is returned at any level in 
the report, level filters are applied to individual output levels and only restrict the data 
returned at the level where they are created. If the report has multiple output levels, the other 
levels are not subject to the level filters applied to other levels in the report.

Expression* Type the expression or right-click in this field and select the 
expression in this column. For descriptions of the table columns 
and functions you can select, refer to “Adding columns to a 
report” on page 253.
Note: If you start to type an entry in the Expression field, a win-
dow will display, showing you a list of database tables that begin 
with the letters you type. You can either continue typing the 
expression or select a table and field from the window.

Use Data Dictionary Click this text to open a window containing the data dictionary tree 
where you can select fields and functions for the expression.
Note: Variables you have added to the report are not available for 
use in report, level, or group filters, and will not appear in the data 
dictionary when creating these filters.

Operator Select the operator to use with the expression. The list of available 
operators will vary depending on the type of field used in the 
expression. Refer to Table 91 on page 317 for a description of the 
available operators.

Value Enter the value for the filter. If you are creating a run-time filter, 
this value will be the filter’s default value which can be changed 
when the report is run. If you are creating a fixed filter, this is the 
filter value the report will use when it is run.
Note: The available options in the Value field will change depend-
ing on the type of field and the operator you select. For example, a 
menu field’s values will display in a drop-down menu, whereas a 
date field’s values will display date and time options. Text area 
fields are not available for use in report filters.

Table 90: Add Filter Window Description (Continued)

Field Description
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To create a level filter:
1 Select the level you want to add the filter to from the Level drop-down menu at the top of 

the design surface.

2 Click the Level tab.

3 Click the Add Level Filter button. The Add Filter window, shown in Figure 163 on page 
314, opens.

4 Enter field information described in Table 90 on page 314.

5 Click the OK button.

Creating group filters
Group filters can be used in output levels with grouped data to prevent rows with a certain 
number of grouped items from displaying. For example, an output level that returns rows 
showing the number of unresolved incidents for each staff member could have a group filter 
to display only rows for staff members with more than ten unresolved incidents. Group filters 
can be fixed or run-time selectable.

To create a group filter:
1 Select the level you want to add the filter to from the Level drop-down menu at the top of 

the design surface.

2 Click the Level tab.

3 Click the Add Group Filter button. The Add Filter window, shown in Figure 163 on page 
314, opens.

4 Enter field information described in Table 90 on page 314.

5 Click the OK button.

Important The filter options for group filters are identical to those for filters applied to the 
overall report. However, you will generally want group filters to filter on the 
results in the output level’s aggregate column. For example, if the aggregate col-
umn in your report counts the number of unresolved incidents a staff member 
has with count(incidents.i_id), then the group filter’s expression could be count(inci-
dents.i_id) > 10, to return rows for staff members with more than ten incidents.
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Selecting filter operators
The operator you select when creating filters will greatly impact the data that is returned, so it 
is important to understand the functionality of each operator. The types of operators available 
for a filter depend on the data type of the filter’s expression. Table 91 describes all available 
operators.

Table 91: Filter Operators Description

Operator Description

equals The expression matches the value exactly, including case.

not equals (exclude No 
Value)

The expression does not match the value exactly, including case. 
This operator excludes any values of No Value (Null). For example, 
a report with a filter of field X not equals (exclude No 
Value) Y will not return any records with a value of Y or No 
Value in field X.

not equals (include No 
Value)

The expression does not exactly match the value, or is No Value 
(Null). For example, a report with a filter of field X not 
equals (include No Value) Y will not return records with a 
value of Y, but will return records with a value of No Value.

less than The expression is less than the value.

less than or equals The expression is less than or equal to the value.

greater than The expression is greater than the value.

greater than or equals The expression is greater than or equal to the value.

between The expression is between two specified values. The between oper-
ator is available to use with date, currency, and numeric (integer 
and float) expressions.
Note: When using this operator with an integer expression, the 
search values that are entered will not be included in the search, but 
the values between them will be.

like The expression matches any part of the value. When using the Like 
operator, you should use the % wildcard symbol to offset your 
value. For example, if you were looking for all fields that contain 
“all,” you should type %all% in the field.
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not like The expression does not match any part of the value. Wildcard 
characters are supported.

not like or null The expression does not match any part of the value, or is a null 
value.

in list The expression values you want to search for are specified by 
selecting check boxes in a menu. The selected options are displayed 
in a separate Selected Items list to assist you when selecting from 
menus with a large number of options.
Note: When using this operator with integer fields, the numbers in 
the Value field must be comma-separated. When using this opera-
tor with text fields, the text strings in the Value field must be 
comma-separated and each text string must be offset by single 
quotes. For example, ‘red’,’green’,’orange’.

not in list The expression values you do not want to search for are specified 
by selecting check boxes in a menu. The selected options are dis-
played in a separate Selected Items list to assist you when selecting 
from menus with a large number of options. This operator is avail-
able only with menu field expressions.
Note: When using this operator with integer fields, the numbers in 
the Value field must be comma-separated. When using this opera-
tor with text fields, the text strings in the Value field must be 
comma-separated and each text string must be offset by single 
quotes. For example, ‘red’,’green’,’orange’.

is null The expression has a null value.
Note: This operator is not available in run-time selectable filters.

is not null The expression does not have a null value.
Note: This operator is not available in run-time selectable filters.

complex expression The expression matches the complex expression in the value. The 
Complex Expression operator is available only with text field 
expressions. Refer to the RightNow Administrator Manual for infor-
mation about complex expressions.

Table 91: Filter Operators Description (Continued)

Operator Description
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Defining logical expressions
When you add multiple fixed or run-time filters at the same level in a report, the filters are 
automatically joined together with a logical expression. This defines how the filters should 
work together to return data. By default, the logical expression uses Boolean AND logic 
rather than OR logic. Thus, if you have a filter of incidents.status_id = Solved and a filter of inci-
dents.queue_id = Queue A, the logical expression will be incidents.status_id = Solved AND inci-
dents.queue_id = Queue A. This expression would result in the report returning only solved 
incidents that are in Queue A.

If the default logical expression does not suit your needs, you can modify the expression from 
the Edit Logical Expression window. You can also delete, edit, and add filters from this win-
dow if you decide your existing filters need to be changed while editing the logical expression. 
Report filters, level filters, and group filters are joined with separate logical expressions, 
though each expression is edited in the same manner.

To edit a logical expression:
1 Open the Edit Logical Expression window for the report filters, level filters, or group fil-

ters, depending on the type of filters you want to change the expression for.

a To open the Edit Logical Expression window for report filters, click the Home tab and 
click the Filters button.

b To open the Edit Logical Expression window for level filters or group filters, select the 
report level you want from the Level drop-down menu at the top of the design surface. 
Click the Level tab and then click the Level Filters or Group Filters button.

not complex expression The expression does not match the complex expression in the 
value. The Not Complex Expression operator is available only with 
text field expressions. Refer to the RightNow Administrator Manual 
for information about complex expressions.

Table 91: Filter Operators Description (Continued)

Operator Description
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Figure 164: Edit Logical Expression Window

When you add filters, they are automatically joined with AND logic and are displayed in an 
AND tree. You will see run-time selectable filters in the tree, along with fixed filters, which 
will have an icon displaying a lock.

2 To add a filter joined with OR logic to the logical expression:

a Click Add OR Node. You will see the node added to the logical expression.
b Click the filter that should be joined with OR logic and drag it to the new OR node.

When you add nodes to the expression, the nodes are displayed in a tree structure, with fil-
ters displayed either under an AND node or an OR node. Filters under the same AND 
node are joined to each other using AND logic. Filters under the same OR node are joined 
to each other using OR logic.

3 To negate a filter, select the filter and click Negate Filter. To negate a node in the expres-
sion, select the node and click Negate Expression.

A negated filter or node will display on the Edit Logical Expression window with an excla-
mation mark. Negated filters and nodes add NOT logic to the filter. For example, if your 
filter is incidents.status_id=Solved and you negate the filter, the filter will become inci-
dents.status_id NOT= Solved.

4 To add a new filter, select the node you want to add the filter to and click Add Filter. Refer 
to “Creating report filters” on page 313 for information about adding filters.

5 To edit a filter, select the filter you want to edit and click Edit Filter. Refer to “Creating 
report filters” on page 313 for information about editing filters.

6 To delete a filter, select the filter you want to remove and click Delete Filter.
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7 To display the filters’ field definitions rather than their names, click Display Filter Descrip-
tions. The Edit Logical Expression window will be updated to display the filters’ defini-
tions. To display the filters’ names again, click Display Filter Names.

8 To view a text definition of the current filters’ logical expression, click View Text Defini-
tion. A sample text definition is shown in Figure 165.

Figure 165: Text Definition Window

9 Click the OK button to close the Text Definition window.

10 Click the OK button on the Edit Logical Expression window to save the logical expres-
sion.

Combining run-time selectable filters
When your report includes multiple run-time selectable filters that expect the same type of 
search input, you can combine the filters to display a single search field on the report’s Search 
window or docked filters. This lets report users enter one search value to search by two or 
more filters simultaneously. For example, you could have one search field to search by con-
tacts’ first names, last names, and organizations’ names.

Run-time selectable filters that have the same data type, operator, and search options, such as 
items in a menu field, can be combined. You can combine multiple report filters and multiple 
level filters, though you cannot combine report filters with level filters.
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To combine run-time selectable filters:
1 Create a run-time selectable filter. Refer to “Creating report filters” on page 313 for infor-

mation about creating filters.

2 Create a second run-time selectable filter.

Docking variables and run-time selectable filters
When you open a report or output level with variables or run-time selectable filters, you can 
select the variables’ or filters’ values from one of three locations:

• If variables or run-time filters are required, the Search window will automatically open 
when the report is opened and you must enter values for the variables or filters.

• If run-time filters are present, but not required, you can click the Search button on the 
report’s Home tab to open the Search window. Refer to “Opening reports” on page 68 
for information.

• If variables or run-time selectable report or level filters are added to an output level’s 
docked filters, you will be able to select variable and filter values at the top of the report. 
Docked filters in a sample report are shown in Figure 166.

Figure 166: Docked Filters in a Report

Important This filter must have the same name as the other filter you are combining. In 
addition, the two filters must use the same operator and must be of the same 
data type. For example, you can combine two integer fields, but you cannot 
combine an integer field with a menu field.
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To add variables or run-time filters to an output level’s docked filters:
1 Click the Home tab.

2 Click the arrow on the Views button and select Data Set View. Figure 100 on page 180 
shows the list of variables and report filters on the design surface when using the data set 
view.

3 Click a filter or variable on the design surface.

4 Click the Design tab.

5 Select the Display in Docked Filters check box.

When you run your report or view it using a different view, you will see the filters and vari-
ables you selected at the top of the report in the Docked Filters report section.

Changing filter and variable display order
The Search window you use to search for information in reports displays the report’s vari-
ables and run-time filters grouped by the type of input field they use. For instance, text fields 
are grouped together, menu fields are grouped together, and date fields are grouped together. 
The contents of each group are further arranged according to the operators used by each field 
in the group. If you have several filters that use the same operators in each group, you can 
organize them to ensure that your most important fields are listed before less important fields 
within each group. Changing the display order does not affect the logical expressions deter-
mining the logic the filters use, so you can easily change the display without impacting the 
report’s results.

To change filter and variable display order:
1 Add multiple variables or run-time selectable filters to your report or to an output level.

2 Click the Home tab.

Tip Using the data set view, you can see every filter and variable in your report, and 
you can select them on the design surface for editing.

Tip You can double-click docked filters and variables shown on the design surface to 
open them for editing.
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3 Click the arrow on the Views button and select Data Set View. The design surface changes 
to the data set view where you can see the variables and run-time selectable filters that will 
be shown on the Search window. Figure 100 on page 180 shows run-time selectable filters 
listed on the design surface when using the data set view.

4 Click the variable or run-time selectable filter you want to move.

5 Click the Design tab.

6 Click the Move Up or Move Down button to move the variable or filter up or down in the 
list.

After you reorder the filters using the data set view, you can view the new ordering by opening 
the report’s Search window.

Creating join filters
You can create join filters to filter data in tables that are joined to the primary table with an 
outer join. Join filters are fixed and cannot be changed when the report is run. Join filters are 
similar to report filters in that they set restrictions on the records that can be returned by the 
report, but they apply to the table join rather than to the data that is returned by the query on 
the database. Join filters limit the data contained in the secondary table of the table join. With-
out join filters, there would be no way to add a report filter to limit returned data from the 
secondary table, while not preventing data from the primary table from being returned.

For example, suppose you want your report to return a list of organizations and the number 
of incidents they have opened before January 1st. You also want to return any organizations 
even if they have not submitted any incidents, so you need to join the incidents table to the orga-
nizations table with an outer join. Using an inner join would prevent organizations that have 
no associated incidents from being returned in the report. You would then add a join filter of 
incidents.created < January 1st. If you also wanted incidents created after March 1st, you would 
add an OR join filter of incidents.created > March 1st to the first filter. Thus, your join filters def-
inition would be incidents.created < January 1st OR incidents.created > March 1st.

The method of adding join filters is similar to that for adding report filters. However, unlike 
report filters, join filters allow you to use either a constant value, as report filters do, or an 
expression you create from the database fields and the functions described in Table 66 on 
page 246.

Note From an SQL perspective, join filters are a condition of the ON clause, whereas 
report filters are a condition of the WHERE clause.
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To create join filters:
1 Click the Home tab while editing a report that has multiple tables.

2 Click the Tables button.

3 Select the table you want to add a join filter to.

4 Click Join Filters. The Data Set window will display the Join Filters section.

Figure 167: Join Filters Section on the Data Set Window

5 Click Add Filter to open the Add Filter window.

Important Join filters are not applicable to tables joined with an inner join. Tables joined 
with an inner join will not have the Join Filters option.
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Figure 168: Adding a Join Filter

6 Enter the expression for the join filter.

Or

Click Use Data Dictionary to open the data dictionary where you can define the filter’s 
expression.

7 To use an expression filter value, select the Expression radio button. The Add Filter win-
dow will display a Value field.

Figure 169: Adding an Expression Join Filter
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8 Enter the expression in the Value field.

Or

Click Use Data Dictionary to open the Edit Expression window, from which you can cre-
ate the value’s expression using database fields, functions, and variables listed in the data 
dictionary.

9 Click the OK button to save the join filter.

Once you add a join filter, the Data Set window will be updated to display the filter, along 
with additional actions, as shown in Figure 170.

Figure 170: Join Filter on the Data Set Window

The additional actions that become available are identical to those used when creating logical 
expressions for report, group, and level filters. These actions allow you to edit your filter, cre-
ate additional filters, add OR logic to the join filters, negate filters, view a text definition of the 
join filters’ logical expression, and toggle between the filters’ descriptions and names. For pro-
cedures on using these actions, refer to “Defining logical expressions” on page 319.

Note Currency fields are not available for use in join filters.
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Adding additional output levels
Once you configure the primary output level in your report, you can add additional output 
levels, also referred to as drill-down levels, that contain details about records in the first level. 
These secondary levels are configured just like the primary output level and are accessed by 
clicking on records in the first level that act as links. You can have multiple drill-down levels in 
your report; these can be linked to from the same output level or from sub-levels of the pri-
mary output level. Refer to “Drilling down in reports” on page 75 for information about 
using drill-down levels when running a report.

When adding drill-down levels to reports, you can group data in one output level and then 
create a drill-down level with more information about the group’s data. You can also create 
comparison periods, graph data trends, and specify data exceptions, and choose to graph your 
data and specify the type of chart used in the report.

For example, you could create a report listing all unresolved incidents in your knowledge base 
grouped by the queue they are associated with. The report’s first output level could display 
every queue and the number of unresolved incidents in the queue. You could then create a 
second output level to display incident details when drilling down on a queue’s name, or on 
the number of unresolved incidents in the queue.

Result grouping
Grouping data in an output level allows you to combine records with similar data into one 
row. Output levels with grouped data often have additional output levels added to them, so 
you can drill down into another output level to view details about the grouped records. When 
you group data, you can order the grouped columns to best suit your needs when you create 
drill-down output levels.

Tip You can also add drill-down functionality to reports by linking reports together. 
Refer to “Linking reports” on page 337.

Tip Each report can have up to fifty output levels.

Important When you add an aggregate column to an output level, grouping will automati-
cally be enabled in the output level. Thus, if you were to add a column with an 
expression of count(incidents.i_id) to an output level to see how many incidents a 
contact has, the output level would automatically be grouped since you are using 
a function to group records together in the column.



Result grouping 329

To enable grouping in an output level:
1 Select the output level you want to edit from the Level drop-down menu at the top of the 

design surface.

2 Click the Level tab.

3 Click the Edit button to open the Level Settings window.

Figure 171: Level Settings Window

4 Select the Group Results check box.

5 Click the OK button.

Changing group ordering
When data is grouped in a level, it is automatically grouped in the order in which the columns 
are listed in the output level. If you add a drill-down level to the output level, you will see that 
the filter options for the drill-down level are listed in this order.

For example, if an output level has columns for Reference #, Subject, and Status Type in that 
order, the output level’s data will also be grouped in that order. If you then add a drill-down 
level and configure the level settings, the options in the Filter drop-down menu would be 
listed in the following order:

• incidents.ref_no

• incidents.ref_no, incidents.subject

• incidents.ref_no, incidents.subject, incidents.status_id
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Group ordering does not affect the rows displayed in the grouped output level. It instead 
affects the ordering of the drill-down filters on the output level that you drill down into. The 
order of the drill-down filters in an output level impacts what records can be viewed when 
drilling down into the level. For example, a drill-down level with incidents.ref_no as the first 
group item in the drill-down filter would have limited usefulness. This is a unique field, so 
multiple incidents cannot be grouped together based on this field.

If incidents.ref_no was the first ordering field for a drill-down level, it would return only infor-
mation related to the particular incident you drilled down on. If you wanted to drill down on 
all incidents grouped by a different field, such as the incidents’ status, you would need to reor-
der the grouping so incidents.status_id is grouped first.

To change group order:
1 Select the Group Results check box on the Level Settings window.

2 Click Change Group Order to open the Define Group Order window. The window will 
populate with the columns included in the output level.

Figure 172: Define Group Order Window

3 Select the field in the list that you want to move.

4 To move the field higher in the list, click the up arrow.

5 To move the field lower in the list, click the down arrow.

6 Click the OK button to save the order.

Note Unique fields contain values that only a single record in the database can have. 
Some examples of unique fields are the Reference #, Contact ID, and Organiza-
tion ID fields. 
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Adding output levels
Once you configure your primary output level, adding a drill-down output level is simple, 
requiring only that you identify the column to filter on and the column(s) to link from in the 
parent output level. By default, the new output level will display the same report sections 
shown on the parent level, such as the charts and data area sections, though you can select dif-
ferent sections to display on the new level from the ribbon. You can add content such as text 
fields, charts, and columns to the new output level just as you did in the primary output level.

To create an additional output level:
1 Select the parent level you want to add the new output level to from the Level drop-down 

menu at the top of the design surface.

2 Click the Level tab.

3 Click the Add Drilldown button to open the Level Settings window with drill-down 
options.

Figure 173: Creating a Drill-Down Level
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4 Enter field information described in Table 92.

Table 92: Level Settings Window Description

Field Description

Name Type the name of the new level in this text box.

Description To add an optional description for the output level, type the 
description you want in this text box. The description will display 
in the level’s Output Descriptions section. Refer to “Adding output 
and search criteria descriptions” on page 231 for information 
about output descriptions.

Group Results This check box will not be used when initially creating new output 
levels. Refer to “Result grouping” on page 328 for information 
about this option.

Drill-Down Settings This section defines the data and the link in the parent output level 
you will use to open the drill-down output level.

Filter Click this drop-down menu to select the output column or col-
umns to use as the filter for the new level. The drill-down filter 
determines the data set that will be displayed in the drill-down 
level.

Link Click this drop-down menu to select the output column that will be 
clicked on to open the drill-down level. You can also select Entire 
Row to open the drill-down level by clicking anywhere on a row in 
the parent output level.

Display Report Level in 
Split Window

Select this check box to open the drill-down output level in a split 
window on the content pane. This will result in the parent output 
level remaining visible in the other part of the content pane.

Window Location When you select the Display Report Level in Split Window check 
box, you can then select the position where the split window 
should open. Click this drop-down menu to select Top, Bottom, 
Left, or Right.

Custom Script This section allows you to create, edit, and remove custom scripts 
to modify the output level’s output. Refer to “Adding custom 
scripts to output levels” on page 335.

Add Click this text to add a custom script to the output level.
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5 Click the OK button to save the output level.

Configuring recursive drill-down levels
You can drill down recursively on hierarchical items (for example, accounts, products, and 
categories). Recursive drill-down allows you to start at specified levels of a hierarchy and 
become more specific at each lower level as you drill down into it. RightNow’s recursive drill-
down feature enables automatic links for hierarchical items so you can access additional levels 
of detail when viewing a report.

You can enable recursive drill-down only for a level that has a hierarchical output column. If 
an output level has a hierarchical output column and you do not enable recursive drill-down 
for the level, then only data for the output column’s first level will be displayed. A level can 
have both regular and recursive drill-down enabled, but the drill-down links cannot be the 
same.

To configure recursive drill-down levels:
1 Create a report output column from a hierarchical item (for example, accounts.hierarchy or 

incidents.prod_hierarchy).

2 Click the Level tab and click the Edit button. The Level Settings window opens with recur-
sive drill-down options.

Edit Click this text to edit an existing custom script.
Note: This option is available only when a custom script has been 
added to the output level.

Remove Click this text to delete an existing custom script.
Note: This option is available only when a custom script has been 
added to the output level.

Table 92: Level Settings Window Description (Continued)

Field Description
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Figure 174: Configuring Recursive Drill-Down

The recursive drill-down feature is automatically enabled. To disable the feature, clear the 
Enable Recursive Drilldown check box.

3 Click the Starting Level drop-down menu and select the starting point for the drill-down 
level. For example, starting level 1 would be the top product in your list of products. Start-
ing level 3 would be three sub-products down from the parent product.

4 Click the Link drop-down menu and select the output column you want as the drill-down 
link in the report. By default, this is the hierarchical item.

5 Click the OK button to save the recursive drill-down settings.
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Adding custom scripts to output levels
You can add custom scripts to your output levels to further manipulate the data in your 
report. For example, a custom script could be used to convert a row of data into a table, 
remove unwanted data, or create a link to another web page.

PHP scripting language must be used when defining a custom script. PHP is a free, open-
source scripting language and interpreter, similar in many ways to JavaScript and Microsoft’s 
VBScript. PHP is a cross-platform alternative to Microsoft’s Active Server Page (ASP) tech-
nology, which runs only on Microsoft’s Windows NT/2000 servers. Like other scripting lan-
guages, PHP allows server-side scripting to be embedded inside client scripting. For 
documentation and information, refer to: http://www.php.net.

To create a custom script:
1 Select the output level you want to add the custom script to from the Level drop-down 

menu at the top of the report design center.

2 Click the Level tab.

3 Click the Custom Scripts button to open the Custom Script editor. If the output level 
already has a custom script, the editor will display the custom script for editing.

Figure 175: Initialization Tab

4 From the Initialization tab, type the script executed before the report is processed. This 
script is executed once when the report starts to process.

Caution You should not attempt to define a custom script unless you are familiar with 
the PHP language and programming concepts.
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5 Click the Headers tab.

Figure 176: Headers Tab

6 Type the script that runs during the start process. This script is called once while passing 
the column headings. The $headers parameter is an array that contains the column headers 
for the report. For example:
Array

(

[0] => Account ID

[1] => Full Name

)

You could manipulate this array by changing, adding, or removing column headers. The 
resulting array will be displayed as column headers in the report.

7 Click the Process tab.

Figure 177: Process Tab
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8 Type the script that runs while the report is generating. This script is called with each row 
passing the row data. The $rows parameter is a nested array, allowing you to return a 
“table” of data rather than just a row. Initially, the $rows parameter contains only data in 
the first row of the table ($rows[0] [$i]). Each data cell contains a val variable that holds 
the value of the data cell. It can also contain a URL variable that contains a link for the 
data cell.

9 Click the Finish tab.

Figure 178: Finish Tab

10 Type the script that runs during the exit process. This script is called after the rows have 
been processed. The Finish script returns data in the $exit_obj variable, which is added to 
the report after each row of the Process script.

11 Click the OK button to apply your custom script to your output level.

12 To remove a custom script, click the Level tab, click the Edit button, and click Remove. 
Click Yes at the removal confirmation.

Linking reports
Just as you can drill down into different levels within a report, you can also drill down into 
another report or dashboard using report linking. You can create links to a report or dash-
board from numerous reports, making it easy to use a single report or dashboard as a drill-
down for a number of separate reports. Linking reports is particularly beneficial when you 
need to create multiple reports with identical drill-down levels, since you can create a single 
report and link to it instead of re-creating identical levels in multiple reports.
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Since linked reports do not need to use the same database tables, you can access a large 
amount of data by linking to a number of reports from a single parent report. Conversely, a 
single report with multiple output levels must include all the database tables used by any of 
the report levels, so is more likely to run slowly or encounter limitations in the amount of data 
that can be queried. By linking reports that each use a smaller data set, you are far less likely to 
encounter data limits or negatively impact analytics performance.

This section describes how to use, create, edit, remove, and reorder report links.

Using report links
When a report link is created, it is applied to a specific column in the parent report. When you 
click the link in the column, the linked report will open on a new tab, an existing tab, or on the 
same tab as the parent report in a split window, depending on how the report link is config-
ured. You close a linked report or dashboard by closing the tab or clicking the Top Level link 
in the report.

Since report links are specific to columns, you can have several links to reports and dash-
boards in the same report. Your report can also include drill-down links to other levels in the 
same report. Report links can be added to any of the output levels in the parent report, allow-
ing you to link to a large number of reports and dashboards from one report.

While report links are easy to use, there are some considerations before adding them to 
reports.

• Report links will function normally when they are added to workspaces, but the links 
will be unavailable if the reports are used in workspace relationship items. Refer to the 
RightNow Administrator Manual for information about using reports in workspaces.

• Just as with drill-down links to other report levels, report links are unavailable when a 
report is forwarded, exported, published, or sent as a scheduled report. Refer to “Dis-
tributing reports” on page 106 for information about these options.

• Report links will be unavailable when the columns they are in are rolled up. Refer to 
“Displaying rollup levels” on page 155 for information about rollups.

• While you can create links to dashboards, you cannot link to a dashboard from a report 
that is being viewed in a dashboard. Links to dashboards will be unavailable when the 
reports they are in are viewed in a dashboard.

• You can create links to public or private reports and dashboards. Staff members with 
permission to view the parent report will be able to view any reports or dashboards 
linked to from the parent report, whether they are public or private. Thus, you should 
be familiar with the content of the report or dashboard you are linking so staff mem-
bers are not able to access sensitive information.
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• You cannot create report links from columns that display values from hierarchical 
fields, such as the incidents product hierarchy field. In addition, columns can be associated 
with a report link or with a drill-down level in the report, but not both.

• If a report or dashboard is deleted, any links to that report or dashboard will be auto-
matically disabled, but the reports containing the links will continue to function nor-
mally.

Creating report links
Before you create report links, you should be familiar with the run-time selectable filters in 
the reports or dashboards you are linking to since you define the values you want to use for 
these filters every time you create a report link. In addition, you should know whether you 
want to use unconditional or conditional links.

• Unconditional links—Use an unconditional link to open a specific report or dash-
board when you drill down on any value in the parent report’s linked column. The con-
tent in the linked report or dashboard can vary depending on the report’s filters and the 
value you drill down on, but you will link to the same report or dashboard regardless of 
the value selected in the parent report’s column. This functionality is similar to drilling 
down on a value in a column to open another report level.

• Conditional links—Use conditional links to open different reports or dashboards 
depending on the value you drill down on in the parent report’s linked column. For 
example, if a column in your parent report lists contacts’ service level agreements 
(SLAs), you could add a conditional link for each unique SLA listed in the column. 
When you click one of the SLAs in the column, a report that shows information spe-
cific to that SLA would open. Just as with unconditional links, the content in the linked 
reports or dashboards can vary depending on the values you specify for the linked 
reports’ filters.

You create links using the Report Linking wizard or the Conditional Report Linking wizard. 
The wizards are similar, though the Conditional Report Linking wizard includes an additional 
step. This section describes how to create an unconditional and a conditional link using the 
wizards and includes the procedure to specify the order of conditional links.

To create an unconditional report link:
1 Edit the report that you want to create the link from.

2 If your report has multiple output levels, select the report level where you want to create 
the link.
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3 Select the column where you want the link to display. It does not need to be the column 
with the data used to filter shown on the linked report.

4 Click the Report Linking button on the ribbon’s Design tab and select Add Report Link. 
The Report Linking wizard opens.

Figure 179: Opening the Report Linking Wizard

The first page of the wizard shows you the reports and dashboards you have access to, 
excluding published reports. You can create links to any of the reports or dashboards 
shown on the page, including those that are private.

5 Select the report or dashboard you want to link to and click the Next button.

Figure 180: Assigning Filter Values
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Once you select the report or dashboard you want to link to, you select the values you 
want to use for the report’s or dashboard’s run-time selectable filters. The values you spec-
ify are applied to the linked report or dashboard when it opens. Required filters are indi-
cated with a red asterisk and you must set a value for these filters. You can also choose to 
define values for filters that are not required.

6 Select the type of value you want to use for each of the linked report’s or dashboard’s run-
time selectable filters from the Use drop-down menu. The value types you can choose 
from are described in Table 93.

Important The filter values you specify determine the information shown in the linked 
report when it opens. Thus, you will often want to use a filter value that cor-
responds to the value clicked on in the parent report to display data related 
to the value in the parent report.

Table 93: Filter Value Types Description

Type Description

Parent Column Value Select this option to use the values in the selected column on the 
parent report to populate the linked report’s filter. When you click 
the link on a row in the parent report, the column’s value from the 
selected row will be used for the linked report’s filter value.
Note: This option is available only when the parent report 
includes a column with the same data type, such as text, integer, or 
menu, as the linked report’s filter.

Parent Filter Value Select this option to populate the linked report’s filter with the cur-
rent value from one of the parent report’s filters.
Note: This option is available only when both reports have filters 
with the same data type and operator.

Parent Variable Value Select this option to populate the linked report’s filter with the cur-
rent value from one of the parent report’s variables.
Note: This option is available only when the parent report 
includes a variable.

Default Filter Value Select this option to use the default filter value specified in the 
linked report for the filter value.
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7 From the Value drop-down menu, select the parent report’s column, variable, or filter you 
want to use to populate the filter in the linked report or dashboard. If you choose a cus-
tom filter value, you will be able to enter the custom value you want in the Value field.

8 Click the Next button. The wizard will present options for specifying where you want the 
linked report to open.

Figure 181: Specifying Display Options for the Linked Report

Custom Filter Value Select this option to specify a custom value for the filter. The val-
ues you can enter depend on the filter’s data type and available 
options. For instance, if the filter uses a text field, you can type the 
text you want to use for the filter’s value. If the filter uses a menu 
field containing staff accounts, you will be able to select the staff 
accounts you want from a menu.

Note When you select filter value types and specify values for each filter, the logical 
expression displayed beneath the filters will be updated to reflect the values you 
select. This is the expression that will be passed to the linked report or dash-
board when you click the link. This information is displayed for reference and 
cannot be edited.

Table 93: Filter Value Types Description (Continued)

Type Description
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9 Select the radio button next to the option you want to use to display the linked report or 
dashboard. The available options are described in Table 94.

10 Click the Finish button to save your changes.

11 Save the report you created the link from.

Table 94: Linked Report Display Options Description

Radio Button Description

Replace Report in the 
Same Window

Select this radio button to close the parent report and display the 
linked report instead.

Display Report in a 
Separate Tab

Select this radio button to open the linked report on a separate tab 
on the content pane.

Use Existing Tab Select this radio button to open the linked report on an existing tab 
each time you click the link. The tab is created the first time you 
click the link. When you open the report again from the same link, 
the report will display on the same tab.

Create a New Tab Select this radio button to open the linked report on a new tab 
each time you click the link.

Display Report in a Split 
Window

Select this radio button to open the linked report in a split window. 
The parent report remains open on one half of the window, and 
the linked report displays above or below the parent report, or to 
the left or right of the parent report.

Top Select this radio button to display the linked report above the par-
ent report.

Bottom Select this radio button to display the linked report below the par-
ent report.

Left Select this radio button to display the linked report to the left of 
the parent report.

Right Select this radio button to display the linked report to the right of 
the parent report.
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To create a conditional report link:
1 Edit the report that you want to create the link from.

2 If your report has multiple output levels, select the report level where you want to create 
the link.

3 Select the column in the parent report where you want the link to display. It does not need 
to be the column with the data used to create the link’s condition.

4 Click the Report Linking button on the ribbon’s Design tab and select Add Conditional 
Report Link. The Conditional Report Linking wizard opens.

Figure 182: Creating a Conditional Link

On this page of the wizard, you specify the condition(s) that must be met for the link to be 
triggered. The link you create is activated only when a value in the parent report meets the 
condition(s) you specify. You can add other conditional links to the same column to open 
different reports or dashboards when selecting other rows in the report.

5 Click the Column drop-down menu and select the column in the parent report that you 
want to use to create the link’s condition. The column you select does not need to be the 
same column the link is displayed on. For example, you can use the values in a hidden col-
umn to create the link’s condition, but display the link on another column in the report.

6 Click the Operator drop-down menu and select the operator you want to use for the link. 
The operators displayed depend on the column’s data type.

7 Enter the value you want to use for the conditional link.
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8 Click the Next button. The remaining pages of the Conditional Report Linking wizard are 
identical to those on the Report Linking wizard. Refer to “To create an unconditional 
report link:” on page 339 for information about these pages.

9 To add other conditional links, repeat steps 2 through 8.

Ordering conditional links
If you create several conditional links on the same column, you may need to reorder them to 
ensure that links with conditions that might overlap are triggered in the order you want. While 
ordering is irrelevant for conditional links with exclusive conditions, it can impact which 
linked report or dashboard will open if you have multiple links that could match a particular 
column value.

To reorder a conditional link:
1 Select the report column that is associated with the link and click the Report Linking but-

ton on the ribbon’s Design tab.

2 Select Manage Conditional Report Links to open the window shown in Figure 183.

Figure 183: Managing Conditional Report Links

The window shows all the conditional links that are associated with the selected column. 
From this window you can add, remove, edit, and reorder conditional links.

3 Select the link you want to move and click the up or down arrow to move it to the position 
you want. Conditional links are examined starting with the link at the top of the list. The 
first link that matches the column value will be triggered and any other links that could 
match the column value will be ignored.

4 Click the OK button to close the Manage Conditional Report Links window.
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Editing and removing report links
Once you create conditional or unconditional report links, you can easily edit or remove 
them.

To edit a report link:
1 Select the report column that is associated with the link and click the Report Linking but-

ton on the ribbon’s Design tab.

2 To edit an unconditional report link, select Edit Report Link to open the Report Linking 
wizard. Refer to “To create an unconditional report link:” on page 339 for information 
about using the wizard.

3 To edit a conditional report link, select Manage Conditional Report Links to open the 
Manage Conditional Report Links window, shown in Figure 183 on page 345.

a Click Edit next to the link you want to edit. The Conditional Report Linking wizard will 
open where you can edit the link. Refer to “To create a conditional report link:” on page 
344 for information about using the wizard.

b Click the OK button on the Manage Conditional Report Links window to close it.

To remove a link:
1 Select the report column that is associated with the link and click the Report Linking but-

ton on the ribbon’s Design tab.

2 To remove an unconditional link from the column, select Remove Report Link. The col-
umn’s unconditional link will be deleted.

3 To remove all conditional links from the column, select Clear All Conditional Report 
Links. All conditional links on the column will be deleted.

4 To remove only some of the conditional links on the column, select Manage Conditional 
Report Links.

a Click Delete next to the link you want to remove, and click the Yes button when asked 
to confirm the deletion.

b Click the OK button to close the window.

Tip You can use the standard Linked Reports and Reports with Disabled Links 
reports to list reports that contain links to reports and dashboards.
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Configuring reports for editing records
When the rows in a report display information from unique records, such as incident refer-
ence numbers, contacts’ names, or organizations’ names, you can perform actions on the 
records using a variety of methods. You can double-click a row, click a link on the row, right-
click the row and select from commands displayed on a menu, or click a button on the rib-
bon’s Home tab to perform an action related to the highlighted record. In addition, you can 
edit information directly from the report without opening records using the Inline Editing 
feature.

You can customize the actions you can perform on records when using any of these methods. 
You can choose the action performed when double-clicking a row and the commands avail-
able as buttons, links, and right-click menu options. You can also enable inline editing and 
specify the fields that can be edited directly on the report.

Customizing record commands
The record commands that are available on your report help your staff members quickly work 
with records shown on the report. For example, staff members can open, print, and delete 
records using record commands. Record commands can be displayed as buttons on the 
report’s Home tab, links displayed in a column, and as options displayed when right-clicking a 
row.

Using record commands, you can perform actions on the record types that are displayed in 
the report, but you can also perform actions on other record types that are related to the 
information displayed in the report. For example, if the report displays information about 
incidents, the report’s record commands can be configured to perform actions on the con-
tacts that are associated with the incidents.

This section describes the procedures to select the record commands you want on your 
report, customize the actions performed when using record commands, and add record com-
mand links to your report.

Note To edit records shown on reports, staff members’ profiles must include permis-
sions to modify the appropriate record types. Refer to the RightNow Administrator 
Manual for information about editing profiles.
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Selecting record commands
By default, every record command available for your report is enabled, but you can remove 
record commands you do not want staff members to access. Record command buttons and 
right-click menu options are added automatically depending on which record commands are 
enabled for the report. The enabled record commands also determine which record com-
mand links are available, though these need to be added to the report manually. Refer to 
“Adding record command links” on page 350.

To select record commands:
1 Click the Home tab and click the Records button. The Customize Record Commands win-

dow opens.

Figure 184: Selecting Record Commands to Include on a Report

Note The Records button is disabled on reports that do not have rows that display or 
are associated with unique records.
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2 To remove a record command from the current report level, expand the record commands 
list to find the command you want to disable and clear the check box next to the com-
mand.

3 To quickly restore the default record commands for all levels in the report, click Reset All.

4 Click the OK button to save your changes.

Customizing record command actions
You can further customize the record commands in your report by selecting the record type 
that actions are performed on when you click record command links or double-click the 
report’s rows. The record type you select is also used as the default record type for record 
command buttons and right-click menu options, though you can select any of the record 
types when using buttons or the right-click menu.

You can also choose the actions you want to perform when you double-click the report’s 
rows. For example, you can choose to open a record, assign a record, or perform other 
actions when you double-click the row.

To customize record command actions:
1 Click the Home tab and click the Records button. The Customize Record Commands win-

dow, shown in Figure 184 on page 348, opens.

2 To select the report level you want to configure, click the Level drop-down menu and 
select the report level you want. The options available on the Default Record and Default 
Action drop-down menus will vary depending on the information displayed in the report 
level you select.

3 Click the Default Record drop-down menu and select the record type you want the record 
command actions to apply to.

4 Click the Default Action drop-down menu and select the action you want performed when 
you double-click a row in the report.

5 To quickly restore the default record command settings for all the levels in the report, click 
Reset All.

Note The record type you select determines which links are available on the Links 
button on the report design center’s Display tab. Refer to “Adding record com-
mand links” on page 350.
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6 Click the OK button to save your changes.

Adding record command links
When you add record command links, they are displayed in a column that is automatically 
added to your report. You can select the links you want to display, though the links’ record 
commands must be enabled for the report on the Customize Record Commands window, dis-
played in Figure 184 on page 348. Not all the record commands you specify for the report are 
available as links.

To add record command links to a report:
1 If your report has more than one output level, click the Level drop-down menu on the 

design surface and select the level you want to add links to.

2 Click the Display tab.

3 Click the Links button and select the link you want to add to the report. When you add the 
first record command link to your report, the Action column will be added to the report.

Figure 185 shows options on the Links button for an incidents report and the Action col-
umn where the record command links are displayed.

Tip When using the report, you can hide or display links that are enabled for the 
report from the Links button on the report’s Display tab.
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Figure 185: Adding Record Command Links to a Report

Enabling inline editing
When a report displays unique records, such as incidents or opportunities, the Inline Editing 
feature lets you edit the values in columns shown on the report without opening the records. 
Individual values can be edited directly from the report, or groups of records can be selected 
to edit values in multiple records. For example, if a report shows the staff member an incident 
is assigned to, you can change the assigned staff member from the report without opening the 
record, or you can reassign several incidents shown on the report to a selected staff member. 
Refer to “Editing data inline” on page 161 for more information about editing data using 
inline editing.

Note If the link you want to add to the report is not displayed on the Links button, 
verify that the associated record command for the link is enabled and that the 
record type you want the links to apply to is selected as the default record. Refer 
to “Customizing record commands” on page 347.
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Before a staff member can edit records on a report, their profile must allow them to edit the 
record types returned in the report. In addition, the report must have inline editing enabled. 
You can enable inline editing for certain columns in the report or for all available columns. 
Refer to the RightNow Administrator Manual for information about editing profiles.

To enable inline editing:
1 Click the Home tab.

2 Click the Inline Editing button and select Allow Inline Editing. By default, inline editing 
will be enabled for all editable columns in the report. Only certain columns, such as those 
containing unique values, can be edited inline.

3 To specify the columns you want inline editing enabled for, click the Inline Editing button 
again and select Choose Editable Columns. The Editing Options window opens.

Figure 186: Editing Options Window

4 Enter field information described in Table 95.

Important You will see inline editing options in the report design center only if your profile 
includes the Modify Inline Report Editing permission on the Analytics tab.

Table 95: Editing Options Window Description

Field Description

Allow Inline Editing Select this check box to enable editing from the report.



Selecting report options 353

5 Click the OK button to save the editing options.

Selecting report options
Once you create a report, you can change several options that impact who can use the report 
and how the report functions. This section contains procedures for setting permissions, view-
ing the report audit log, and changing report options such as the report’s owner and the time 
zone used when the report is run.

Viewing the audit log
You can open an audit log for a report to see when the report was created, edited, run, pub-
lished, and which staff members performed these actions. Since the audit log is a report, you 
can perform common report actions on the audit log, such as printing, forwarding, or slicing.

To view the audit log:
1 Click the Home tab.

2 Click the Audit Log button.

Automatically Save Inline 
Edit Changes

Select this check box to enable the Auto Save feature by default. 
Refer to “Saving changes to the server” on page 164 for informa-
tion about Auto Save.

Select Columns You Wish 
to Make Available for 
Editing

Select the check boxes next to the report’s columns that you want 
to make available for editing.
Note: Reports with multiple output levels show all output levels in 
an expandable tree. Only columns that return unique, editable val-
ues from database fields are available for editing. For example, a 
column that returns the staff account an incident is assigned to will 
be available for editing, whereas a column that returns incident cre-
ation dates or a count of incidents will not be available.

Table 95: Editing Options Window Description (Continued)

Field Description

Note This step is not necessary when viewing a standard report.
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Figure 187: Audit Log

3 To access a list of actions that can be taken on the audit log, click the Options button. 
Refer to “Ribbon options when viewing reports” on page 78 for descriptions of the 
actions that can be performed on the report.

4 Click the OK button to close the audit log.

Specifying permissions
Report permissions allow you to specify which profiles can open or edit a report. You can 
select Open and Edit permissions for each profile defined in your system.

To specify report permissions:
1 Click the Home tab.

2 Click the Permissions button to open the Permissions window.

Note Permissions applied to private reports are irrelevant until the report is made 
public.
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Figure 188: Permissions Window

3 Enter field information described in Table 96.

4 Click the OK button to save the permissions.

Changing report properties
Report options allow you to select the time zone that should be used for the report, change 
the report’s owner, and modify settings that impact how the report functions when it is 
opened for viewing. You can also configure automatic refresh of the data shown in the report, 
add notes to the report, and change the image displayed for the report in lists.

To change report properties:
1 Click the Home tab.

2 Click the Options button and select More Options to open the Edit Settings window.

Table 96: Permissions Window Description

Field Description

Open Select this check box next to a profile name to allow staff members 
assigned to that profile permission to open the report. You can 
select multiple profiles.

Edit Select this check box next to a profile name to allow staff members 
assigned to that profile permission to edit the report. You can 
select multiple profiles.



356 Custom Reports

Chapter 5

Figure 189: Edit Settings Window

3 Enter field information described in Table 97.

Table 97: Edit Settings Window Description

Field Description

Time Zone Click this drop-down menu to select the time zone to use with the 
report. The dates and times shown in the report will be adjusted 
according to the time zone that is specified. The available options 
include the following:

• Same as Interface—The report’s time zone will be the time 
zone set for the interface. This is the default setting.

• Same as Account—The report’s time zone will be set to 
that of the staff member who is running the report.

• A specific time zone you can select from a list of standard 
time zones.

Owner Click this drop-down menu to select a report owner. The report 
owner is the only staff member who can view or edit the report, 
unless the owner grants permissions to other profiles. Refer to 
“Specifying permissions” on page 354.
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Open report without 
prompting for search 
parameters

Select this check box to have the report automatically run and 
return data when it is selected from a navigation list. The report 
will run using the default values specified in the report’s filters.
Note: This option is referred to as Initial Run on the Reports 
explorer’s Find pane. Refer to “Searching in explorers” on page 18 
for information about finding reports.

Refresh report when data 
shown is changed due to 
an action initiated from 
this report

Select this check box to have the report’s output automatically 
updated when an edit to a record is initiated from the report. The 
report will refresh only if a record is modified in such a way that it 
no longer matches the report’s search criteria.

Open editor when report 
contains only one row 
(quick search reports only)

Select this check box to automatically open the record for editing 
when the report returns only one record.
Note: This option applies only to Quick Search reports and search 
reports used in workspaces.

Cache the drilldown levels Select this check box to enable caching of data shown in report 
output levels. When this option is enabled, the data shown in the 
initial output level when you view a report will be stored on your 
workstation. When you view a second output level and then return 
to the top level of the report, it will load quickly since the data you 
are viewing is cached on your workstation. The cache will be 
cleared when you close the report.
Note: When this option is not enabled, the database is queried 
every time you drill down to an output level or return to a previous 
level even if you have recently viewed the output level.

Return to previous level 
when current level no 
longer has data

Select this check box to instruct the report to automatically display 
the previous output level if the current output level no longer dis-
plays any records.

Automatically refresh 
report at a regular interval

Options in this section let you configure automatic refresh of the 
report’s data to ensure the most recent data is displayed.

Auto-refresh options 
visible at run-time

Select this check box to add an arrow on the Home tab’s Refresh 
button. Clicking the arrow displays options to enable or disable 
automatic refresh and to change the refresh interval time. When 
this check box is not selected, the report’s data is refreshed only 
when the button is clicked.

Table 97: Edit Settings Window Description (Continued)

Field Description
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4 Click the OK button to save the report options.

Auto-refresh enabled by 
default

Select this check box to enable automatic refresh of the data shown 
on the report.

Interval Enter the number of seconds after which the data shown on the 
report will be automatically refreshed.

Image Click Change to select a different image to display next to the 
report in lists such as navigation lists. The image that is displayed 
by default is determined by the layout selected when creating a new 
report. When selecting an image, you can choose from a list of 
standard images or from custom images that have been added in 
the Images explorer. Refer to “Images explorer” on page 52 for 
procedures on adding images.

Data Source Select which database you want the report to run on.
Note: This option is available only if your site has a replicated 
database. For information on replicated databases, contact your 
RightNow account manager.

Report Database Select this radio button if you want the report to run only on your 
replicated database. This option is helpful if your report queries a 
large amount of data since the query size restrictions on replicated 
databases are more relaxed than those on operational databases.

Operational Database Select this radio button if you want the report to run only on your 
operational database. This option is helpful if you need the report 
to return the most current data available.

Notes Type any text you want to add as a note to the report. The note will 
display on the Edit Settings window, but will not display to anyone 
viewing the report.

Table 97: Edit Settings Window Description (Continued)

Field Description
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6
Dashboards

When viewing standard or custom reports, you generally open reports one at a time, and 
search for data in only the report that is active. However, you can view and search for data in 
several reports simultaneously by adding them to a dashboard. Each report in a dashboard 
retains the same functionality as if you opened the report separately, allowing you to easily 
access and work with a variety of data from one dashboard.

Dashboards are particularly useful for managers who need to view a wide range of data from 
different reports. Using dashboards eliminates the need to open a large number of reports 
individually.

In this chapter

• Creating dashboards—Describes the components of the dashboard design center, where you 
create dashboards. Also contains procedures describing how to create dashboards, add content to 
them, and change dashboard options. Refer to page 360.

• Using dashboards—Describes how to queue dashboards and how dashboards are displayed 
when they are opened. Also describes how to perform searches when using dashboards. Refer to 
page 398.
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Creating dashboards
Dashboards are created and edited on the dashboard design center. Since dashboards are sim-
ply groupings of reports, creating a dashboard is not complicated. The process involves drag-
ging reports to the dashboard, adding optional descriptions, images, text, and controls, and 
configuring display options. If you do not want to create a new dashboard, you can copy an 
existing custom or standard dashboard in the Reports explorer and then edit the copy using 
the dashboard design center.

Opening the dashboard design center
The dashboard design center provides all the tools you need to create and edit dashboards, 
and lets you access optional items such as text fields and images to enhance your dashboards. 
The dashboard design center can be opened from the Reports explorer or by right-clicking a 
dashboard on the navigation pane and selecting Edit Report Definition. The following proce-
dure describes opening the design center from the Reports explorer.

To open the dashboard design center:
1 Click the Analytics button on the navigation pane.

2 Double-click Reports Explorer.

3 Click the New Dashboard button to create a dashboard.

Or

Right-click an existing dashboard in the list and select Edit.

Note Customizations made to report displays in existing dashboards are not carried 
over when copying dashboards. This can result in a copied dashboard displaying 
somewhat differently than the original.
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Figure 190: Dashboard Design Center

Selecting report or design views
When you open a dashboard, you can choose to view it using a design or report mode. The 
design view is used by default, which you can use to edit the dashboard’s properties and add 
reports, images, and text fields to the dashboard. Once you have modified your dashboard, 
you can switch to the report view to preview what the dashboard will look like when it is used 
by staff. When viewing a dashboard using the report view, the dashboard is presented to you 
just as your staff members will see it, though certain items, such as action links displayed in 
reports, are disabled. When you want to edit the dashboard again, you can switch back to the 
design view.

To select the report or design views:
1 Edit or create a new dashboard. By default, the dashboard is shown in the design view.

2 Click the ribbon’s Home tab.

3 Click the arrow on the Views button and select Report View to change the view.
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4 To view the dashboard with the design view, click the arrow on the Views button and 
select Design View.

Dashboard design center ribbon
When you open the dashboard design center, the ribbon will include the Home, Display, and 
Page Setup tabs from which you can access tools to edit the dashboard. Each tab has one or 
more groups containing buttons you can use to modify the dashboard or items on the dash-
board.

Home tab
The options available on the Home tab allow you to preview the dashboard you are editing 
and configure options that apply to the entire dashboard. For example, you can select a dash-
board layout and specify when the dashboard’s contents should be refreshed. Figure 191 
shows the Home tab.

Figure 191: Home Tab

The groups and buttons on the Home tab are described in Table 98.

Note To minimize the ribbon when editing a dashboard, double-click a tab. Click the 
tab to temporarily display the buttons and click the tab again to hide them. To 
permanently restore the tab buttons, double-click the tab again.

Table 98: Home Tab Description

Group/Button Description

Views This button lets you choose whether to view the dashboard using 
the report view or design view. Refer to “Selecting report or design 
views” on page 361.
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Properties The buttons in this group let you modify properties that apply to 
the entire dashboard.

Options Click this button to select different options that impact how the 
dashboard will be run. For example, you can edit the dashboard 
description and specify when the dashboard’s contents should be 
refreshed. Refer to “Changing dashboard options” on page 386.

Scheduling Click this button to schedule the dashboard to be sent to other 
individuals. A dashboard can be scheduled and sent just as a report 
can. However, since data exceptions cannot be applied to dash-
boards, alerts cannot be added to the dashboard’s schedule. Refer 
to “Scheduling dashboards” on page 390.
Note: This button appears only when scheduled reports are 
enabled. For information about enabling scheduled reports, con-
tact your RightNow account manager.

Permissions Click this button to define which profiles should have access to run 
and edit the dashboard. Refer to “Specifying permissions” on page 
391.

Audit Log Click this button to open the audit log for the dashboard, which 
shows you when the dashboard was created, edited, run, and pub-
lished, and which staff members performed these actions.
For information about the audit log, refer to “Viewing the audit 
log” on page 392.

Display The buttons in this group let you modify how the dashboard is dis-
played. For example, you can apply a style to all the reports on the 
dashboard to give them a similar appearance.

Screen Click this button to display all the dashboard’s reports on the 
screen when the dashboard is run. Each report can have separate 
scroll bars to view the report contents. 

Table 98: Home Tab Description (Continued)

Group/Button Description
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Display tab
The options available on the Display tab allow you to add images and text fields, show the 
dashboard header and footer, and hide portions of the design center so you can see only the 
components you need. Figure 192 shows the Display tab.

Scrollable Click this button to display all the contents of each report on the 
dashboard when the dashboard is run. Each report will display in 
its preferred size and the height and width of the items in each 
report will be fixed. When this option is selected, separate reports 
will not have separate scroll bars, but the dashboard will have verti-
cal and horizontal scroll bars if necessary.
Note: If the entire size of the dashboard exceeds 32767 x 32767 
pixels, dashboard contents will be clipped when using this option.

Display Options Click this button to change the dashboard’s width, add report title 
bars, and select which report sections you want to display. Refer to 
“Changing dashboard display options” on page 395.

Auto Format Click this button to apply a style to all the reports in a dashboard. 
This will override styles applied to the individual reports. Refer to 
“Applying a style to a dashboard” on page 394.

Layouts Click this button to load a predefined dashboard layout. Layouts let 
you quickly select how many reports will be shown on the dash-
board and their position. When you select a layout, the design sur-
face is automatically adjusted to conform to the layout you 
selected. Refer to “Selecting a layout” on page 373.

Parameter Values Click this button to open the Set Filter Values window where you 
can specify defaults for searching reports in the dashboard. For 
information about setting default search options, refer to “Specify-
ing search defaults” on page 392.

Add Tab Click this button to add a tab to the dashboard. Tabs let you create 
multiple pages for the same dashboard, and you can select the 
reports that will display on each tab.

Table 98: Home Tab Description (Continued)

Group/Button Description
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Figure 192: Display Tab

The groups and buttons on the Display tab are described in Table 99.

Table 99: Display Tab Description

Group/Button Description

Insert The buttons in this group let you add images and text fields to your 
dashboard. Refer to “Adding images and text fields to dashboards” 
on page 379.

Sections The check boxes and button in this group let you show or hide the 
Dashboard Header and Dashboard Footer sections, and choose 
how you want to display the dashboard’s description. Refer to 
“Adding dashboard descriptions” on page 378.

Show/Hide The buttons in this group let you show or hide different parts of 
the dashboard design center. Showing the reports explorer lets you 
select reports to add to the dashboard. You can also add rulers, 
rule lines, field outlines, section headers, and a grid to the design 
surface to help you create your dashboard. Refer to “Understand-
ing dashboard design center components” on page 369 for infor-
mation about these options.

Items The buttons in this group let you remove a selected report or a 
report placeholder from the dashboard, and let you show or hide 
the title of the selected report when the dashboard is generated.
Note: The Remove button is disabled when the only report on a 
dashboard is selected.

Dashboard Tab The buttons in this group let you add, delete, rename, and move 
dashboard tabs. Refer to “Adding tabs to the dashboard” on page 
377.
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Page Setup tab
The options on the Page Setup tab allow you to configure printing options for the dashboard. 
These options are applied only when printing. Figure 193 shows the Page Setup tab.

Figure 193: Page Setup Tab

The groups and buttons on the Page Setup tab are described in Table 100.

Table 100: Page Setup Tab Description

Group/Button Description

Print The buttons in this group let you configure the dashboard for 
printing and add the Page Header and Page Footer sections.

Print Margin Click this button to select the size of the margins used when print-
ing the dashboard. The available options are Normal, Narrow, 
Medium, and Wide.

Size Click this button to select the size of the paper used when printing 
the dashboard. The available options are Letter, Legal, Executive, 
A3, A4, and A5.

Portrait/Landscape Click these buttons to print the dashboard in portrait or landscape 
mode.

Page Header/Page 
Footer

Select these check boxes to include a page header and page footer 
when printing the dashboard.

Print to Fit Select this check box to scale the dashboard to your printer’s 
default page width and send the dashboard to the printer.
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Text Field tab
The Text Field tab is shown on the ribbon when you select a text field on the dashboard 
design center. You can use the buttons on the tab to edit the text field’s fonts, margins, and 
borders. Figure 194 shows the Text Field tab.

Figure 194: Text Field Tab

The groups and buttons on the Text Field tab are described in Table 101.

Table 101: Text Field Tab Description

Group/Button Description

Edit Click this button to open the Edit Text Field window, from which 
you can select fonts, margins, fill colors, and borders for the text. 
Many of the buttons on the Text Field tab let you customize the 
same options available on the Edit Text Field window.

Arrange The buttons in this group let you position and size the selected text 
field.

Anchor Click this button to define an anchor style for the image or text 
field. Anchor styles determine how an image or text field will move 
in relation to the borders of the dashboard section. Refer to 
“Defining anchor styles” on page 230 for information about defin-
ing anchor styles.

Bring to Front/Send to 
Back

Click these buttons to place the selected item on top of or beneath 
other overlapping items.

Size to Fit Click this button to automatically shrink or expand the element 
containing the image or text field to fit the selected item.
Note: Manually resizing the selected element disables this option.

Font The buttons in this group let you change the font style, size, and 
color. You can also select font attributes, such as bold and italic, 
and change the text’s alignment within the text field. In addition, 
you can add a background color for the text field.
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Options tab
The Options tab is shown on the ribbon when you select an item on the dashboard design 
center. The buttons on the tab vary depending on the item you select and let you customize 
the item. For example, if you select a report on the dashboard, you can use the buttons on the 
Options tab to add a border around the report and choose background colors. Figure 195 
shows the Options tab.

Figure 195: Options Tab

The groups and buttons on the Options tab are described in Table 102.

Margin Click this button to select the width of the margins around the 
item. The available options are None, Narrow, Medium, Wide, and 
Custom. Selecting Custom lets you specify the number of pixels 
for the top, bottom, left, and right margins.

Border The buttons in this group let you add borders to the text field and 
change the borders’ display options. You can identify which bor-
ders you want and choose the borders’ color, size, and style.

Table 102: Options Tab Description

Group/Button Description

Margin Click this button to select the width of the margins around the 
item. The available options are None, Narrow, Medium, Wide, and 
Custom. Selecting Custom lets you specify the number of pixels 
for the top, bottom, left, and right margins.

Border The buttons in this group let you add borders to the text field and 
change the borders’ display options. You can identify which bor-
ders you want and choose the borders’ color, size, and style.

Table 101: Text Field Tab Description (Continued)

Group/Button Description
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Understanding dashboard design center components
The tasks you perform when creating or editing a dashboard are done through the ribbon, 
design surface, and reports explorer components of the dashboard design center. These com-
ponents provide access to the reports, dashboard sections and other items you will use to cre-
ate and edit dashboards. The dashboard sections are described in Table 103.

Fill The buttons in this group let you add a background color to the 
selected item. You can select the background color and add a gra-
dient color to blend into the primary color. You can also choose 
how intense the colors should be with the Transparency setting.

Layout The buttons in this group let you define how the content of the 
selected dashboard section should be arranged and how the height 
of the dashboard section should be managed. Refer to “Selecting 
dashboard section layout options” on page 380.

Add Text Field Click this button to add a new text field to the dashboard.

Table 102: Options Tab Description (Continued)

Group/Button Description

Table 103: Dashboard Sections Description

Dashboard Section Description

Page Header This section accepts images and text fields and is displayed at the 
top of dashboards when you print them.

Dashboard Header Contains text fields and images that will display at the top of the 
dashboard. By default, the header contains text fields you can mod-
ify for the dashboard’s title and sub-title.

Dashboard Description Contains text that you can modify to provide general information 
about the dashboard. You can display dashboard descriptions 
inline to show the description on the dashboard or as text on a 
separate tab on the dashboard. Refer to “Adding dashboard 
descriptions” on page 378 for information about adding text to 
this section.
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Design surface
The design surface displays the dashboard sections you want to include in the dashboard. 
Once a dashboard section is displayed on the design surface, you can add, edit, and remove 
content in the section. For example, you can drag reports to the Dashboard Items section, 
insert text fields into the Dashboard Header, and change the background of the Dashboard 
Footer.

You can add rulers, lines, and headings to help you identify sections and fields shown on the 
design surface. Figure 196 on page 372 shows a dashboard design center with these options 
enabled. These options are accessed from the Show/Hide group on the ribbon’s Display tab:

• Show Rulers—Click this button to display horizontal and vertical rulers when design-
ing the dashboard to provide a perspective on the size of the dashboard.

• Show Rule Lines—Click this button to display horizontal lines separating the dash-
board sections displayed on the design surface.

• Show Field Outlines—Click this button to display borders around the fields you add 
to the dashboard.

• Show Section Headers—Click this button to display a heading above each dashboard 
section.

• Show Grid—Click this button to display a grid in the dashboard’s header and footer 
sections to help you align items you add to the sections. You can also click the arrow on 
the button to select the grid size you want to use.

Dashboard Items Contains the reports and components you add to the dashboard.
Note: If you add tabs to the dashboard, the name of this section 
will change to Tabs, and a tree will be added from which you can 
add content to each tab. Refer to “Adding tabs to the dashboard” 
on page 377 for information about adding tabs to a dashboard.

Dashboard Footer This section contains text fields and images that will display at the 
bottom of the dashboard.

Page Footer The page footer is similar to the page header section. The text 
fields and images added to this section display at the bottom of 
printed dashboards.

Table 103: Dashboard Sections Description (Continued)

Dashboard Section Description
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Reports explorer
The dashboard design center’s reports explorer lists the items that can be added to a dash-
board. These include reports, notifications, sales scorecards, and a web browser component. 
These can be added to a dashboard by dragging them from the reports explorer to the dash-
board’s design surface.

You can hide the reports explorer to add more room to the design surface if you do not need 
to add reports. To hide the reports explorer, click the Display tab and then click the Reports 
Explorer button. You can click the button again to show the reports explorer.

Figure 196 shows the Dashboard design center’s components and display options.

Note If your site is configured to use custom add-in components, they will be avail-
able on the reports explorer’s Components tree. Custom add-ins can be dragged 
to dashboards and positioned just like reports. For information about custom 
add-ins, contact your RightNow account manager.

Note You can drag the reports explorer and reposition it on the dashboard design 
center or open it in a new window just as you can move the data dictionary on 
the report design center. Refer to “Moving the data dictionary” on page 208 for 
information about repositioning the data dictionary.
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Figure 196: Dashboard Design Center

Adding content to the dashboard
You can easily add reports, notifications, and other items to a dashboard by dragging them 
from the dashboard design center’s reports explorer to the design surface. You decide where 
to place each item and how much content you want on the dashboard. Alternately, you can 
use layouts to format the dashboard and then drag the items to the predefined sections on the 
dashboard.

If you want more items in a dashboard than can comfortably fit on one page, or if you want 
to organize the dashboard’s items into groups, you can add tabs to the dashboard which will 
add other pages where you can place additional reports.

Ruler

Page Header section

Dashboard Header section

Dashboard Footer section
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Field Outline
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Selecting a layout
You can use dashboard layouts to add predefined regions to the design surface. The use of 
layouts is optional, but they offer a helpful starting point when creating dashboards.

To apply a layout to a dashboard:
1 Click the Home tab.

2 Click the Layouts button to open the layouts menu.

Figure 197: Dashboard Layouts Menu

3 Select the layout you want to apply to the dashboard. The design surface will be updated to 
reflect the layout you selected.

4 To modify the spacing of the dashboard layout you selected, mouse over the spaces 
between the report areas until the cursor changes to show direction arrows. You can then 
drag the borders to the position you want. Figure 198 shows a dashboard with a modified 
layout.
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Figure 198: Resizing a Dashboard Layout

Placing content on the dashboard
You can easily add a report and position it on the dashboard by dragging the report from the 
reports explorer to the design surface. Additional reports are added to the dashboard in the 
same manner.

You can also drag the Notifications component to the dashboard to allow your staff to 
receive notices on the dashboard when particular events happen, such as an incident being 
assigned. Refer to the RightNow User Manual for information about notifications.

You can add sales scorecards to dashboards to display gauges on your dashboard showing 
sales agents’ performance in relationship to other agents and to criteria specified by your 
organization. For information about configuring and using sales scorecards, refer to our cus-
tomer support site at http://crm.rightnow.com.

A web browser can be added to a dashboard as well, allowing staff members to navigate to a 
web page displayed in the dashboard. To add the browser to a dashboard, drag the Web 
Browser–Component report from the Public Reports>Common report folder to the dash-
board. Once the browser is added to the dashboard, you can specify a default URL in the 
dashboard’s parameters. Refer to “Specifying search defaults” on page 392 for information 
about specifying dashboard parameters.

Important If you add private reports to a dashboard, other staff members will be able to 
view the reports when they open the dashboard.

Note Each dashboard can have a maximum of fifty items placed on it.
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This section describes adding reports to the dashboard, but the same process is used to add 
any of the other items listed in the dashboard’s reports explorer.

To add reports to a dashboard:
1 In the reports explorer, navigate to the report you want to add to the dashboard.

2 Select the report and drag it to the dashboard.

3 Drop the report on the design surface where you want the report to display. 

When you drag the report to the design surface, you will see positioning images appear. 
Hovering over the various images will highlight portions of the design surface, as shown in 
Figure 199. Once the section where you want the report is highlighted, drop the report. 
The design surface will be refreshed to show the updated dashboard layout. In the exam-
ple shown in Figure 199, the Group Performance report being dragged would be added to 
the highlighted portion of the bottom section of the dashboard.

Figure 199: Dragging a Report to the Design Surface

Note If a report that is used in a dashboard is later deleted, the report will automati-
cally be removed from the dashboard.

Tip You can quickly locate reports by right-clicking a report folder in the reports 
explorer and selecting the Search option.
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The positioning icons that display on the design surface when dragging a report are 
described in Table 104.

Removing, replacing, and editing dashboard reports
If you want to change the reports that are on a dashboard, you can simply remove the reports 
from the dashboard or replace them with new reports. If you need to make a change to a 
report on the dashboard, you can also open the report for editing.

Table 104: Dashboard Report Positioning Icons

Icon Description

 Entire Area

This icon group will appear over the predefined dashboard section 
you are hovering over when dragging a report. Hovering over the 
various icons in the group will highlight different portions of the 
dashboard section where you can drop the report.
You can hover over the center of the icon group to drop the report 
in the full dashboard section. You can also place the report in the 
top, bottom, left, or right portions of the dashboard section by 
hovering over the individual icons in the group.
If you break up a predefined dashboard section when dropping 
your report onto the dashboard section, the dashboard’s layout will 
be split into continuously smaller areas.

 Top Area
Drop a report over this icon to place the report in the top half of 
the dashboard.

 Right Area
Drop a report over this icon to place the report in the right half of 
the dashboard.

 Bottom Area
Drop a report over this icon to place the report in the bottom half 
of the dashboard.

 Left Area
Drop a report over this icon to place the report in the left half of 
the dashboard.

Note If your dashboard has only one report, you will not be able to remove it, but you 
can replace it with another report.
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To remove a report from the dashboard:
Right-click the report on the design surface and select Remove.

Or

Click the item on the dashboard, click the Display tab, and click the Remove button.

To replace a report on the dashboard:
Drag the new report you want on the dashboard from the reports explorer and place it on top 
of an existing report on the dashboard. The existing report will be replaced with the new 
report.

To open a report for editing:
Right-click the report on the design surface and select Edit Report Definition. The report will 
open in the report design center where you can edit it. Refer to Chapter 5, “Custom Reports,” 
on page 175 for information about editing reports.

Adding tabs to the dashboard
When creating a dashboard, you may find that you want more reports than can easily be 
viewed or that you want to group similar reports together. By adding tabs to the dashboard, 
you can create multiple pages for the same dashboard, and you can select the reports that will 
display on each tab. Each tab acts as a distinct page of the dashboard, and reports are added 
to the pages just as they would be if the dashboard had only one page.

To add a tab to a dashboard:
1 Click the Home tab.

2 Click the Add Tab button.

Once you add a tab, the dashboard design center will be updated to show the tabs on the 
design surface. The tab names will likely not be what you want, but you can easily change 
them.

Tip Each dashboard can have a maximum of fifty tabs.
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To change the name of a tab:
1 Right-click the tab on the design surface and select Rename.

Or

Click the tab, click the Display tab, and click the Rename button.

Figure 200: Renaming a Dashboard Tab

2 Type the new name for the tab.

3 Click the OK button to save the tab’s name.

Adding dashboard descriptions
If you create a dashboard that will be accessed by other people, you can add a description to 
explain the purpose of the dashboard or to relay other information concerning the dash-
board. The description text can display inline on the dashboard or as text accessed from a 
separate tab.

Figure 201 shows an example of a dashboard with the dashboard description displayed on a 
tab.

Figure 201: Dashboard with Description Displayed in a Tab

Dashboard 
description
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To add a dashboard description:
1 Click the Home tab.

2 Click the Options button and select Edit Dashboard Description. The Edit Dashboard 
Description window opens.

Figure 202: Edit Dashboard Description Window

3 Type the text for the description in the Description field.

4 Click the OK button to save the description.

To define the description location:
1 Click the Display tab and then click the Dashboard Description button.

2 To display the dashboard description on the dashboard, select Display Dashboard 
Description Inline.

3 To display the dashboard description on a separate Description tab, select Display Dash-
board Description on Separate Tab.

Adding images and text fields to dashboards
You can add images and text fields to your dashboard’s header and footer sections to clarify 
the dashboard’s purpose or to make it more presentable to your target audience. When you 
place an image or text field on the dashboard, you can either manually position the item or it 
can be positioned automatically depending on the section’s layout properties. Once you add 
an image or text field to a dashboard section, you can reposition it if needed, and you can edit 
any text fields you have added directly from the dashboard.
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Selecting dashboard section layout options
When you add images or text fields to a dashboard section, you can manually position the 
item if the section has a manual layout. If the section has an automatic layout, the text field or 
image will be positioned automatically, and the dashboard section’s height will be adjusted to 
best fit the image or text field. You can also set table layout options to change how the items 
in the section are sized. By default, dashboard sections have manual layout enabled.

To enable automatic layout of a dashboard section:
1 Add the dashboard section you want to your dashboard.

a To add the dashboard header or footer sections, click the Display tab and select the 
Dashboard Header or Dashboard Footer check box.

b To add the page header or footer sections, click the Page Setup tab and select the Page 
Header or Page Footer check box.

2 Click the dashboard section you want to modify on the design surface.

3 Click the Options tab and click the Automatic button.

4 To prevent the section’s height from being automatically adjusted to fit the items you add 
to the section, click the Auto Height button to disable the feature.

If a dashboard section has an automatic layout, the images and text fields you add to it are 
arranged in an invisible table structure with the items placed in rows and columns. You can 
adjust the sizing of the rows and columns to arrange the images and text fields as you want 
them.

To change a dashboard section’s table layout options:
1 Add images and text fields to the dashboard section.

2 Select the dashboard section you want to modify on the design surface and then click the 
Options tab.

3 If the section has a manual layout, click the Automatic button to change to an automatic 
layout.

Tip When Auto Height is disabled, you can manually change the height of the dash-
board section by dragging the section’s horizontal borders up or down, just as 
you would if the section had a manual layout.
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4 Click the Table Layout button.

5 To give each column in the section’s table the same amount of width, select Size All Col-
umns Equally.

6 To give each row in the section’s table the same amount of height, select Size All Rows 
Equally.

7 To size each column to best show the column’s contents, select Auto Size All Columns.

8 To size each row to best show the row’s contents, select Auto Size All Rows.

9 To manually configure the table’s layout, select More Options. The Edit Table Layout 
Properties window opens.

Figure 203: Configuring a Dashboard Section’s Table Layout

10 Enter field information described in Table 105.

Table 105: Edit Table Layout Properties Window Description

Field Description

Show Select the row column you want to configure and then click this 
drop-down menu to select whether you are configuring rows or 
columns.

Size Type Specify how the size of the report section is determined in this sec-
tion.

Absolute Select this radio button to specify a certain size for the selected row 
or column in pixels.
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11 Click the OK button to save your changes.

Adding text fields
RightNow contains predefined text fields you can add to your dashboard, along with custom 
text fields you create in the Text Fields explorer. You can also add new text fields you create 
from the dashboard design center. The dashboard’s page header, dashboard header, page 
footer, and dashboard footer sections all accept text fields. Refer to “Text Fields explorer” on 
page 54 for information about creating custom text fields.

Once you add a text field to a dashboard, you can modify its text, fonts, colors, and borders to 
tailor the text field to the dashboard’s audience. These edits to the text field are specific to the 
dashboard and do not affect the original text field. This lets you easily customize the same 
text fields for different dashboards.

To add a text field to a dashboard:
1 Add the dashboard section to the design surface that you want to add the text field to.

a To add the dashboard header or footer sections, click the Display tab and select the 
Dashboard Header or Dashboard Footer check box.

b To add the page header or footer sections, click the Page Setup tab and select the Page 
Header or Page Footer check box.

2 If you want the text field to be automatically positioned on the dashboard, click the dash-
board section, click the Options tab, and click the Automatic button. Refer to “Selecting 
dashboard section layout options” on page 380 for more information.

3 Click the Display tab.

4 Click the Text button to open the Insert Text Field window.

Percentage Select this radio button to specify a certain percentage of the total 
available space in the section to allocate to the selected row or col-
umn.

Best Fit Select this radio button to have the size of the selected row or col-
umn automatically adjusted to best fit the row’s or column’s con-
tents.

Table 105: Edit Table Layout Properties Window Description (Continued)

Field Description
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Figure 204: Insert Text Field Window

The window displays standard text fields and custom text fields that you have added in the 
Text Fields explorer. The text fields’ default fonts, colors, and other attributes are reflected 
in the display.

5 Click the text field you want to add to the dashboard. The Insert Text Field window will 
close, and the cursor will display the name of the text field you are adding when you hover 
over dashboard sections that accept text fields, such as the dashboard header.

6 Click the dashboard section on the design surface where you want to add the text field. 
The text field will be added to your dashboard, as shown in Figure 205.

Figure 205: Text Fields Added to Dashboard Header
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7 To add a new text field you will use only on the dashboard, click the Options tab and click 
the Add Text Field button. The new text field will be added to the dashboard section with 
default text and text attributes which you can then edit. Refer to “Editing text fields” on 
page 384 for information about editing text fields.

8 Click the Save button to save the changes to the dashboard.

Editing text fields
Once you add a text field to your dashboard, you can edit it to change the fonts, colors, text, 
and other attributes. These edits will apply to the text in the dashboard, but the original text 
field will not be affected.

To edit a text field:
Right-click the text field and select Edit Text Field.

Or

Click the text field, click the Text Field tab, and then click the Edit button.

The Edit Text Field window opens. For procedures on using this window, refer to “Editing 
text fields” on page 229.

You can also edit the text field using the buttons in the Font, Margin, and Border groups on 
the Text Field tab. These buttons provide shortcuts to many of the same options available on 
the Edit Text Field window.

Adding images
You can insert images you have added to your dashboard’s page header, dashboard header, 
dashboard footer, and page footer. Images can act as backgrounds or header images in these 
sections. Refer to “Images explorer” on page 52 for information about adding images to your 
site using the Images explorer.

Note Certain standard text fields, such as Current Date, include values that are 
dynamically updated when the report is run. While these fields can be edited, 
you cannot edit their dynamic value placeholders.
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To add an image to a dashboard:
1 Add the dashboard section to the design surface that you want to add the image to.

a To add the dashboard header or footer sections, click the Display tab and select the 
Dashboard Header or Dashboard Footer check box.

b To add the page header or footer sections, click the Page Setup tab and select the Page 
Header or Page Footer check box.

2 If you want the image to be automatically positioned on the dashboard, click the dash-
board section, click the Options tab, and click the Automatic button. Refer to “Selecting 
dashboard section layout options” on page 380 for more information.

3 Click the Display tab on the ribbon.

4 Click the Image button to open the list of images added in the Images explorer.

Figure 206: Example of Images List

5 Click the image you want to add.

6 Mouse over the section where you want to add the image. The cursor will display the name 
of the image you selected when it is over a section that can accept an image.

7 Click to place the image in the dashboard section you select.

8 Click the Save button to save the changes to the dashboard.
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Moving images and text fields
Once you add an image or text field to a dashboard section, you can move the field by drag-
ging it to the appropriate place in the section. This may require dragging other text fields in 
the dashboard section to prevent the fields from overlapping.

If the dashboard section has a manual layout, you can move the item to any location in the 
section you want. If the dashboard section has an automatic layout, you can still move the 
item, but blue lines will display when you drag the item, showing you where the item can be 
placed in relation to any other images or text fields in the section.

When you click an image or text field that has been added to a dashboard section, handles will 
appear on the field’s borders, as shown in Figure 205 on page 383. To increase or decrease the 
size of the field, click the appropriate handle and drag it to a new position. When dragging a 
text field, the font size will remain unchanged, but the text field’s area will be altered. How-
ever, when dragging an image, the image itself will be resized.

Changing dashboard properties
Many of the buttons on the ribbon’s Home tab let you specify a number of options that 
impact how the dashboard can be used. For example, you can select who owns the dashboard, 
specify dashboard permissions, and set the time zone the dashboard uses when it is opened. 
You can also schedule the dashboard to be sent in an email, view an audit log to see who has 
viewed or edited the dashboard, and modify how the dashboard’s reports are searched.

Changing dashboard options
Dashboard options allow you to select the time zone that should be used for the reports in 
the dashboard, change the dashboard owner, and modify settings that impact how the dash-
board functions when it is opened for viewing. You can also configure automatic refresh of 
the data shown in the dashboard’s reports, add notes to the dashboard, and change the image 
displayed for the dashboard in report lists.

Several of the dashboard options you select play an important role in how the dashboard’s 
reports are searched. These options are described in this section and also addressed in 
“Searching dashboard reports” on page 406.
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To edit dashboard options:
1 Click the Home tab.

2 Click the Options button and select More Options to open the Edit Settings window.

Figure 207: Edit Settings Window

Note Dashboard options can also be selected from the Options button without open-
ing the Edit Settings window.
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3 Enter field information described in Table 106.

Table 106: Edit Settings Window Description

Field Description

Time Zone Click this drop-down menu to select the time zone to be used with 
the dashboard’s reports. The dates and times listed in the report 
output, filters, and parameters will be adjusted according to the 
time zone that is specified. The available options are:

• Same as Interface—The reports’ time zones will be the time 
zone set for the interface. This is the default setting.

• Same as Account—The reports’ time zones will be set to 
that of the staff member who is using the dashboard. This 
is set in the staff member’s staff account.

• A specific time zone you can select from a list of standard 
time zones.

Owner Click this drop-down menu to select a dashboard owner. Only the 
dashboard’s owner can view or edit the dashboard, unless the 
owner makes the dashboard public and grants permissions to other 
profiles. Refer to “Specifying permissions” on page 391.

Open dashboard without 
prompting for search 
parameters

Select this check box to open the dashboard using the default run-
time filters for the reports. If this check box is not selected, the 
Search window will open for the dashboard’s reports before the 
dashboard is displayed. Selecting this check box does not prevent 
the Search window from opening if a report has a required run-
time filter.
Refer to “Searching dashboard reports” on page 406 for informa-
tion about searching reports in a dashboard.

Refresh dashboard when 
data shown is changed due 
to an action initiated from 
this dashboard

Select this check box to automatically refresh the dashboard’s 
reports when you initiate an edit from one of the reports in such a 
way that the reports’ contents would change. The dashboard is 
refreshed only if a record is edited in such a way that the record no 
longer matches the dashboard reports’ search criteria.
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Combine filters on the 
same field in search dialog

Select this check box to combine filters on the same field used in 
multiple reports on the dashboard. For example, multiple reports 
on the same dashboard might all have filters to search by contact 
email address. If this check box is selected, the dashboard’s Search 
window will join these into one common filter for this field. The 
search value entered for the common filter will filter the results for 
all reports that have this filter.

Combine filters with the 
same name and type in 
search dialog

Select this check box to combine filters that have the same name 
and filter on different fields with the same data type. For example, 
if there are two filters both named Contact, and one filter searches 
a text field for first name, and the other searches a text field for last 
name, these filters can be joined into one common filter. The 
search value entered for the common filter will be checked against 
both the first name and last name fields.

Cache the drilldown levels 
for all reports

Select this check box to automatically cache the data in report lev-
els when they are displayed. When you open a dashboard with this 
option enabled, the data shown on the reports’ initial output levels 
will be stored on your workstation. When you drill down on a 
report to view another output level and then return to the report’s 
top level, it will load quickly since the data you are viewing is 
cached on your workstation. The cache will be cleared when you 
close the dashboard.
If this option is not selected, the database is queried every time you 
view an output level to ensure the most recent data is displayed 
even if you have already viewed the level. This default functionality 
can result in longer page load times than necessary when viewing 
reports with data that does not change frequently.
Note: This option is also available for individual reports. When 
using a dashboard that has this option enabled, the dashboard’s 
setting will override the settings in the dashboard’s report.

Undock docked filters Select this check box to not dock filters on the dashboard that are 
docked in the dashboard’s reports. If this check box is not selected 
and a report on the dashboard includes docked filters, the filters 
will be displayed in the dashboard’s Search window, and will be 
docked above the reports in the dashboard.

Table 106: Edit Settings Window Description (Continued)

Field Description
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4 Click the OK button to save the dashboard options.

Scheduling dashboards
You can schedule a dashboard to be sent to recipients or to be published in the same manner 
that reports can be scheduled. When a dashboard is scheduled, the recipients will receive an 
email containing the dashboard in the format you select when creating the schedule.

To open a dashboard’s Schedules window, select the Scheduling button on the Properties tab. 
Refer to “Scheduling reports” on page 121 for information about adding schedules.

Automatically refresh 
dashboard at a regular 
interval

Options in this section let you configure automatic refresh of the 
data shown in the dashboard’s reports to ensure the most recent 
data is displayed.

Auto-refresh options 
visible at run-time

Select this check box to add an arrow on the Home tab’s Refresh 
button. Clicking the arrow displays options to let staff members 
enable or disable automatic refresh and change the interval time.
Note: When this check box is not selected, the Refresh button 
refreshes the dashboard’s data only when the button is clicked.

Auto-refresh enabled by 
default

Select this check box to enable automatic refresh of the data shown 
in the dashboard’s reports.

Interval Enter the number of seconds after which the data shown on the 
dashboard will be automatically refreshed.

Image Click Change to select a different image to display next to the 
dashboard in lists such as navigation lists. When selecting the new 
image, you can choose from a list of standard images or from cus-
tom images that have been added in the Images explorer. Refer to 
“Images explorer” on page 52 for procedures on adding images.

Notes Type any text you want to add as a note to the dashboard. The note 
will display on the Edit Settings window, but will not display to 
individuals viewing the dashboard.

Note Dashboard schedules cannot have alerts applied as report schedules can, since 
dashboards do not have data exceptions associated with them.

Table 106: Edit Settings Window Description (Continued)

Field Description
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Specifying permissions
A dashboard’s permissions specify the profiles whose staff accounts can open or edit the 
dashboard. You can select Open and Edit permissions for each profile defined in your sys-
tem. 

To specify dashboard permissions:
1 Click the Home tab.

2 Click the Permissions button.

Figure 208: Permissions Window

3 Enter field information described in Table 107.

4 Click the OK button to save the permissions.

Note Permissions applied to a private dashboard will take effect only when the dash-
board is made public.

Table 107: Permissions Window Description

Field Description

Open Select this check box next to a profile to allow staff members 
assigned to that profile permission to open the dashboard. You can 
select multiple profiles.

Edit Select this check box next to a profile to allow staff members 
assigned to that profile permission to edit the dashboard. You can 
select multiple profiles.
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Viewing the audit log
You can open an audit log for a dashboard to see when the dashboard was created, edited, 
run, and published, and which staff members performed these actions. Since the audit log is a 
report, you can perform common report actions on the audit log, such as printing, forward-
ing, or slicing.

To view the audit log:
1 Edit a dashboard.

2 Click the Home tab.

3 Click the Audit Log button.

Figure 209: Audit Log

4 To access a list of actions that can be taken on the audit log report, click the Options but-
ton. Refer to “Report design center ribbon” on page 182 for descriptions of the actions 
that can be performed on the report.

5 To close the audit log, click the OK button.

Specifying search defaults
When opening a dashboard, the dashboard’s reports will automatically display with their 
default filter values, comparison date offsets, and output variables. However, you can select 
different defaults for the reports when they are opened from the dashboard by changing the 
dashboard’s parameter values. If your dashboard includes the Web Browser–Component 
report, you can also specify a default URL for the web browser displayed in the dashboard.
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You also have the option to set limits on the total number of rows returned in each report or 
the number of rows returned on each page of the reports. For more information about 
searching for information in the reports shown in a dashboard, refer to “Searching dashboard 
reports” on page 406.

To set dashboard reports’ search defaults:
1 Click the Home tab.

2 Click the Parameter Values button to open the Set Filter Values window.

Figure 210: Setting Default Filter Values



394 Dashboards

Chapter 6

The window displays the run-time selectable filters, comparison date offsets, and variables 
that are in the dashboard’s reports. If any of the reports have identical filters, comparison 
date offsets, or output variables, these will be grouped together. You can also set limits on 
the number of rows returned on each page of the reports or the total number of rows the 
reports can return.

3 Select the default values you want for the reports’ variables and filters.

4 To set record or page limits on the reports, select options in the Limit section of the Set 
Filter Values window.

a Select the Limit To check box.
b Type the number of rows to return.
c Select the Per Page check box to apply the entered row limit to each page of the report.

5 Click the OK button to save the dashboard parameters.

Customizing dashboard output
The appearance of the dashboard can be customized by applying a style to the dashboard, by 
changing fonts, by changing the dashboard’s width, and by specifying how the reports on the 
dashboard should be scrolled. You can also add titles to the dashboard’s reports and choose 
which report sections to display.

Applying a style to a dashboard
Dashboards can have report styles applied to them, just as individual reports can. When you 
apply a style to a dashboard, all reports on the dashboard will use the same style when viewed 
from the dashboard. If a new report is added to the dashboard, the dashboard style will need 
to be applied again for the style to be applied to the new report. Refer to “Changing report 
displays with styles” on page 129 for information about applying a style to a report. For pro-
cedures on editing and creating styles, refer to “Styles explorer” on page 27.

To apply a style to a dashboard:
1 Click the Home tab.

2 Click the Auto Format button to open the Auto Format window.

Note If the Per Page check box is not selected, the row limit you enter restricts the 
total number of rows returned in the reports.
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Figure 211: Auto Format Window

3 To prevent the style from being applied to all levels in the reports shown on the dash-
board, clear the Apply Style to All Report Levels check box.

4 Click the style you want to apply to the dashboard.

The report style you choose will be automatically applied to all the reports on your dash-
board.

Changing dashboard display options
You can adjust the dashboard’s display options to add margins and titles to the reports in the 
dashboard. You can also specify which report sections should display in the dashboard’s 
reports.

To change display options:
1 Click the Home tab.

2 Click the Display Options button to open the Display Options window.
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Figure 212: Display Options Workspace Tab

3 Enter field information described in Table 108.

Table 108: Display Options Workspace Tab Description

Field Description

Margins This section contains options for defining the margins for the 
dashboard. The margins you select are applied to the outer margins 
of the entire dashboard, rather than to the margins between 
reports in the dashboard.

Left Select the size of the left margin in pixels.

Right Select the size of the right margin in pixels.

Top Select the size of the top margin in pixels.

Bottom Select the size of the bottom margin in pixels.

View Mode Options in this section let you specify how the dashboard’s reports 
will scroll so you can view the data in the reports.

Screen Select this radio button to add scroll bars to the individual reports 
in the dashboard. The dashboard will not have scroll bars added 
with this option.
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4 Click the Titlebars tab.

Figure 213: Display Options Titlebars Tab

5 To display a report’s title above the report in the dashboard, select the check box next to 
the report.

6 Click the Report Sections tab.

Scrollable Select this radio button to permit each report to display in its pre-
ferred size, with the height and width of the items in each report 
fixed. When this option is selected, a single set of scroll bars will be 
added to the dashboard so you can view the entire dashboard sur-
face.
Note: If the entire size of the dashboard exceeds 32767 x 32767 
pixels, dashboard contents will be clipped when using this option.

Table 108: Display Options Workspace Tab Description (Continued)

Field Description
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Figure 214: Display Options Report Sections Tab

This tab displays the common report sections included in the dashboard’s reports. Sec-
tions common to all reports in the dashboard have a black check mark, sections that are 
not shared by all reports have a gray check, and sections that are not in any of the reports 
have no check.

7 Select the check box next to each report section you want to display on the dashboard. To 
remove a section you have already selected, clear the check box next to the section.

8 Click the OK button to save your display options.

Using dashboards
You open dashboards just as you would open a regular report from the Reports explorer or 
one of your navigation lists. Dashboards can also be opened from links you add to reports. 
When you open a dashboard, it will load with current report data. Alternatively, you can 
queue the dashboard to view it at a later time.

The dashboard will include options similar to those accessed from the Report tab when view-
ing a report. The dashboard will also include docked filters that are common to the reports in 
the dashboard and may include tabs to access reports on other dashboard pages.

Since every report in a dashboard is fully functional, you can access the standard options 
available when viewing a report that allow you to sort columns, show or hide columns, and 
add column calculations. If the report and the permissions allow it, you can also access 
records listed in the reports. 

Figure 215 shows a sample dashboard highlighting dashboard features.
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Figure 215: Sample Dashboard

Dashboard ribbon
When you open a dashboard, the dashboard’s ribbon will include Home and Page Setup tabs. 
You can use the options on these tabs to print the dashboard and adjust the dashboard’s dis-
play and output. When you select an individual report on the dashboard, the ribbon is 
updated to include additional tabs containing options you can use to modify the selected 
report. These tabs are described in this section.

Minimized report

Dashboard tabs

Docked filters

Report menu options

Report ribbon tabs

Note When viewing a published dashboard or a dashboard that is run after being 
queued, some options on the ribbon will not be available.
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Dashboard tabs
The buttons available on the Home and Page Setup dashboard tabs let you open the Search 
window, refresh the display, select display options, forward the dashboard, configure print 
options, and perform other actions that impact the entire dashboard. Refer to “Page Setup 
tab” on page 366 for descriptions of the buttons on the Page Setup tab. The dashboard’s 
Home tab is shown in Figure 216.

Figure 216: Home Tab When Viewing Dashboards

The groups and buttons on the Home tab are described in Table 109.

Important Permission to export, print, and forward reports must be selected in your profile 
for the Page Setup tab and the Export and Forward buttons on the Home tab to 
display. Refer to the RightNow Administrator Manual for information about editing 
profiles.

Table 109: Home Tab Description

Group/Button Description

Data Set The buttons in this group let you search for data in all the dash-
board’s reports, refresh the display, and reset the search criteria to 
the dashboard’s defaults.

Search Click this button to open the dashboard’s Search window. Refer to 
“Searching dashboard reports” on page 406.

Refresh Click this button to refresh the dashboard’s data using the current 
search criteria.
Note: If the auto-refresh feature is enabled, an arrow will display 
on the button, as shown in Figure 216. Clicking the arrow displays 
options to let staff members enable or disable automatic refresh 
and change the interval time for automatic refresh of data. Refer to 
“Changing dashboard options” on page 386 for information about 
automatic refresh of dashboard data.
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Reset Click this button to reset the dashboard’s search criteria to the 
defaults and regenerate the dashboard using the default search cri-
teria.

Display The buttons in this group let you modify how the dashboard is dis-
played. For example, you can apply a style to all the reports on the 
dashboard to give them a similar appearance.

Screen Click this button to display all the dashboard’s reports on the 
screen when the dashboard is run. Each report can have separate 
scroll bars to view the report contents. 

Scrollable Click this button to display all the contents of each report on the 
dashboard. Each report will display in its preferred size and the 
height and width of the items in each report will be fixed. When 
this option is selected, separate reports will not have separate scroll 
bars, but the dashboard will have vertical and horizontal scroll bars 
if needed to display the entire dashboard.
Note: If the entire size of the dashboard exceeds 32767 x 32767 
pixels, dashboard contents will be clipped when using this option.

Display Options Click this button to change the dashboard’s width, add report title 
bars, and select which report sections you want to display. Refer to 
“Changing dashboard display options” on page 395.

Auto Format Click this button to apply a style to all the reports in a dashboard. 
This will override styles applied to the individual reports. Refer to 
“Applying a style to a dashboard” on page 394.

Table 109: Home Tab Description (Continued)

Group/Button Description
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Dashboard The buttons in this group let you export the dashboard, forward 
the dashboard in an email, and save and restore default settings.
Note: Permission to export, print, and forward reports must be 
selected in your profile for the Export and Forward buttons to dis-
play. Refer to the RightNow Administrator Manual for information 
about editing profiles.

Export Click this button to export the data from the dashboard’s reports 
to a file for use with third-party applications. You can export the 
dashboard in the following formats: HTML, PDF, Excel, XML, 
Image, and Delimited. Dashboards and reports are exported using 
the same method and can be exported in the same formats. Refer 
to “Exporting report output” on page 115.
Note: When a dashboard is exported in the Excel format, the 
placement of reports on the dashboard and the reports’ row and 
column spacing are reset so the data will be displayed sequentially 
in the third-party application.

Forward Click this button to send the dashboard to individuals or distribu-
tion lists in an email. Dashboards and reports are forwarded using 
the same method. Refer to “Forwarding reports” on page 111.

Default Settings Click this button and select Save as Default to save your personal-
ized display and data settings for a dashboard for later use. Select 
Restore to remove personalized display and data settings from a 
dashboard and restore the settings to those defined in the dash-
board. Refer to “Resetting display and data settings” on page 160.

Sections The options in this group let you select whether to show the dash-
board’s header, footer, and description.

Dashboard Header Select this check box to show the dashboard’s header.

Dashboard Footer Select this check box to show the dashboard’s footer.

Dashboard Description Click this button and select how the dashboard description should 
be displayed. You can choose to not display a description, display 
the description inline, or display the description on a separate tab.

Table 109: Home Tab Description (Continued)

Group/Button Description
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Report tabs
When you click a report on the dashboard to select it, the ribbon will be updated to include 
the report’s Home, Display, and Page Setup tabs. You can use the buttons on these tabs to 
perform all the same actions you could if viewing the report outside of a dashboard. For 
example, you can add calculations, select fields to show in the report, sort the report output, 
and edit records. For descriptions of the buttons on these tabs, refer to “Ribbon options 
when viewing reports” on page 78.

Queuing dashboards
Dashboards can be queued to run at a later time just as reports can. Dashboards can be man-
ually queued or automatically queued. Once a queued dashboard generates, you can view the 
dashboard using a standard report or a notification just as you can with queued reports.

For more information about queuing, refer to “Queuing reports” on page 100.

Manually queuing dashboards
You can easily queue dashboards containing reports that you think may query or return large 
amounts of data. This is also helpful if you want to view a number of dashboards but do not 
want to wait for each to generate.

To manually queue a dashboard:
1 Select the dashboard on the Reports explorer and click the ribbon’s Queue button.

Or

Right-click the dashboard, either on the Reports explorer or the navigation list, and select 
Queue.

The Queue Search Filters window opens where you specify the search parameters you 
want to use for the queued dashboard.
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Figure 217: Entering Search Parameters for a Queued Dashboard

2 Enter the search parameters you want to use. For information about selecting search 
parameters, refer to “Searching dashboard reports” on page 406.

3 Click the Queue button. A window displays an approximation of when the dashboard will 
be available to view.

Figure 218: Estimated Delivery Time for a Queued Dashboard

4 Click the OK button to close the window.

Automatic queuing
When you attempt to open a dashboard, the queries that are required to run each of the dash-
board’s reports are examined. If the system determines that one or more of the reports will 
take too long to process, the Unable to Process Dashboard message displays.
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Figure 219: Unable to Process Dashboard Message

The message tells you which report(s) in the dashboard are causing the problem and you can 
choose to queue the dashboard or not. If you choose to queue the dashboard, it will be 
queued to run at a later time using the search parameters you entered. A message will show 
you the estimated time when the dashboard will be ready for viewing. If you choose not to 
queue the dashboard, you can try to run it again using more restrictive search parameters.

Viewing queued dashboards
After you queue a dashboard, you can use standard reports to see the dashboard’s status in 
the queue. Once the dashboard runs and is ready to view, you will be notified and you can 
open it from several locations. When you view the dashboard, you will see that most of the 
standard options are available on the dashboard’s ribbon, though there are some exceptions.

It is possible that some of the reports in the dashboard will not be able to queue successfully, 
for the reasons described in “Queuing failures” on page 103. If a report in a dashboard can-
not be queued, the queued dashboard will not be processed.

The methods to view and open dashboards that have been queued are identical to those used 
with queued reports. For information about viewing and opening queued reports, refer to    
“Viewing queued reports” on page 103.

Displaying and hiding reports in a dashboard
When viewing a dashboard, you can use buttons displayed in each report’s title bar to mini-
mize, maximize, or close each report. This allows you to simplify the dashboard display when 
you want to focus on certain reports in the dashboard.

Note The minimize, maximize, and close buttons are not available when the dash-
board is displayed with a scrollable view mode. Refer to “Changing dashboard 
display options” on page 395 for information about view modes.
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The buttons in each report’s title bar are described in Table 110.

Searching dashboard reports
Searching for information in reports on a dashboard is similar to searching the reports when 
they are generated on their own. However, there are some differences which are explained in 
this section.

Docked filters
When a report includes docked run-time filters, they display at the top of the report when the 
report is run outside of a dashboard. When the report is opened in a dashboard, the report’s 
docked filters are displayed at the top of the dashboard.

If multiple reports in the same dashboard include docked filters, all the reports’ docked filters 
are displayed at the top of the dashboard. If two or more reports in the dashboard have the 
same docked filters, these can be merged so only one docked filter displays. Values you set in 
the merged filter are applied to all reports with that filter. Refer to “Changing dashboard 
options” on page 386 for information about combining filters for dashboard reports.

Search window
When reports are displayed together on a dashboard, you can search for information in all the 
reports simultaneously. Searching for information in a dashboard is similar to searching for 
information in a report, though a dashboard’s Search window will display filters common to 

Table 110: Dashboard Report Display Buttons Descriptions

Button Description

 Minimize Click this button to minimize the report. When a report is mini-
mized, the report name and icon will display in the lower left cor-
ner of the dashboard. To restore the report, right-click the 
minimized option and select Restore.

 Maximize Click this button to maximize the report. When a report is maxi-
mized, the other reports in the dashboard will be hidden.

 Restore Click this button in the maximized report’s title bar to return the 
report to its previous size.

 Close Click this button to close the report. The report will be displayed 
the next time you load the dashboard.
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multiple reports, followed by report-specific filters. These common and report-specific filters 
are separated by headers on the Search window. For specific information about using the 
Search window, refer to “Searching in reports and analyzing output” on page 90.

Figure 220 shows a sample search window from a dashboard with several reports.

To search for information in all reports on a dashboard:
1 Open the dashboard and click the Home tab.

2 Click the Search button to open the dashboard’s Search window.

Figure 220: Search Window for Reports in a Dashboard

3 Select the filters, variables, and limits you want. 
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4 Click the OK button to apply the search criteria to all the reports on the dashboard.

If you want to search a specific report on the dashboard without searching the dashboard’s 
other reports, select the report on the dashboard, click the report’s Home tab on the ribbon, 
and then click the Search button.

To search for information in only one report on a dashboard:
1 Open the dashboard.

2 Select the report on the dashboard you want to search. When you select a single report on 
the dashboard, additional report tabs will display on the ribbon, as shown in Figure 221.

Figure 221: Report Tabs on the Dashboard Ribbon

3 Click the Home tab beneath the ribbon’s Report heading and then click the Search button 
to open the report’s Search window.

The search you perform from the report’s Search window will apply only to the selected 
report.

Note Certain options you select when creating dashboards impact the behavior of the 
Search window. For example, if you select the Open Dashboard Without 
Prompting for Search Parameters option on the Edit Settings window, the 
Search window will automatically open when you open the dashboard. Refer to 
“Changing dashboard options” on page 386 for information about these 
options.
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Enterprise Analytics

Enterprise Analytics provides you with a data warehousing system you can use to report on 
data from your RightNow site along with data from other databases you may use. This solu-
tion allows you to view trends in your data over time and create complex reports for manag-
ers and other staff members who need high-level overviews of large amounts of data from 
diverse sources. Using Enterprise Analytics, you can create and customize reports that include 
features you may already be familiar with, such as charts, calculations, and drill-down levels. 
You can also create dashboards to display a number of reports in one location.

In this chapter

• Configuring Enterprise Analytics—Describes the procedures to configure access to Enterprise 
Analytics on your RightNow interface. Refer to page 410.

• Using Enterprise Analytics—Provides an overview of how to use Enterprise Analytics. Also 
describes how to find detailed information about Enterprise Analytics. Refer to page 415.
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Configuring Enterprise Analytics
Before you can use Enterprise Analytics, it must be enabled on your site. Once it is enabled, 
you should verify that staff members who can access Enterprise Analytics have a valid email 
address. You also must configure profiles and navigation sets to allow your staff members to 
access Enterprise Analytics.

This section describes how to verify staff members’ email addresses, assign profile permis-
sions, and customize navigation sets for Enterprise Analytics.

Verify account email addresses
To use Enterprise Analytics, staff members must have a valid email address specified in their 
staff account. For detailed information about configuring staff accounts, refer to the RightNow 
Administrator Manual.

To verify an email address:
1 Click the Common Configuration button on the navigation pane.

2 Double-click Staff Accounts under Staff Management. The Staff Accounts tree and editor 
display.

3 Right-click the staff account you want to verify and select Edit. The staff account’s infor-
mation displays.

4 To add or change the email address, type the address you want in the Email Address field.

5 Click the Save button to save the change to the staff account.

Important To enable Enterprise Analytics, contact your RightNow account manager. The 
administration options described in this section will not be visible until Enter-
prise Analytics is enabled.
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Assigning Enterprise Analytics profile permissions
Profiles permissions allow you to control what product functionality and areas of RightNow 
your staff members can access. To use Enterprise Analytics, staff members must by associated 
with a profile that contains some or all permissions to view, create, edit, export and delete 
reports and dashboards in Enterprise Analytics. Permissions also need to be granted to allow 
staff members to view dashboards and perform administrative tasks in Enterprise Analytics.

This section describes how to assign the profile permissions that are specific to Enterprise 
Analytics. For more information about profiles, refer to the RightNow Administrator Manual.

To assign profile permissions for Enterprise Analytics:
1 Click the Common Configuration button on the navigation pane.

2 Double-click Account Profiles under Staff Management.

3 Right-click the profile you want to change and select Edit Profile.

4 Click the Enterprise Analytics tab, shown in Figure 222.

Figure 222: Selecting Enterprise Analytics Profile Permissions
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5 Select the check boxes next to the permissions you want to assign. The available permis-
sions are described in Table 111.

6 Click the Save button to save the changes to the profile.

Customizing navigation sets
Before staff members can access Enterprise Analytics, you need to add the Enterprise 
Analytics button to their navigation set and select the items that will be available. Three sepa-
rate components can be added, each giving staff members access to different areas of Enter-
prise Analytics. A navigation list including the Enterprise Analytics items is shown in Figure 
223.

Table 111: Enterprise Analytics Profile Permissions

Option Description

Enterprise Analytics Select this check box to select all check boxes on this tab.

View Dashboards Select this check box to provide read-only access to dashboards 
within Enterprise Analytics.
Note: This option is required for staff members to create, edit, and 
delete dashboards and to access the Dashboards item on the 
Enterprise Analytics navigation list. We recommend that all staff 
members who use Enterprise Analytics are granted this permis-
sion.

Export Reports/
Dashboards

Select this check box to allow the staff member to export reports 
and dashboards from Enterprise Analytics.

Create/Edit/Delete 
Reports

Select this check box to allow the staff member to create, edit, and 
delete reports in Enterprise Analytics.
Note: Selecting this option is required for staff members to access 
the Reports item on the Enterprise Analytics navigation list.

Create/Edit/Delete 
Dashboards

Select this check box to allow the staff member to create, edit, and 
delete dashboards in Enterprise Analytics.

Administrator Select this check box to allow the staff member to access the cata-
log administration tool in Enterprise Analytics.
Note: Selecting this option is required for staff members to use 
the Catalog item on the Enterprise Analytics navigation list.
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Figure 223: Enterprise Analytics Navigation List

For more information about customizing navigation sets, refer to the RightNow Administrator 
Manual.

To customize navigation sets for Enterprise Analytics:
1 Double-click Navigation Sets under Application Appearance. The Navigation Sets 

explorer opens.

2 Right-click the navigation set you want to change and select Open.

3 Select the Enterprise Analytics check box on the upper right of the content pane to add 
this navigation button to the navigation set.

4 Expand the Components tree on the left and open the Enterprise Analytics folder to view 
the items you can add to the navigation list.

Note You can add all three Enterprise Analytics items to the navigation list even if 
some staff members do not have profile permissions to use all items. The navi-
gation list items will be disabled for staff members who lack permissions to use 
them.
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The Enterprise Analytics items you can add to navigation lists are described in Table 112.

5 Select an item and click the Add button to add it to the navigation list. To add multiple 
items at the same time, press Ctrl while selecting items.

6 Click the Save and Close button on the ribbon to save the changes to the navigation set.

Table 112: Enterprise Analytics Navigation Set Items

Button Description

Catalog Add this item so staff members can use administration tools to 
manage the reports and dashboards catalog in Enterprise 
Analytics.
Note: This item is available to only those staff members with the 
Administrator check box selected in their profile.

Dashboards Add this item so staff members can view, create, edit, and delete 
dashboards in Enterprise Analytics.
Note: This item is available to only those staff members with the 
View Dashboards or Create/Edit/Delete Dashboards check boxes 
selected in their profile.

Reports Add this item so staff members can create reports in Enterprise 
Analytics.
Note: This item is available to only those staff members with the 
Create/Edit/Delete Reports check box selected in their profile.

Note You can also drag items and drop them on the lower part of the right side of the 
content pane.
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Using Enterprise Analytics
Once you configure Enterprise Analytics, you can open it from the Enterprise Analytics navi-
gation list. When you select one of the items, Enterprise Analytics will open on a new tab on 
the content pane.

• Dashboards—Select this item to view reports shown on dashboards or to create dash-
boards.

• Reports—Select this item to create new reports or edit existing reports.

• Catalog—Select this item to organize reports and dashboards in folders using actions 
such as copy, move, and delete.

Enterprise Analytics resources
When you view, create, edit, and delete reports and dashboards in Enterprise Analytics, you 
use tools provided by Birst, Inc., a vendor RightNow has partnered with. While these tools 
are not described in this documentation, you can find help, FAQs, training videos, and other 
information on Birst’s online help site located at http://akweebeta.com/mediawiki-1.12.0.

Important Enterprise Analytics uses data sent from your RightNow database each night. 
Thus, the RightNow data you view in Enterprise Analytics can be from 0 to 24 
hours old, depending on when the data was sent and when you access your 
reports or dashboards in Enterprise Analytics.

Important Since your data is automatically uploaded into Enterprise Analytics and the tools 
you use are already integrated with RightNow, not all help topics accessible from 
Birst’s online help site are applicable. Topics pertaining to reports, ad hoc 
reports, dashboards, and catalog administration apply to your use of Enterprise 
Analytics, while the others apply exclusively to Birst.

http://akweebeta.com/mediawiki-1.12.0
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Appendix A
Analytics System Configuration Settings

There are a number of system configuration settings that can impact how your reports run, 
how certain information in them is displayed, and how much information is available for the 
reports to return. The settings you should be aware of are described in this appendix. For 
information about accessing and changing system configuration setting values, refer to the 
RightNow Administrator Manual.

RightNow Common settings
The settings described in Table 113 are located in RightNow Common on the General Con-
figuration Menu. These settings let you adjust a number of values that impact what informa-
tion is available in certain reports, the maximum size of generated reports, date and time 
formats, and other aspects of reporting.

Important Changes made to system configuration settings can greatly impact the perfor-
mance and functionality of your entire RightNow site. Before you change any 
system configuration setting, it is important that your organization understands 
the impact of changing the setting.

Table 113: RightNow Common Analytics Settings

To… Use this setting…

Service Modules>Clustering Field

Enable clustering and the use of clustering information by 
other modules. 
Note: The default value for this setting is enabled (Yes).

CLUST_ENABLED

Service Modules>Scheduled Reports

Enable the Alerts/Scheduled Reports feature. SR_ENABLED
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General Analytics Options>Server Options

Specify how many days charts and other images in sched-
uled reports and forwarded reports will be kept. Scheduled 
reports use the “stored on the server” formats; forwarded 
reports use the HTML attachment option. The maximum 
is 90 days. 
Note: The default value for this setting is 14.

KEEP_EMAILED_IMAGES

Specify the maximum file size, in bytes, the Web server will 
try to return to the client when generating a report. The 
maximum value for this setting is 2147483647 (2 GB).
Note: The default value for this setting is 15728640
(15 MB).

MAX_ANALYTICS_FILE_SZ

Specify the number of days after which report run audit log 
rows will be deleted. 
Note: The default value for this setting is 10.

PURGE_REPORT_RUN_
AUDITS

General Analytics Options>Report Options

Specify the choice of the From address when a report is 
emailed as a subscription or when using the Send To fea-
ture. The accepted values are: 1 - The From address defined 
in the default mailbox for the interface. 2 - The email 
address of the staff member who owns the scheduled 
report and/or sends the report. 
Note: The default value for this setting is 2.

RPT_FROM_ADDR

General Analytics Options>Custom Scripts

Specify the size of the data buffer (in bytes) used when pro-
cessing custom scripts in Analytics. 
Note: The default value for this setting is 50000.

CUSTOM_SCRIPT_DATA_SIZE

Table 113: RightNow Common Analytics Settings (Continued)

To… Use this setting…
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General Analytics Options>Group Date Format

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Month/Day at runtime. 
Note: The default value for this setting is YYYY/MM/
DD.

GRP_DT_DATE_DAY_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Month/Day/Hour at runtime. 
Note: The default value for this setting is YYYY/MM/
DD/HH24. 

GRP_DT_DATE_HOUR_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Month at runtime. 
Note: The default value for this setting is YYYY/MM.

GRP_DT_DATE_MONTH_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Quarter at runtime. 
Note: The default value for this setting is YYYY/Q.

GRP_DT_DATE_QUARTER_
FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Week at runtime.
Note: The default value for this setting is YYYY/WW. 

GRP_DT_DATE_WEEK_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Year/Week Start at runtime. 
Note: The default value for this setting is YYYY/WWW.

GRP_DT_DATE_WEEK_
START_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by Day 
of Month at runtime. 
Note: The default value for this setting is DD.

GRP_DT_DAY_OF_MONTH_
FMT

Table 113: RightNow Common Analytics Settings (Continued)

To… Use this setting…
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Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by Day 
of Week at runtime. 
Note: The default value for this setting is DAY.

GRP_DT_DAY_OF_WEEK_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Hour at runtime. 
Note: The default value for this setting is HH24. 

GRP_DT_HOUR_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Month/Day at runtime. 
Note: The default value for this setting is MM/DD.

GRP_DT_MONTH_DAY_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Month at runtime. 
Note: The default value for this setting is MM.

GRP_DT_MONTH_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Quarter at runtime. 
Note: The default value for this setting is Q.

GRP_DT_QUARTER_FMT 

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Week at runtime. 
Note: The default value for this setting is WW.

GRP_DT_WEEK_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by 
Week Start at runtime. 
Note: The default value for this setting is WWW.

GRP_DT_WEEK_START_FMT

Specify the format string used in the predefined group date 
list for output variables, if the user selects grouping by Year 
at runtime. 
Note: The default value for this setting is YYYY.

GRP_DT_YEAR_FMT

Table 113: RightNow Common Analytics Settings (Continued)

To… Use this setting…
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RightNow User Interface settings
Only one setting in the RightNow User Interface category impacts reports: VLR_HARD, 
located under Misc. Customization>Query. This configuration setting allows you to specify 
the maximum number of rows that can be displayed in a report. Limiting the number of rows 
prevents inefficient reports from returning more rows than can be quickly processed and dis-
played. If the number of rows returned in a report exceeds this number, the remaining results 
will not be displayed. The default value for this setting is 10000.

Agedatabase Utility settings
The Agedatabase utility automatically runs on the server(s) hosting your RightNow site(s). 
The utility’s main function is to perform automatic maintenance on your knowledge base (for 
example, aging incidents and answers). However, Agedatabase also caches report data into 
individual report tables to make report generation more efficient, and it purges old informa-
tion that is no longer required for reports to help maintain the efficiency of your database.

The settings described in Table 114 are located in Agedatabase Utility on the General Config-
uration Menu. These settings allow you to set the aggressiveness of the utility’s data caching 
and purging, and specify values used by certain sales reports and scorecards that use cached 
data.

Important Changes made to system configuration settings can greatly impact the perfor-
mance and functionality of your entire RightNow site. Before you change any 
system configuration setting, it is important that your organization understands 
the impact of changing the setting.

Table 114: Agedatabase Utility Analytics Settings

To… Use this setting…

Batch Processing>Miscellaneous Purging

Define the number of days after which answer statistics are 
removed from the database. Set this value to 0 to prevent 
answer statistics from being removed from the database.
Note: The default value for this setting is 0.

PURGE_DELETE_ANS_STATS
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Define the number of days after which incident perfor-
mance statistics are removed from the database. Set this 
value to 0 to prevent statistics from being removed from 
the database.
Note: The default value for this setting is 0.

PURGE_DELETE_INC_
PERFORMANCE

Define the number of days after which keyword search sta-
tistics are removed from the database. Set this value to 0 to 
prevent statistics from being removed from the database. 
Note: The default value for this setting is 120.

PURGE_DELETE_KEYWORD_
SEARCHES

Define the number of days after which queue statistics are 
removed from the database. Set this value to 0 to prevent 
statistics from being removed from the database. 
Note: The default value for this setting is 120.

PURGE_DELETE_QUEUE_
STATS

Define the number of days after which session summary 
statistics are removed from the database. Set this value to 0 
to prevent statistics from being removed from the database. 
Note: The default value for this setting is 0.

PURGE_DELETE_SESSION_
SUMMARY 

Define the number of days after which login/logout ses-
sions are removed from the user_trans table (relative to the 
logout time). Set this value to 0 to prevent login/logout ses-
sions from being removed from the database.
Note: The default value for this setting is 0.

PURGE_DELETE_USER_
TRANS

Define the number of days after which voice statistics are 
removed from the database. Set this value to 0 to prevent 
statistics from being removed from the database.
Note: The default value for this setting is 90. For sites with 
multiple interfaces, statistics will be removed from all inter-
faces based on the interfaces’ smallest non-zero value for 
this setting.

PURGE_DELETE_VOICE_
STATS

Specify the number of days after which files that store the 
output from queued reports and dashboards will be 
deleted.
Note: The default value for this setting is 7 days.

PURGE_QUEUED_REPORT_
DAYS

Table 114: Agedatabase Utility Analytics Settings (Continued)

To… Use this setting…
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Specify the number of days after which Rule Log entries 
will be deleted. The maximum value for this setting is 180. 
A value of zero will result in the data being deleted after 
180 days.
Note: The default value for this setting is 30.

PURGE_RULE_LOG_FREQ

Specify the number of days after which session tracking 
data will be deleted from the database. Set this value to 0 to 
prevent session data from being deleted.
Note: The default value for this setting is 30.

PURGE_SESSION_TRACKING

Batch Processing>SA Opportunities

Specify the day of the week that the opportunities table will 
be cached for the current sales period(s). Values refer to the 
day of week, with 1 being Sunday, 2 being Monday, and so 
on. A value of 0 disables opportunity caching.
Note: The default value for this setting is 6 (Friday).

OPP_SNAPSHOTS_SCHEDULE

Batch Processing>Gap Analysis

Specifies how frequently (in days) the Information Gap 
report is generated.
Note: The default value for this setting is 7.

GAP_FREQUENCY

Specify the time period reported on in the Information 
Gap report. The report will analyze incidents created dur-
ing the specified number of days.
Note: The default value for this setting is 7.

GAP_TIME_PERIOD

Batch Processing>Sales Performance

Specify the quota attainment threshold as a percentage that 
a given salesperson should meet to be classified as a “Top 
Performer.” 
Note: The default value for this setting is 95.

SALES_TOP_PERFORMER_
THRESHOLD

Table 114: Agedatabase Utility Analytics Settings (Continued)

To… Use this setting…
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Specify the relative value from 1-10 of a salesperson or 
group’s lost revenue in reviewing current performance. 
This value is relative to the other 
SALES_TP_REL_VALUE_* configuration settings. 
Note: The default value for this setting is 5.

SALES_TP_REL_VALUE_LOST

Specify the relative value from 1-10 of a salesperson or 
group’s closed revenue in reviewing current performance. 
This value is relative to the other 
SALES_TP_REL_VALUE_* configuration settings. 
Note: The default value for this setting is 5.

SALES_TP_REL_VALUE_
CLOSED

Specify the relative value from 1-10 of a salesperson or 
group’s closed revenue of new business in reviewing cur-
rent performance. This value is relative to the other 
SALES_TP_REL_VALUE_* configuration settings.
Note: The default value for this setting is 5.

SALES_TP_REL_VALUE_NEW_
BUSINESS

Specify the relative value from 1-10 of a salesperson or 
group’s pipeline in reviewing current performance. This 
value is relative to the other SALES_TP_REL_VALUE_* 
configuration settings. 
Note: The default value for this setting is 5.

SALES_TP_REL_VALUE_
PIPELINE

Specify the relative value from 1-10 of money versus 
opportunity counts in reviewing a salesperson or group’s 
current performance. A value of 5 means they are treated 
equally. A value of 7 means that total monetary value of 
opportunities is more important than the number of 
opportunities. A value of 3 means that the number of 
opportunities is more important than the total value of 
those opportunities.
Note: The default value for this setting is 5.

SALES_TP_METRIC_BALANCE

Table 114: Agedatabase Utility Analytics Settings (Continued)

To… Use this setting…
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Appendix B
Transaction Descriptions

Many of the standard reports available in RightNow Analytics use data from the database’s 
transactions table. The information in this table describes the actions taken on records (such as 
incidents, answers, and contacts) and items (such as mailings, surveys, and quotes) in your 
database. For example, when an incident is created and then assigned to a staff member, two 
entries are added to the transactions table. The first entry describes when the incident was cre-
ated, who created it, and where it was created from. The second entry describes who the inci-
dent was assigned to and when it was assigned.

Due to the amount of information stored in the transactions table, it can be challenging to write 
custom reports that use information from the table. However, once you understand how to 
use the data in the table, you can create powerful custom reports to output or filter on almost 
all actions taken on the records and items in your database.

This appendix identifies the data stored in the transactions table and will help you use the data 
to create the custom reports you want. Table 115 briefly describes all the fields in the transac-
tions table, Table 116 on page 427 describes the types of transactions and the records and 
items they can apply to, and Table 117 on page 429 describes the information contained in 
the table’s attribute 1, attribute 2, attribute 3, and description fields.

Important You can view additional information about the transactions table and information 
about the other tables in your RightNow database in the data dictionary. You can 
access the data dictionary from the RightNow Console at Common 
Configuration>Database Administration>Data Dictionary.

Table 115: Transactions Description

Field Description

Account ID (acct_id) The staff member who performed the transaction. This field will 
be NULL for transactions not initiated by a staff member.

Attribute 1 (id1) This field contains information specific to certain types of transac-
tions taken on certain records and items. This field will be NULL 
for many transactions. Refer to Table 117 on page 429 for descrip-
tions of this field’s contents.
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Attribute 2 (id2) This field contains information specific to certain types of transac-
tions taken on certain types of records and items. This field will be 
NULL for many transactions. Refer to Table 117 on page 429 for 
descriptions of this field’s contents.

Attribute 3 (id3) This field contains information specific to certain types of transac-
tions taken on certain types of records and items. This field will be 
NULL for most transactions. Refer to Table 117 on page 429 for 
descriptions of this field’s contents.

Date Created (created) The date and time the transaction occurred.

Date/Time (dttm) The scheduled date and time for a mailing. This value will be 
NULL for any other record or transaction type.

Description (description) This field contains information specific to certain types of transac-
tions taken on certain types of records and items. This field will be 
NULL for many transactions. Refer to Table 117 on page 429 for 
descriptions of this field’s contents.

Foreign Key (id) The unique ID number of the record, such as an incident or con-
tact, that the transaction affected.

Interface (interface_id) The interface the transaction was performed in.

Source (source_lvl1—
source_lvl2)

The RightNow component where the transaction occurred. Level-
1 source codes are the general area of RightNow, and level-2 
sources are the specific component. Refer to the data dictionary for 
descriptions of the source codes.

Source Hierarchy 
(source_hierarchy)

The level-1 and level-2 sources displayed in a hierarchical menu.

Table Association (tbl) The type of record or item the transaction occurred on, such as an 
incident, quote, or survey. Refer to Table 116 for a list of record 
and item types and the types of transactions that can apply to them.

Type (trans_type) The type of transaction that occurred, such as a record being cre-
ated or edited. Refer to Table 116 for a list of all transaction types.

Table 115: Transactions Description (Continued)

Field Description
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The types of transactions stored in the transactions table are listed in Table 116. The table also 
shows the types of records and items that the transaction types can apply to. The numbers 
shown in parentheses after the transaction and record and item types are the numeric codes 
for the types.

Table 116: Transaction Types and Table Associations

Table Association (tbl)
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Transaction Type (trans_type)

Created (2) X X X X X X X X X X X X X X

Edited (3) X X X X X X X X X X X X X X X

Assigned (4) X X X X X X X

Access Level Changed (5) X

Status Changed (6) X X X X X X X

Time Billed Added (7) X

Response Sent (8) X

Escalated (11) X X X X X X

SmartAssistant (12) X

Forwarded (14) X

Message Send Failure (15) X

Incident Proposed (16) X

Queue Changed (17) X

Stage Changed (18) X

Moved (20) X

Forwarded by a Rule (21) X X
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Quote Sent (22) X

Opt-In (23) X

Sent (24) X

Completed (25) X

Survey Disabled (26) X

Advanced Mode (27) X

Mailing Error (28) X

Mailing Scheduled (29) X

Audience Counted (30) X X X X

CAN-SPAM Compliance (31) X

Quote Forecasted (32) X

Quote Price Schedule 
Changed (33)

X

Quote Template Changed 
(34)

X

Invalid Email Flag Changed 
(35)

X

Contact Password Reset (36) X

Table 116: Transaction Types and Table Associations (Continued)

Table Association (tbl)
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The information contained in the transactions table’s attribute 1, attribute 2, attribute 3, and descrip-
tion fields vary depending on the transaction type and the type of record or item the transac-
tion is associated with. The information in these fields is described in Table 117.

Note These fields are not populated for all types of transactions or all combinations 
of transactions and records. For example, the attribute 1 field contains the IP 
address of the source of an incident creation, but the value in this field will be 
NULL for an answer creation or an incident escalation.

Table 117: Attribute and Description Fields

Field Description

Attribute 1 (id1) The following describes the contents of this field for each transac-
tion type. The number in parentheses is the type’s ID number.

• Created (2)—If the record type is an incident, this is the IP 
address of the incident’s source, stored in Int64 format.

• Edited (3)—If the record type is an incident, this is the IP 
address of the incident’s source, stored in Int64 format.

• Assigned (4)—This is the ID number of the assigned group.

• Status Change (6)—This is the ID number of the new sta-
tus.

• Response Sent (8)—This is the staff member who sent the 
response.

• Forwarded (14)—This is the staff member who forwarded 
the record.

• Message Send Failure (15)—This indicates the type of 
transaction that failed:

8–Response sent
14–Forwarded
21–Forwarded by a rule
22–Quote sent

• Incident Proposed (16)—This is the answer that was cre-
ated from the proposed incident.

• Queue Changed (17)—This is the queue the record is 
assigned to.

Continued on the next page
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Attribute 1 (id1) (cont.) • Stage Changed (18)—This is the stage the opportunity was 
moved to.

• Quote Sent (22)—This is the staff account that sent the 
quote.

• Opt In (23)—If the value in the transaction’s attribute 2 field 
is 1, this is the ID number of the custom field.

• Disabled (26)—This indicates if the survey is disabled:

0–Active
1–Disabled

• Advanced Mode (27)—This indicates if the survey is in 
Advanced mode:

0–Not in Advanced mode
1–In Advanced mode

• Mailing Error (28)—This is the code associated with the 
mailing error. For a descriptions of the error codes, refer to 
the error details (error_code) field in the Mailing Messages 
(mailing_formats) table in the data dictionary. You can access 
the data dictionary from the RightNow Console at Com-
mon Configuration>Database Administration>Data Dic-
tionary.

• Audience Counted (30)—This is the audience count the last 
time it was counted.

• CAN-SPAM Compliance (31)—This is a bit mask that indi-
cates the results of CAN-SPAM compliance testing.

• Quote Forecasted (32)—This indicates if the quote was 
forecasted:

0–Not forecasted
1–Forecasted

• Quote Price Schedule Changed (33)—This is the schedule 
for the associated price schedule.

Continued on the next page

Table 117: Attribute and Description Fields (Continued)

Field Description
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Attribute 1 (id1) (cont.) • Quote Template Changed (34)—This is the action that was 
performed on the template:

1–Add
2–Update
3–Delete

• Invalid Email Flag Changed (35)—This indicates if the pri-
mary email address was set to Invalid:

0–Not set to Invalid
1–Set to Invalid

• Password (36)—This indicates if the password was manu-
ally changed or reset:

0–Changed
1–Reset

Attribute 2 (id2) The following describes the contents of this field for each transac-
tion type. The number in parentheses is the type’s ID number.

• Assigned (4)—This is the staff member the record is 
assigned to.

• Status Changed (6)—This is the group the staff member 
who performed the status change belongs to.

• Response Sent (8)—This is the group the staff member 
who sent the response belongs to.

• Forward (14)—This is the group the staff member who for-
warded the record belongs to.

• Message Send Failure (15)—This indicates the reason for 
the mailing error:

1–Unknown
2–Message disabled
3–No escalation action
4–Escalation disabled
5–Message queued
6–SMTP error
7–No valid recipients
8–Empty thread

Continued on the next page

Table 117: Attribute and Description Fields (Continued)

Field Description
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Attribute 2 (id2) (cont.) • Queue Changed (17)—This is the queue the incident was 
previously assigned to.

• Stage Changed (18)—This is the strategy the opportunity 
was changed to.

• Quote Sent (22)—This is the group the staff member who 
sent the quote belongs to.

• Opt-In (23)—This indicates the type of the opt-in flag:

1–Custom field
2–Global opt-in flag

• Quote Template Changed (34)—This is the template used 
by the quote.

• Invalid Email Flag Changed (35)—This indicates if the first 
alternate email address was set to Invalid:

0–Not set to Invalid
1–Set to Invalid

Attribute 3 (id3) The following describes the contents of this field for each transac-
tion type. The number in parentheses is the type’s ID number.

• Created (2)—If the record was created from a call, this is 
the call the incident or opportunity was created from.

• Edited (3)—If the record was updated from a call, this is 
the call the incident or opportunity was updated from.

• Opt-In (23)—This indicates if the flag was enabled or dis-
abled:

0–Disabled
1–Enabled

• Quote Template Changed (34)—This is the template that 
was changed.

• Invalid Email Flag Changed (35)—This indicates if the sec-
ond alternate email address was set to Invalid:

0–Not set to Invalid
1–Set to Invalid

Table 117: Attribute and Description Fields (Continued)

Field Description
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Description (desc) The following describes the contents of this field for each transac-
tion type. The number in parentheses is the type’s ID number.

• Created (2)—If the new record is a meta-answer created 
from a proposed incident, this is the reference number of 
the incident that was proposed.

• Access Level Changed (5)—This is a bit mask describing 
the answer’s new access level(s).

• Response Sent (8)—This lists the email addresses (not 
including BCC) the response was sent to.

• Escalated (11)—This is the ID number of the new escala-
tion level.

• Forward (14)—This lists the email addresses the item was 
forwarded to.

• Message Send Failure (15)—This lists the email addresses 
(not including BCC) that were to receive the message.

• Incident Proposed (16)—This is the reference number of 
the incident that was proposed.

• Forwarded by a Rule (21)—This lists the email addresses 
the record was forwarded to.

• Quote Sent (22)—This lists the email addresses (not includ-
ing BCC) the quote was sent to.

Table 117: Attribute and Description Fields (Continued)

Field Description
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RightNow Glossary

Absolute time—An exact date and time defined 
in an escalation action for business rules or a com-
parison period for custom reports. In standard 
reports, absolute time is the amount of time passed 
based on a 24-hour clock.
See also Relative time.

Access level conditional section—A method of 
controlling the visibility of a portion of an answer. 
Only those staff members and customers with per-
mission to view the access level assigned to the 
answer section can view it.

Accessibility interface—A non-graphical inter-
face in RightNow Service that allows staff mem-
bers to work on the administration interface and 
customers to use the Classic end-user interface. All 
mouse functionality is accomplished with key-
strokes to make navigation simple and fast.

Action—The part of a business rule that defines 
what happens when an object (answer, contact, 
incident, chat session, opportunity, organization, 
target, or task) meets the rule’s conditions. Rules 
can contain multiple actions. An action is also a 
component of a campaign. Actions can perform 
one of nine functions in a campaign, including 
sending broadcast and transactional mailings, exe-
cuting external events, adding contacts to lists, and 
notifying staff members.

Action arrow—An arrow on a workspace field or 
control that displays available editing options.

Activate—A process that is manually run after 
making changes to a state, function, or rule in a 
rule base to check for errors, archive the current 
rule base, and convert the edited rule base to the 
active rule base.
See Business rules and Rule base.

Active—One of the default opportunity statuses 
and status types. An opportunity with the Active 
status is currently advancing in the system toward a 
sale.

Add-in—A custom .NET component that is 
loaded and activated by RightNow to add new fea-
tures and integration capabilities.

Add-In Manager—A utility for adding, updating, 
and deleting add-ins in RightNow. The Add-In 
Manager is also used to set add-in permissions for 
each RightNow interface.
See also Add-in.

Administration buttons—The buttons on the 
navigation pane associated with RightNow’s 
administration options: Common Configuration, 
Service Configuration, Marketing and Feedback 
Configuration, and Sales Configuration. Clicking a 
button displays that option’s list of administration 
items.

Administration interface—The graphical user 
interface that staff members use to configure, 
manage, and work with all elements of a RightNow 
application.
See also RightNow Console.

Administrator—A staff member who configures, 
customizes, and maintains a RightNow applica-
tion.
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Administrator login—The default login used by 
the RightNow administrator to log in the first time 
after downloading RightNow. This special login is 
not a defined staff account and has no profile asso-
ciated with it. After logging in with the administra-
tor login, a profile with full access and edit 
permissions must be created, and a staff account 
with that profile must be added. A navigation set, 
containing navigation buttons and their associated 
navigation lists, must be assigned to the profile in 
order to access all RightNow functionality.

Advanced mode—A workspace editing mode 
that includes controls for panels, tab sets, and 
tables, which are not present in the basic mode. 
Advanced mode also allows the definition of addi-
tional properties for fields and controls on the 
workspace.

Agedatabase—A scheduled utility that operates 
on the knowledge base data to maintain dynamic 
answers and make searching more efficient for 
staff members and customers.

Agent—A staff member in RightNow Service 
who may be assigned incidents and chats with cus-
tomers, and who may also maintain contact and 
organization records.

Agent mode—The availability status of an agent 
using CTI in RightNow. Agent modes are deter-
mined by the phone switch. The default modes can 
be edited and renamed, and custom CTI agent 
modes can be added.
See CTI.

Agent scripting—A feature that helps guide staff 
members in entering information into records on 
workspaces.
See Script.

Aging—An automatic process that reduces an 
answer’s solved count as the frequency with which 
the answer is viewed by customers declines. As the 
solved count is lowered, the answer will move 
down the list of answers and be less visible to cus-
tomers.

Alias—A word that represents another word or 
phrase. Aliases and the words or phrases they rep-
resent can be added to the synonym list to enhance 
customer searching.
See Wordlist file. 

Anchor—A node on an action or decision in a 
campaign used to create a path. Actions and deci-
sions have anchors for incoming and outgoing 
paths. Anchor also refers to a destination for 
hyperlinks placed at locations within documents 
for use in mailings and questionnaires for surveys 
and in answers when linking to another answer.

Announcements box—A white board or memo 
box on the Support Home and My Overview 
pages for displaying information to customers, 
such as upcoming product releases or marketing 
information. Announcement boxes can be enabled 
or disabled, and the text can be customized.

Answer—Any knowledge base information that 
provides solutions to common customer support 
questions.

Answer access level—A method of controlling 
what information is visible to staff members and 
customers. The default answer access levels are 
Help and Everyone, and custom access levels can 
be added.

Answer custom field—A field for gathering and 
displaying additional information about answers. 
Answer custom fields appear when adding or edit-
ing an answer and on the Find Answers and 
Answer pages.
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Answer relationship—The relationship between 
two or more related answers. Answer relationship 
types include sibling, manually related, and learned 
link. Sibling and manually related answer relation-
ships are defined by staff members; learned link 
answers are automatically defined through cus-
tomer activity.

Answer status—A method of controlling the visi-
bility of an answer. The default answer statuses are 
Public, Private, Proposed, and Review, and custom 
answer statuses can be added.

Answer status type—The status of an answer 
that determines whether it can be viewed by cus-
tomers. The default answer status types are Public 
and Private.

Answer type—The format in which answers are 
displayed to customers. Answer types include 
HTML, URL, and file attachment.
See File attachment answer, HTML answer, and 
URL answer.

Answer update notification—A way for custom-
ers to sign up to be notified whenever a particular 
answer is updated. Customers can also sign up for 
notification whenever any answer associated with a 
specific product or category is updated.

API (application program interface)—An inter-
face that allows programmers the ability to com-
municate with the RightNow database. The API 
includes functionality to create, update, delete, and 
retrieve answers, contacts, hierarchical menus, inci-
dents, opportunities, organizations, quotes, SLA 
instances, staff accounts, and tasks.

Application button—The button at the top left 
of the RightNow Console for accessing the appli-
cation menu.

Application menu—A list of options for working 
in the RightNow application, including access to 
other areas of the product and shortcuts to adding 
records and items in RightNow. The application 
menu also provides access to options for changing 
personal settings and password and customizing 
the content pane and navigation pane display. Staff 
members can also exit their RightNow application 
from this menu.

Ask a Question—A link on the Support Home 
page that customers can click to submit a question 
when they cannot find an answer in the knowledge 
base. This component of RightNow Service is 
restricted and requires a customer account.
See Customer account.

AT command—A Windows command used to 
schedule when processes, including utilities, are 
automatically run.

Audience—All of the contacts belonging to the 
lists and segments associated with a mailing or sur-
vey.
See also Contact list and Segment.

Audit log—A list of all the actions taken on a 
record or item in the knowledge base, including 
who performed the action, what the action was, 
and when the action was taken.

Auto filter—A control added to report columns 
used to filter report data by values in the columns.

Automatic call distribution (ACD)—A tele-
phone switch that routes incoming telephone calls, 
assigning them to individual extensions based on 
the dialed number and a set of handling rules.

Automatic number identification (ANI)—A 
service that identifies the telephone number of the 
caller. This information can be used to identify 
customers in CTI.

Backup directory—The directory that contains 
all the backup files created by the File Manager.
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Backup file—A file that is automatically saved 
each time a file is edited through the File Manager. 
Before the file is overwritten, the backup file is 
saved. The restore function can be used to revert 
to the backup file.

Basic File Manager—The default version of File 
Manager that provides access to the most com-
monly modified files, including the files used to 
modify headers and footers of the email messages, 
images in RightNow Chat, wordlist files, and dic-
tionary files.
See also File Manager and Expanded File Manager.

Billable task—A way of classifying and recording 
the amount of time agents spend working on inci-
dents. The default billable task is Miscellaneous, 
and custom billable tasks can be added.

Block quotes—A symbol or HTML tag that des-
ignates a section of text that is not part of the most 
current email reply, such as previous entries in the 
email conversation.
See also Checksum and Techmail.

Boolean searching—A knowledge base search 
that allows customers to connect multiple key-
words using & (AND) and |(OR) operators.

Bounced email—Email that is undeliverable. 
Email can be bounced when email accounts are 
not functioning properly or are full at the time the 
mailing is sent. RightNow Marketing and Right-
Now Feedback track bounced emails.
See also Email management.

Broadcast mailing—A mailing sent to one or 
more contact lists or segments. Broadcast mailings 
can be sent at a scheduled time and used in a cam-
paign. 
See also Contact list and Segment.

Broadcast survey—A survey sent as a broadcast 
mailing in which the message, audience, and mail-
ing options are defined in the survey.

Bulkdel—A utility for deleting several incidents at 
once.

Business rules—A component in RightNow for 
defining processes to automate workflow, notifica-
tion, and escalation. Business rules can automati-
cally route incidents, opportunities, and chat 
sessions; send email and marketing messages; esca-
late answers, incidents, opportunities, and tasks; 
update records; assigns SLAs; and create Offer 
Advisor targets.

Cached data—Report data that has been tempo-
rarily stored in the database for quicker report gen-
eration. This data is cached nightly by the 
Agedatabase utility and can be purged regularly.

Campaign—A multiple-step marketing process 
based on business logic. Campaigns can contain 
any number of actions and decisions and move 
contacts through a series of steps when specified 
criteria have been met.

Canceled—A mailing and survey status that indi-
cates a mailing or survey has been manually can-
celed before being completed.

Category—An option for grouping answers and 
incidents that allows more precise organization in 
the knowledge base. Staff members can classify 
answers and incidents by category and up to five 
additional levels of sub-categories, allowing more 
refined searching by customers and staff members.
See also Product.

Certificate—A digital piece of information for 
email and Internet security that includes the name 
of the certification authority, the holder of the cer-
tificate, the certificate holder’s public key, the dates 
the certificate is valid, the serial number, and the 
digital signature of the certification authority. Cer-
tificates are also referred to as public certificates.
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Certificate revocation list—A list of certificates 
that have been suspended or revoked before they 
have expired. The certification authority maintains, 
updates, and publishes the certificate revocation 
list at regular intervals.

Certification authority—A third party authorized 
to issue certificates and authenticate the identity of 
the holder of the certificate.

Channel—The source of an incoming incident 
(for example, email, Ask a Question, chat session, 
phone call, fax, or mail). Channels are also used to 
indicate the source of information for incident 
notes on the accessibility interface and contact, 
opportunity, and organization notes.

Chart style—A collection of display settings that 
can quickly be applied to charts used in reports. 
Chart styles control most of the graphical configu-
ration of charts.

Chat agent status—A method of tracking an 
agent’s availability to chat. The default chat agent 
statuses are Unrestricted, Unqualified, Unspeci-
fied, In Meeting, and On Break, and custom sta-
tuses can be added.

Chat agent status type—The status of an agent’s 
availability to chat. Default chat agent status types 
are Available, Unavailable, and Logged Out.

Chat session—A real-time, two-way dialog 
between a customer and one or more RightNow 
Chat agents.
See RightNow Chat.

Chat session queue—A sequence of unassigned 
requests for chat sessions. The default chat session 
queue is the RightNow Live Default Queue, and 
custom queues can be added. Requests are added 
to chat session queues automatically by business 
rules.

Chat session routing—A process of routing cus-
tomer requests for a chat to a specific queue based 
on rules in the Chat rule base.
See Chat session queue.

Checksum—A calculated value that represents 
the content of a block of quoted text. This value is 
sent within the block quote tags of the email mes-
sage and is used to determine if text has been 
added to the original message. 
See also Block quotes and Techmail.

Choice question—A question type that allows 
customers to choose their answer from a menu, 
radio button, check box, or list.

Click-Once installer—A utility used to install the 
RightNow Smart Client on staff members’ work-
stations.
See also MSI and RightNow Smart Client.

Client—The interface that displays on a cus-
tomer’s computer when submitting a request to 
chat with a RightNow Chat agent.

Clone—To create an exact copy of an existing 
interface.

Closed—One of the default opportunity statuses 
and status types. An opportunity with the Closed 
status has resulted in a sale.

Clustering—An automatic process that groups 
the knowledge base into clusters of related answers 
and labels each cluster group with keywords that 
define those answers.
See also Data mining.

Co-browse—A feature in RightNow Chat that 
enables agents to guide customers through web 
pages using the mouse pointer to demonstrate 
actions.
See RightNow Chat.
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Color scheme—A collection of colors that can be 
applied to chart styles. Multiple colors can be 
defined and combined into one color scheme. 
Charts that use the same scheme use the same set 
of colors.

Comparison period—A reporting parameter 
used to compare a report’s time period to an iden-
tical length of time in the past. Comparison peri-
ods are defined when creating or editing a custom 
report and can be included in standard reports.

Competitor—An option for identifying other par-
ties pursuing the same opportunity.

Compile—A process that runs the compiler 
engine to check states, functions, and rules within 
a rule base to ensure there are no errors.
See Rule base and Activate.

Completed—A mailing and survey status that 
indicates a broadcast mailing or broadcast survey 
has been sent. The system automatically sets the 
status to Completed from the Sending status.

Complex expression—A search technique that 
enables customers and staff to search for a broader 
set of content. This technique allows wildcard 
searching using an asterisk (*) at the end of a word 
or partial word and a tilde (~) before a word to 
perform a similar phrases search on that word 
only. Word stemming and logical operators are 
also supported. This technique is available on the 
RightNow Console and the customer portal.
See also Word stemming and Logical operators.

Computed field—A column whose value is 
derived from calculations performed on database 
fields. Computed fields can be added to output 
levels in custom reports.

Condition—The part of a business rule that deter-
mines whether an answer, contact, incident, chat 
session, opportunity, organization, target, or task 
matches a business rule. Rules can contain multiple 
conditions.

Conditional formatting—A method of highlight-
ing specific information in report columns that 
does not require creating data exceptions.

Conditional section—A section of text in a doc-
ument that appears only to those contacts meeting 
certain criteria. Conditional sections can also be 
placed in answers and tagged with specific answer 
access levels.
See Document and Access level conditional section.

Conference—A feature in RightNow Chat that 
enables an agent to conference another agent into 
a chat session with a customer. Conferencing is 
also available in CTI, allowing multiple agents to 
talk with a customer.

Configuration Editor—The editor for customiz-
ing configuration settings.

Configuration settings—All of the settings 
accessed from the Configuration Editor to config-
ure and customize a RightNow interface.

Configuration Wizard—An interactive utility for 
customizing and configuring RightNow. Configu-
ration categories include Outgoing Email, Support 
Home, Answers, Ask a Question, My Stuff, Secu-
rity, Incidents, Agedatabase Utility, and SmartAs-
sistant Response.

Contact—Any individual with a contact record in 
the knowledge base. Contact records can be added 
by staff members and by customers when submit-
ting a question.

Contact custom field—A field for gathering and 
displaying additional information about contacts. 
Contact custom fields appear when adding or edit-
ing a contact record and on the My Stuff page.
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Contact list—A static or fixed group of contacts 
that is used to choose the contacts who receive a 
broadcast mailing or survey. Contacts can be 
added to lists.

Contact role—An option for classifying contacts 
by their roles in opportunities.

Contact type—An option for classifying contacts 
by types, such as job positions or decision-making 
roles.

Contact Upload—An interactive utility used for 
importing contact records into the RightNow data-
base.

Contact upload template—A saved format used 
by the Contact Upload feature to map columns in 
a CSV file to columns in the RightNow database. 
See Contact Upload.

Content Library—A component for creating 
content that can be used in mailings, web pages, 
and surveys. Content includes documents, tracked 
links, files, templates, and snippets.

Content pane—The area on the right side of the 
RightNow Console where staff members work 
with items selected from the navigation pane. This 
includes administration items, reports, individual 
records, and explorers.

Content pane tabs—A way for staff members to 
switch between the items currently open on the 
RightNow Console. Content pane tabs display at 
the top of the content pane. Staff members can 
click a tab to return to a report or item or right-
click a tab and select from Open in New Window, 
Close, Close All But This, and Close All. 

Context-sensitive answers—A subset of Smar-
tAssistant that allows organizations to construct 
special Related Answer links from any web page to 
provide additional information to their customers.
See also Help access level.

Control—A tool for placing titles, spacers, 
reports, and other advanced features on a work-
space.

CRM state—See State.

crontab—A UNIX command used to schedule 
when processes, including utilities, are automati-
cally run.

crontabfile—A UNIX file that contains and 
stores the scheduled processes.

Cross tab—A method of displaying report data in 
a table format.

CSV (comma-separated value)—A file format 
with commas separating one column value from 
the next. Each row is delineated by a hard return. 
Also called comma-delimited.

CTI (computer telephony integration)—A data 
connection between telephone systems and com-
puters.

CTI screen pop—A computer telephony integra-
tion function that causes information related to 
contacts, incidents, organizations, or opportuni-
ties to be opened on staff members’ workstations 
when they answer a call.

Currency—A monetary denotation based on 
country of origin. Currencies can be defined for 
each country or province in which an organization 
does business.
See also Exchange rate.

Custom field—A field for gathering and display-
ing additional information about answers, con-
tacts, incidents, opportunities, organizations, sales 
quotes, sales products, staff accounts, and tasks. 
Custom fields appear when adding and editing 
records; depending on the type and visibility, they 
may also appear on the customer portal.
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Custom report—A report that is created by copy-
ing and editing one of the standard reports in ana-
lytics and saving it as a new report, or by 
combining data from selected tables in RightNow 
to create a new report. Custom reports can include 
customized output, data computation, and sched-
uling.

Customer—A contact or organization that has a 
service or purchase history in the RightNow 
knowledge base.

Customer account—Information consisting of a 
user ID and password that allows customers to 
access certain functions on the customer portal, 
such as Ask a Question and My Stuff. Customers 
can create a customer account when submitting a 
question; this adds a contact record to the knowl-
edge base.

Customer portal—See RightNow Customer Por-
tal.

Customer Portal Studio—A software develop-
ment framework for integrating an organization’s 
web site with RightNow elements that provide 
customers with access to the information in the 
knowledge base. The Customer Portal Studio pro-
vides templates, pages, widgets, and other tags, as 
well as a tag gallery that contains code and other 
information about standard RightNow widgets and 
other elements. It also includes the WebDAV pro-
tocol for file management and an extension for 
Adobe Dreamweaver.
See also RightNow Customer Portal.

Dashboard—Any combination of individual 
reports shown together in one report. Dashboards 
enable staff members to search for and view a wide 
range of data from different reports without open-
ing each report individually.

Data dictionary—A list of all the available tables 
and fields from the database that can be used in 
custom reports. Functions, output variables, and 
computed fields can also be selected from the data 
dictionary.

Data mining—The exploration and analysis of 
large quantities of data to discover meaningful pat-
terns and rules. Data mining enables organizations 
to turn raw data into information they can use to 
gain a marketplace advantage.

Data set—The database tables and table joins that 
determine what data can be returned in a report. 
Data set also consists of the database columns a 
segment (dynamic list in RightNow Marketing and 
RightNow Feedback) will have access to and what 
filters will be used to determine the final data set.

Data type—A set of data having predefined char-
acteristics such as strings, integers, or dates. Each 
column in a database table is assigned a data type. 
Data type also refers to the type of custom field 
specified when adding staff account, organization, 
contact, sales products, incident, answer, opportu-
nity, sales quotes, and tasks custom fields. Data 
types consist of menu, radio, integer, date, date/
time, text field, and text area fields.

Database—The tables and fields that store infor-
mation that is retrieved, edited, and added in a 
RightNow application.

Dbaudit—A utility that builds and populates the 
schema and performs the database portion of the 
RightNow upgrade. Dbaudit can also be used to 
view the database schema.

Dbstatus—A scheduled utility that escalates inci-
dents, answers, tasks, and opportunities based on 
business rules. Dbstatus also sends out watchlist 
notifications.
See Business rules and Watchlist notification.



443

Dead—One of the default opportunity statuses 
and status types. An opportunity with the Dead 
status is no longer being pursued by a sales repre-
sentative.

Decision—A component of a campaign. Deci-
sions filter contacts by specified criteria and can 
have Yes and No paths.

Decryption—The process of converting 
encrypted text into readable text using private keys 
assigned to authorized persons.

Default directory—The directory containing 
original default copies of all the files customizable 
through the File Manager. During an upgrade, any 
files that have changed will also be updated in the 
default directory. Using the restore function, a file 
can be restored to the original configuration.

Default response requirements—The maximum 
time allowed (in minutes) for incident response 
and resolution within the operating hours defined 
by the organization. The default response require-
ments are used to measure agent performance in 
responding to and solving incidents and can also 
be used as the response requirement for SLAs that 
do not have customized response requirements.
See also SLA and Response interval.

Deliverability—The degree to which an email 
message aligns with industry-accepted practices to 
ensure delivery to an intended recipient. Emails 
with low deliverability are often blocked by ISPs 
and spam filters.

Deploy—To promote, compile, and optimize all 
the customer portal pages from the development 
folder where they are created and tested into the 
production folder, where they become publicly 
available on an organization’s web site.

Design space—The section of the workspace 
designer where fields and controls are added, 
edited, moved, and removed to create a work-
space.

Desktop workflow—A sequence of workspaces, 
scripts, decisions, and actions presented to staff 
members as a dynamic interface to support com-
plex business processes.

Dialed number identification service 
(DNIS)—A service that identifies the telephone 
number that the caller dialed. This is useful if sev-
eral telephone numbers are redirected to a single 
destination number.

Disconnected access—The mode in which 
RightNow Sales functions when an Internet con-
nection is not present. When an Internet connec-
tion is not present, RightNow Sales communicates 
with the offline (local) database. Also called offline 
mode.

Display position—The position where a new 
answer appears on the Find Answers page. 
Options include Historical Usefulness; Place at 
Top, Middle, or Bottom; Fix at Top, Middle, or 
Bottom. The display position is selected from the 
answer’s Display Position drop-down menu.

Disposition—An option for classifying and 
recording how incidents are ultimately resolved. 
Up to six levels of dispositions are available.

Distribution list—A mailing list of non-staff 
member email addresses used for scheduling 
reports or any mailing event.

Docked filter—A run-time selectable filter or out-
put variable that is added to the top of a report. 
Docked filters let report users select different run-
time filter values and output variables in the report, 
bypassing the Search window.
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Document—The material used in a survey, mail-
ing, or served as a web page that can contain text, 
snippets, conditional sections based on contact fil-
ters, merge fields, links, and web forms.

DomainKeys (DK)—A form of email authentica-
tion that uses a cryptographic signature to verify 
that an email message originated from a specific 
organization. DomainKeys differs from DKIM 
authentication primarily by the email headers used 
to generate the signature.

DomainKeys Identified Mail (DKIM)—A form 
of email authentication that uses a cryptographic 
signature to verify that an email message originated 
from a specific organization. DKIM differs from 
DomainKeys authentication primarily by the email 
headers used to generate the signature.

Dormant incident—An incident that is not 
returned when performing word- or phrase-based 
searches. After remaining in the Solved status for a 
specified time, incidents become dormant to 
ensure that the knowledge base is populated with 
the most useful and timely information.

Draft—The preliminary status of a mailing or sur-
vey. When a mailing or survey is created, it is set to 
the Draft status. The status will also return to 
Draft if the mailing or survey’s schedule is can-
celed.

Drill down—To start at a top or general level and 
become more specific at each lower level. Right-
Now’s drill-down feature enables access to addi-
tional output levels in reports.

Drill-down filter—The fields in an output level 
used to filter the data returned when drilling down 
to another output level. This impacts what data is 
returned in the drill-down level.

Drill-down link—The field in an output level that 
is used as a link to drill down to the next output 
level.

Dual tone multi frequency (DTMF)—The sys-
tem used to identify the numbers on the telephone 
keypad by using two tones of different frequencies 
for each key. This is used by the dialed number 
identification service.

Editor—A layout format on the content pane 
when working with administration items. The edi-
tor contains the fields for adding and editing an 
administration item.

Else clause—The clause that follows the Then 
clause of a business rule. If the conditions of a rule 
are met, the actions in the Then clause are invoked; 
if the rule’s conditions are not met, the actions in 
the Else clause are invoked.

Email answer—A feature that enables customers 
to email answers they are viewing to a specific 
email address.

Email management—A function of RightNow 
that sends and receives email messages, processes 
bounced messages, intelligently routes incoming 
inquiries based on business rules, and automati-
cally suggests answers to inquiries.

Email message—An email that is automatically 
sent by RightNow to customers or staff members. 
The sending of email messages is triggered by 
events in RightNow. For example, when a cus-
tomer submits a question in RightNow Service, the 
Question Receipt message will be sent to the cus-
tomer’s email address. Email messages can be 
enabled or disabled, sent in ASCII text or HTML 
format, and the text, headers, and footers can be 
customized.

Encryption—The process of translating a text 
message into unreadable text to ensure security. 
Encrypted messages may be read only by autho-
rized persons with access to a private key that 
allows them to convert the message back into 
readable text.
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End-user interface—The term for older versions 
of the customer portal. These include the Classic 
and November ’07 pages sets, which may still be in 
use by organizations that have upgraded from ear-
lier versions of RightNow Service.
See also RightNow Customer Portal. 

Enterprise Analytics—An enterprise-level 
reporting tool for viewing diverse data on large 
data sets, including data from external databases.

Escalation—A means of tracking answers, inci-
dents, opportunities, and tasks using business 
rules. When a rule’s conditions are met, the rules 
engine schedules escalation to the new level. When 
the scheduled time (based on absolute or relative 
time) arrives, the rules engine sets the escalation 
level and takes the action specified by the rule, 
such as sending an email, notifying a manager, or 
following up with a customer.
See Business rules.

Even split mode—A market testing mode that 
sends test messages to equal portions of an audi-
ence for broadcast mailings. 
See Market testing.

Everyone access level—An access level designed 
to allow answers to be visible to all staff members 
and customers depending on the answer status.

Exception—A method of highlighting report data 
that meets certain criteria. Data exceptions also 
allow email alerts to be sent when data in a sched-
uled report meets the exception criteria.

Exchange rate—A scale of monetary conversion 
from one currency to another.
See Currency.

Expanded File Manager—A version of the File 
Manager that provides additional access to the mail 
directory for modifying the format of email mes-
sages.
See also File Manager and Basic File Manager.

Explorer—A layout format on the content pane 
that displays a tree on the left, containing folders 
and other items, and a detailed list of the selected 
folder’s contents (subfolders and files) on the right. 
Explorers are available for certain administration 
items and components in RightNow.

Expression—A component of fixed and run-time 
selectable filters that defines a function, database 
column, value, or any combination of the three.

Extension—See RightNow Dreamweaver exten-
sion.

External event—A program or script that runs as 
the result of an event occurring in RightNow, an 
action specified in a business rule, or an action in a 
marketing campaign.

FCRR (first contact resolution rate)—A statis-
tic that reports how often staff members or groups 
solve incidents with only one response. This num-
ber is displayed as the percentage of incidents 
solved with only one staff response.

File—A file that is uploaded to RightNow Market-
ing for attaching as a link in a document or snip-
pet. From the Content Library, files can be 
uploaded and their characteristics can be defined.

File attachment—A file that is attached to an 
answer, contact, incident, opportunity, organiza-
tion, or task, or sent with an incident response or 
sales quote. Files that are permanently attached to 
an incident or answer can be viewed by customers 
who view the record. Files that are sent with an 
incident response can be opened with the cus-
tomer’s email client and are not permanently 
attached to the record.

File attachment answer—A type of answer that 
appears as a file attachment.

File link—A clickable link to a file attachment 
that is inserted in a snippet or a document.
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File Manager—The interface used to modify files 
for RightNow products. The File Manager is avail-
able in Basic and Expanded versions. Administra-
tors can modify files used to customize a site’s 
email messages, Chat images, word lists, and dic-
tionary files.
See also Basic File Manager and Expanded File 
Manager.

Final message—A mailing format used to send 
the mailing as final. In broadcast mailings, final 
messages are sent to all audience members who 
have not yet received a test message.

Find Answers—A link on the Support Home 
page that opens the Find Answers page where cus-
tomers can view answers and search the knowl-
edge base. Customers can view individual answers 
or search the knowledge base using selection crite-
ria to narrow their search. If enabled, customers 
can also use the Web Indexer to search answers, 
documents, and web sites.
See also Web Indexer.

First due—A queuing pull policy that uses the 
incident due date or longest wait to determine 
which incidents or chats to retrieve from the 
queue.

Fixed filter—A component of RightNow Analyt-
ics and RightNow Marketing and RightNow Feed-
back segments used to define the data set available 
in the report or segment. Fixed filters are state-
ments constructed from expressions, functions, 
and operators, and cannot be altered when using a 
segment or when running a report.

Flow diagram—A graphical representation of a 
campaign, survey, or desktop workflow. Flow dia-
grams allow staff members to diagram the events 
and decisions of a campaign, survey, or business 
process. When a campaign or survey is launched, 
contacts are automatically moved through the flow 
based on the specified criteria. When a desktop 
workflow is associated with a record editor in a 
profile, staff members with that profile will move 
through the flow when opening a record of the 
corresponding type.
See also Desktop workflow.

Forecast—A projection of sales revenue for an 
opportunity that may close in a given sales period.

Foreign key—A column or columns that contain 
values found in a primary key of another table. 
Foreign keys are used to ensure relational integrity 
and are rarely primary keys.
See also Primary key.

Forward to Friend link—A link that enables con-
tacts to forward the message to another email 
address. This type of link can be added to docu-
ments, templates, and snippets for use in mailings, 
surveys, or web pages.

Function—A mathematical operator that can be 
applied to data from database fields to modify the 
data that is returned in an output column. Func-
tion also refers to a container for business rules. 
Functions are used anywhere in a business process 
that dictates doing the same thing in more than 
one place. Functions reduce the number of rules 
needed by allowing the same rules to be evaluated 
from multiple states.
See also Business rules and Rule state.

Group—A way to organize staff accounts.

Grouping—A method for grouping data in a seg-
ment. Filters can be used when grouping and are 
applied to the data after the grouping is completed.
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Guide—Information about a promotion gener-
ated by a marketing staff member. This informa-
tion appears on the Offer Advisor window to help 
an agent present the promotion to a customer. 
Guide also refers to a collection of branching ques-
tions, responses, answers, and text explanations 
used in guided assistance in RightNow Service.
See Guided assistance and Offer Advisor.

Guided assistance—A component in RightNow 
Service that helps agents quickly locate answers 
and text explanations using branching questions to 
guide them to the answers they need. The answers 
and explanations agents find can be sent to cus-
tomers in incident responses or relayed to custom-
ers over the phone.

Help access level—An answer access level for 
context-sensitive answers. Help answers are not 
visible to customers except through special hyper-
links.
See Context-sensitive answers.

HTML answer—A type of answer that appears 
to customers as standard HTML on the customer 
portal.

HTML editor—A WYSIWYG (what you see is 
what you get) editor for formatting and editing 
answers, mailings, campaigns, documents, ques-
tionnaires, and invitation messages in HTML with-
out previous HTML experience.

iKnow—RightNow’s intuitive knowledge founda-
tion that incorporates the self-learning knowledge 
base, customer data, and analytics to respond in an 
intuitive, intelligent manner when interacting with 
customers and staff members.
See also Self-learning knowledge base.

IMP (import) file—A data file with an extension 
of .imp that is used by the Kimport utility to map 
values in the CSV file to columns in the RightNow 
database.

In Meeting—One of the default chat agent sta-
tuses. This status indicates that the agent is in a 
meeting and is unavailable to chat. The In Meeting 
chat agent status has an Unavailable status type.

Inactive—One of the default opportunity statuses 
and status types. An opportunity with the Inactive 
status is no longer being pursued but could be acti-
vated at a later date.

Inbox—An agent’s personal queue consisting of 
all the incidents that have been assigned to the 
agent.

Inbox limit—The maximum number of incidents 
in an agent’s inbox that cannot be exceeded when 
pulling from a queue. The inbox limit is set in the 
profile to which the agent is assigned.

Incident—Any question or request for help sub-
mitted by a customer through the Ask a Question 
page, email, a chat session, site or answer feedback, 
or from an external source using the API. Inci-
dents can also be added by agents when they work 
with customers by phone, fax, or mail.

Incident archiving—A process that permanently 
removes incidents from the database. Archived 
incidents are then stored in searchable data files 
that can be accessed from the RightNow Console. 
Staff members can access archived incidents once 
the Archived Incidents component has been added 
to their navigation set.

Incident custom field—A field for gathering and 
displaying additional information about incidents. 
Incident custom fields appear when adding or edit-
ing an incident and on the Ask a Question and My 
Stuff–Questions pages.
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Incident queue—A sequence of unassigned, 
unresolved incidents. When an incident queue is 
added, it can be defined as the default queue. Inci-
dents are added to queues automatically by busi-
ness rules or manually by re-queuing and are 
handled in a first-in, first-out manner.

Incident severity—An option for classifying and 
recording an incident’s importance and urgency.

Incident status—A method of tracking an inci-
dent’s state. The default incident statuses are 
Solved, Unresolved, Updated, and Waiting, and 
custom statuses can be added.

Incident status type—The status of an incident 
as it moves through the system. Default incident 
status types are Solved, Unresolved, and Waiting.

Incident thread—The list of all activity on an 
incident, including the original question, agent 
responses and updates, customer updates, records 
of conversations, and staff member notes about 
the incident (which are not visible to customers). 
The incident thread lists activity in chronological 
order and can be filtered by thread type.

Indexing—A process in which the text of an 
answer or incident is stemmed and indexed into 
keywords and phrases. These keywords and 
phrases are used to build the answer and incident 
phrases tables that are used during text searching. 
When an answer is added or updated, the Key-
words, Summary, Question, and Answer fields are 
stemmed and indexed to create one-, two-, and 
three-word phrases. When an incident is added or 
edited, the Subject field and incident thread are 
stemmed and indexed to create one-word phrases.

Industry type—An option for classifying organi-
zations by type of industry.

Information gaps—A report that clusters inci-
dents in RightNow Service and compares the top-
ics to answer clusters, allowing organizations to 
pinpoint those areas (or gaps) in the knowledge 
base needing additional answers.

Initial state—A required state in every rule base. 
The rules engine evaluates a new or updated object 
using all rules in the initial state. Unless one or 
more rules in the initial state transition the object 
to a function or different state, the rules engine 
stops after all the rules in the initial state have been 
processed.
See also Rule state.

Inline—A method of displaying output defini-
tions and filter definitions as lines of text in the 
report.
See also Output definition.

Inline editing—A feature for editing values 
directly on a report without having to open each 
record to make changes. Staff members can edit 
individual values in one record or select several 
rows to change values in multiple records. Staff 
members must have permission in their profile to 
edit the specific record type, and inline editing 
must be enabled on the report.

Inner join—A relational database operation that 
selects rows from two tables on the condition that 
the value in the specified column of the primary 
table is equal to the value in the specified column 
of the secondary table.
See also Outer join.

Interactive voice response (IVR)—A telephone 
system application that allows callers to provide 
information (for example, incident reference num-
bers or organization name) to the system using 
either their voice or a touch-tone keypad.
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Interface—The console, windows, and pages used 
by staff members and customers to access a Right-
Now application and interact with a single knowl-
edge base. The interface name determines the URL 
for the web site, the name of the RightNow exe-
cutable, and the .cfg directory name.
See also Administration interface.

Interface Manager—A utility for managing mul-
tiple interfaces using one RightNow knowledge 
base.

Invitation method—A way of distributing a sur-
vey: broadcast survey, transactional survey, or 
website link.

Kexport—A utility for exporting either single 
tables or an entire database from a RightNow 
application.

Keywordindexer—A utility that creates an index 
of the keywords found in incidents, answers, file 
attachments, and documents indexed by the Web 
Indexer. The keyword indexes are used when 
searching incidents, answers, file attachments, and 
other indexed documents.
See also Web Indexer.

Kimport—A utility for importing data, either sin-
gle tables or an entire external database, into the 
RightNow database.

Knowledge base—All information (such as 
answers, incidents, contacts, organizations, oppor-
tunities, products, staff accounts, tasks, mailings, 
and campaigns) maintained and presented by 
RightNow in a meaningful way; knowledge base 
also refers to the interrelationships among the 
pieces of information.

Knowledge engineer—The staff member 
responsible for populating and maintaining the 
answers in the knowledge base for RightNow Ser-
vice. Responsibilities may include identifying when 
answers should be added, editing proposed 
answers, and reviewing existing answers to keep 
them current.

Langcvt—A utility for changing the language 
pack in RightNow from English to an alternate 
language pack. This utility converts the message 
bases and prepopulated knowledge base to the new 
language. 

Language—The language for a specific interface 
that determines, in part, what answers are visible 
for viewing by customers.

Launched—A mailing and survey status that indi-
cates a transactional mailing or transactional survey 
has been launched and can be included in a rule or 
campaign.

Layout—A predefined format that can be used in 
custom reports to apply fonts, colors, and other 
display options. Layouts can also be used in dash-
boards to apply a predefined structure for inserting 
reports.

Lead—A potential opportunity. A lead is a con-
tact discovered through a marketing campaign and 
forwarded to a sales representative through 
RightNow Sales.
See Opportunity.

Lead rejection type—An option for classifying 
and recording the reasons for rejecting a lead.

Leaf level—A level of product, category, or dispo-
sition that does not contain any sub-levels.

Learned link—Related answers that have a 
learned relationship as a result of customer activity.

Live Help—A link on the Support Home page 
that customers can click to submit a request to chat 
with a RightNow Chat agent.
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Live Media bar—The toolbar that displays when 
RightNow Chat, CTI (customer telephony integra-
tion), or both are enabled. The Live Media bar 
allows agents to log in, log out, set their status or 
mode, and manage chats or calls.

Local settings—The interface defaults in Right-
Now that control how and what information dis-
plays on the navigation pane and the content pane, 
the interface color and tint, toast notifications, and 
report appearance, including display and data set-
tings and column formatting. Changes made by 
staff members to customize these settings affect 
only their workstations. In addition, staff members 
can return to the defaults at anytime.

Logical expression—An expression that defines 
the relationship between report filters or business 
rule conditions. The components of a logical 
expression are joined using Boolean logic and can 
be grouped and joined with AND, OR, and NOT 
operators.

Logical operators—The symbols, (+) and (–), 
that can be used in most search techniques in 
RightNow Service to explicitly find answers that 
have a word (+) or that do not have a word (–).

Login window—A window for entering login 
name, password (if required), and site information 
to access the administration interface of a Right-
Now application.

Lost—One of the default opportunity statuses 
and status types. An opportunity with the Lost sta-
tus has been lost, for example, to a competitor.

Mailbox—An email box specified in RightNow 
and dedicated to collecting email inquiries sent by 
customers, responses to mailings, and bounced 
messages. Incoming emails are processed by 
RightNow’s Techmail utility.
See also Techmail.

Mailer daemon (rnmd)—A utility that monitors 
RightNow Marketing and RightNow Feedback, lis-
tening for requests from other components to start 
the email process. The mailer daemon is installed 
during the initial installation and can be configured 
to send messages in the most efficient manner for 
an organization.

Mailing—A collection of one or more messages 
sent to one or more contacts. A mailing can con-
tain multiple messages for testing purposes.

Mailing status—A method of tracking the state 
of a mailing. The default mailing statuses include 
Draft, Launched, Scheduled, Preparing to Send, 
Sending, Suspended, Suspended by Error, Can-
celed, and Completed.

Manual policy—A pull policy that enables agents 
to manually pull incidents into their inbox from 
any queue designated in their profile.

Manually related answer—A relationship 
between two or more answers manually defined by 
a staff member.

Market testing—A method for testing different 
message formats in mailings on a percentage of the 
audience before launching a final email. Market 
testing is available in even split and sampling 
modes.
See Even split mode and Sampling mode.

Mask—A defined pattern that determines the for-
mat of information that can be typed in a field.

Matrix question—A question type for displaying 
a series of survey questions in a table. Matrix ques-
tions are useful when a group of questions can be 
responded to with the same set of answer choices.
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Merge field—A field that looks up contact infor-
mation and inserts it in the text of a document, 
snippet, or mail attributes of a mailing. Merge field 
also refers to a database field that can be inserted 
in quote templates and merged with opportunity 
data. Merge fields act as variables and are visible on 
the Quote Template ribbon when creating quote 
templates.

Message—An email consisting of a collection of 
HTML, text, and images in a particular format.

Message base—An editable text string that 
allows international language support and customi-
zation of headings, labels, buttons, and other text 
on the administration interface and customer por-
tal and in email messages and notifications.

Message Base Editor—The editor used for cus-
tomizing the message bases, including all the head-
ings, labels, buttons, and other text on the 
administration interface and customer portal.

Monitor—A feature in RightNow Chat that 
allows a supervising agent to monitor the chat ses-
sions of other agents and to intervene when neces-
sary.

Msgtool—A utility for creating a configuration 
report for a RightNow site, or for changing config-
uration settings when an error has been made in 
one of the settings that subsequently locks staff 
members out of the Configuration Editor.

MSI (Microsoft Installer)—An interactive utility 
used to install the RightNow Smart Client on staff 
workstations. The installer can be used as an alter-
native to the Click-Once installer for organizations 
that use free-seating with roaming profiles, require 
a fully automated distribution system, or restrict 
the administrative permissions on staff worksta-
tions.
See also Click-Once installer and RightNow Smart 
Client.

Multi-select—A feature for updating more than 
one record at a time.

Multiline—A method of displaying report data 
grouped under headings based on common values 
in report columns.

My Stuff—A link on the Support Home page that 
takes customers to their account information. Cus-
tomers can view and update all the questions they 
have previously submitted and view any answer 
notifications to which they are subscribed. They 
can also view and edit their search preferences and 
account and contact information. This component 
is restricted and requires a customer account.
See Customer account.

Natural language—Any approach that accepts 
and correctly handles human language. For exam-
ple, English, French, and Japanese are natural lan-
guages; computer languages, such as FORTRAN 
and C, are not. RightNow Service provides natural 
language technology for searching the knowledge 
base.

Navigation buttons—The buttons on the naviga-
tion pane associated with record types and compo-
nents. Clicking a button displays that record type 
or component’s navigation list.

Navigation list—All the reports, folders, and 
items associated with a specific record type or 
component in RightNow. Navigation lists are 
organized in a tree on the navigation pane.

Navigation pane—The area on the left side of 
the RightNow Console where staff members select 
items and change navigation lists and administra-
tion options. What appears on the navigation pane 
depends largely on the permissions in a staff mem-
ber’s profile and which navigation or administra-
tion button is active.
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Navigation set—Any combination of navigation 
lists and their associated navigation buttons. Staff 
members are assigned a default navigation set in 
their profile.

Normalized URL—A URL that has been refor-
matted to ensure that documents that are referred 
to by multiple URLs will be indexed only once. 
Normalization may include reformatting domain 
names (for example, removing capital letters) or 
removing query parameters.

Note—Information that can be added to cam-
paigns, contacts, documents, mailings, opportuni-
ties, organizations, and surveys for internal 
reference. Notes can also be added to incidents in 
the incident thread.

Notification—A message that notifies appropri-
ate staff members about incidents, answers, mail-
ings, campaigns, opportunities, and system errors.

Object—The specific answer, contact, incident, 
chat session, opportunity, organization, target, or 
task that is evaluated by the rules in the object’s 
rule base.
See also Object class.

Object class—A grouping of database entities, 
including answers, contacts, incidents, chat ses-
sions, opportunities, organizations, targets, and 
tasks, for which business rules have been defined. 
Each object class has a separate rule base for eval-
uating objects.

Offer—A promotion developed by marketing per-
sonnel or a product suggestion generated automat-
ically by Offer Advisor that is presented to a 
customer by an agent.

Offer Advisor—A feature in RightNow Service 
for creating and presenting promotions to custom-
ers and for making automatic recommendations 
based on customer attributes and purchase history.

Offline mode—The mode in which RightNow 
Sales functions when an Internet connection is not 
present. In offline mode, RightNow Sales commu-
nicates with the offline (local) database. Also called 
disconnected access.
See Disconnected access.

On Break—One of the default chat agent sta-
tuses. This status indicates that the agent is on 
break and is not available to chat. The On Break 
chat agent status has an Unavailable status type.

Online mode—The mode in which RightNow 
Sales functions when an Internet connection is 
present. In online mode, RightNow Sales commu-
nicates with the online (remote) database.

Operating system—The program that, after 
being initially loaded onto the computer by a boot-
strap program, manages all other programs in a 
computer. UNIX, Windows, VMS, OS/2, and 
AIX are all examples of operating systems.

Operator—A symbol or word that represents a 
mathematical or logical action that can be applied 
to a condition or value.

Opportunity—Information about a specific sale 
or a pending deal that is tracked and maintained in 
the knowledge base.

Opportunity custom field—A field for gathering 
and displaying additional information about 
opportunities. Opportunity custom fields appear 
when adding or editing an opportunity.

Opportunity status—A method of tracking an 
opportunity’s state. The default opportunity sta-
tuses are Lead, Reject, Active, Closed, Lost, Inac-
tive, and Dead. Custom statuses can also be added.

Opt-in—The explicit granting of permission by a 
contact to receive email communications from an 
organization. Opt-ins can be specific to certain 
mailing lists or applied globally across all mailing 
lists.
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Opt-out—An explicit request by a contact to be 
removed from a specific mailing list or from all 
lists, most often communicated by email or web 
form. Also called Unsubscribe.

Organization—Any company, business unit of a 
large company, or government agency that has an 
organization record in the knowledge base.

Organization address type—A way of storing 
multiple addresses for a single organization. The 
default organization address types are Shipping 
and Billing, and custom address types can be 
added.

Organization association—A feature for associ-
ating a contact with a specific organization. Orga-
nization association links the incident and 
opportunity history of the contact and organiza-
tion.

Organization custom field—A field for gather-
ing and displaying additional information about 
organizations. Organization custom fields appear 
when adding or editing an organization.

Organization hierarchy—A feature for creating 
or changing the hierarchy of organizations. A hier-
archy can be created by making one or more orga-
nizations subordinate to another organization. 
Twelve hierarchy levels can be used.

Outer join—A relational database operation that 
selects rows from two tables regardless of whether 
the specified columns contain corresponding val-
ues. An outer join will return all rows from the pri-
mary table and any rows from the secondary table 
where the value in the specified column of the pri-
mary table is equal to the value in the specified col-
umn of the secondary table.
See also Inner join.

Output definition—A description of a report that 
can be viewed when generating a report or when 
mousing over the report title and columns. Output 
definitions are predefined for all standard reports 
and can be defined when creating a custom report. 

Output level—A distinct section of a report that 
outputs report data. Reports can have multiple 
output levels, each of which can have their own fil-
ters, groupings, data exceptions, headers, footers, 
and descriptions. Output levels in a report are 
related through drill-down links and drill-down fil-
ters.

Page—A web page; a customer portal page in a 
RightNow Service application.

Path—The connector between items in a cam-
paign flow diagram. A path can be one of four 
types (Standard, Submit, Yes, or No) and can con-
nect two actions or an action and decision in cam-
paigns.
See also Action and Decision.

Personal settings—An option in RightNow that 
allows staff members to change settings in their 
staff account and certain settings that apply to the 
interface defaults in RightNow. Settings defined in 
staff accounts that can be changed include default 
currency, default country, time zone, and email 
notifications. The staff account settings changed 
from the Personal Settings option will also be 
made to the corresponding settings in the staff 
account.

Pipeline—Calculated revenue that has not yet 
been acquired but is forecasted to close in a speci-
fied time period.
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Preliminary screen pop—The toast notification 
that displays when an incoming chat request or call 
in CTI (computer telephony integration) is 
received. The preliminary screen pop displays as a 
two-column table that allows agents to view infor-
mation about the chat request or call before 
accepting or declining the request.

Preparing to Send—A mailing and survey status 
that indicates a broadcast mailing or broadcast sur-
vey is about to be sent.

Price schedule—An option for creating various 
pricing levels that can be assigned to sales prod-
ucts. Price schedules allow the same product to 
have different prices, such as wholesale and retail 
prices.

Primary key—A database table column that is 
indexed to enforce a unique constraint, meaning 
that a given value cannot appear more than once in 
the column. This column is used to uniquely iden-
tify each record in the table. Primary keys are often 
the target of a foreign key in a different table.
See also Foreign key. 

Priority—A ranking that defines the order in 
which RightNow Service pulls incidents from mul-
tiple queues. The priority ranking also identifies 
which queues agents can retrieve incidents from.

Private—One of two default answer status types. 
Answers marked Private are never visible to cus-
tomers.
See Answer status type.

Private branch exchange (PBX)—A telephone 
switch that is owned and operated by a private 
party.

Private key—A password-protected key used by 
the holder to create digital email signatures and 
decrypt messages that were encrypted using the 
holder’s associated public key.

Privileged access answers—Answers that are 
assigned a custom access level for viewing by cer-
tain contacts and organizations assigned to the 
appropriate service level agreement.
See SLA.

Product—An option for grouping answers and 
incidents that allows more precise organization in 
the knowledge base. Staff members can classify 
answers and incidents by product and up to five 
additional levels of sub-products, allowing more 
refined searching by customers and staff members.
See also Category.

Product catalog—The list for organizing sales 
products.

Product linking—An option for linking products 
to categories and products to dispositions so that 
category and disposition choices are narrowed to 
only those associated with the selected product for 
staff members working with incidents and custom-
ers searching on the customer portal.

Professional Services—Services provided by 
RightNow Technologies, including training, sup-
port, and consulting.

Profile—A mechanism for controlling access to 
administration functions and for assigning staff 
members specific permissions, default workspaces, 
a default navigation set, and report access.

Promotion—A specific message (for example, a 
discount, renewal notice, or announcement) deliv-
ered to a specific group of customers using Offer 
Advisor. Promotions are generally created by mar-
keting staff members and presented to customers 
by agents.
See Offer Advisor.
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Proof—A way to review the content of a mailing 
or survey to ensure the message is approved by the 
necessary contacts and staff members and as a 
final check for any mistakes. Proofs can be sent to 
a proof list or group of staff members who, in 
turn, can accept or reject the proof.

Proof list—A group of contacts, either internal or 
external, who review mailings and surveys before 
they are finalized.

Propose answer—A function for proposing that 
an incident’s solution be added to the answers 
available to customers. The proposed answer is 
reviewed by the knowledge engineer, who deter-
mines if it should be made public and, if so, its 
access level, status, language, and visibility.

Proposed—One of the default answer statuses. 
This answer status indicates that the answer has 
been proposed by a staff member from an inci-
dent. Answers with a Proposed status are not visi-
ble to customers.
See Answer status.

Provide Feedback—A link on the Support Home 
page that customers can click to submit feedback 
about an organization’s web site, customer service, 
or product satisfaction.

Public—One of the default answer statuses and 
status types. Answers marked Public may be visible 
to customers depending on their access level and 
language.
See Answer status and Answer status type.

Public key—Public information that may be 
attached to email messages to allow those who 
reply to the message to encrypt their response. The 
public key also verifies that the digital signature 
was created with the associated private key, 
thereby ensuring the integrity and authenticity of 
the message. Public keys are often referred to as 
public certificates, although certificates hold addi-
tional information besides the public key.

Publish report—A method of preserving a 
report’s graphical and tabular output as a snapshot. 
Once a report is published, it cannot be modified 
and the report data will remain unchanged even as 
the knowledge base is updated.

Pull policy—The method for determining which 
queues agents can retrieve incidents or receive chat 
requests from and in what order. Pull policies 
include Strict Priority, Manual, and First Due.

Pull quantity—The specified number of incidents 
to be retrieved from the queue at one time when 
an agent pulls incidents.

Question—The main element in a survey. Text, 
choice, and matrix question types can be created. 
Questions can be used in multiple surveys, mixing 
and matching as necessary. 
See Text question, Choice question, and Matrix 
question.

Questionnaire—The complete set of questions 
and all the pages in a survey. Using the HTML edi-
tor, staff members can create dynamic surveys 
using a graphical interface to add questions and 
create survey branches based on how customers 
answer. A questionnaire must be created for each 
survey.

Queue—See Incident queue and Chat session 
queue.
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Queued report—A report that has been manually 
or automatically scheduled to run in the back-
ground after the report’s search criteria is entered. 
When a queued report has been generated, a toast 
notification displays with a link to open the report.

Quick Access toolbar—One or more buttons 
used as shortcuts to commands on the ribbon. The 
initial set of buttons on the Quick Access toolbar 
is specified by what is displayed on the content 
pane, but staff members can customize the toolbar 
to add frequently used buttons. By default, the 
Quick Access toolbar appears above the ribbon.

Quick Search—A component in RightNow used 
to search for records and files when only limited 
information is known. Quick Search can be used 
to search the knowledge base no matter what navi-
gation list is displayed or what is open on the con-
tent pane. RightNow contains a number of default 
Quick Search reports, and other reports can be 
added to the Quick Search button in navigation 
sets.

Quota—The revenue goal assigned to a sales rep-
resentative during a specified time period, such as 
month or quarter.

Quote—A formal price assigned to a sales product 
for a particular customer during a sales period. 
Quotes also include any discounts applied as well 
as the valid dates for the quote.

Quote template—A template defined for a spe-
cific type of sales quote. Quote templates are used 
when generating a quote for an opportunity.
See also Quote.

Record pool—The memory space used to tempo-
rarily store all records loaded in a single desktop 
workflow session.

Record tabs—All the tabs associated with the 
open record on the content pane. Each tab con-
tains fields and options for adding and updating 
record information.

Regular expression—A combination of opera-
tors and character strings used to define a search 
field or a condition statement in a business rule.

Reject—One of the default opportunity statuses 
and status types. A lead with the Reject status has 
been rejected by a staff member.

Related answers—A feature that assists custom-
ers in finding answers to questions related to the 
current session history. Related answers appear on 
the bottom of the Answer page and are sorted by 
relatedness—those answers that appear at the top 
of the list are most related to the answer being 
viewed.

Relationship item—A control used to create 
workspaces. Relationship items can include lists of 
records as well as other information, such as audit 
logs and file attachments.

Relative time—The number of hours from a spe-
cific event or time, such as two hours from the 
time an incident was created; relative time is used 
in business rules and custom reports. In standard 
reports, relative time is the amount of time passed 
based on an organization’s work hours.
See also Absolute time.

Report—Any standard report, custom report, or 
list of records accessed from a navigation list on 
the navigation pane. Standard and custom reports 
can also be accessed from the Reports explorer.

Report control—A control that inserts a report 
into a workspace.
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Report linking—A feature in RightNow Analyt-
ics for creating links between reports. Linked 
reports and dashboards can be seamlessly opened 
from other reports, just as report levels can be 
opened from other levels in the same report. Both 
conditional and unconditional links can be created.

Report schedule—An option for subscribing to a 
standard or custom report. Staff members can 
schedule the report to be sent to an individual staff 
member, a group of staff members, a distribution 
list, an external email address, or any combination 
of these options.

Report section—A section of an output level that 
contains a component of the report’s output, such 
as a title, chart, or tabular data.

Reportgen—A scheduled utility that sends out 
scheduled reports.
See Report schedule and Scheduled report.

Re-queuing—The action of moving an incident 
from an agent’s inbox into a queue.

Resolution time—The maximum allowable time 
(in minutes) set by a service organization for 
resolving incidents.
See also Default response requirements.

Response interval—Defines when a service orga-
nization makes itself available to respond to and 
solve incidents on a daily basis in RightNow Ser-
vice. Days and hours can be specified.
See also Default response requirements.

Response requirements—The maximum time 
allowed (in minutes) in RightNow Service for inci-
dent response and resolution associated with a par-
ticular SLA.
See also Default response requirements and SLA.

Response time—The maximum allowable time 
(in minutes) set by a service organization for ini-
tially responding to new incidents.
See also Default response requirements.

Result grouping—A feature in a report definition 
for selecting fields to group data by. Result group-
ing provides a more organized view of a report. 
Multiple levels can be defined for result grouping; 
the more levels used, the finer the detail will be.

Review—One of the default answer statuses. This 
status can be used to notify the knowledge engi-
neer when a public answer needs to be reviewed.
See also Answer status.

Ribbon—All the tabs and buttons for taking 
actions and performing functions on an entire 
report, individual records in a report, or items in 
an explorer tree or list. The buttons on each tab are 
grouped by related functions, and each group is 
labeled. The tabs and buttons on the ribbon 
change based on what is displayed on the content 
pane.

RightNow Analytics—A business analytics soft-
ware that provides organizations with full visibility 
into all of their customer touch points across sales, 
marketing, service, and feedback.

RightNow Chat—A component in RightNow 
Service that provides customers with access to chat 
agents for questions and issues that require human 
interaction.

RightNow Cloud Monitor—A monitoring tool 
for gathering and acting on information about your 
organization that appears on social networking ser-
vices such as Twitter and YouTube.

RightNow Console—The administration inter-
face for working in RightNow. Staff members can 
work with records and components, generate stan-
dard reports and create custom reports, access 
their notifications, and work in RightNow Chat 
from this console. The RightNow administrator 
can also configure and customize the RightNow 
application from this console.
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RightNow Customer Portal—The set of pages 
in RightNow Service that customers use to look up 
answers, view account information, request a chat, 
and ask questions. Certain functions can require a 
customer account. The RightNow Customer Por-
tal can be completely integrated with an organiza-
tion’s web site using the Customer Portal Studio, 
which allows developers and designers to add 
RightNow elements to any page or template.
See also Customer Portal Studio.

RightNow Dreamweaver extension—A plug-in 
developed by RightNow Technologies for the 
Adobe Dreamweaver software application. The 
RightNow Dreamweaver extension provides the 
ability to quickly add widgets, define page 
attributes, and insert RightNow variables into cus-
tomer portal pages that are developed in 
Dreamweaver.

RightNow Feedback—A customer survey tool 
for gathering information about customers’ experi-
ences with an organization. With a wide range of 
customization and formatting options, questions 
types, and full analytics for efficient reporting, sur-
veys provide organizations with a flexible method 
of tracking customer satisfaction.

RightNow Marketing—An email and campaign 
solution for delivering personalized, richly format-
ted email communications to targeted segments of 
customers and prospects and for launching full-
scale marketing campaigns.

RightNow Sales—A sales automation solution 
that enables sales representatives to easily manage 
and track all opportunity, organization, and contact 
information and track all quote interactions in one 
consolidated application.

RightNow Service—A customer service and sup-
port solution that intelligently assists both custom-
ers and agents with inquiry resolution across 
traditional and online channels. RightNow Service 
assists customer service and support organizations 
that need to easily capture, respond to, manage, 
and track all service interactions in one consoli-
dated application.

RightNow Smart Client—The web-based CRM 
software that allows local applications to interact 
with the server-based applications. The RightNow 
Smart Client can be installed on staff workstations 
using the Click-Once or MSI deployment method.
See also Click-Once installer and MSI.

RightNow Wireless—The interface for accessing 
RightNow Service from a wireless phone or any 
device with a WAP (wireless application protocol) 
browser, such as a PDA (personal digital assistant).

Rollover—A method of displaying additional 
report details by mousing over data described in 
the report’s output definition.

Rollup—A method of displaying report data that 
groups records together by specific fields. The 
grouped records are displayed under headings that 
can be expanded or collapsed to display or hide the 
records under the heading.

Root certificate—A self-signed certificate gener-
ated by a party that signs other public certificates. 
Certification authorities may authorize other enti-
ties to issue certificates; the root certificate belongs 
to the top-level certification authority.

Round-robin queue—A type of incident queue 
in which unresolved incidents are automatically 
assigned to agents in a rotating fashion.

RPA (responses per assignment)—A statistic 
that calculates the average number of times a staff 
member or group responded to each incident.

Rule—See Business rule.
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Rule base—All rules, states, functions, and vari-
ables associated with a particular object class 
(answers, contacts, incidents, chat sessions, oppor-
tunities, organizations, targets, and tasks) in busi-
ness rules.

Rule log—A feature for viewing the rule or rules 
that have fired against a specific answer, contact, 
incident, opportunity, organization, or task.
See also Business rules.

Rule state—A container for business rules. Every 
rule base must contain an initial state, and states 
can be added to handle all stages of object process-
ing. Rules in the initial state can transition objects 
to other states in the rule base.
See also Initial state.

Rules engine—The software that evaluates 
objects to determine if they meet the conditions of 
any rules in the rule base and then executes the 
actions defined in the rules.

Run-time selectable filter—A component of 
RightNow Analytics that defines the initial data set 
available in the report and allows staff members 
and customers to customize the data returned. 
Run-time selectable filters are statements con-
structed from expressions, functions, and opera-
tors, and can be customized when running a report 
and by customers on the Preferences section of the 
Edit My Profile page.

S/MIME (Secure Multipurpose Internet Mail 
Extensions)—A standard for sending secure 
email messages that can verify the sender’s identity. 
S/MIME emails can be encrypted for security and 
signed to verify authenticity.

Safe mode—A login method that allows staff 
members to log in to RightNow without activating 
add-ins. Safe mode is available after malfunction-
ing add-ins have prevented administrators and 
staff members from logging in.
See Add-in.

Sales period—The period of time used to track 
the revenue goals assigned to each sales represen-
tative. The default sales periods are annual, semi-
annual, quarterly, monthly, and weekly.

Sales product—An option for identifying items 
or services sold by an organization. Sales products 
can be added to quotes and promotions.

Sales products custom field—A field for gather-
ing and displaying additional information about 
sales products. Sales products custom fields appear 
on the Details tab of the Sales Product editor.

Sales quotes custom field—A field for gathering 
and displaying additional information about sales 
quotes. Sales quotes custom fields appear when 
sending a quote with an opportunity.

Sales representative—A staff member who may 
be assigned opportunities and who may also main-
tain contact and organization records.

Sampling mode—A market testing mode that 
sends test messages to a specified percentage of 
the audience. After determining the most effective 
message, a final message can be sent to any audi-
ence members who did not receive a test message.
See Market testing.

Scheduled—A mailing and survey status that indi-
cates a broadcast mailing or broadcast survey is 
ready to be sent and will be emailed at the sched-
uled send date and time.
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Scheduled report—A report that is sent as an 
HTML email or HTML email attachment to staff 
members, distribution lists, or external email 
addresses at specified times. Scheduled reports can 
also be sent when alerts defined in data exceptions 
are triggered.

Schema—The structure of a database system 
described in a formal language supported by                      
the database management system. In a relational 
database, the schema defines the tables, the fields 
in each table, and the relationships between fields 
and tables.

Score—A calculated value that ranks the order of 
displayed answers. An answer’s score is deter-
mined by its solved count and any display position 
that was set when the answer was added or 
updated. Score also refers to the relative weight 
assigned to each choice in a choice question for 
surveys. Score values can be used for survey calcu-
lations to trigger rules or campaign actions based 
on a contact’s answers and also for reporting pur-
poses.

Screen pop—See CTI screen pop and Third-party 
screen pop.

Script—A control that can be added to a custom 
workspace to help staff members enter record 
information in a logical order. Scripts can contain 
multiple pages with fields and other controls as 
well as branching logic to guide staff members to 
different pages based on actions they take on a 
script page.

Search and selection criteria—The run-time 
selectable filters and sorting options that can be 
defined when searching for a particular record.
See also Run-time selectable filter.

Search index—A matrix that includes a list of 
important words within a document and their doc-
ument of origin, allowing efficient searching. In 
some cases, the matrix is a database table; in other 
instances, the matrix is a file stored on a hard drive. 
For a word or phrase to be searchable within an 
incident, answer, file attachment, or external docu-
ment, it must first be indexed.

Secure email—Incoming and outgoing email that 
has authenticity (the sender is who it appears to 
be), integrity (content has not changed during 
transmission), and privacy (only the intended 
recipient can read it).

Seeding—The initial set of answers in the knowl-
edge base.

Segment—The criteria for creating dynamic lists 
of contacts based on user-defined filters. Multiple 
filters can be created and logical expressions can be 
used to create the exact data set needed to target 
contacts. Once a segment is created, it can be used 
in broadcast mailings and surveys and the group of 
contacts will be constantly adjusted and updated as 
they meet or fall outside of the segment’s require-
ments.

Self-learning knowledge base—The automatic 
generation of self-service content based on cus-
tomer interactions so that the most pertinent 
information is presented.
See also iKnow and Knowledge base.

Sender ID—A form of email authentication that 
identifies IP addresses authorized to send mail on 
behalf of a specific organization. Sender ID differs 
from SPF authentication primarily by the compo-
nents of the email used to authenticate the mes-
sage.
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Sender Policy Framework (SPF)—A form of 
email authentication that identifies IP addresses 
authorized to send mail on behalf of a specific 
organization. SPF differs from Sender ID authenti-
cation primarily by the components of the email 
used to authenticate the message.

Sending—A mailing and survey status that indi-
cates the broadcast mailing or broadcast survey is 
currently being sent to contacts. The system auto-
matically sets the status to Sending after the mail-
ing or survey is done being prepared to send or at 
the scheduled date and time.

Service level agreement—See SLA.

Session—The period of time a customer spends 
looking for a satisfactory answer to a question. The 
end of a session generally occurs when a customer 
closes the browser or leaves the interface or when 
a specified time period elapses.

Session tracking—A feature that tracks a cus-
tomer’s current session history; that is, the pages 
on the customer portal that the customer clicked 
before submitting a question.

Sharing—The process of sharing contacts, tasks, 
or both between Microsoft Outlook and Right-
Now. All sharing functions are initiated from Out-
look.

Sibling answer—Related answers that share the 
same product or category. These related answers 
may also contain the same file attachments.

SLA (service level agreement)—A contract that 
is applied to contacts and organizations specifying 
the level and type of customer service they are eli-
gible to receive. Generic SLAs are created by 
administrators, and SLA instances are applied to 
specific customers, either automatically through 
business rules or manually by staff members. SLA 
instances are called service contracts on the cus-
tomer portal and can be accessed from the My 
Stuff page.
See also Default response requirements.

SLA instance—A customer’s individual copy of 
an SLA. An SLA is a generic contract that has not 
been applied to a specific customer; an SLA 
instance is a copy of the generic SLA applied to a 
specific customer.

Slicing—A method of grouping tabular report 
data by a common element. When slicing, a com-
mon value in a field can be chosen and only those 
rows that have that value will be returned in the 
report. Other slice groups can be selected from 
links or a tree element.

Smart Merge—A feature in RightNow Service 
that allows staff members to merge similar answers 
in the knowledge base to provide more meaningful 
answers to customers and to reduce answer dupli-
cation.

SmartAssistant—RightNow technology that uses 
business rules to automatically suggest possible 
answers to customers’ email questions and Ask a 
Question queries. Staff members can use SmartAs-
sistant to search for answers in the knowledge base 
that are related to an open incident or a current 
chat session.
See also Suggested answers. 
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SmartSense—RightNow technology that esti-
mates a customer’s emotional state or attitude 
based on the words and language the customer 
uses when submitting a question in RightNow Ser-
vice. SmartSense also rates the incident responses 
sent by agents. The SmartSense ratings for both 
customer and agent appear wherever they have 
been placed on the workspace. In RightNow 
Feedback, SmartSense evaluates text questions 
submitted by customers in surveys.

Snippet—Any text or part of a document that can 
be used in more than one document. Snippets can 
be added to documents from the Content Library 
component.

Soft phone functions—Standard telephone func-
tions such as receiving, transferring, and confer-
encing.
See CTI.

Solved—One of the default incident status types 
and incident statuses. An incident marked Solved 
has been resolved.

Solved count—The method for determining 
where an answer will display in the list of answers. 
The most useful answers (those with the highest 
solved count) are pushed to the top of the list, 
while those with the lowest ratings are moved 
down on the list. When a customer clicks one of 
the options in “How well did this answer your 
question,” it directly affects the solved count. The 
solved count is increased for answers that are 
viewed and decreased for answers viewed earlier in 
the same session. The solved count is also 
increased when an agent uses a SmartAssistant 
suggested answer when responding to a customer’s 
question.

Sort order—The sort order of a report’s output 
columns. The default sort order is defined when 
generating a report and can be modified when run-
ning the report.

Spacer—A control that is manually added to a 
workspace to maintain the row and column 
arrangement when fields and controls are moved 
and removed or to create white space in a work-
space.

SSL (secure sockets layer)—An industry stan-
dard for secure Internet-based transfer of informa-
tion.

Staff account—The settings for a staff member 
authorized to access a RightNow application, 
including login name, password, profile, group 
assignment, and email information.

Staff account custom field—A field for gather-
ing and displaying additional information about 
staff members. Staff account custom fields appear 
on the Details tab of the Staff Accounts editor.

Staff member—Any employee with a staff 
account and profile authorized to access a 
RightNow application.

Stage—The level of completion of a particular 
opportunity within a specific strategy. Tasks can be 
defined within a stage and can be required to be 
completed before the opportunity can move to the 
next stage.
See Strategy and Task.

Standalone Configuration Editor—A web page 
that allows access to the Configuration Editor 
without going through the RightNow Console. 
Entry is made using a specific URL.

Standard reports—The complete set of pre-
defined reports available in RightNow. Standard 
reports can be copied and used to create custom 
reports.

Standard text—Any text or response prepared in 
advance that can be sent to customers when 
responding to incidents, appended to responses by 
a business rule, or sent by an agent during a chat 
session. Also called standard response.
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State—A field that classifies how contacts and 
organizations were added and what actions have 
occurred since their creation. The State field is 
automatically populated when a contact or organi-
zation record is added or updated; staff members 
can also manually update the State field. State field 
options include Service, Sales, Marketing, and any 
combination of the three. State also refers to the 
current stage of an object in rules processing.
See Rule state.

Status—The current state of an answer, incident, 
mailing, opportunity, survey, or task.
See Answer status, Incident status, Mailing status, 
Opportunity status, Survey status, and Task status.

Status type—The current state of an answer, inci-
dent, or opportunity. Default answer status types 
are Public and Private. Default incident status 
types are Unresolved, Solved, and Waiting. Default 
opportunity status types are Active, Closed, Dead, 
Inactive, Lead, Lost, and Reject.

Stopword—A word that is not included in the 
keyword indexes in RightNow Service and is not 
searchable as a result. Pronouns, articles, and 
adverbs are common stopwords.

Strategy—A sales plan defined by an organization 
that includes stages and associated tasks that must 
be completed in order for opportunities to move 
through each stage. Strategies allow organizations 
to define multiple sales plans based on their busi-
ness processes and help ensure that policies and 
procedures are enforced.

Strict priority—A pull policy that defines the 
order in which the system pulls incidents or chats 
from multiple queues. The strict priority ranking 
also identifies from which queues agents can 
retrieve incidents.

Style—All of the specifications that can be defined 
for presenting graphical and tabular data in a 
report, including fonts, colors, and borders.

Suggested answers—The list of answers from 
the knowledge base that is returned when Smar-
tAssistant is invoked, either by staff members 
working on incidents or engaged in chat sessions 
or through business rules that append answers to 
email questions and Ask a Question queries from 
customers.
See also SmartAssistant. 

Suggestion—A product recommendation auto-
matically generated by Offer Advisor using a pre-
dictive model based on customer purchase history.

Support Home—The entry page on the customer 
portal that contains links to the main functions in 
RightNow Service. This page provides customers 
with quick access to the tools they need to answer 
their questions and receive immediate customer 
service.

Survey—A method of gathering customer 
responses and feedback. Surveys can be sent as 
mailings, served as a web page, or sent as events 
triggered by a campaign or business rule.
See RightNow Feedback.

Survey status—A method of tracking the state of 
a survey. The default survey delivery statuses 
include Draft, Launched, Scheduled, Preparing to 
Send, Sending, Suspended, Suspended by Error, 
Canceled, and Completed.

Suspended—A mailing and survey status that 
indicates a mailing or survey has been temporarily 
suspended from the Sending or Launched status.

Suspended by Error—A mailing and survey sta-
tus that indicates a transactional mailing or transac-
tional survey encountered an error and has been 
temporarily suspended.
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Synchronization—The process of collecting and 
combining records from online and offline data-
bases to ensure data is consistent between both 
databases. Also called sync.
See also Offline mode and Online mode.

Syndicated widget—A customer portal widget 
that can access the RightNow database from any 
external web page. The code used to place the syn-
dicated widget on a web page is available in the tag 
gallery.
See also Tag gallery.

Table instance—A component of a data set that 
specifies the database tables that data can be 
selected from and how database tables are joined 
in a report or segment.

Tag gallery—A reference site that provides infor-
mation about the tags that can be used for creating 
pages and templates for the RightNow Customer 
Portal. The tag gallery is a dynamic, self-document-
ing file; that is, when a widget is edited, the tag gal-
lery immediately reflects those changes and 
displays a preview of the changes in the gallery.

Target—A specific group of customers sharing 
common characteristics to whom a promotion is 
presented. A customer may belong to more than 
one target.

Target rule—A type of business rule that has the 
sole purpose of creating a target consisting of con-
tacts who meet the conditions established by the 
rule.

Task—An action or activity scheduled to be com-
pleted within a specified time. Tasks can be standa-
lone, or they can be associated with answers, 
campaigns, contacts, documents, incidents, mail-
ings, opportunities, organizations, surveys, and 
stages in a sales strategy.

Task custom field—A field for gathering and dis-
playing additional information about tasks. Task 
custom fields appear when adding or editing a task.

Task inheritance—A feature for linking a task’s 
assigned staff member, contact, or organization to 
the equivalent value in a record associated with the 
task.

Task status—A method of tracking a task’s state. 
The default task statuses are Not Started, In 
Progress, Completed, Waiting, and Deferred.

Techmail—A scheduled utility that retrieves mail 
from specified POP3 mailboxes. RightNow Ser-
vice processes some of the mail into new incidents 
and routes the incidents using business rules 
(depending on settings). RightNow Marketing and 
RightNow Feedback process bounced messages to 
assist in tracking incorrect email addresses.

Template—A structured format used in a docu-
ment in which specified sections are locked and 
cannot be edited and a section is open for custom-
ized content. Templates can be added from the 
Content Library component.

Territory—A specific geographical sales region 
configured in RightNow Sales. Sales representa-
tives can be assigned specific territories for oppor-
tunity assignment. Up to twelve levels of territories 
can be defined.

Test message—A mailing message that can be 
sent to small cross-sections of an audience to test a 
response before launching a final message.

Text explanation—A text field that can be associ-
ated with a response in a guided assistance guide. 
The text explanation is displayed after an agent 
selects the associated response from a question in 
the guide.
See Guided assistance.
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Text field—A customizable field containing text 
that is commonly added to reports. Once a text 
field is created, it can be added to any custom 
report and then adjusted as necessary.

Text matching—A feature in Offer Advisor that 
enables agents to search for specific terms that 
best express the customer’s interests. After a 
search, the list of promotions and suggestions on 
the Offer Advisor window will be reordered, and 
the ranking of each will reflect its relevance to the 
terms entered by the agent.
See Offer Advisor.

Text question—A question type that allows cus-
tomers to type their answer to a question.

Theme—A group of related text responses to a 
survey question. Themes are created by topic mon-
itoring and identified by common keywords.
See also Topic monitoring.

Thin client—The non-graphical interface in 
RightNow Service.
See Accessibility interface.

Third-party screen pop—A feature in RightNow 
that allows staff members to open a RightNow 
Console or report from a third-party application.

Time billed—A way to track the time spent 
responding to incidents. Data from the Time 
Billed field can be used for customer billing and 
determining average incident resolution time.

Topic monitoring—A process that groups survey 
text responses into clusters of related responses 
called “themes” and labels each theme with key-
words that define the responses.
See also Data mining and Themes.

Topic word—A word that is associated with an 
answer or document. The associated answer or 
document will always be displayed to customers 
when the topic word is included in their search 
text.

Tracked link—A link that can be tracked by 
RightNow Marketing and reported on for statisti-
cal purposes.

Tracked link category—An option for classify-
ing tracked links for reporting purposes. A tracked 
link category can have one sub-category level.

Transactional mailing—A mailing that is sent 
only when an event occurs. Transactional mailings 
are sent to a contact when the contact meets speci-
fied criteria in a campaign and can be scheduled to 
be sent immediately, on a specific date, or at an 
interval in the future.

Transactional survey—A survey that is sent only 
when an event occurs. Transactional surveys are 
sent to a contact when the contact meets specified 
criteria in a campaign or business rule and can be 
scheduled to be sent immediately, on a specific 
date, or at an interval in the future.

Transfer—A feature in RightNow Chat that 
enables an agent to transfer a customer to another 
agent during a chat session.

Trending—A method of predicting a trend for a 
specified date range in the future based on a 
report’s current data. Trending periods are defined 
when creating or editing a custom report and can 
be included in standard reports.

Unqualified—One of the default chat agent sta-
tuses. This status indicates that the agent is not 
available to chat. The Unqualified chat agent status 
has an Unavailable status type.

Unresolved—One of the default incident status 
types and statuses. Incidents with an Unresolved 
status have recently entered the system, either by a 
customer or agent.
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Unrestricted—One of the default chat agent sta-
tuses. This status indicates that there are no restric-
tions to the agent’s availability to chat. The 
Unrestricted chat agent status has an Available sta-
tus type.

Unspecified—One of the default chat agent sta-
tuses. This status indicates that the agent is logged 
out of RightNow Chat. The Unspecified chat 
agent status has a Logged Out status type and is 
displayed to agents by default.

Unsubscribe link—A link in a mailing that con-
tacts can click to opt out of future mailings or sur-
veys.

Updated—One of the default incident statuses. 
An incident marked Updated has been updated by 
a customer from My Stuff. Updated incidents have 
an Unresolved status type.

URL answer—A type of answer that consists of a 
link to an external URL. The URL address and the 
content of the web page are displayed.

Utility—Any of a number of programs in 
RightNow to help manage and configure a Right-
Now installation. RightNow utilities include Age-
database, Bulkdel, Dbaudit, Dbstatus, Kexport, 
Kimport, Langcvt, Msgtool, Reportgen, Techmail, 
and Wltool.

Variable—A temporary data item in a rule base. 
The variable is assigned an initial value that can be 
modified through rule actions, used as a rule con-
dition to trigger other actions, and restored to its 
initial value for the next round of rules processing. 
Variables also refer to shortcuts defined for a 
larger string that can be inserted in the body of an 
answer or inserted inline during a chat session. 
When the variable is inserted in the body of the 
answer or in a chat response, it is replaced with the 
value specified in the variable.

Visibility—A setting that determines where a cus-
tom field or customizable menu item will appear. 
Visibility settings specify the interfaces in a multi-
ple interface installation where these fields appear; 
the settings can also define whether the fields 
appear on the administration interface and cus-
tomer portal and whether certain custom fields 
with customer visibility can be edited.

Waiting—One of the default incident status types 
and incident statuses. An incident marked Waiting 
has been responded to by a staff member and is 
waiting for a response from the incident creator.

Watchlist notification—An email sent to those 
customers who have requested to be notified when 
a particular answer has been updated.

Web form—A document in RightNow Marketing 
that allows contacts to input information that can 
be submitted to the database. Web forms are 
served as web pages by RightNow.

Web Indexer—A search method in RightNow 
Service that allows customers to simultaneously 
search the knowledge base along with web pages 
and other web-accessible documents within a spec-
ified domain.

Web spider—A software application that reads 
web pages and other documents and indexes the 
content for a search engine, often following hyper-
links from one web page to another.

Website link survey—A type of survey that is 
published as a web page and can be linked to from 
any source.
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Weight—A displayed value given to resulting 
answers of a text search. The value is equal to the 
sum of the weights (for indexed words) of all the 
matched words from the text search. Weight also 
refers to an internal value given to each indexed 
keyword for an answer or incident. The value is 
relative to a constant and is based on number of 
occurrences, capitalization, and location of the 
word (ranked high to low: Keywords, Summary, 
Question, and Answer field for answers; Subject 
field and incident thread for incidents).

Widget—A collection of files that generates a spe-
cific function when it is placed on a page of the 
RightNow Customer Portal. Widgets can be but-
tons, fields, reports, or other elements that can 
access the RightNow database and communicate 
with other widgets through events or to the server 
through AJAX requests.

Win/loss reason—An option for classifying and 
recording reasons for winning or losing an oppor-
tunity.

Wltool—A utility that is manually run after mak-
ing changes to one of the wordlist files.
See Wordlist file.

Word stemming—A feature used in keyword 
indexing and text searching that finds the root of 
each word and stores the stemmed root instead of 
the whole word, thereby saving large amounts of 
space while making a search broader and more 
appropriate.

Wordlist file—Any of the files that can be modi-
fied to customize indexing, text searching, and 
SmartSense emotive ratings.

Work group—All of a record’s open, associated 
records (for example, an incident’s contact, organi-
zation, and tasks) that have been docked to the 
RightNow Console. When another, non-associated 
record is opened, the records in the work group 
are collapsed on a single content pane tab. All 
records in a work group are saved and closed in a 
single operation.

Workflow—See Desktop workflow.

Working record—The record being evaluated or 
acted upon by a workflow element or connector. 
For instance, a workspace element can display the 
first or last record opened in the workflow or a 
record named elsewhere in the workflow.

Workspace—The configuration of the content 
pane when working with answers, contacts, inci-
dents, opportunities, organizations, and tasks; 
when working in RightNow Chat; and when work-
ing with quotes, quote products, and service 
opportunities. Standard workspaces exist for each 
type of workspace, and custom workspaces can be 
created. The workspaces staff members use 
depend on their profile.

Workspace designer—The tool used to create 
and edit custom workspaces.

WYSIWYG (what you see is what you get)—See 
HTML editor.
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Index

A
actions, adding actions column 133
Actions column 350
Add Alert window, field descriptions 128
Add Filter window, field descriptions 314
Add Variable List Item window 241
aggregate functions 246
alerts, in schedules 127
Alignment Tab window, field descriptions 271
Analytics explorers

Chart Styles explorer 33
Color Schemes explorer 50
copying items in 23
Images explorer 52
Reports explorer 25
saving items in 24
searching in 18
Styles explorer 27
Text Fields explorer 54

anchor styles 230
audit log

in dashboards 392
in reports 353

Audit Log window 354, 392
auto filters 143

auto filter example 144
Custom Auto Filter window 145
Top 10 window 145

auto format
dashboards 394
reports 129
see also styles

Auto Format window 130, 395
auto refresh, dashboards 388

B
backgrounds

adding to report sections 220
adding to report styles 30
adding to reports 135
adding to text fields 58

Backgrounds Tab window, field descriptions 135
borders

adding 222
to report sections 222
to reports 136
to styles 32
to text fields 60

Borders Tab window, field descriptions 32
buckets, slice by 151

C
caching 99
calculations

adding 281
displaying on separate lines 133

Calculations window, field descriptions 282
chart styles

applying to charts 311
creating and editing, overview 35
overview 33

chart styles editor
bar settings, descriptions 39
category grid lines, descriptions 46
color schemes 42
format options, descriptions 49
gauge color ranges, descriptions 41
gauge settings, descriptions 39
labels buttons, descriptions 43
line settings, descriptions 39
selecting fonts 61
3D settings, descriptions 38
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chart styles editor (continued)
value grid lines, descriptions 46
value scale, descriptions 44
value tick marks, descriptions 47

Chart Styles Editor window 36
Chart Styles explorer, overview 33
chart types and subtypes 304
Chart Wizard

Chart Type window 303
General Settings window, field descriptions 310
Source Data window, field descriptions 306

charts
adding charts to reports 299
automatic sizing 312
chart types descriptions 34, 304
creating and editing chart styles 35
section layout options 312
selecting layouts 302

Choose a Report Definition for Import window 178
Choose Font window, field descriptions 62
Color Ranges window 41
Color Schemes explorer 50
colors

Color Menu 63
Color window 63
Custom Color Selection window 64
selecting 63

column calculations, adding 281
Column Definition window, field descriptions 254
Column Format window 265
Column Trend Options window 260
Comparison Date Offset window 255
Comparison Match Columns window 257
Comparison Percentage window, field descriptions 258
comparison percentages 257
comparison values

options 256
overview 255

computed fields
comparison percentages 257
comparison values 255
overview 242
report moving average 243
report moving total 243
report percentage of average 244
report percentage of total 245
report running average 245

computed fields (continued)
report running total 245
trend percentages 260
trend values 259

Conditional Report Linking Wizard 344
configuration settings, see system configuration settings
Copy As window 23
copying standard items 23
Cross Tab window, field descriptions 154
cross tabs 152
currency functions 252
Currency Tab window, field descriptions 269
Custom Auto Filter window 145
custom folders, creating 22
custom report example 167
Custom Script Editor

Finish Tab window 337
Headers Tab window 336
Initialization Tab window 335
Process Tab window 336

custom scripts 335
Customize Data Dictionary window 208

D
dashboard descriptions, adding 378
dashboard design center

design surface 370
opening 360
reports explorer 371
ribbons

Display 364
Home 362
Options 368
overview 362
Page Setup 366
Text Field 367

sample Dashboard Design Center 361
see also dashboards

dashboard headers 369
dashboard layouts menu 373
Dashboard Permissions window, field descriptions 391
dashboards

adding notifications to 374
adding reports to 374
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dashboards (continued)
adding web browser to 374
auto-refresh 390
caching drilldown levels 389
custom add-ins 371
dashboard design center

design surface 370
example 361
opening 360

dashboard sections
automatic layout 380
table layout 380

descriptions, adding 378
design view 361
displaying and hiding reports 405
Edit Settings window 387
forwarding 111
images, adding to dashboard sections 385
Layout Tab window 396
layouts, applying to a dashboard 373
linking, see report linking
output

applying styles 394
changing display options 395

positioning reports and notifications 375
properties

editing options 386
specifying permissions 391

queuing 403
Report Sections Tab window 398
report view 361
ribbons

Display 364
Home 362
Options 368
Page Setup 366
Text Field 367

scheduling 390
searching

for data in reports 406
sample search window 407
specifying search defaults 392

Set Filter Values window 393
Table Layout Properties window, field descriptions 381
tabs

adding to a dashboard 377
renaming tabs 377

dashboards (continued)
text fields

adding to dashboard sections 382
moving and editing 386

Titlebars Tab window 397
using dashboards

Home tab description 400
overview 398

views 361
data dictionary, in report design center 207
Data Display Options Tab window 133
data exceptions

creating 284
displaying 139
ordering 289

data grouping 94
data points, changing for moving calculation columns 243
Data Set window, field descriptions 298
database fields 236
date functions 248
Date Range Filter window, field descriptions 94
date ranges

defining relative date ranges 93
overview 93
rounding 94

Date Tab window, field descriptions 266
default display and data settings

restoring 160
saving 160

Definition Tab window, field descriptions 285
delimited export format 117
design surface

in dashboard design center 370
in report design center 206

Design tab
chart button descriptions 198
column button descriptions 192
data exception button descriptions 196
filter button descriptions 200
table button descriptions 199
text field button descriptions 195
variable button descriptions 200

display options
backgrounds tab 134
borders tab 136
display links column 133
fix column headers 133
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display options (continued)
page options 131
record layout 130
row numbering 133
tabular layout 130

Display tab
auto format 129
button descriptions 83
display options 131
section visibility 138

docked filters
in dashboards 406
in reports 322
report section 211

drill-down
overview 75
recursive 333
report linking 337
see also output levels

E
Edit Dashboard Description window 379
Edit Logical Expression window 320
Edit Row Limit window, field descriptions 291
Edit Selection menu 163
Edit Settings window

dashboard field descriptions 388
report field descriptions 356

Edit Table Layout Properties window 225, 381
Editing Options window, field descriptions 352
Enterprise Analytics

configuring
email addresses 410
navigation sets 412
overview 410
profile permissions 411

training resources 415
Excel export format 117
Exception Editor

Definition Tab window, field descriptions 285
Graphical Display Tab window, field descriptions 289
Tabular Display Tab window, field descriptions 286

Exception Visibility window 139

exceptions
creating 284
displaying 139
ordering 289

explorers
accessing 18
Chart Styles explorer 33
Color Schemes explorer 50
copying items in 23
custom folders, creating 22
Images explorer 52
Reports explorer 25
saving items in 24
searching in 18
Styles explorer 27
Text Fields explorer 54

Export Options window, field descriptions 118
exporting, report data 115

F
FCRR (first contact resolution rate) 99
Field Chooser window 141
Fill Tab window, field descriptions 31
filters

Add Filter window, field descriptions 314
auto filters 143
combining run-time selectable filters 321
data grouping 94
docked filters

in dashboards 406
in reports 322

group filters 316
join filters 324
level filters 315
limits 313
logical expressions 319
operators 317
ordering 323
overview 312
report filters 313
run-time filters 313
Search window 91
using date range filters 93

Find window, field descriptions 20
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first contact resolution rate calculation (FCRR) 99
fixed filters 313
fonts, selecting 61
Forward Report window 111
forwarding reports and dashboards 111
freeze column 89, 203
functions, descriptions 246

G
Gauge Tab window, field descriptions 280
Getting Started window 177
Graphical Display Tab window, field descriptions 289
group filters 316

H
hide repeating values 89, 203, 272
Home tab, button descriptions 79, 184
HTML export format 116

I
icons

changing dashboard icons 390
changing report icons 358

image export format 117
images

adding
to dashboards 385
to report sections 227
to the Images explorer 52

changing list images
in dashboards 390
in reports 358

updating in Images explorer 54
Images explorer 52
incident performance intervals 95
inline editing

editing individual values 161

inline editing (continued)
editing multiple values 162
Editing Options window, field descriptions 352
enabling in reports 351
overview 161
saving changes 164

inner joins 291
Insert Image window 227, 385
Insert tab, button descriptions 189
Insert Text Field window 228, 383

J
join conditions 298
join filters 324

L
Layout Tab window, field descriptions 396
layouts

applying
to dashboards 373
to reports 216

selecting charts layouts 302
level filters 315
Level Settings window, field descriptions 332
Level tab, button descriptions 190, 202
limits

charts per report level 300
dashboard tabs 377
data exceptions 284
filters 313
items per dashboard 374
output columns 253
report output levels 328
tables 253

linking reports, see report linking
links, adding action links 350
logical expressions

Edit Logical Expression window 320
overview 319
Text Definition window 321

logical functions, see functions
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M
margins

adding
to dashboards 396
to report sections 219
to reports 132
to text fields 57

Margins Tab window, field descriptions 30
math functions 251
moving averages 243
Moving Calculation Options window 244
multiline report output 133

N
New Color Scheme window 51
New Schedule window 122
Number Tab window, field descriptions 267

O
operators 317
outer joins 292
output columns

action links column 133
adding to reports 253
calculations, displaying on separate lines 133
column calculations 281
Column Definition window 253
column options descriptions 262
comparison percentages 257
comparison values 255
computed fields 242
conditional formatting 274
database fields 236
format options

alignment 271
conditional formatting 274
currency column options 269
date column options 266

output columns (continued)
format options

gauges 280
numeric column options 267
overview 264
styles 273
text column options 265
URLs 278
width 272

functions 245
inserting fields from different tables 294
moving columns 262
overview 236
showing and hiding in reports 140
suffixes 236
trend percentages 260
trend values 259
variables 238

output descriptions
adding 231
options 233

output levels 210
adding 331
custom scripts 335
drill-down feature overview 75
group filters 316
group ordering 329
grouping 328
level filters 315
Level Settings window, field descriptions 332
overview 328
recursive drill-down 333
sections 210

output variables, data grouping 94

P
page breaks, adding 146
page footers

dashboards 370
reports 212

page headers
dashboards 369
reports 211

Page Options Tab window, field descriptions 132
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Page Setup window, field descriptions 110
PDF export format 117
permissions

dashboards 391
reports 354

Permissions window, field descriptions 355
PHP scripting 335
pivot tables 152
Preview Text Field window 61
previewing, print preview 108
previewing reports 179
print preview 107
Print Preview window, field descriptions 108
printing, reports 109
Publish As window 115
publishing, reports 114

Q
Queue Report window 101
queuing

dashboards 403
reports

opening queued reports 104
overview 100
queue statuses 103
queueing automatically 102
queueing manually 100
reasons for queueing failure 103
ribbon options on queued reports 105
viewing in queue 103
when using report databases 105

R
record command links 350
record layout 130
record limits 290
recursive drill-down 333
refresh, reports in dashboards 386
refreshing reports, refresh options 356
relative date ranges 93
Renaming Dashboard Tabs window 378

replication databases, see report databases
report caching 99
report calculations 282
report databases 105
report definition 72
Report Definition window 73
report definitions

exporting 74
importing 178

report design center
customizing chart style options 312
data dictionary

customizing 207
moving 208
overview 207

design surface 206
displaying report sections 218
importing report definitions 178
opening 176
output levels 210
overview 176
parameters 214
report sections 210
ribbon

Design 192
Display 187
Format 201
Home 184
Insert 188
Layout 201
Level 189
Options 204
overview 182

see also reports
report filters 313
report footers 212
report headers 211
report layouts 216
Report Layouts menu, layout descriptions 217
report levels, see output levels
report linking

assigning filter values 341
creating links 339
deleting links 346
editing links 346
linked report display options 343
ordering conditional links 345
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report linking (continued)
overview 337

Report Linking Wizard 340
report magnification 139
report moving average 243
report moving total 243
report parameters descriptions 214
report percentage of average 244
report percentage of total 245
report queueing 100
report queuing , see also queueing
report running average 245
report running total 245
report sections

adding search criteria descriptions 233
layouts 224
overview 210
table layout 224

Report Sections Tab window 398
report styles, see styles
reports

charts
adding to reports 299
see also charts

creating a sample report 167
cross tabs 152
data exceptions

creating 284
ordering 289

data set view 179
design view 179
display and data settings

restoring 160
saving 160

display options 131
distributing

display modifications made to reports 107
overview 106

Edit Table Layout Properties, field descriptions 225
editing data 161
exporting data 115
filters

combining filters 321
creating join filters 324
creating level filters 315
creating report filters 313
defining logical expressions 319

reports (continued)
filters

docking filters 322
overview 312
selecting operators 317

forwarding 111
importing report definitions 178
inline editing

editing individual values 161
editing multiple values 162
enabling in reports 351
overview 161
saving changes 164

layout view 77, 179
linking, see report linking
opening 68
output columns

adding 253
changing column options 262
column calculations 281
comparison columns 255
computed fields 242
functions 245
moving 262
selecting columns to display 140
suffixes 236
variables 238

output levels
adding levels to reports 331
changing group ordering 329
configuring recursive drill-down 333
creating custom scripts 335
creating group filters 316
drill-down feature overview 75
overview 328
result grouping 328

output options
adding borders 136
adding page breaks 146
adding row numbers 133
applying styles 129
changing margins and report width 131
changing report backgrounds 134
changing report magnification 139
changing sort options 141
displaying calculations on separate lines 133
enabling auto filters 143
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reports (continued)
output options

enabling multiline 133
fixing column headers 133
showing or hiding report sections 138

permissions, specifying 354
planning custom reports 166
previewing 179

print preview 107
printing 107
publishing 114
queuing

automatic 102
manual 100
opening queued reports 104
overview 100
queue statuses 103
reasons for queueing failure 103
ribbon options on queued reports 105
viewing objects in queue 103
when using report databases 105

record limits 290
report definitions

exporting 74
importing 178
overview 72

report linking, drill-down feature overview 75
report sections

adding images to 226
adding output descriptions 231
adding text fields to 228
adding to reports 218
applying report layouts 216
editing styles 219
layout 224
overview 210
resizing sections 219

report view 77, 179
ribbons

Design 86, 192
Display 83, 187
Format 87, 201
Home 78, 184
Insert 188
Layout 201
Level 189
Options 204

reports (continued)
ribbons

Page Setup 85
rollups 155
scheduling

adding alerts 127
overview 121

searching 90
slicing

buckets 151
overview 147

table relationships
changing table order 299
changing table relationships 297
defining table relationships 294
table joins 291

text fields
adding to report sections 228
editing 229

viewing 68
Reports explorer

in dashboard design center 371
navigating report folders 26
overview 25
ribbon options 78
searching for reports 18

result grouping 328
ribbons

Design 86, 192
Display 83, 187, 364
Format 87, 201
Home 78, 184
Home tab 362
Insert 188
Layout 201
Level 189
minimizing 78
Options 204, 368
Page Setup 85, 366
Text Field 367

rollup calculations 282
rollups 155
Rollups window, field descriptions 157
row numbering 133
run-time selectable filters

combining filters 321
docking filters 322
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run-time selectable filters (continued)
overview 313
requiring filters 322

S
Save As window 24
Schedule Recurrence window, field descriptions 125
scheduling

adding alerts 127
dashboards 390
reports 121

Scheduling window 122
search criteria descriptions 233
Search Dashboard window 407
searching

dashboard reports 406
date range filters 93
docked filters, in dashboards 406
filters 312
row limits 92
Search window, field descriptions 91

section styles
Borders Tab window 222
Fill Tab window 221
Margins Tab window 220

Select Image window 53
Select Intermediate Table and Join window 296
Select Join window 294
Select Names window, field descriptions 112
Set Filter Values window 393
Size Tab window, field descriptions 57
Slice Bucket window, field descriptions 152
Slice window, field descriptions 149
slicing

buckets 151
overview 147

Sort window 142
sorting, report output 141
string functions 246
Style Editor window 28
styles

applying
to dashboards 394
to reports 129

styles (continued)
Auto Format window 130
Borders Tab window 32
creating styles 27
Fill Tab window 30
Margins Tab window 29
Style Editor 28

Styles explorer
Borders Tab window, field descriptions 32
creating styles 27
Fill Tab window, field descriptions 31
Margins Tab window, field descriptions 30
overview 27
Style Editor 28

Styles Tab window, field descriptions 273
suffixes, added to database fields 236
system configuration settings

Agedatabase Utility settings 421
analytics server options 418
clustering 417
date format options 419
gap analysis reporting options 423
opportunity snapshot reporting options 423
overview 417
purging report data 422
report custom scripts 418
report options 418
report row limit 421
RightNow Common settings 417
RightNow User Interface settings 421
sales reporting options 423

T
table joins 291

changing join conditions 297
changing join types 297
examples 292
inner joins 291
intermediate joins 295
outer joins 292

tables
changing join conditions 297
changing join types 297
changing table aliases 298
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tables (continued)
changing table relationships 297
defining intermediate table joins 295
defining table relationships 295
deleting tables 297
ordering tables 299
understanding table relationships 291

tabs, dashboards 377
Tabular Display Tab window, field descriptions 286
tabular layout 130
Text Definition window 321
Text Field tab, button descriptions 195
text fields

in dashboards
adding text fields 382
editing text fields 384
moving text fields 386

in reports
adding text fields 228
editing text fields 229

Text Fields explorer
Borders Tab window, field descriptions 60
creating text fields 55
Fill Tab window, field descriptions 58
Margins Tab window, field descriptions 57
overview 54
Size Tab window, field descriptions 57
Text Tab window, field descriptions 56

Text Tab window, field descriptions 56, 265
time zone options

in dashboards 388
in reports 356

Titlebars Tab window 397
Top 10 window 145
transaction codes

attribute fields 429
overview 425
table field descriptions 425
transaction types and table associations 427

Trend Percentage window, field descriptions 261
trend percentages 260
trend values

options 260
overview 259

U
Unable to Process Report window 102
URL Tab window, field descriptions 278

V
variables

adding to columns 242
creating 238
data types descriptions 240
ordering 323
overview 238
variable types descriptions 239

views
dashboards

design view 361
report view 361

reports
data set view 179
design view 179
layout view 77, 179
report view 77, 179

W
Width Tab window, field descriptions 272

X
XML export format 117

Z
zoom feature 139
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